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Modul 1: Photoshop
1. Nəfis Patbingsu (qırmızı lobya, buz, su) hazırlamaq
2. Gözəl foto dizayn etmək
3. Gözəl buz qəlibi yaratmaq
4. Maraqlı slayd filmi təşkil etmək
5. Smart ana səhifəni dizayn etmək

Modul 2: Illustrator
1. Əyləncəli simvol markası yaratmaq
2. Simvolu istifadə edərək koster yaratmaq
3. Sadə plakat hazırlamaq (küçə reklamı)
4. 3D obrazı yaratmaq (əjdaha)
5. Gündəlik plan yaratmaq
6. Kraliça gülü loqosunun hazırlanması
7. Qalın xətt istifadə edərək loqonun hazırlanması
8. Kiçik nöqtə ilə nöqtə loqosu növünün hazırlanması
9. Vaxtı göstərmək üçün yarlığın dizayn olunması
10. Canlı tekstura ilə bannerin yaradılması

Modul 3: Premiere
1. Hərəkətli şəkil effekti animasiyası düzəltmək
2. Qeyri-şəffaflığı dəyişmək üçün animasiya yaratmaq
3. Xüsusi rəng standartlarını tətbiq etmək
4. Başlıqlara effektlər tətbiq etmək
5. VR şəklini redaktə etmək
a. VR şəklinin redaktə olunması
b. VR şəklinin çıxarılması
c. VR təsvirinin YouTube-a yüklənməsi
d. Premiere Pro ilə VR şəklinin yüklənməsi
e. VR şəklini səs yoxlaması ilə əlaqələndirmək
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Modul 4: HTML - JAVASCRIPT
1. Müxtəlif qutular hazırlamaq 
2. CSS ilə menyu yaratmaq  
3. HTML ilə əsas Menyuları düzəltmək  
4. Faydalı məlumat lövhəsi yaratmaq  
5. Özünü təqdimat üçün veb səhifə tərtib etmək  
6. Pop-up pəncərəsini göstərmək  
7. Rəqəmi yoxlamaq  
8. E-mail Formasını yoxlamaq  
9. İngilis simvolu və rəqəmini müəyyənləşdirmək  
10. Qadağan olunmuş sözü axtarmaq 

Modul 5: UX/UI
1. Kamera tətbiqləri üçün ikon dizayn etmək  
2. Kamera çəkilişi üçün səhifəni dizayn etmək 

Modul 6: SQL (Oracle üçün)
1. JOIN qaydalarını tərtib etmək  
2. ERD əsasları  
3. Cədvəl, Və (Dəyər obyekti) və məlumat toplusu yaratmaq

Modul 7: PHP
1. PHP-nin istifadəsinə başlamaq 
2. PHP qeydiyyat proqramını hazırlamaq

 
Modul 8: Proqramlaşdırma dili (Java)
1. Bu günün şans oyununu yaratmaq 
2. Daş, kağız və qayçı oyununu düzəltmək 
3. Vurma cədvəli yaratmaq
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538
540
546
551
560

Modul 9: Sosial şəbəkə xidməti (Bloq)
1. İngilis dilində bloq yaratmaq  
2. Yahoo saytında bloq yaratmaq  
3. Twitter yaratmaq 
4. Facebook yaratmaq
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Ön söz 

 Şəkil redaktə proqram təminatı olan Photoshop Adobe Systems Inc tərəfindən yaradılıb və ink-
işaf etdirilib. Photoshop şəkil redaktə proqram təminatında liderlərdən biri hesab olunur. Pro-
qram təminatı dijital şəkillərdə manipulyasiya, kəsimə, ölçünün yenidən dəyişdirilməsinə və 
rəng düzəlişlərinə imkan verir. Proqram təminatı əsasən peşəkar fotoqraflar və qrafik dizaynerlər 
arasında məşhurdur. 
 Daha detallı izah etsək Adobe Photoshop MacOS və Windows üçün Adobe Systems tərəfindən 
hazırlanmış və nəşr olunan raster qrafik redaktorudur. Photoshop 1988-ci ildə Thomas və John 
Knoll tərəfindən yaradılıb. O vaxtdan etibarən Photoshop raster qrafik redaktəsində de-fakto 
sənaye standartı hesab olunur. Adobe şirkəti “photoshop an image”, “photoshopping” və “photo-
shop contest” kimi ifadələri qəbul etmədiyinə görə photoshop sözünün özü ümumi bir marka halı-
na gəldi. O, raster şəkilləri bir neçə qatda yarada və redaktə edə bilir, eyni zamanda RGB, CMYK, 
CIELAB, spot rəngləri və duoton da daxil olmaqla bir neçə rəng modellerini dəstəkləyir. 
Photoshop qrafik fayl formatları üçün böyük dəstək göstərir. Həmçinin özünün yuxarıda göstərilən 
xüsusiyyətləri dəstəkləyən PSD və PSB kimi fayl formatlarını da istifadə edir. Raster qrafiklərinə 
əlavə olaraq onun mətnləri, vektor qrafikləri, 3D qrafikləri və videoları redaktə etmək qabili-
yyətləri limitlidir. Photoshop-un xüsusiyyət dəstəyi Photoshop plugins tərəfindən genişləndirilə 
bilər. Proqramlar onun içərisində fəaliyyət göstərərək Photoshop-da azad şəkildə yaradılır və yeni 
xüsusiyyətlər təklif edir. 
 Photoshop-un adlandırma sxemi əvvəlcə versiya nömrələrinə əsaslanırdı. Lakin 2002-ci ildə Cre-
ative Suite markasının tətbiqi ilə əlaqədar olaraq Photoshop-un hər yeni versiyası “CS” üstəgəl 
nömrə ilə müəyyənləşdirilməyə başladı. Misal üçün, Photoshop-un 8-ci əsas versiyası Photoshop 
CS və 9-cu əsas versiyası CS2 idi. Photoshop CS3 ilə CS6 arası, həmçinin iki müxtəlif buraxılışda 
yayıldı: standart və genişlənmiş. 2013-cü ilin iyun ayında Creative Cloud markasının təqdimatı ilə 
Photoshop-un lisenziyalaşdıra proqramı “xidmət icarə modeli” kimi proqram təminatına dəyişdi-
rildi və “CS” suffiksləri “CC” ilə əvəz olundu. Tarixən Photoshop “Adobe ImageReady”, “Adobe 
Fireworks”, “Adobe Bridge”, “Adobe Device Central and Adobe Camera RAW” kimi əlavə pro-
qram təminatı ilə bağlanırdı. Photoshop ilə yanaşı Adobe, həmçinin “Photoshop Elements”, “Pho-
toshop Lightroom”, “Photoshop Express”, “Photoshop Fix”, “Photoshop Sketch and Photoshop 
Mix”-i də yaradıb, inkişaf etdirir. Adobe, eyni zamanda 2019-cu ildə iPad üçün Photoshop-un tam 
versiyasını yaratmağı planlayır. [6] Kollektiv olaraq bu proqramlar “The Adobe Photoshop fami-
ly” adı altında brendləşib. Bu faktiki olaraq lisenziyalaşdırılmış proqram təminatıdır.
 Yekun olaraq mən çoxsaylı mənbələrə, xüsusilə YouTube, Yahoo, Wikipedia, “www.hrdbank.
net” və Google saytlarına təşəkkür edirəm. Onlar mənə texniki təcrübə modullu dərsliyin hazırlan-
masında köməklik etdilər. 

                YUN, Hyung Soon, IKT üzrə Texniki Ekspert
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Photoshop yaratma alətinin komponentlərini izah edəcək.
2.   Müxtəlif alətləri istifadə edərək nəfis Patbingsu hazırlamağı bacaracaq.

Təcrübə materialları:
1.   Noutbuk/Stolüstü kompüter
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   Photoshop proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1.  Photoshop proqramının ekran tərkibi

1. Nəfis Patbingsu 
(qırmızı lobya, buz, su) hazırlamaq

Şəkil 1-1: Ekran tərkibi

Menyu
sətri

Vəziyyət sətri

Parametr 
sətri

Panel

Lövhə

Alət qutusu
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Şəkil 1-2: Qat

2. Qat (Layer)
1) Qatlar panelində (Windows>Layers) yuxarı qatdan arxa fonun aşağı qatına qədər bütün qat-

lar şəkil kimi sıralanır. Əgər özəl iş mühitində mütəxəssis olaraq işləyirsinizsə qatlar panelini çöl 
hissəyə sürüyüb digər panellərlə etiketləyə bilərsiniz. 

2) İşlədiyiniz aktiv qat asan identifikasiya üçün işarələnir. Bir şəkil üzərində işlədikdə dəyişik-
liklər və düzəlişlərin düzgün qatda nümayiş olunduğundan əmin olmaq üçün aktiv qatı yoxlayın. 
Misal üçün, siz əmri seçirsinizsə və heç nə görünmürsə düzgün qata baxdığınızdan əmin olmaq 
üçün yoxlayın. 

3) Paneldə ikondan istifadə etdikdə qatı yaratmaq, əlaqələndirmək, kilidləmək və silmək kimi 
bir çox tapşırığı yerinə yetirə bilərsiniz. Bəzi istisnalarla dəyişikliklər yalnız seçilmiş və ya aktiv 
olan qata təsir edir.

3. Seçim aləti
1) Seçim - sizin təyin etdiyiniz şəkil sahəsidir. Siz seçimi yaratdıqda sahə redaktə oluna bilir 

(Misal üçün, siz şəkilin bir hissəsini qalan hissəyə təsir etmədən işıqlandıra bilərsiniz). Seçimi 
ya seçim aləti, ya da seçim əmri ilə etmək mümkündür. Gizlədə biləcəyiniz seçim sərhədi həmin 
seçimi əhatə edir. Siz seçim sərhədi içərisində pikselləri dəyişə, kopyalaya və ya silə bilərsiniz, 
amma seçim xaricindəki sahələrə seçməni götürənədək toxuna bilməzsiniz.

2) Adobe Photoshop elementləri müxtəlif növ seçimlər üçün seçim alətini təmin edir. 
3) Seçim aləti parametrləri:
1. Elliptical Marquee (Ellipsşəkilli sətir seçmə) aləti dairəvi və ellipsşəkilli sahələri seçir. 
2. Magic Wand (Sehirli çubuq aləti) bir klik ilə oxşar rənglərin sahəsini seçə bilir. 
3. Daha çətin seçimlər Lasso (kəmənd aləti) ilə edilə bilər. Siz seçimin kənarlarını kənar dü-

zləşdirmə aləti ilə tənzimləyə bilərsiniz. 
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Şəkil 1-3: Düzbucaqlı və ellipsşəkilli Marquee aləti parametrləri

Şəkil 1-4: Köçürmə aləti parametrlər sətri

4. Köçürmə aləti (Move tool)
1) Köçürmə aləti sizə şəkildə piksel seçimini kəsib başqa yerə sürüməyə imkan verir. Siz həmçi-

nin bu aləti şəkillər arasında sseçımləri köçürmək və kopyalamaq üçün Photoshop elementlərində, 
eyni zamanda sseçımləri dəstəkləyən digər tətbiqlərdə də istifadə edə bilərsiniz. 

1. Redaktə iş sahəsində seçim aləti ilə seçimi edin və alət qutusundan köçürmək alətini kliklə-
yin.

2. Seçimlər sətrindən köçürmə alətinin parametrlərini dəyişin.
3. İşarəedicini seçim haşiyəsinin içərisinə köçürün və seçimi yeni vəziyyətə gətirin. Əgər siz 

birdən çox sahəni seçmiş olsanız seçdiyiniz bütün piksellər sürüdüyünüz kimi qalacaq.
2) Köçürmə aləti parametrləri:

1. Avtoseçim qatı (Auto Select Layer)
Hal-hazırda seçilmiş qatın yerinə köçürmə alətinin kursorunun aşağısında pikselləri olan ən üst 

qatı seçir.  
2. Sərhədləyici qutunun göstərilməsi (Show Bounding Box)
Şəkildə və ya seçilmiş qatın ətrafında sərhədləyici qutunu nümayiş etdirir (əgər şəkildə 

heç bir aktiv seçim yoxdursa). Tərəflərdə və künclərdə qutular sizə qatı və ya seçimi yenidən 
ölçüləndirməyə imkan verir. 

※ Qeyd: 
Sərhəd qutusu arxa fon qatı üçün görünməz olur.
3. Rollover (Çevrilmə) üzərində işarələrin göstərilməsi
Siçan şəkilin üstünə gəldikdə qatlar tək-tək vurğulanır. Seçmək və köçürmək üçün işarələnmiş 

qata klik edin. Seçilmiş qatlar rollover-də vurğulanmır.  
4. Menyunun yerləşdirilməsi (To arrange menu)
Seçilmiş qatı digər qatların qarşısına, arasına və ya arxasına köçürün. Seçimlərə “Bring To 

Front”, “Bring Forward”, “Send Backward” və “Send To Back” daxildir. Yerləşdirmək üçün qatı 
seçin və daha sonra yerləşdirmək menyusundan bir element seçin.
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5. Menyunun düzülməsi (To align menu)
Seçilmiş qatları düzür. Seçimlərə “Top Edges”, “Vertical Centers”, “Bottom Edges”, “Left Edg-

es”, “Horizontal Centers” və “Right Edges” (yuxarı kənarlar, şaquli mərkəzlər, aşağı kənarlar, 
üfüqi mərkəzlər və sağ kənarlar ) daxildir.  Seçimlər arasında birdən çox qat eyni zamanda sıralana 
bilər. Düzmək üçün qatı seçin, şhift düyməsini basılı saxlayıb digər qatı seçin və sonra düzmək 
menyusundan bir element seçin. 

6. Menyunun təsnif edilməsi (To distribute menu)
Seçilən qatları bir-birindən ayırır. Seçimlərə yuxarı künclər, şaquli mərkəzlər, aşağı künclər, sol 

künclər, üfüqi mərkəzlər və sağ künclər daxildir. Birdən çox qat eyni anda mövcud ola bilər. Qat-
ları bir-birindən ayırmaq üçün bir qat seçin. Shift düyməsini basılı saxlayaraq digər qatları seçin 
və menyudan bir element seçin. 

5. Möhür aləti (Stamp tool)

Şəkil 1-5: Kopyalama möhür aləti

1) Kopyalama möhür aləti şəkilin bir hissəsini digər hissəsi üzərində və ya eyni rəng rejimi 
olan hər hansı sənədin digər hissəsi üzərində çəkir. Siz, həmçinin hansısa qatın bir hissəsini digər 
qat üzərində çəkə bilərsiniz. Kopyalama möhür aləti obyektlərin kopyasını çıxarmaq və şəkildə 
nöqsanı silmək üçün Faydalıdır. 

2) Siz, həmçinin kopyalama möhür alətini videoda və ya animasiya çərçivəsində məzmunu 
rəngləmək üçün də istifadə edə bilərsiniz. 

3) Kopyalama möhür alətini istifadə etmək üçün pikselləri kopyalamaq istədiyiniz sahədə bir 
nümunə nöqtəsi təyin edin və digər sahəni boyayın. Boyamanı dayandırdığınız və davam etdiyiniz 
zaman düzüm parametrini seçin. İlkin nümunə nöqtəsindən boyamağa başlamaq üçün neçə dəfə 
boyamanı dayandırdığınız və davam etdiyinizdən asılı olmayaraq düzüm seçimini ləğv edin. 

4) Kopyalama möhür aləti üçün sahə ölçüsünə nəzarət edə bilən istənilən növ fırça istifadə edə 
bilərsiniz. Həmçinin rəngləmə tətbiq olunan sahəyə qeyri-şəffaflıq və axım parametrlərini tətbiq 
edə bilərsiniz.

1
Fırça toplayıcısı

Kopyalama möhür aləti
2
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Şəkil 1-6: İş mühitinin hazırlanması

Şəkil 1-8: Ön fonun dəyərlərinin 
tənzimlənməsi

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Photoshop-da iş mühitinin əvvəlcədən 
hazırlanması
1.1 File>New
1. Başlıq: Patbingsu
2. Şəkil ölçüsü: 
 - En: 18sm
 - Hündürlük: 18sm
3. Dəqiqlik: 300 pixel/inch
4. Rəng rejimi: RGB color
5. Məzmun: Ağ
6. Arxa fonu çəkmək 

2. Arxa fonun çəkilməsi
2.1 Arxa fona qradientin tətbiq olunması
1. Ön fon rənginə klik edin.
2. Rəng seçimi pəncərəsində
aşağıdakıları daxil edin:
 - C 2, M 37, Y 100, K 0
3.[OK] düyməsini klik edin.

1

2
Arxa fon rəngi

Ön fon rəngi



İKT

12

2.2 Arxa fon qatına qradientin tətbiq olun-
ması
1. Qradient alətinə klik edin.  
2. Şhift düyməsini basılı saxlayaraq siçanı   
lövhənin aşağısından yuxarısına doğru sürüyün.
3. Arxa fon qatına qradienti tətbiq edin.

3. Patbingsu (Buzlu su) fi ncanının seçilməsi
3.1 Buzlu su materialını hazırlamaq üçün 
“Patbingsu mənbəyi” faylını açın.
1. Sehirli çubuq alətini seçin.  
2. Parametr sətrində tolerantlığı “20” edin. 
3. Asan seçilməsi üçün buzlu su fi ncanının 
kənarlarını sadə rəng edin.

3.2 Buzlu su fi ncanının seçilmiş sahəsini 
böyüdün.
1. Select>Modify ilə böyütmək pəncərəsini açın. 
2.  “4 piksel”i daxil edin.
3. [OK] düyməsini klik edin.
 - Beləliklə, buzlu su fi ncanının kənar xətti seçil-
ir.
4. Aktiv seçim yerində Select>Inverse ilə seçilm-
iş sahəni tərsinə çevirin. 

3.3 Buzlu su fi ncanının seçilmiş kənar xətləri-
ni və ya konturlarını zənginləşdirin. 
1. Select>Modify
2. Feather alt menyusunu klik edin. 
3. [Feather] dialoq qutunu açın.
 - Feather Radiusuna “2 piksel”i daxil edin.
4. [OK] düyməsini klik edin. 

※ İş pəncərəsinə seçilmiş şəkilin köçürülməsi
 - Obyekti kopyalayın və iş pəncərəsinə 

Şəkil 1-9: Ön fon qatının qradienti

Şəkil 1-10: Siçanı sürümək

Şəkil 1-11: Qradientin yekunlaşdırılması 

Şəkil 1-12: Alt menyunun böyüdülməsi

2

1

2 3
1
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yapışdırın. 
 - [Move] aləti ilə seçilmiş sahəni klik edin və 
onu iş pəncərəsinə sürüyün.

4. Jelenin ehtiyatla seçilməsi
4.1 Mənbə faylından  jeleləri fi ncanda buz 
üzərinə qoyun. 
1. Lasso (kəmənd) alətini seçin.  
 - Jelenin istədiyiniz hissəsindən bir azını klik 
edin və sürüyün. 
2. [+ Şhift] ilə dəyişiklik edin.
 - Əgər jele seçimində eyni vaxtda böyük yük 
olduqda dayandırmaq istədiyiniz yerdə siçanı iki 
dəfə klik edin. 
 - Bu nöqtədə seçim sahəsi qurulur. 

4.2 Seçim sahəsini dəyişdirin və redaktə edin.
1. Sizin seçməli olduğunuz sahə seçmək istədi-
yiniz sahədən kiçikdirsə Lasso alətini istifadə 
edərək sahəni əlavə edin.
 - Seçmə sahəsində parametr sətrində  [Add to 
Selection] düyməsini istifadə edin.  
 - [Shift] düyməsini basılı saxlayın.
2. Sahəni çıxarmaq istədikdə parametrlər sətrində 
Lasso alətini sürüyərək seçilmiş sahəni çıxarın. 
 - Seçim sahəsində parametr sətrinin seçimdən 
çıxarılması.  
 - [Alt (option)] düyməsini basılı tutun.

4.3 Jelelərə Feather dəyərini tətbiq edərək 
buz üzərinə qoyun.
1. Obyektin ölçüsünü və istiqamətini tənzim-
ləmək üçün  Edit>Free Transform qısaldılması 
olan [Ctrl (Command) + T] qısayol düyməsini 
klik edin. 
 - [Bounding Box] ekranda meydana çıxır.

Şəkil 1-13: Alt menyunun tərsinə çevrilməsi

Şəkil 1-14: Feather radiusu

Şəkil 1-15: Qara, qırmızı və açıq yaşıl jelenin 

Şəkil 1-16: Çöl üzümlərinin seçilməsi

2

1 3
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2. Əyri ox işarəsini sürüyərək obyekti fırladın və 
ölçüsünü tənzimləyin.
 - Siçan [Bounding Box]-un kənarına yaxın gəl-
dikdə əyri ox işarəsi meydana çıxır.
3. Alt düyməsini basılı saxlayaraq, seçilmiş jele-
ni sürüyərək obyekti kopyalayın.
 - Buzun üzərində iki parça jelenin yaxşı görün-
məsini təmin edin.
 - Eyni qaydada digər jeleləri buz üzərinə qoyun.

5. Meyvələri buzlu suyun üzərinə qoyulması
5.1 Seçim sahəsini düzgün şəkildə təyin etmək 
üçün [Quick Mask Mode]-u   iki dəfə klik 
edin.
1. İş şəkli ilə tanış olmaq üçün sürətli maska re-
jimini qurun. 
 - Bu, rəng tətbiq etmə sahəsinin maska sahəsinə 
gəldiyi sahədir.
 - Bu, rəng tətbiq etmə sahəsinin seçim sahələrinə 
gəldiyi sahələrdir.
2. Kivini seçin.
 - [Quick Mask Areas]-da [Selected Areas]-i tə-
yin edin, çünki Patbingsu şəkili xaric digər sahə 
kivini seçmək üçün çox genişdir.
 - Şəkilin bir-birindən fərqlənməsi üçün rəngi 
müəyyən edin.

5.2 Pozan aləti ilə seçiləcək kivi sahəsini 
boyayın.
1. Boyama sahəsinin ölçüsünə uyğun olaraq 
fırça ölçüsünü tənzimləyin. 
2. Seçilmiş sahəni daha dəqiq etmək üçün [Ctrl 
(Command) + “+”]-ı klik edin. 
3. Görünməyən halda [Space Bar] düyməsini 
basaraq şəkili sürüyün və yerini dəyişin. 

5.3 Lazımsız sahəni silin. (Şəkil 1-19)
1. Dəyişiklik üçün [Color Transform Button (X)] 
düyməsinə klik edin.

Şəkil 1-17: Kopyalamaq və yapışdırmaq

Şəkil 1-18: Sürətli maska rejimi

Şəkil 1-19: Kivinin çəkilməsi və silinməsi

2

1 3
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 - Ön fon rəngini qara rəngə dəyişin.  
 - Siçanı sürüdükdə lazımsız sahələr silinir. 
2. Daha çox seçim üçün alternativ olaraq  [Stan-
dard mode] və [Quick Mask mode]-u yoxlayın.

5.4 Hamar olmağı üçün şəkilin kənarlarını 
düzəldin. (Şəkil 1-20)
1. Kivini seçdikdən sonra:
 - Select>Feather
 - Dəyər: 2
 - [OK] düyməsini klik edin. 
2. Kivini seçdikdə onu iş pəncərəsinə sürüyün.
 - İlk olaraq kivi şəklini seçin.
 - İş pəncərəsinə yeni şəkil əlavə etdikdə onu, 
eyni zamanda kopyalayın. 
3. Kivi şəklinin ölçüsünü və istiqamətini tənzim-
ləyin.
 - [Ctrl (Command) + T] düyməsini istifadə edin. 

5.5  (Şəkil 1-22)-də olduğu kimi meyvə 
hissələrini və portağalı buz suyu üzərində 
qoymaq üçün prosesi təkrarlayın.
1. PAT-ı kopyalayın. (Qırmızı lobya)

6.1 [Patbingsu] faylından PAT-ı kopyalayın. 
1. [Stamp]   tool>Close stamp 
2. Parametrlər sətrindən fırçanın müvafiq 
ölçüsünü seçin.
3. [Alt (option)] düyməsini basılı saxlayaraq əsas 
nöqtəyə klik edin. 

6.2 İki fərqli iş pəncərəsi yaradın.  
1. İş pəncərəsinə yeni bir qat əlavə edin və  bu 
qat buzlu su fincanının üzərində yerləşəcək.
2. Mənbə pəncərəsinin üstəgəl işarəsinə bax-
arkən (+) siçanı sürümək üçün kopyalayın. 

Şəkil 1-20: Feather funksiyası

Şəkil 1-21: Feather funksiyası

Şəkil 1-22: Buzlu suyun üzərinə meyvələrin 
qoyulması 

3
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3. Davamlı iş üçün kopyalamağı dayandırdıqda 
kopya etmək üçün seçimlər pəncərəsində [Align] 
seçimini aktivləşdirin.  

 
7. Patbingsu fincanına dondurma qoymaq 
7.1 Yekun olaraq dondurmanı fincanın mərkəz-
inə qoyun. 
1. [Magnetic Lasso]   alətini seçin.
2. Dondurma şəklini rəng sərhədinin başlanğıc 
nöqtəsini klik etmək üçün seçin. 
3. Siçanı şəkilin sərhədləri boyunca hərəkət et-
dirin, beləliklə kənar sərhədlər avtomatik olaraq 
seçiləcək. 

7.2 Magnetic Lasso aləti [o] işarəsini göstər-
dikdə siçanı klik edərək seçilmiş sahələri 
tamamlayın. 
1. Əgər hər hansı bir səhv olarsa, [Delete] 
düyməsini basın. Beləliklə əsas nöqtəni bir-bir 
silin. 
2. Dondurmanı rəng sərhədinin başlanğıc 
nöqtəsini klik etmək üçün seçin. 
3. İz başlanğıc nöqtəsindən bitmə nöqtəsinə gəl-
dikdə şəkilin sərhədi boyunca siçanı hərəkət etdi-
rin. Beləliklə, sərhəd avtomatik olaraq seçiləcək. 

7.3 Son olaraq dondurmanı “Patbing-
su source” pəncərəsində sürüyərək iş 
pəncərəsinə köçürün. Ölçünü Edit>Transform 
ilə tənzimlədikdən sonra dondurmanı fincanın 
mərkəzinə köçürün.

Şəkil 1-23: Möhürləmə aləti ilə kopyalamaq

Şəkil 1-24: Rənglər arasında sərhəd nöqtəsi

Şəkil 1-25: Tamamlanmış Patbingsu

1
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Photoshop-un komponentlərini düzgün şəkildə izah etdi?
2. Müxtəlif alətlərdən istifadə edərək nəfis Patbingsu hazırladı?
3. Verilmiş şərtlərə uyğun olaraq arxa fon rəngini tərtib etdi?
4. Müvafiq istifadə üçün seçim alətini düzgün şəkildə tətbiq etdi?
5. İş prosesində Lasso alətinin istifadəsini tətbiq etdi? 
6. Əmr kimi qısa yol düyməsini istifadə etdi?
7. İş vəziyyətinə görə pozan alətini istifadə etdi?  
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1. Qatlar və kanalların funksiyalarını dəqiq şəkildə izah edəcək.
2. Bir təsvirdə çoxlu şəkilləri düzgün şəkildə dizayn etməyi bacaracaq.

Təcrübə materialları:
1.   Noutbuk/Stolüstü kompüter
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   Photoshop proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1.  Qat maskası (Layer mask)
1. Qat maskası - qatın, qrupun və tənzimləmə qatının görüşünə nəzarət edir. Qat maskası bütövlük-

də ağ olduqda qat tamamilə görünən olur. Qat maskası bütövlükdə qara olduqda isə qat tamamilə 
görünməz olur.

2. Siz müvafiq sahəni qaraya boyayaraq qatın bir hissəsini görünməz etmək üçün seçim edə 
bilərsiniz. Siz fırça aləti, kopya möhür aləti, qradient aləti və digər seçimlər də daxil olmaqla alətlərin 
çoxunu alətlər panelində istifadə edə bilərsiniz. 

3. Misal üçün, əgər siz arxa fondan süjeti kəsmək istəyirsinizsə süjetin ətrafını seçin və bu seçimi 
qat maskası kimi yükləyin. Süjet arxa fonda görünəcək və arxa fon görünməz olacaq. 

2. Qat maskasının əlavə olunması
1. Photoshop ediləcək şəkli açın.
2. Seçim (Select) menyusunu və Ləğv etmək (Deselect) əmrini seçərək şəkilin istədiyiniz hissəsi-

ni ləğv edin. 
3. Qatı seçin və ona klik edin.
4. Qat maskasını seçin.
5. Hamısını gizlət (Hide all) əmrini klik edin.

2. Gözəl foto dizayn etmək 
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Şəkil 2-1: Qat maskası şəkili

• Hamısını göstərmək:  Ağ rəngdə boş qat maskası yaradıldı və bütün şəkil meydana çıxdı. Qara 
ilə rənglənmiş hissə gizlədildi. 

• Hamısını gizlətmək: Qara rəngdə boş qat maskası yaradıldı və bütün şəkil gizlədildi. 
• Seçimi göstərmək: Şəkil seçim sahəsi əsasında seçim sahəsinin xarici hissəsini gizlədən qat 

maskası yaradıldı. 
• Seçimi gizlətmək: Şəkil seçim sahəsində seçim sahəsinin daxili hissəsini gizlədən qat maskası 

yaradıldı. 
 
■ Qeyd
A. Qat maskasının əlavə edilməsi 
Siz qat maskasını əlavə etdikdə bütün qatları gizlədə və ya göstərə bilərsiniz və ya maskanı seçimə, 

yaxud şəffaflığa əsaslandıra bilərsiniz. Daha sonra maskanın üzərini rəngləyərək qatın hissələrini gi-
zlədə, altındakı hissələri meydana çıxara bilərsiniz. 

B. Bütün qatı göstərmək və ya gizlətmək üçün maskanın əlavə olunması
1. Şəkilin heç bir hissəsinin seçilmədiyindən əmin olun. Select>Deselect-i seçin.
2. Qatlar panelində qat və ya qrupu seçin. 
3. Aşağıdakılardan birini edin:
 • Bütün qatı göstərməyə maska yaratmaq üçün qatlar panelindən Add Layer Mask   (Maska qa-

tının əlavə olunması) düyməsini və ya Layer>Layer Mask>Reveal All-u seçin.
 • Bütün qatı gizlətməyə maska yaratmaq üçün Alt-click (Windows) və ya Option-click (Mac OS) 

the Add Layer Mask button (Maska qatının əlavə olunması düyməsi) və ya  Layer>Layer Mask>Hide 
All-u seçin. 

C. Qatın bir hissəsini gizlətmək üçün qat maskasıının əlavə olunması 
1. Qatlar panelində qat və ya qrupu seçin. 
2.  Şəkildə hissəni seçib aşağıdakılardan birini edin:
 • Seçimi göstərmək üçün qatlar panelində New Layer Mask düyməsinə   (Yeni qat maskası) klik 

edin. 
 • Seçimi gizlətmək üçün qatlar panelində Alt-click (Windows) və ya Option-click (Mac OS) the 

Add Layer Mask düymələrini klik edin.
 • Layer>Layer Mask>Reveal Selection or Hide Selection düyməsini seçin. 
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3. Qat maskasının silinməsi
1. Ləğv etmək (Discard): Yalnız qat maskası silinir, amma qat şəkilinin gizli hissəsi bərpa olunur.
2. Tətbiq etmək (Apply): Qat maskası kimi qat şəkli də eyni zamanda silinir. 

Şəkil 2-2: Orijinal şəkil (SuHyun.jpg)

Şəkil 2-3: Rəng rejimini dəyişmək

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Duoton rəng rejimini hazırlayın.
1.1 Mənbə faylından [SuHyun.jpg] faylını açın. 

1.2 Faktiki rəng rejimini Duoton rəng re-
jiminə çevirin. 
1. [RGB] rəng rejimini [Grayscale] rejiminə 
dəyişin.  
2. Əmri aşağıdakı kimi seçin: 
 - Image>Mode>Grayscale 
3. Xəbərdarlıq mesajını diqqətə almamaq üçün 
[Discard] düyməsini klik edin.
 - Rəng [Grayscale] rejiminə dəyişiləcək. 

2

1

3
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1.3 Image>Mode>Duotone dəyişin. 
1. [Ink2]-ni klik etdikdə, [Custom Colors] dialoq 
qutusu görünəcək. 
2. İstədiyiniz rəngi seçin.
3. [OK] düyməsini klik edin.
4. Qurulmanı yekunlaşdırdıqdan sonra Duoton 
sseçımləri dialoq qutusundan  [OK] düyməsini 
klik edin.
 

Şəkil 2-4: Boz rəngin çalarları rejimi

Şəkil 2-5: Duotonun qurulması 

Şəkil 2-6: Duoton rəngi 

1

5
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2. Südəbənzər üz düzəldin.
2.1 Arxa fon qatının (Background Layer) nüsx-
əsini kopya edin. 
1. Arxa fon qatını sürüyün və [Create a new lay-
er] ikonu   üzərində klik edin. 

2. Digər şəkildə [pop-up] düyməsini seçin 
(siçanın sağ düyməsini klik edin).

2.2 Şəkilin bulanıq görünə bilməsi üçün filtr 
(Filter) funksiyasını tətbiq edin.  
1. [Background copy layer]-i seçin. 

2. [Filter] əsas menyusun-dan [Gaussian Blur] 
alt menyusunu istifadə edin. 

1.3 Bir neçə qatı bir qatda birləşdirin. 
1. [Background copy] qatını dəyişin və qatlar 
palitrasında seçimi normaldan Overlay-ə dəy-
işin.

 - İki şəkilin üst-üstə düşməsi zamanı örtülü şəkil 
əvvəlki şəkildən daha parlaq və hamar görünür.                      
2. Siyahı düyməsinə klik edin. 

Şəkil 2-7: Arxa fon qatının kopyalanması 

Şəkil 2-8: Qaus bulanıqlığı (Gaussian Blur)

Şəkil 2-9: Kəsmək və yapışdırmaq

1

1

2

2

1
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3. [Merge Down] əmri ilə qatları bir qatda 
birləşdirin. 
  

4. Şəkil hissələrini (gözlər, burun və ağız) təs-
vir edin.
4.1 Üzün təsvir olunması zamanı üz cizgiləri-
nin (dəri, gözlər, burun, ağız) bulanıqlığını 
düzəldin. 
1. [Quick Mask Mode]-u seçin.
 - Seçilən yer mövcud parametrlərin rəngi ilə 
rənglənəcək. 
2. [Brush] alətini seçin.
3. [Brush] aləti ilə cizgiləri (gözlər, burun, ağız) 
sürüməklə böyük fərqlə iş sahəsini qurun. 

4.2 Cizgilərin (gözlər, burun, ağız) seçilməsini 
yekunlaşdırdıqdan sonra [Standard Mode]-u 
seçin.
1. Rejimi [Quick Mask]-dan [Standard]-a dəy-
işin.
2. Seçilmiş qatı yeni qat kimi yaddaşa vermək 
üçün seçim yerində [Ctrl (Command) + J] əmrini 
basaraq qat 1-i (Layer 1) düzəldin. 
 - Ctrl (Command) + J
 - Layer>New>Layer via Copy
 - [Ctrl] düyməsini basıb saxlayaraq seçilm-
iş şəkil üzərində siçanın sağ düyməsini basın 
və seçilmiş qatı, son olaraq isə Layer via Copy 
(Kopyala) qatını klik edin. 

4.3 İki qatı bir qatda birləşdirin.  
1. Yeni yaradılmış qat 1-də;
 - Filter> Sharpen> Unsharp Mask
 - Miqdar: 70%, Radius: 3.5 piksel,    Kandar: 10 
mərhələ
2. Filtrlədikdən sonra [Flatten Image] əmri ilə iki 
qatı bir qatda birləşdirin. 

5. Üzün daha gözəl olmasını təmin edin.

Şəkil 2-10: Qatın birləşdirilməsi 

Şəkil 2-11: Üz cizgilərində dəyişiklik etmək

Şəkil 2-12: Yeni qat 1(Layer 1) -i yaratmaq

Şəkil 2-13: Kəskinliyi azaltmaq maskası və 
şəkili yastılaşdırmaq

2
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5.1 Üzü dəyişdirin. 
1. [Liquify] əmri; 
 - Image>Mode>RGB color
 - Duoton rejimini RGB rejiminə dəyişin. 
2. Filter> Liquify-a gedin.
3. [Face tool] ilə yuvarlaq üz almaq üçün üzün 
konturlarını biraz içəriyə doğru dartın.  
 - [Brush]-ı tənzimləyin və [Wrap] funksiyası ilə 
siçanı çənə hissəyə doğru sürüyərək üz cizgiləri-
ni ensizləşdirin. 

5.2 [Burn] alətini aşağıdakı kimi istifadə edin:
1. 5.1-dəki kimi və ya (Şəkil 2-13)-də olduğu 
kimi düz çənə xəttini sürüyərək üzün düzgün 
Formasını tənzimləyin.  
2. Daha detallı cizgilər üçün (gözlər, burun, 
ağız), qaşlar, gözlər, burun forması və dodaqları 
çəkin.
3. Lazımsız hissənin qaralmasının qarşısını al-
maq üçün [Dodge] alətini seçin.
 - Ağız boşluğunda şəkili böyüdən zaman dişlərin 
parlaqlığını təmin edin. 

5.3 Seçim aləti ilə gözləri cəzbedici edin. 
1. [Rectangular Marquee] aləti ilə sol gözü seçin.
 - Çünki sol göz sağ gözdən daha kiçikdir. 
2. [Ctrl (Command) + J] ilə seçim sahəsini yeni 
qat kimi düzəldin.

3. [Ctrl (Command) + T] əmri ilə sol gözü yux-
arı-aşağı uzadaraq mümkün qədər sağ gözün 
ölçüsünə gətirin. 

Şəkil 2-13: Şəffaflaşdrma funskiyası (Liquify)

Şəkil 2-14: Kandar aləti

1
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4. İki qatı bir qatda birləşdirin. 
 - Qatları birləşdirin; [Ctrl + E]
 - Onları [Layer 1] kimi birləşdirin.
 

5.4 Gözləri daha böyük edin. 
1. [Rectangular Marquee] alət ikonu   ilə gözləri 
seçin.
2. [Ctrl (Command) + J] ilə seçim sahəsini yeni 
qat kimi düzəldin.
3. [Ctrl (Command) + T] ilə gözləri yuxarıya və 
aşağıya uzadın, azacıq sağ istiqamətə çevirin. 
4. İki qatı arxa fon qatına (Background layer) 
birləşdirin.
 

6. Arxa fon rənginin dəyişdirilməsi
6.1 Arxa fon təmiz olmadığı üçün lazımsız 
hissələri silin.
1. Silmək üçün Pipet aləti   ikonu ilə arxa fonu 
klik edin.
 - Arxa fon rəngi şəkilin arxa fonuna dəyişilir.        
                                                    
6.2 [Erase] aləti ilə üzün ətrafını ehtiyatla 
düzəldin. 
1. [Erase] alətini   seçin.
2. Kiçik fırça ilə şəkilin yanındakı hissəni ehti-
yatla silin.  
 - Şəkil yalnız arxa fonun lazımsız hissəsində 
böyük fırçayla qalsın.
3. Yeni qat yaradın.
4. [Color Transform] düyməsini klik edin. Qab-
aq fon rəngi ağ rəngə dəyişiləcək. 
5. Qabaq fon ağ olduğu vəziyyətdə [Alt (Op-
tion)+Delete] ilə fonu ağ edin.

Şəkil 2-15: Möhür aləti ilə Patın 
kopyalanması

Şəkil 2-16: Gözlərin düzəldilməsi

Şəkil 2-17: Pipet ilə iş

4

2

1

3

1

4
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Şəkil 2-18: Alt+Delete funksiyası ilə qabaq 
fon rənginin doldurulması

6. Şəkili tamamlayın. 
1. [Layer 1]-də qeyri-şəffaflıq dəyərlərini tən-
zimləyin. 
 - Altdakı şəkilin qısa müddətə görünməsinə ica-
zə verin.
 - Qeyri-şəffaflıq dəyərləri: 50% 
2. Üzün mərkəzində seçim edərək üzün sahəsini 
yaradın.
 - [Elliptical Marquee] aləti ikonunu   seçin.
 - [Feather]-i seçim sətrindən “60 px”-ə dəyişin.

3. Seçim sahəsini tərsinə çevirin.
- Əmr: Select> Inverse
 - Qat palitrasında qat maskası (Layer Mask) 
ikonunu klik edin. 

4. Seçim sahəsindən başqa digər sahəni gizlədin. 
 - Seçim üçün qeyri-şəffaflıq dəyərini (Opacity 
value) “100” edin.
 - Qaranlıqda gizlədilmiş şəkil ağ arxa fon ilə 
aydın şəkildə görünür. 
 - Üzdən başqa digər hissə təbii effektli görünür.
 

2

1

3

4 5

Layer Mask icon
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Şəkil 2-19: 60 px ilə seçim sahəsi

Şəkil 2-20: Seçim sahəsinin tərsinə çevrilməsi

Şəkil 2-21: Tamamlanmış şəkil

3

1

2

4
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Qatlar və kanalların funksiyalarını dəqiq şəkildə izah etdi?
2. Bir şəkildə bir neçə şəkili düzgün formada dizayn etdi?
3. Qat maskasını (Layer Mask) şəkildə düzgün formada tətbiq etdi?
4. Qatlar paneli ikonunu effektiv şəkildə istifadə etdi?
5. Şəkil menyusu ilə rəng rejimini digərinə dəyişdi? 
6. Arxa fon rəngini tələbə əsasən düzgün formada dəyişdi?
7. Obyekti asanlıqla doldurmaq üçün [Alt+Delete] düyməsini isti-
fadə etdi?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Çəkmə alətlərinin funksiyalarını detallı şəkildə izah edəcək;
2.    Müxtəlif alətləri izah edərək aydın şəkildə gözəl bir buz qəlibi hazırlamağı bacaracaq.

Təcrübə materialları:
1.   Noutbuk/Stolüstü kompüter
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   Photoshop proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Qat qarışdırma rejimi (Layer Blending Mode)
Seçimlər sətrində göstərilən qarışdırma rejimi boyama və ya redaktə alətinin şəkildəki piksellərə 

necə təsir etdiyinə nəzarət edir. Qarışdırma rejiminin effektlərini vizuallaşdırmaq üçün aşağıdakı 
rəngləri göz önündə canlandırın: 

• Əsas rəng (base color) - şəkildə orijinal rəngdir. 
• Qarışdırma rəngi (blend color) - boyama və ya redaktə aləti tətbiq olunan zaman olan rəngdir.  
• The result color - qarışdırmadan alınan nəticə rəngidir.

2. Qarışdırma rejimi təsvirləri (Blending mode descriptions)

3. Gözəl buz qəli̇bi̇ yaratmaq

Şəkil 3-1: Qat qarışdırma rejimi
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※ Qeyd:
32 bit şəkillərdə yalnız normal, həll, tündləşdirən, artan, işıqlanan, xətti yayınma, fərq, Canlılıq, 

rəng tonu, rəng, parlaqlıq, daha açıq rəng, daha tünd rəng rejimləri mövcuddur. 

Blending seçim sətirində Pop up menyu
1) Normal - nəticədəki rəngi əldə etmək üçün pikseli redaktə edər və ya boyayar. Bu, ilkin rejim-

dir. (bitmap və ya indeksli-rəngli şəkillərlə işləyəndə normal rejim Threshold adlanır.)
2) Həll (Dissolve) - nəticədəki rəngi əldə etmək üçün pikseli redaktə edər və ya boyayar. Ancaq 

nəticədəki rəng piksel yerləşməsində qeyri-şəffaflıqdan asılı olaraq əsas rəng və ya qarışıq rəng ilə 
piksellərin təsadüfi yerləşməsidir. 

3) Arxa (Behind) - yalnız qatın şəffaf hissəsində redaktə və ya boyama edir. Bu rejim yalnız kilid 
şəffaflığı ləğv olunduqda qatlarda işləyə bilir və asetat lövhədə şəffaf sahələrin arxasındakı təsvirə 
bənzərdir.

4) Aydın (Clear) -hər bir pikseli redaktə edir, boyayır və onu şəffaf edir. Bu rejim fiqur alətləri 
(seçilmiş sahə doldurulduqda  ), boya çəlləyi aləti  , fırça aləti , karandaş aləti   və doldurma əmri 
üçün mövcuddur. Siz bu rejimi istifadə etmək üçün şəffaflığı kilid ilə ləğv olunmuş qatda olmalısınız. 

5) Tündləşdirən (Darken) - hər bir kanaldakı rəng məlumatlarına baxır, əsas və ya qarışdırma 
rənglərini seçir. Qarışdırma rənglərindən daha açıq rəng pikselləri yerləşdirilir və daha tündlər dəy-
işdirilmir. 

6) Artan  (Multiply) - hər bir kanalda rəng məlumatlarına baxır və qarışdırma rəngi vasitəsilə 
əsas rəngi artırır. Nəticədə yaranan rəng həmişə tünddür. Qara ilə istənilən rəngi artırdıqda qara rəng 
yaranır. İstənilən rəngi ağ rəng ilə artırdıqda rəng dəyişməz qalır. Ağ və qaradan başqa bir rəng ilə 
boyayarkən qələm aləti ilə yaradılan rəng tədricən qara rəngə dəyişər. Bu effekt işarələmə qələmi ilə 
çəkən zaman da oxşar olur.   

7) Rəng parıltısı (Color Burn) - hər bir kanalda rəng məlumatlarına baxır və qarışdırma rəngini 
əks etdirmək üçün ikisi arasında kontrastı artırmaqla əsas rəngi tündləşdirir. 

8) Xətti parıltı (Linear Burn) - hər bir kanalda rəng məlumatlarına baxır və qarışdırma rəngini əks 
etdirmək üçün parlaqlığı azaldaraq əsas rəngi tündləşdirir. 

9) İşıqlandırmaq (Lighten) - hər bir kanalda rəng məlumatlarına baxır və hər bir kanalda əsas və 
ya qarışdırma rəngini seçir (hansı daha yüngül olarsa). Qarışdırma rənglərindən daha tünd rəng pik-
sellər yerləşdirilir və daha açıqlar dəyişdirilmir. 

10) Ekran (Screen) - hər bir kanalın rəng məlumatlarına baxır, qarışıq və əsas rənglərin təsirini 
artırır. Qara rəng ilə göstərən zaman rəng dəyişilmir, ağ rəng ilə göstərilən zaman isə ağ rəng yaranır. 
Effekt - birdən çox fotonun slayd şəklində bir-birinin üzərinə əksetdirməyə bənzəyir. 

11) Rəng yayınması (Color Dodge) - hər bir kanalın rəng məlumatlarına baxır və qarışıq rəngi əks 
etdirmək üçün ikisi arasında kontrastı azaldaraq əsas rəngi parlaqlaşdırır.  Qara rəng ilə qarışdırdıqda 
heç bir dəyişiklik baş vermir. 

12) Xətti yayınma (Linear Dodge) - hər bir kanalın rəng məlumatlarına baxır və qarışıq rəngi əks 
etdirmək üçün parlaqlığı artıraraq əsas rəngi parlaqlaşdırır. Qara ilə qarışdırdıqda heç bir dəyişiklik 
baş vermir.

13) Örtmək (Overlay) - əsas rəngdən asılı olaraq rəngləri artırır. Nümunə naxışlar əsas rəngin köl-
gələrini qoruyaraq mövcud pikselləri örtür. Əsas rəng əvəz olunmur, amma orijinal rəngin işıqlılığını 
və ya qaranlıqlığını əks etdirmək üçün qarışıq rəng ilə qarışdırılır. 

14) Yüngül işıq (Soft Light) - qarışdırma rəngindən asılı olaraq rəngləri işıqlandırır və qaraldır.  
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Effekt - şəkildə diffuziya olunmuş spot işığının parıldamasına bənzəyir. Əgər qarışıq rəng bozdan 
50% daha açıqdırsa şəkil solğun kimi görünür.  Əgər qarışıq rəng bozdan 50% daha tünddürsə şəkil 
daha tünd görünür. Yalnız qara və ağ rəng ilə boyamaq daha qaranlıq və daha aydın sahə yaradır, 
amma bütovlükdə qara və ağ rəng nəticə yaratmır. 

15) Tünd işıq (Hard Light) - qarışdırma rəngindən asılı olaraq rəngləri artırır. Effekt - şəkil üzərində 
kəskin spot işığına bənzəyir. Əgər qarışıq rəng (işıq mənbəyi) bozdan 50% daha azdırsa şəkil sanki 
ekranlaşdırılmış kimi işıqlanır. Bu, təsvirə vurğu əlavə etmək üçün Faydalıdır. Əgər qarışıq rəng  
bozdan 50% daha tünddürsə şəkil tündləşir. Bu, şəklə kölgələr əlavə etmək üçün Faydalıdır. Yalnız 
qara və ağ rəng ilə boyamaq bütövlükdə qara və ağ nəticə yaradır. 

16) Parlaq işıq (Vivid Light) - qarışdırma rəngindən asılı olaraq kontrastı artıraraq və azalda-
raq rəngləri parlaqlaşdırır. Əgər qarışıq rəng (işıq mənbəyi) bozdan 50% daha azdırsa şəkil kon-
trastı azaltmaqla işıqlanır. Əgər qarışıq rəng bozdan 50% daha tünddürsə şəkil kontrastı artırmaqla 
tündləşir.

17) Xətti işıq (Linear Light) - qarışdırma rəngindən asılı olaraq parlaqlığı artıraraq və azaldaraq 
rəngləri parlaqlaşdırır. Əgər qarışıq rəng (işıq mənbəyi) bozdan 50% daha azdırsa şəkil parlaqlığı 
artırmaqla işıqlanır. Əgər qarışıq rəng 50% bozdan daha çoxdursa şəkil parlaqlığı azalmaqla tündləşir. 

18) Pin işığı (Pin Light) - qarışdırma rəngindən asılı olaraq rəngləri yerləşdirir. Əgər qarışıq rəng 
(işıq mənbəyi) bozdan 50% daha azdırsa qarışdırma rəngindən daha tünd rənglər yerləşdirilir, daha 
açıq rənglər isə dəyişmir. Əgər qarışıq rəng bozdan 50% daha tünddürsə qarışdırma rəngindən daha 
açıq rənglər yerləşdirilir, daha tünd rənglər isə dəyişmir. Bu, şəklə xüsusi effektlər vermək üçün 
Faydalıdır. 

19) Mürəkkəb qarışım (Hard Mix) - qarışdırma rənglərinin qırmızı, yaşıl və mavi kanal dəyərləri-
ni əsas rəngin RGB dəyərlərinə əlavə edir. Bir kanal üçün əldə edilən cəm 255 və daha çoxdursa 
o, 255-in dəyərini əldə edir. Əgər 255-dən daha azdırsa dəyər 0-a bərabər olur. Bu səbəblə bütün 
qarışdırılmış piksellər 0 və ya 255 olan  qırmızı, yaşıl və mavi kanal dəyərlərinə sahibdir. Bu, bütün 
pikselləri ilkin qarışıq rənglərə (qırmızı, yaşıl və ya mavi), ağ və ya qaraya dəyişdirir.

※Qeyd: 
CMYK təsviri üçün, mürəkkəb qarışım bütün pikselləri ilkin subtraktiv rənglərə (mavi, sarı və 

bənövşəyi), ağ və ya qaraya dəyişdirir. Maksimum rəng dəyəri 100-dür.
20) Fərq (Difference) - hər bir kanalda rəng məlumatlarına baxır və hansının daha yüksək parıltı 

dəyəri olmasından asılı olaraq ya əsas rəngdən qarışdırma rəngini çıxarır, ya da qarışdırma rəngindən 
əsas rəngi çıxarır. Ağ ilə qarışdırmaq əsas və ya təməl rəng dəyərlərini əksinə dəyişir, qara ilə qa-
rışdırmaq isə heç bir dəyişiklik etmir. 

21) Çıxarma (Exclusion) - fərq rejiminə oxşardır, amma kontrastda daha aşağı effekt yaradır. Ağ 
ilə qarışdırmaq əsas və ya təməl rəng dəyərlərini əksinə dəyişir, qara ilə qarışdırmaq heç bir dəyişik-
lik etmir. 

22) Çıxarma (Subtract) - hər bir kanalda rəng məlumatlarına baxır və əsas rəngdən qarışdırma 
rəngini çıxarır. 8 və 16-bit şəkillərdə ortaya çıxan neqativ dəyərlər sıfıra bərabərdir.

23) Ayırmaq (Divide) - hər bir kanalda rəng məlumatlarına baxır və əsas rəngdən qarışdırma 
rəngini ayırır. 

24) Rəng tonu (Hue) - əsas rəngin saturasiya və parlaqlığı, eyni zamanda  qarışıq rəngin rəng tonu 
ilə nəticə rəngi yaradır. 

25) Saturasiya (Saturation) - əsas rəngin parlaqlığı, rəng tonu və qarışıq rəngin saturasiyası ilə 
nəticə rəngi yaradır. 0 saturasiyalı (boz) sahədə bu rejim ilə boyama heç bir dəyişikliyə səbəb ola 
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bilmir. 
26) Rəng (Color) - əsas rəngin parlaqlığı, qarışıq rəngin saturasiyası və rəng tonu ilə nəticə rəngi 

yaradır. Bu, şəkildə boz səviyyələri saxlayır və monoxrom şəkillərin rənglənməsi və rəngli təsvirləri 
yenidən rəngləmək üçün Faydalıdır. 

27) Parlaqlıq (Luminosity)- əsas rəngin rəng tonu və saturasiyası və qarışıq rəngin parlaqlığı ilə 
nəticə rəngi yaradır. Bu rejim, rəng rejiminin əks effektini yaradır.

28) Daha açıq rəng (Lighter Color) - qarışıq və əsas rənglər üçün bütün kanal dəyərlərini müqay-
isə edir və yüksək dəyər rəngi nümayiş etdirir. Daha açıq rəng üçüncü rəng yaratmır. Çünki o, nəticə 
rəngi əldə etmək üçün əsas və qarışıq rəngdən ən yüksək kanal dəyərlərini seçir. 

29) Daha tünd rəng (Darker Color) - qarışıq və əsas rənglər üçün bütün kanal dəyərlərini müqay-
isə edir və daha az dəyər rəngi nümayiş etdirir. Daha tünd rəng üçüncü rəng yaratmır. Çünki o, nəticə 
rəngi əldə etmək üçün əsas və qarışıq rəngdən ən aşağı kanal dəyərlərini seçir.

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. İş mühitinin qurulması 
1) File>New - klik edərək yeni iş sənədini 
yaradın. 
 - Ad: DC03 Make a delicious ice bar (Gözəl buz 
qəlibi yaratmaq)
 - En: 21sm
 - Hündürlük: 29.7 sm
 - Dəqiqlik: 300 pixel/inch
 - Rəng rejimi: RGB Color, 8bit
 - Arxa fon məzmunu: Ağ (White) 

Şəkil 3-2: İş mühtinin qurulması
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2. İş sahəsində  
1)İş pəncərəsində xətkeşləri göstərin.
 - View>Rulers
 - [Move] alətini seçin.
Üfüqi və şaquli xətt çəkin. 

2) Qat palitrasının aşağısında [Create a new La
yer] düyməsini     klik etməklə yeni qat yaradın. 

3) [Rectangular Marquee] aləti ilə qəlibin 
ölçüsündən bir qədər böyük olan seçim sahəsi 
yaradın. 

4) (Şəkil 3-5)-də hazırlanmış [Paint Bucket] aləti 
ilə seçilmiş sahəni rəngləyin. 
- Qabaq fon rəngini aşağıdakı kimi təyin edin:
C38, M8, Y85, K0

Şəkil 3-3: Boz ton çaları rejimi

Şəkil 3-5: Qəlibi çəkmək

Şəkil 3-6: Qabaq fon rəngini tənzimləmə

Şəkil 3-4: Yeni qat yaratmaq

1

2

3
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(Qat 1)

5) Şəkilin  çat divardakı kimi görüntü-sünü 
yaradın.
 - [Ctrl (Command) + D] ilə seçilən obyekti ləğv 
edin. 
 - [Layer 1]-i aktivləşdirin.
 - Filter>Filter Gallery>Craquelure
Çat sahəsi (Crack Spacing): 33
Çat dərinliyi (Crack Depth): 8
Çat parlaqlığı (Crack Brightness): 8

6) Əvvəlki addımın çat vəziyyətini tənzim-
ləyərək taxta tekstura düzəldin. 
 - Filter>Blur>Motion Blur

 

7) Lazımsız hissəni silin, çünki filtr effekti bir 

Şəkil 3-7: Qabaq fon rənginin boyanması 

Şəkil 3-9: Hərəkət bulanıqlığı (Motion blur)

Şəkil 3-8: Kraklür (tablolarda görünən incə 
çat)

a: Bucaq: 2°
b: Məsafə:     
42 piksel 6

Klik

4

5

a
b
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Şəkil 3-10: Seçim sətri

Şəkil 3-11: Tərsinə çevirmə və silmə 

Şəkil 3-12: Qəlibin qradasiyası  

tərəfdən digər tərəfə  yayılır. 
- [Rectangular Marquee] aləti ilə nümunə xəttə 
baxaraq ehtiyac olan qədər kiçik hissəni seçin.

8) Seçilən sahəni tərsinə çevirdikdən sonra onu 
[Delete] düyməsi ilə silin.
 - Lazım olmayan hissə seçim sahəsinin kənarın-
da qalır. 
a) Select>Inverse-ə gedin.

9) Kölgəni tənzimləmək üçün [Gradient]-i seçin. 
-  [Ctrl (Command) + “Layer 1”i eyni vaxtda 
seçərək seçimi edin.
a) Qabaq fon rəngini aşağıdakı kimi təyin edin:
C48, M35, Y100, K11 
b) [Gradient] alətini istifadə edin.
c) Sətirin yuxarı hissəsindən aşağı hissəsinə 
doğru [Foreground to Transparent] ilə siçanı 
sürüyün.    

10) Kub eff ekti üçün aşağı sektorda [Add a Lay-

9

7

8

a

a

b

c
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er Style]-ı klik edin. 
a) Layer>Layer Style>Bevel and Emboss…
b) [Layer Style] pəncərəsində aşağıdakıları tən-
zimləyin.

 

 

c) Şəkilin sərhədinin əsasında içəri tərəf vurğu-
lanır, xarici tərəf isə kölgə effekti olur. 
      

3. Buz çəkilməsi

Şəkil 3-13: Bevel Emboss  

Şəkil 3-14: Bevel Emboss dialoq qutusu

Şəkil 3-15: Kölgə effekti

b

c

a
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Şəkil 3-16: Yeni qat 2 (layer 2) yaratmaq 

Şəkil 3-17: Buzun çəkilməsi 

Şəkil 3-18: Qabaq fon rənginin 
dəyişdirilməsi

3.1 Yeni qat yaradın.
1) Qat (Layer) sektorundan [Pop-up]  
 menyunu seçin.
Və ya 
2) [Create a new layer]      ikonunu klik edin.

3.2 Buzun fiqurunu dizayn edin.
1) [Elliptical Marquee] aləti ilə xətlər boyunca 
oval dairə çəkin.
2) Əlavə seçim üçün [Rectangular Marquee] + 
[SHIFT] düyməsini basıb saxlayaraq [Rectangu-
lar Marquee] alətini klik edin. 

3.3Filter>Render>Clouds funksiysına 
gedin.
1) Qabaq fon rəngini aşağdakı kimi təyin edin: 
C100, M96, Y0, M0 
2) Arxa fon rəngini aşağdakı kimi təyin edin:
C77, M72, Y0, M0 
3) Əvvəlki 1 və 2-ci addımlarla qabaq fon rəng-
ini doldurun.

3.4 Top faylını buzun üzərində yerləşəcək şəkildə 

1

1

2

21

+ SHIFT
2
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açın.  
1) Sehirli çubuq aləti     ilə arxa fon hissəyə klik 
edin, çünki arxa fon ilə top arasındakı rəng fərqi 
çox fərqlidir. 
2) Arxa fon seçimində [Shift + Ctrl (Command) 
+ I] ilə seçimi tərsinə çevirin. 
3) [Move] aləti ilə seçilmiş topu iş pəncərəsinə 
sürüyün. 
- Qatlar panelinə qat 3-ü əlavə edin və topu 
buzun üzərinə yerləşdirin.

3.5 Topu buz üzərində donmuş kimi [Filter gal-
lery…]-ni istifadə edin.
1) Filter>Filter Gallery-ə klik edin.
2) Filter Gallery dialoq qutusunda Brush 
Strokes>Spatter hissələrini klik edin.
3) [Spatter]-i aşağıdakı kimi təyin edin:
 - Sprey Radiusu- 25
 - Hamarlıq -15
4) [OK] düyməsini klik edin. 

3.6 Qat 3-də [Blending] rejimini [Screen] re-
jiminə dəyişin.
1) [Pop-down] işarəsini klik edin.
2) [Screen] alt menyusunu klik edin.
 - Hamar və təbii kompozisiya üçün mövcud re-
jimi Screen rejiminə dəyişin. 

 
3.7 Buz və topu bir şəkildə birləşdirin. 
1) Qat 3-də [List] işarəsini    seçin.
2) [Merge Down]-u klik edin.
 - [Layer 2] və [Layer 3] ilə birləşən şəkil itir.

3.8 [Layer 2] birləşməsinin kopyası ilə buz 

Şəkil 3-19: Buz kompozisiyası və top

Şəkil 3-20: Ləkə effekti (Spatter effect) 

Şəkil 3-21: Screen rejimi

Şəkil 3-22: Birləşdirmək (Merge Down)

3
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2
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üzərində oyun.
1) [Layer 2]-ni basıb saxlayaraq onu [Create a 
New Layer] ikonu üzərinə sürüyün.
a) [List]   ikonuna klik edin. 
b0 [Duplicate Layer…]-i klik edin.

3.9 Şəkil üzərində Gragürü göstərin.  
1) [Elliptical Marquee] aləti ilə yuxarı hissədə 
dairə çəkin. 
2) İlk olaraq [Rectangular Marquee] alətini seçin. 
Daha sonra [Shift] düyməsini basılı saxlayaraq, 
eyni zamanda düzbucaqlı alətini sürüyün.
 - (Şəkil 3-24)-də olduğu kimi seçim sahəsini 
düzəldin. 
3) Mövcud qatı saxlayaraq digər qatları görün-
məyən yerə dəyişin. 

3.10 Topun içindən qütb şəklini çəkin.
1) Klaviaturada [Delete] düyməsi ilə əvvəlki ad-
dımın [3.9; (Şəkil 3-24)] seçim sahəsini silin.
2) Seçim sahəsini sağ istiqamətə dəyişmək üçün
 - Sol seçim sahəsini seçin.
 - [Shift] düyməsini basılı saxlayaraq siçanı sağ 
tərəfə sürüyün.
3) Delete düyməsi ilə çuxuru düzəltdikdən sonra 
[Ctrl (Command) + D] ilə seçilmiş sahəni silin.

3.11  Üç ölçülü effekt verin (Kub effekti)
1) Həcmi tapmaq üçün
 - Layer>Layer>Bevel & Emboss…

 
2) [Bevel & Emboss…] dialoq qutusunda şəklə 
həcm effekti verin.  
 - (Şəkil 3-26)-da olduğu kimi hər biri üçün dəyər 

Şəkil 3-23: Screen rejimi

Şəkil 3-24: Screen rejimi

Şəkil 3-25: Qütb fiquru

Şəkil 3-26: Screen mode

21 3
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təyin edin. 

3.12  Top faylını açın. 
 - Yalnız topu seçin və onu mövcud iş pəncərəsinə 
sürüyün. Topu iş pəncərəsinə daxil edin və sonra 
(Şəkil 3-27)-də olduğu kimi faylı bağlayın. 

3.13 Qatları (Layers) uyğun qaydada yerləşdirin. 
1) [Layer 3]-ə daxil edilmiş topu [Layer 2] və 
[Layer 2 Copy] arasında yeləşdirin.  
2) Qatın qarışdırma rejimini rəng rejiminə qurun 
və bununla da şəkillər təbii olaraq birləşəcək. 

3.14 Overlay (örtmək) rejimi ilə örtük rəngini 
daha parlaq göstərin. 
1) Parlaqlıq fərqini həcmli və örtük bir 
fenomendən çıxaran [Layer 2 Copy]-ni seçin.  
2) Qarışdırma rejimini [Overlay]-ə tənzimləyin.

4. Buz qəlibi ilə uyğun gələn mətni yazın. 

Şəkil 3-27: Topun buz qəlibinə daxil edilməsi 

Şəkil 3-28: Rəng qarışdırma rejimi

Şəkil 3-29: Overlay blending rejimi
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4.1 Mətnin asanlıqla yazılması üçün məlumat 
xəttini çəkin.
1) Məlumat xəttini [Move] alət sahəsinə uzadın. 
2) [Horizontal Type] alətini seçin. 
 - Seçim sətrində şrift rəngini və şrifti müəyyən-
ləşdirin.
 - Siçan klik olunduqda avtomatik olaraq yeni 
qat yaratmaq imkanı olur.
 - [A cool & delicious Taste!] mətnini daxil edin.

4.2 Məlumat xətti boyunca şrift ölçüsünu 
müvafiq şəkildə tənzimləyin. 
1) [Ctrl (Command) + T] düyməsini basın.  
2) Şrift növünü italic etmək üçün çərçivə qu-
tusunda düzbucaqlının kənarlarını dartın.

4.3 Mətni italic şrift ilə (Şəkil 3-31)-də olduğu 
kimi düzəldin.  
1) [Ctrl (Command) + T] ilə mətni italic stilində 
uzadın. 
 - Kursoru çərçivə qutusunun yuxarı sağ küncü 
üzərinə qoyun.
 - [Ctrl (Command) + T] düyməsi basıldıqda kur-
sorun forması üçbucaq fiquruna dəyişir. 
2) Bu vaxtı siçanı sağ tərəfə sürüyün. Beləliklə, 
mətni (hərfləri) sağ istiqamətə uzadın. 

4.4 Başlıq görüntüsünün özəlliyi üçün uyğun 
olan mətni düzəldin. 
1)Üfüqi yazı aləti ilə [Go to a Wonderful Fu-
ture!] mətnini daxil edin. 

2) Şrifti və mətni redaktə etmək üçün mətni 
sürüyərək müəyyən edin.  
3) [Character] palitrasını gətirmək üçün seçim 
sətrindən ikona klik edin.
 - Windows>Character 
4) Character palitrasında rəngi, hərflər arasında-
kı məsafəni və şkalanı tənzimləyin. 

4.5 Buz qəlibinin sağ tərəfinə mətni əlavə edin. 

Şəkil 3-30: Mətni yazmaq

Şəkil 3-31: Italic şrift növü

Şəkil 3-32: Mətnin redaktə olunması

Şəkil 3-33: Character palitrası

guide line 21
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1) Şaquli yazı alətini seçin. 
2) [The Hub of ICT!] mətnini daxil edin. 

4.6 [Character] və [Free Transform] palitrasının 
funksiyalarını tətbiq edin.
1) Şrift ölçüsünü tənzimləyin.
2) Xüsusilə [Character] palitrasında mətn 
boşluğunun tənzimlənməsi vasitəsilə sözlər 
arasındakı boşluğu tənzimləyin. 
 - Windows>Character
3) Lövhə ölçüsünü müvafiq ölçüdə tənzimləyin. 
 - Image>Canvas Size

5. Şəklə harmonik şəkildə loqo işarəsini (Logo 
Mark) daxil edin. 
5.1 Loqo işarəsini mövcud iş pəncərəsinə gətirin.
1) File>Place Embedded-i icra edin. 
2) Loqo işarəsini seçin və [Place] düyməsini 
basın.
 - Uzatma: EPS
3) [Place] funksiyası klik olunduqda loqo işarəsi-
ni çərçivə-qutu kimi iş pəncərəsinin mərkəzində 
yerləşdirin. 
4) İş vəziyyətini bir daha yoxlayın.  

Şəkil 3-34: Şaquli yazı aləti    

Şəkil 3-35: Character palitrasında

Şəkil 3-36: Tamamlanmış şəkil
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Çəkmə alətinin funksiyalarını detallı şəkildə izah etdi?
2. Müxtəlif alətləri istifadə edərək gözəl buz qəlibini aydın şəkildə 
düzəltdi? 
3. Qarışdırma rejimi ilə şəkili düzgün formada tətbiq etdi?
4. Qat stilini görüntüyə uyğun şəkildə tənzimlədi?
5. Filtri müvafiq formada istifadə edərək şəklə xüsusi effekt verdi?
6. Müəyyən edilmiş vəziyyətdə düzgün şəkildə mətni əlavə etdi?
7. Buz qəlibinin bütün elementlərini müvafiq şəkildə tətbiq etdi? 
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Səviyyələrin və tarixin funksiyalarını aydın şəkildə izah edəcək;
2.   Slayd filmlərinin düzgün şəkildə tərtib olunmasını biləcək.

Təcrübə materialları:
1.   Noutbuk/Stolüstü kompüter
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   Photoshop proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Səviyyələr (Levels)
Səviyyə tənzimləmələri şəkilin ton səviyyəsi və rəng balansında kölgələri, orta tonları və vurğu-

lanan hissələrin səviyyə intensivliyini tənzimləyərək düzəliş edir. Histoqram səviyyəsi şəkilin əsas 
tonlarını tənzimləmək üçün vizual bələdçidir.  Şəkildəki əsas rəng orijinaldır.

• İki xarici giriş səviyyəsi slayderi (Input Levels sliders) qara və ağ nöqtələri çıxış slayderinin 
parametrlərinə uyğunlaşdırır.  

• Qiyabi olaraq output slayderində səviyyə piksellər qara olduqda 0, piksellər ağ olduqda isə 255-
dir.

• Output slayderi başlanğıc vəziyyətdə ikən qara giriş sürüşdürücüsünün hərəkət piksel səviyyəsi-
ni 0-a, ağ nöqtə sürüşdürücüsünün piksel dəyərini isə səviyyə 255-ə bərabərləşdirir.  

• Qalan səviyyələr 0-255 arası yenidən bölüşdürülür. 
• Yenidən bölüşdürülmə şəkilin ton aralığını artırır və nəticədə təsvirin ümumi kontrastı artır.

4. Maraqli slayd fi̇lmi̇ təşki̇l etmək

Şəkil 4-1: Səviyyələrin tənzimlənməsi
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2. Tarixçə
4. Bu funksiya mövcud iş seansında səhv baş verdikdə tarixçə panelində müvafiq listi seçərək 

əvvəlki mərhələni geri qaytarır. 
5. Əvvəlki mərhələyə qayıtmaq üçün: [Alt + Ctrl (Command) + Z]

A: Tarixçə fırçası üçün mənbələri tənzimlə-
yin
B: Anlıq görünüşün şəkli
C: Tarixçə vəziyyəti
D: Tarixçə vəziyyəti slaydı

Şəkil 4-2: Tarixçə paneli

Şəkil 4-3: Tarixçə paneli

1) İş prosesinin rəqəmləri
• Tarixçə vəziyyətində [Edit>Preferences>General]-da iş seansının rəqəmlərini müəyyənləşdirin. 
• Photoshop (Mac) və ya redaktə (Windows) menyusunda (Edit) əldə edilə bilən photoshop 

sseçımlərində performans bölməsi tarixçəni tənzimləmək üçün seçimlərdən ibarətdir. Tarixçə vəzi-
yyətlərini artırmaq 20 dəfədən daha çox geri qaytarmağa icazə verir.  

• İstifadə etdiyiniz tarixçə çoxaldıqca yaddaşda saxlamaq üçün Photoshop tərəfindən daha çox 
boş disk sahəsi tələb olunur. Çünki bütün addımlar sənəd bağlanana qədər müvəqqəti yaddaşa ver-
ilir. Adətən bir çox mərhələsi olan böyük layihələr üzərində işləyirsinizsə tarixçə vəziyyətini artıra 
bilərsiniz. Lakin əgər Photoshop yavaş işləməyə başlayırsa boş disk sahəsinin bitdiyini bildirən xəta 
mesajı meydana çıxacaq və bu halda siz əvvəlki vəziyyətə qayıda bilərsiniz. 

Mövcud vəziyyətdən yeni sənəd 
yaratmaq

Anlıq şəkil yaratmaq

Silmək

2
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2) Anlıq şəkil (Snapshot)
• Anlıq şəkil tarixçə palitrasının bir hissəsidir. Şəkilin vəziyyətini müəyyən bir zamanda yaddaşa 

vermək üçün istifadə olunur. 
• Əsaslı dəyişikliklər etməzdən əvvəl onu yaddaşa verməkdə əmin olmadığınız zaman anlıq şəkil 

yaratmaq istəyə bilərsiniz və beləliklə siz “.psd” faylının anlıq şəklinə yaddaşa verdiyiniz nöqtədə 
geri dönə bilərsiniz. 

• Misal üçün, əgər siz şəkili seçirsinizsə, çəkirsinizsə və fırladırsınızsa bu vəziyyətlərin hər biri 
paneldə ayrıca sıralanır. Siz bu vəziyyətlərdən hər hansı birini seçirsinizsə şəkil ilk dəyişiklik tətbiq 
olunan vəziyyətə qayıdır.

• Siz həmçinin tarixçə panelini Photoshop-da şəkil vəziyyətlərini silmək və yeni sənəd yaratmaq 
üçün də istifadə edə bilərsiniz.  

• Tarixçə panelini göstərmək üçün Windows >History seçin və ya History paneli yarlıkını klik 
edin.

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Şəkilin skanını əldə edin. 
1.1 Skaner ilə şəkilin skanını əldə etmək 
1. Şəkili skanerə qoyun. 
2. Photoshop proqramından skaneri seçin.
 - File>Import>… Scanner name

Şəkil 4-4: Şəkilin skanını əldə etmək

2

Scanner Name
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1.2 Skan olunmuş şəkilin xüsusiyyətlərini təyin 
edin. 
1) İlk olaraq [Prescan] ilə skan olunmuş şəkili 
yoxlayın. 
2) Skan etmək üçün şəkili siçan ilə sürüyərək 
ölçünü təyin edin. 
3) Ölçü və dəqiqliyi təyin edin.  
 - Şəkil üçün: 300ppi
 - Arxa fon şəkili üçün: az dəqiqlik
4) Faylın adını “Coliseum.jpg” kimi yaddaşa 
verin.

2. Skan olunmuş təsviri dəqiq şəkildə dəyişdi-
rin. 
2.1 Uzadılmış formada olan təsviri üfüqi forma-
ya dəyişdirin. 
1. Skan etmək üçün şəkili açın. 
 - Uzadılmış formada olan təsviri üfüqi formaya 
dəyişdirmək üçün [Ruler] ölçü      alətini seçin. 

Şəkil 4-5: Coliseum.jpg

Şəkil 4-6: Boz rəng çalarlı rejimi

- ppi = pixel per inch

- dpi = dot per inch

- epi=element per inch
 
- ipi = line per inch

1

1

a

b
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2.2 Skan olunmuş şəkildə xətti düzəldin. 
1) Bucağı ölçmək üçün şəkilin sol künc nöqtəsi-
ni klik edin. 
a) Siçan sağ nöqtəyə doğru hərəkət etdikdə xətt 
gorünür. 
b) Seçim sətrində bucaq metri: -1.0 dərəcə
2) 1-ci addımda olan bucaq dərəcəsi kimi şəkili 
fırladın. 
 - [Ctrl (Command) + T] əmrinə gedin. 
 - Seçim sətrinin bucaq pəncərəsinə  “-1.0” əlavə 
edin. 
 - Digər şəkildə Image>Image Rotation>Can-
vas>Arbitrary-i seçin. 
3) Lazımsız kənar hissəni kəsmək üçün 
 - [Crop] aləti ilə şəkili daxil edin. 
 - [Enter] düyməsini basın. 

 
2.3 Kölgəni dəyişdirin və hissəni düzgün şəkildə 
göstərin. 
1) Image>Adjustments>Levels-ə gedin. 
2) Sol sürüşdürücünü səviyyələrin sağ tərəfinə 
sürüyün. 
 - Şəkil bütünlükdə qaralır və orta ton kölgə 
hissəyə dəyişilir. 

3) Sağ sürüşdürücünü səviyyələrin sol tərəfinə 
sürüyün. 
 - Orta ton vurğulanmış sahəyə dəyişilir və şəkil 
yüksək kontrastlı aydın şəklə çevrilir. 
 - Dəyəri əlavə edin: kölgə giriş səviyyəsində 36, 
orta ton giriş səviyyəsində 0.97 və vurğulanan 
giriş səviyyəsində 210.

Şəkil 4-7: Kəsmək funskiyasından sonra şəkil 

Şəkil 4-8: Səviyyələrin tənzimlənməsi

2

3

2

1

3

Unnecessery part



İKT

52

2.4, “ROMA 2004”mətnini silin. 
• Şəklə kopya edərək təmiz yerdə  dəyişiklik 
edin, çünki fon daşlardır.  
1) [Rectangular Marquee] aləti ilə   mətnin altın-
dakı hissəni seçilmiş sahəyə tənzimləyin.  
2) Seçilmiş sahəni qat etmək üçün [Ctrl (Com-
mand) + J] -ni seçin. 
 - Qat 1 (Layer 1) kimi yaddaşa verin. 
3) Arxa fon üçün kopyalanan şəkili görün-
məyəcək şəkildə sol üst tərəfə köçürün.
4) [Ctrl (Command) + T] ilə şəkilin hündürlüyünü 
azaldın və mətni gizlədəcək şəkildə kopyalanan 
şəkili yerləşdirin.  

2.5 Qatları birləşdirilmiş qat kimi yaddaşa verin. 
1) (Şəkil 4-9), [2.4]-də daha əvvəl kiçildilmiş qat 
1-in şəklini seçin. 
 - [Ctrl (Command)] düyməsini basıb saxlayaraq 
Layer 1-i klik edin. 
2) [Ctrl (Command) + J] işlədikdə onu Layer 2 
olaraq yaddaşa verin. 
 - Şəkili azacıq sağa doğru hərəkət etdirin. 
3) [Ctrl (Command) + T] funksiyası ilə şəki-
lin hündürlüyünü azaldın və onu mətn görün-
məyəcək şəkildə arxa fonda yerləşdirin.

2.6 Davamlı olaraq yeni qat yaradın. 
1) (Şəkil 4-10), [2.5]-də daha əvvəl kiçildilmiş 
Layer 2-nin şəklini seçin. 
 - Ctrl (Command)] düyməsini basıb saxlayaraq 
Layer 1-i klik edin. 
2) [Ctrl (Command) + J] işlədikdə onu Layer 3 
olaraq yaddaşa verin. 
3) [Ctrl (Command) + T] funksiyası ilə şəkilin 
hündürlüyünü azaldın və sonra onu [2.5] səvi-
yyəsinin şəklinə köçürün. 

Şəkil 4-9: Örtülmüş mətn

Şəkil 4-10: Yeni ad qatının yaradılması

Şəkil 4-11: Yeni qatın (Layer) yaddaşa 
verilməsi

2

1
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2.7 Bütün iş seansını “Coliseum.psd” adlı yeni 
fayl kimi yaddaşa verin. 
1) Bir qatı yaratmaq üçün qatlar panelində açılan 
menyuda [list] ikonunu klik edin.
 - [Merge Visible] seçimini klik edin. 

2)İndiyə qədər olan bütün iş seanslarını yaddaşa 
vermək üçün File> Save-i seçin. 
 - Faylın adı: “Coliseum. Psd”

3. Slayd film panelini düzgün şəkildə qurun. 
3.1 Verilmiş şərtlərə əsasən yeni iş pəncərəsi 
yaradın. 
1) Yeni iş pəncərəsi yaratmaq üçün  File>New-a 
gedin :
 - Pəncərə ölçüsü: 5.5sm × 5.5sm
 - Dəqiqlik: 300 ppi
 - Arxa fon məzmunu: şəffaf
2)bQabaq fon rəngini isə ağ rəngə dəyişin. 

3) [Rounded Rectangle] alətini seçin. 

4) Seçim sətrini aşağıdakı kimi tənzimləyin:
 - Sabit ölçü: 5cm × 5cm
 - Radius: 25px
 - Stil: mövcud deyil
 - Lövhə üzərində kursoru klik edin. 

Şəkil 4-13: Dairəvi düzbucaqlı qatın 
pikselləşdrilməsi 1

Şəkil 4-12: Birləşdirilmiş qatların “Coliseum.
psd” kimi yaddaşa verilməsi

2
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5) Faktiki qatı [Rasterize Layer]-ə dəyişin.
 

6) Əvvəlcə şəkil üzərinə kölgə çəkin.
 - Layer>Layer Style>Drop Shadow
Düşən kölgənin tənzimlənməsi:
 - Qarışdırma rejimi: artan
 - Qeyri-şəffaflıq: 75%
 - Bucaq: 120°, ümumi işıq istifadəsi-klik
 - Məsafə 10px, sürət 0px, ölçü 20px
 - Yayılma: 0%

3.2 Fiqur üzərinə kölgə salınması (3.1-1) 
1) Qabaq fon rəngini ağ fona dəyişin. 
2) [Rounded Rectangle]   alətini seçin. 
3) Seçim sətrini aşağıdakı kimi tənzimləyin:
 - Sabit ölçü: 3.6sm × 3.4sm 
 - Radius: 13px
 - Stil: mövcud deyil 
4) Mövcud qatı [Rasterize Layer]-ə dəyişin. 
 - [Rounded Rectatgular 2]-də siçanın sağ 
düyməsini klik edin.
 - Açılan siyahıdan [Rasterize Layer]-i klik edin. 
5) Əvvəlki şəkilin fiquru üzərinə kölgə salın.
 - Layer>Layer Style>Inner Shadow
Daxili kölgənin tənzimlənməsi:
 - Qarışdırma rejimi: artan
 - Qeyri-şəffaflıq: 75%
 - Bucaq: 150°, ümumi işıq istifadəsi-klik
 - Məsafə 5px, Surət 0px, Ölçü 5px
 - Yayılma: 0%

Şəkil 4-14: Düşən kölgənin qurulması

Şəkil 4-15: Dairəvi düzbucaqlı qatın 
pikselləşdrilməsi 2

Şəkil 4-16: Daxili kölgənin tənzimlənməsi

4

5

6

3

Click Right-Mouse button
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3.3 İki qatı birləşdirmək üçün linki yerləşdirin.
1) Hər iki qatı birləşdirərək üfüqi və şaquli vəzi-
yyətin ortasında yerləşdirin.
2) İki qatı birgə birləşdirmək üçün 
a) [Rounded Rectangular2] qatını seçin və [Ctrl] 
düyməsini basılı saxlayaraq, eyni zamanda   
[Rounded Rectangular 1] düyməsini seçin. 
b) Layer panel sətrində  pop-up düyməsini   klik 
edin. 
c) [Merge Layers] alt menyusunu klik edin. 
• Ctrl (Command) + E

6) Birləşdirilmiş qatı eninə (Width) dəyişin.
 - Qatı adlandırmaq üçün siçanı iki dəfə klik edin. 

7) Eni (Width) sürüyüb qatı kopyalaraq yeni qat 
yaradın.
 - Kopyalanan qatın adını hündürlük (Height) 
qoyun.
8) [Rectangular Marquee]-nin     seçim sətrindən 
aşağıdakı dəyərləri tənzimləyin: 
 - İlk olaraq [Width] qatını seçin. 
 - Sabit ölçü: 3.6sm×2.4sm  
9) Şəkildə seçilmiş sahəni seçin.
 - Silin - daha çox aydınlıq üçün hündürlük qatını 
(Height layer) görünməz edin.

Şəkil 4-17: Daxili kölgə

Şəkil 4-18: Qatları birləşdirmək

Şəkil 4-19: Ölçü 3.6 sm×2.4 sm

a

b
c

2

4
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3.4 İş seansını “Film Stand.psd” kimi yaddaşa 
verin.
1) Qatlar panelində hündürlüyü ( Height) seçin.
2) [Rectangular Marquee]   alətinin seçim 
sətrindən aşağıdakı dəyərləri tənzimləyin: 
 - Sabit ölçü: 2.4sm×3.4sm  
3) Şəkildə seçilmiş sahəni silin. 
4) Qat stili ilə kölgə salın. 
 - Layer panelindən [Width] qatını seçin.
 - Layer>Layer Style>Drop Shadow seçin.
5) [Drop Shadow] aşağıdakı kimi tənzimləyin:
 - Qarışdırma rejimi: artan 
 - Qeyri-şəffaflıq: 75%
 - Bucaq: 120°, ümumi işıq istifadəsi-klik
 - Məsafə 10px, sürət 0px, ölçü 20px
 - Yayılma: 0% 

6) En (Width) qatının [Copy Layer Style]-nın 
surətini çoxaltmaq. 
 - En (Width) qatı üzərində siçanın sağ düyməsi-
ni klik edin.
 - Kopya qat stili əmrini seçin. (Copy Layer Style 
command)

7) Bütün prosesləri “Film Stand. Psd” faylı kimi 
yaddaşa verin.
 - Kopyalanmış qat stilini yapışdırmaq üçün en 
qatı üzərində (Width layer)  siçanın sağ düyməsi-
ni klik edin.
 - Qat stilini yapışdırmaq əmrini  (Paste Layer 
Style command)  seçin. 

Şəkil 4-20: Ölçü 2.4 sm×3.4sm

Şəkil 4-21: Kölgə düşməsi

Şəkil 4-22: Qat stilinin kopyalanması 

Şəkil 4-23: Qat stilinin yapışdırılması

2

1
3

6
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4. Ağ-qara şəkili hazırlayın. 
4.1 “Coliseum.psd” faylından ağ və qara şəkil 
düzəldin. 
1) RGB rejimini saxlayaraq ağ-qara şəkil düzəlt-
mək üçün Image> Adjustment> Desaturate-i 
seçin.

2) Rəsm əsəri rejimində şəkilin dəyişdirilməsi:
 - RGB rejimini saxlayaraq 
Filter>Filter Gallery>Artistic>Colored Pencil-i 
seçin. 

3) Şəklə rəngli karandaşla çəkilmiş effekti verin.
[“Colored Pencil” dialog box]-da
• Karandaş üni: 4
• Vuruş təzyiqi: 8
• Kağız parlaqlığı: 25

Şəkil 4-24: Film Stand.psd şəkili

Şəkil 4-25: Solğun şəkil

Şəkil 4-26: Rəngli karandaş

Şəkil 4-27: Rəsm əsərinə bənzər şəkil

2

3

1
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4.2 “FilmStand.psd” faylını “Coliseum.psd” -ə 
gətirin.
1) Slayd filmi  boyalı panelə gətirmək üçün 
“FilmStand.psd”-ni açın. 
 - Hər bir şəkili sürüyərək “Coliseum.psd” faylı-
na - mövcud iş pəncərəsinə gətirin. 

2) En qatını (Width layer) kopyalayın və en 
nüsxəsi (Width copy) qatını yaradın.
3) Lövhənin mərkəzində “Width copy” şəklini 
köçürün. 
4) [Ctrl (Command) + T] menyusuna gedin və 
seçimlər menyusundan aşağıdakı dəyərləri tən-
zimləyin:
 - Şkala: 135%×135%
 - Fırlatma bucağı: -30°  

5) Slayd filmində təsvirləri dəyişdirmək üçün 
[Lasso] alətini seçin.
 

6) Seçilmiş sahənin şəkili də daxil olmaqla 0 qa-
tını (Layer 0) seçin. 
7) [History Brush] alət ikonunu klik edin.
8) [History Brush] alətini seçin:
 - Ölçünü tənzimləyin.
9) Seçilmiş sahənin sərhədləri çərçivəsində 
siçanı sürüyərək orijinal şəkili vizuallaşdırın. 
10) Siçanı sürüyən zaman sərhədin içini rəngli, 
çölünü isə qara edin.

Şəkil 4-29: Ödənişsiz transformasiya

Şəkil 4-30: Lasso aləti

Şəkil 4-31: Rəngli və qara sahələr ilə böyük 
şəkil

Şəkil 4-28:  İş pəncərəsinə slaydların 
gətirilməsi 

2
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5. İş pəncərəsində şəkili yerləşdin.  
5.1 Lövhə ölçüsünü tənzimləyin. 
1) Sağ tərəfə mövcud kənar boşluğundan bir az 
yer vermək üçün aşağıdakıları tənzimləyin:
 - Bucaq: sol
Genişlik və ya en: 21sm 

2) Genişləndirilmiş şəffaf lövhəni doldurmaq 
üçün:
a) Qat 0-ın (Layer 0) arxa fonunu [Foreground 
color] kimi təyin edin. 
b) [Rectangular Marquee] ilə genişləndirilmiş 
lövhənin şəffaf hissəsini seçin.
c) [Alt (Command) + Delete] ilə qabaq fon rəng-
ini doldurun.

3) En (Width) qatının  nüsxəsini bir daha çox-
aldın. 
 - Onu “Width copy 2” kimi adlandırın.
4) Üç paneli düzmək üçün onları təxmini şəkildə 
qoyun. O, sağ kənar düzümlü ola bilər. 
5) Seçim sətrindən aşağıdakıları tənzimləyin:  
 - Düzüm: sağ 
- Paylanma: mərkəz

5.2 Slayd görünüşünü panelə uyğunlaşdırın. 
1) “Travis” faylını açın və onu cari iş pəncərəsinə 
sürüyün.

Şəkil 4-32: Lövhənin yenidən ölçülməsi 

Şəkil 4-34: Slayd filmin düzülüşü

Şəkil 4-35: Travis şəkili

Şəkil 4-33: Boş sahənin qabaq fon rəngi ilə 
doldurulması
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Alt+Del
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2) “Travis” şəklini uzununa qoyun və [Ctrl (com-
mand) + T]-ni seçin. 
a) Hündürlük və eni mərkəzdən eyni dərəcədə 
ölçmək üçün [Alt (command) + Shift] düyməsini 
basılı saxlayaraq ölçünü tənzimləyin.
b) “Pietro, Spain, Square” kimi şəkilləri seçin və 
onları uzunlamasına yerləşdirin. 
3) En qatınının (Width layer) nüsxəsini bir daha 
çoxaldın. 
a) Qatı müvafiq yerə köçürün.
b) [Free Transform] funksiyasını seçin.
c) Seçim sətrində 
• Şkala: 120% × 120% 
• Fırlanma: 15°
 
4) Məbəd şəkilini cari iş pəncərəsinə gətirin. 
(Coliseum.psd) 
a) Qatı müvafiq yerə köçürün.
b) [Free Transform] funksiyasını seçin. 
c) Seçim sətrində 
• Şkala: 120% × 120%, 
• Fırlanma: 15°
 

5) Onu üç qat ilə qoyun, çünki qatlar çox 
yaradılıb. 
a) Arxa fon 0 qatından  (Layer 0) başqa digər 
qatlarla əlaqəni qurun.
b) Pop-up (List) düyməsini klik edin.
• Qatlardan yeni qrup (New Group from Layers) 
alt menyusunu yaradın.
• Dialoq qutusunda ad bölməsinə şəkil əlavə 
edin.

 

Şəkil 4-36: Slayd film düzümü

Şəkil 4-37: Məbəd slaydı

Şəkil 4-38: Qrupun yaradılması

Şəkil 4-39: Qrup adı

a

b

b
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6. Mətni smart şəkildə düzəldin. 
6.1 “ROMA” və “BAKI” mətnini daxil edin. 
1) Qabaq fon rəngini aşağıdakı kimi təyin edin:
 - R243, G109, B40
 - [Horizontal Type] aləti ilə “ROMA” və ya 
“BAKI” yazın. 

2) Mətn yaratmaq üçün Layer> Layer Style> 
Bevel and Embossu tətbiq edin.
 - Stil: qabarma
 - Texnika: hamar
 - Dərinlik: 230%
 - İstiqamət: yuxarı
 - Ölçü: 45px
 - Yumuşaqlıq: 2px
 - Bucaq: 120°

 

6.2 Paneldəki xüsusiyyətlərə reallıq hissi verin. 
1) Qabaq fon rəngini aşağıdakı kimi təyin edin:
a) R218, G218, B218
b) [Horizontal Type] aləti ilə “ROMA” və ya 
“BAKI” yazın. 

 

2) Mətn yaratmaq üçün Layer>Layer Style>Bev-
el and Emboss edin.
 - Stil: yastıq qabarması 
 - Texnika: hamar
 - Dərinlik: 230%
 - İstiqamət: yuxarı
 - Ölçü: 45px
 - Yumuşaqlıq: 2px
 - Bucaq: 140 

Şəkil 4-40: Qabaq fon rəngi

Şəkil 4-41: Əyri və qabarma

Şəkil 4-42: ROMA-nın qabaq fonu 

Şəkil 4-43: Yastıq qabarması

a b

2
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1
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6.3 Bütün sxemi yaddaşa vermək üçün yoxlayın.
1) Panelə əsasən şəkili fırlatmaq üçün seçim 
sətrində “-30°”-ni yazın.
2) “ROMA” (və ya “BAKI”) yazı qatını kopya-
layın.
 - Panel üçün uyğun ölçünü bir az kiçildib fır-
ladın.
3) Bütün sxemi yaddaşa vermək üçün təsdiq 
edin.
 
 

Şəkil 4-44: Ödənişsiz transformasiya

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Səviyyələr və tarixçənin funksiyalarını aydın şəkildə izah etdi?
2. Slayd filmlərini düzgün şəkildə tərtib etdi?
3. Verilmiş şərtlərə əsasən şəkili düzgün formada skan etdi? 
4. Rəngli şəkili ağ-qara şəklə dəyişdi?
5. Slaydları hazırlamaq üçün şəkilləri birləşdirdi?
6. İş prosesində qat paletindən kifayət qədər yararlandı?
7. Ehtiyaca əsasən tarixçə paletini düzgün şəkildə tətbiq etdi?

21
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.    Filtr alətinin effektini aydın şəkildə izah edəcək;
2.   Filtr tətbiqi vasitəsilə yeni və smart şəkillərlə təbii formada ana səhifə keçidini dizayn etməyi 
biləcək. 

Təcrübə materialları:
1.   Noutbuk/Stolüstü kompüter
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   Photoshop proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Dəqiqlik
1.1 Photoshopda dəqiqlik nə deməkdir?
• Photoshopda dəqiqlik (Resolution) - şəkilin hər bir düymündə nə qədər nöqtə olduğu deməkdir. 

Photoshopda bu 72 dpi-dır. 
• Əgər şəkildə dəqiqlik yüksəkdirsə o deməkdir ki, düymə görə nöqtələr çoxdur və belə şəkillər 

kifayət qədər ağır olur (yaddaş kartınızın kilobaytını çox istifadə edir). 

1.2 İstifadə məqsədinə görə ayırdetmə dəqiqliyinin növləri: 
• Ekranın ekskluziv istifadəsi üçün şəkil: 72dpi/inch
• Qəzet üçün kağız üzərində çap olunan şəkil: 70~90dpi/inch 
• Boş kağız üzərində print olunan şəkil: 150~200dpi/inch
• Yüksək keyfiyyətli kağız üzərində çap olunan şəkil: 200~250dpi/inch
• Kataloq, kitab üzlüyü və broşür istifadəsi üçün şəkil: 300dpi/inch 

1.3 Piksel ölçüləri və çap olunmuş şəklin dəqiqliyi.
1) Piksel ölçüləri:
• Piksel ölçüləri şəkilin eni və hündürlüyü boyunca piksellərin ümumi sayını ölçür. Ayırdetmə 

dəqiqliyi bitmap şəkilində detalların incəliyidir və pikseldə düymlə (inch) ölçülür (ppi). 
• Düymə görə nə qədər çox piksel olarsa dəqiqlik bir o qədər böyük olar. Daha çox dəqiqliyə sahib 

şəkil daha yaxşı görüntü keyfiyyətini təmin edir. 
• Ayırdetmə dəqiqliyinin nümunələri:

5. Smart ana səhi̇fəni̇ di̇zayn etmək
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Şəkil 5-1: Piksel ölçü dəqiqliyi

Şəkil 5-2: Çap olunmuş şəkil dəqiqliyi  

2) Print olunmuş şəkilin dəqiqliyi:
1. Printer dəqiqliyi düyümlə ölçülür və həmçinin dpi olaraq tanınır. Düymə görə nə qədər çox 

nöqtə olarsa çapdan çıxan şəkil o qədər yaxşı olar. Əksər inkjet printerlərin dəqiqliyi 720 və 2880 
dpi arası olur. Texniki olaraq inkjet printerlər lazer printerlər kimi nöqtələri deyil, mürəkkəbin 
mikroskopik spreyini hasil edir.

2. Printer dəqiqliyi fərqlidir və şəklin dəqiqliyinə bağlıdır. İnkjet printerində yüksək keyfiyyətli 
print etmək üçün şəkilin dəqiqliyi azı 220 ppi olmalır.

3. Ekran tezliyi bozun çalarları olan şəkilləri və rəng ayırmalarını çap etmək üçün istifadə olunan 
printer nöqtələrinin düymə görə  sayıdır. O, həmçinin ekran cizgisi və ya xətt ekranı kimi də tanınır. 
Ekran tezliyi düym (inch lpi) və ya yarı ton ekranda elementlərin xətləri ilə ölçülür. Çıxış cihazının 
dəqiqliyi nə qədər çox olarsa istifadə etdiyiniz ekran bir o qədər incə olmalıdır. 

Şəkil dəqiqliyi və ekran tezliyi arasında əlaqə print olunmuş şəkildə detalların keyfiyyətini 
müəyyən edir. Ən yüksək keyfiyyətdə yarı ton bir şəkil yaratmaq üçün  siz ekran tezliyinin 1,5-i ilə 
2 qatı olan şəkil dəqiqliyini istifadə edə bilərsiniz. Amma bəzi şəkillər və çıxış cihazları ilə aşağı 
dəqiqlik də yaxşı nəticə əldə edə bilər. Printerinizin ekran tezliyini müəyyən etmək üçün printer 
sənədlərini yoxlayın və ya servis provayderinə müraciət edin. 

A. 65 lpi: İri ekran adətən qəzetləri və market 
kuponlarını hazırlamaq üçün istifadə olunur. 
B. 85 lpi: Orta ekran adətən qəzetləri çap etmək 
üçün istifadə olunur. 
C. 133 lpi: Yüksək keyfiyyətli ekran dörd rəng 
jurnalları çap etmək üçün istfadə olunur. 
D. 177 lpi: Çox incə ekran adətən illik hesabatlar 
və incəsənət kitablarında şəkillər üçün istifadə 
olunur. 

2. Pattern 
2.1 Fotoqrafiyada Pattern ifadəsi 
• Pattern - seçim və ya qatı dolduran zaman təkraralanan və qata doldurulan şəkildir. 
• Photoshop seçim sətrində açıla bilən palitrada görünən müxtəlif naxışlardan və ya 
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şəkil formalarından (boya çəlləyi, naxış möhürü, düzəldici fırça və yamaq alətindən) ibarətdir.  

   
2.2 Seçimi naxış ilə doldurmaq 
1) Naxışı tətbiq etmək üçün ən asan yol [Fill] əmrini istifadə etməkdir. 
2) Onu istifadə etmək üçün istədiyiniz ölçüdə və məzmunda yeni sənəd açın.
3) Alətlər panelində interfeysin sol tərəfində  Marquee alətini istifadə edərək naxışı tətbiq etmək 

istədiyiniz sahəni seçin. 
4) Sahəni seçdikdən sonra [Edit>Fill], [Pattern] -ni seçin və daha sonra aşağıdakı kimi naxışı 

seçin. 

Şəkil 5-3: Pattern və ya naxış nümunəsi 

Şəkil 5-4: Marquee alət seçimi 

Şəkil 5-5: Pattern nəticəsi

3. Filtr
3.1 Photoshopda filtr nədir
• İstifadəçi şəkilləri təmizləmək və yenidən retuşlamaq, şəklin eskiz görünüşü üçün xüsusi bədii 

effektlər vermək, işıq effektlərini istifadə edərək xüsusi transformasiyalar yaratmaq üçün filtri isti-
fadə edə bilər. 

• Adobe tərəfindən təchiz olunan filtrlər “Filtr” menyusunda mövcud olur. Üçüncü qrup tərti-
batçılar tərəfindən təmin olunan filtrlər plug-ins kimi mövcuddur. Bu filtrlər bir dəfə quraşdırdıqdan 
sonra həmişə Filtr menyusunda görünür. 
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3.2 Filtr qalereyası 
• Filter qalereyası xüsusi filtr effektlərinin ön görünüşünü təmin edir. 
• İstifadəçi birdən çox filtr tətbiq edə, filtr effektini açıb bağlaya, filtr üçün sseçımləri sıfırlaya və 

filtrin tətbiq edilmə sırasını dəyişə bilər. 
• Filtr menyusundakı bütün filtrlər həm də filtr qalereyasında mövcud olmur.

Şəkil 5-6: Filtr qalereya dialoq qutusu

A. Öncədən baxış  B. Filtr kateqoriyası C. Seçilən filtrin kiçik şəkili D. Filtrin kiçik şəklini 
göstərmək/gizlətmək E. Filtrin açılan menyusu F. Seçilən filtr üçün parametrlər G. Tətbiq olu-
nacaq filtr effektlərinin siyahısı H. Seçilən, amma tətbiq olunmayacaq effektlərin siyahısı  I. Topla-
nan, amma seçilməyən filtr effektlərinin tətbiq olunması J. Gizlədilən filtr effektiю

Qeyd:  Müxtəlif filtrləri yoxlayan zaman vaxt qazanmaq üçün şəklinizin kiçik bir hissəsini 
seçin. 

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

1. İş mühitinin yaradılması
1) File>New/Fayl>New-nu klik edərək yeni 
sənəd yaradın. 
 - Ad: DC05 Smart Ana səhifənin dizayn olun-
ması
 - Piksel ölçüləri: 
 - En: 1024 piksel
 - Hündürlük: 768 piksel
 - Dəqiqlik: 72 pixels/inch
 - Rəng rejimi: RGB, 8bit
 - Arxa fon məzmunu: ağ (White) 

2. Pattern və ya naxışın aydın şəkildə düzəld-
ilməsi
2.1 Ləkəli bir naxış düzəldin.
1) [Rectangular Marque] aləti ilə fi quru çəkin və 
onu seçdiyiniz rəngə boyayın.
2) Patterni qeydiyyat etmək üçün:
 - Seçim sahəsini qurun. 
 - Edit>Defi ne Pattern
3) Pattern dialoq qutusunda:
 - Pattern adını daxil edin: Square (Kvadrat)  
 - [OK] düyməsini klik edin.

2.2 Qeydiyyatdan keçirilmiş naxış (Kvadrat) ilə 
iş pəncərəsini doldurun. 
1) [Paint Bucket] alətini seçin.

2) Seçim sətirində:
 - Doldurmaq: Pattern 
3) Pattern Qeydiyyat Pəncərəsinin açılması üçün 
pop-down menyu oxunu klik edin.
4) [2.1-3]-də qeydiyyat olunmuş  [Square]-ı 
seçin.

5) İş pəncərəsində siçan vasitəsilə seçilən naxışı 
əlavə edin. 

3. Kəsim maskası

Şəkil 5-7: İş mühitinin yaradılması

Şəkil 5-8: Pattern “Square” (Naxış kvadratı)

Şəkil 5-9: Pattern ilə iş pəncərəsi

2

1

3

4
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3.1 Qabaq fonu yeni yaradılmış fon rəngi ilə 
doldurun.  
1) Yeni qat yaradın.
Adı: Layer 1
2) [Rectangular Marquee] aləti ilə düzbucaqlı 
fiquru çəkin.  
3) [Foreground Color]-ı aşağıdakı kimi edin:
 - R277, G216, B148
4) Alt (Option) + Delete]-i klikləyib təyin olunan 
rəng ilə [Foreground Color] davam edin. 

3.2 [Layer 1 copy] adlı yeni qata ölçü təyin edin.
1) [Layer 1]-i bir dəfə də kopyalayın.
 - Qat 1-dən kiçik olan başqa bir kvadrat düzəl-
din.
2) Ctrl (Command) + T] ilə “Free Transform”-u 
seçin.
a) [Alt (Option)] düymələrini sıxıb saxlayaraq 
siçanı yuxarı və aşağı sürüyün.
3) En ölçüsünü saxlayaraq yeni kiçik kvadratın 
hündürlüyünü azaldın. 
※ Qeyd:
• Seçim aləti: [Move tool]-da seçmək üçün [Ctrl 
+ Layer]-i klik edin.  
• Arxa fon rənginin doldurulması: [Ctrl + Back-
space] düyməsi
• Qabaq fon rənginin doldurulması: [Alt + Back-
space] düyməsi

3.3 [Layer 1 copy]-ni ağ rəng ilə doldurun. 
1) Siçanın sağ düyməsini basılı saxlayaraq, qat 1 
kopyasında sahə yaradın. 
2) Seçilən sahəni ağ rəng ilə doldurun. 
 

Şəkil 5-10: Yeni qat 1 (New Layer1)

Şəkil 5-11: Qat 1 kopyası ( Layer1 copy)

Şəkil 5-12: “Layer 1 copy”-ni ağ rəng ilə 
doldurmaq  

2
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3.4 [File> Place Linked] əmri ilə “Piece of Cloth.
eps” yaradın.
1) “Place Linked”-in sərhəd qutusu sahəsində 
“Piece of Cloth” fayl adlı qat yaradın. 

2) Onu iş pəncərəsinə gətirin. 

3.5 Parça hissələrinin birləşməsinə bənzər effekt 
verin.
1) Filter>Filter Gallery…>Texture>Texturize-ə 
gedin. 
2) Hər birini aşağıdakı kimi tənzimləyin:
 - Tekstura: lövhə
 - Şkala: 54%
 - Qabarma: 6
 - İşıq indeksi: yuxarı

3.6 (3.4) də hazırlanmış ağ dördbu-caqlıda parça 
şəklini kəsin. 
1) [Alt (Option)] düyməsini basılı saxlayaraq 
[Layer 1 copy] və “Piece of Cloth” qatları arasın-
da görünən [Clipping] ikonunu klik edin. 
 - Digər şəkildə Layer>Layer Mask>Reveal-ə 
gedin.

2) “Piece of cloth” qatının yaratdığı qrup 
hissələrini ağ rəng sahəsinə köçürün.

Şəkil 5-13: “Piece of Cloth”-un yaradılması

Şəkil 5-14: Tekstura vermək

Şəkil 5-15: Kliping ikonlar

Şəkil 5-16: Əməliyyatdan sonra

2

1

2

1
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3.7 “Pieces of cloth”-u görünməz edin.
1) Qat panelində [Layer Mask]-ı klik edin. 
2)  [Gradient] alətini seçin.
 - Seçim sətrindən [Gradient] yazısını seçin.
3) Seçim sətrində qradienti [Foreground to Back-
ground]-a dəyişin.  
4) Qradienti tətbiq etmək üçün siçanı sağdan 
sola sürüyün.

3.8 3 qatı bir qatda birləşdirin.
1) Arxa fon qatını göstərməyin.  
2) Arxa fon qatı gözünü söndürün. Qat paletinin 
[pop-up] düyməsini klik edin. 
3) [Merge Visible] alt menyusunu istifadə edin. 

3.9 Şəkilin kənarlarına kölgə salmaq effektini 
verin. 
1) 1 qata birləşdirilmiş qata qat stili (Layer Style) 
verin.  
2) Layer>Layer Style>Drop Shadow-a gedin.
3) Aşağıdakıları təyin edin:
Rejim: artan
Qeyri-şəffaflıq: 75%
Bucaq: 125°
Məsafə: 7
Yayılma: 0
Ölçü: 50 
4) [OK] düyməsini klik edin. 

Şəkil 5-17: “Pieces of Cloth” qatının 
qradienti

Şəkil 5-18: Görünüşü birləşdirmək

Şəkil 5-19: Kölgə salmaq (Drop Shadow)

2
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4. İşarə loqosu və əsas menyu fiqurunu ya-
rardın.
4.1 Verilmiş dəyərə [Drop Shadow]-nu tətbiq 
edin. 
1) [File>Place Linked] əmri ilə “Mark.eps’ 
faylını açın. 
 - Layer>Layer Style>Drop Shadow

2) [Drop Shadow]-nu  aşağıdakı kimi tənzimlə-
yin:
Rejim: artan
Qeyri-şəffaflıq: 75% 
Bucaq: 120
Məsafə: 7  
Yayılma: 0   
Ölçü: 24 

4.2 Mətni istədiyiniz kimi yazın.
1) [Horizontal Type]        alətini seçin. 
 - Şrift: Backoak Std
 - Şrift ölçüsü: 65 pt
 - Məktuba düzgün şəkildə “Nly” yazın.

2) [Horizontal Type] ilə “l” hərfini dartın.
 - Xüsusiyyət panelində [Set the Baseline Shift]-ə 
dəyişiklik edərək təməl sətri fərqli edin.  

4.3 Mətn rəngində dəyişiklik etmək üçün rəngi 
dəyişin.
1) [Eyedroppe] ilə işarə rəngini dəyişin. 

 - Çıxarılmış rənglərdən rəng məlumatlarını yox-
layın. 
 - Seçim: [Caps + Click Dropper] aləti kölgə və 
rəngi əldə etməyə kömək edəcək. 

Şəkil 5-20: İşarənin kölgələnməsi

Şəkil 5-21: Təməl sətir sürüşdürməsinin 
qurulması 

Şəkil 5-22:  Pipet

2
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1
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4.4 Verilən mətni düzgün şəkildə yazın. 
1) [Horizontal Type] rejimini seçin. 
2) Mətn qutusuna “hand made Quilt” (Əl işi 
örtü) yazın. 

4.5 Əsas menyunu müvafiq şəkildə yaradın.
1) [Horizontal Type] aləti ilə HOME, GAL-
LERY, SHOP, BOARD, MY PAGE və s. sözləri-
ni yazın.
 - Şrifti, onun rəngini, ölçüsünü tən-zimləyin. 
2) Şrift rəngi: R160, G100, B38
3) Orta nöqtə: R255, G0, B0
 
※Qeyd: 
Maddə işarəsini yazın.
• Windows-da, Alt+0+1+4+9 düymələrini basın.
• Windows-da>“l”>Enter
• Mac-da Option+8-i basın.
• Alternativ olaraq siz kəsə və yapışdıra da 
bilərsiniz.

4) Mətnin arxa fon hissəsinə və sərhədləri arası-
na yüngülvari kölgə effekt verin. 
5) Qat stilindən Layer>Bevel and  Emboss… -a 
gedin.
6) [Pillow Emboss]-u seçin. 
Dəyərləri (Şəkil 5-17)-də olduğu kimi təyin edin. 

Şəkil 5-23: Əl işi örtü (hand made Quilt)

Şəkil 5-24: Əsas menyu

Şəkil 5-25: Yastıq qabarması effekti (Pillow 
Emboss Effect)
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4.6 Çoxlu qatları sadələşdirmək üçün qrup 
şəklində yaradın. 
1) Qatı digər bir qatlara birləşdirmək üçün əlaqə 
qurun.
 - [Layer Eye] (Qat gözü) ikonuna yaxın boş bir 
sahəni klik edin.  

2) Qatın pop-up menyusunu klik edin.
 - [New Group from Layers] alt menyusuna ge-
din.
 - [New Group from Layers]-in dialoq qutusu 
görünəcək.

3) Ad hissəyə “Pieces of Cloth” (Parça hissələri) 
yazın.
4) [OK] düyməsini klik edin.

5. Şəkili müvafiq formada tənzimləyin.
5.1 Şəkili istifadə etmək üçün faylı tənzimləyin.
1) Mənbə yarlıkından “Bag.jpg” faylını seçin.

2) Qələm alətini seçin.

3) Qələm aləti seçim sətrini aşağıdakı kimi tən-
zimləyin:
• Alət rejimi: Path (Keçid)
• Keçid fəaliyyəti: Fiqurları birləşdirin

4) Qələm aləti ilə çantanın xətləri boyunca keçid 
çəkin.
※ Qeyd: 
Xəttin istiqamətinə nəzarət edin: [ALT + Drag]

Şəkil 5-26: Yeni qrup qatı (Parça hissələri)

Şəkil 5-27: Qələm aləti keçidi
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5.2 Şəkillə birgə istifadə etmək üçün olan faylı 
tənzimləyin.
1) Qələm aləti sətrindən [Subtract from Shape]-i 
seçin.
 - Çantanın arxa fon hissəsini çıxarın.

2) Select [Pen] tool 
 - Çanta tutacağını arxa plana keçirmək üçün 
onun iç hissəsi boyunca xətt çəkin. 

3) Path panelinin ad pəncərəsində “Work Path”-i 
iki dəfə klik edin. 
 - Yeni ad yazın və ya orijinal adı saxlayın: [Path 
1]
4) [OK] düyməsini klik edin.  

5.3 Seçim sahəsi olmağı üçün “Path 1”-ı düzəl-
din. 
1) “Path 1”-ı [Load path as a selection] düyməsinə 
sürüyün.
 
2) Select>Modify>Contrast ilə sahəni “1px”-ə 
azaldın.

3) Select>Modify>Feather ilə sahənin kənar 
xətlərini “1px”-ə dəyişin.

4) [Move] alətini seçin.

5) Seçilmiş çanta şəkilini iş pəncərəsinə sürüyün. 

Şəkil 5-28: Qabaq fiqurlardan çıxarış

Şəkil 5-29: Keçid adı=Path 1

Şəkil 5-31: Kontrast və Feather

Şəkil 5-32: İş pəncərəsinə çantanın 
köçürülməsi

Şəkil 5-30: Yükləmə keçidi və Seçim 
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5.4 Yeni qat düyməsi ilə dördbucaq yaradın.
1) Qat seçimi sətrindən yeni qat yaradın.
 - [Alt] düyməsini basılı saxlayaraq “yeni qat 
əlavə edin” ikonunu klik edin. 
 - Yeni qat pəncərəsinə dördbucaqlı (quadrangle) 
yazın. 
2) [Rectangular Marquee] alətini seçin.
 - Stil: Sabit ölçü – en 6.5 sm, hündürlük 6.5 sm
3)  Əvvəlki addımda yaradılmış qatı aktivləşdi-
rin.
 - Qabaq fon rəngini aşağıdakı kimi tənzimləyin:
R239, G227, B204
 - Qabaq fon rəngi üçün [Alt + Backspace] 
düyməsinə basın.

4) İş pəncərəsində qaydalar hazırlayın. 
 - İstifadəçi siçanı klik etdikdə “6.5 sm×6.5 sm” 
kvadrat sahə yaranr.
 - O sahəni ağ fon rəngi ilə doldurun. 
5) [Rectangular Marquee] alət seçimi vəzi-
yyətində:
 - Qabaq fon rəngi ilə doldurun.
 - Əvvəlki qaydada bir daha düzbucaqlı aləti 
yaradıldı.
※ Qeyd:
Daha dəqiq iş üçün View>Snap to> Guides-ə ge-
din.
6) ‘2~4’ –cü addımda olduğu kimi qabaq fon 
rəngini müəyyənləşdirin. 
a) Qabaq fon rəngi: R208, G181, B138
b) Kvadrat sahəni bir-bir sürüşdürün və qabaq 
fon rəngi ilə doldurun.
c) [Free Transform] funksiyası ilə kvadrata yer-
ləşə bilməyi üçün çanta ölçüsünü tənzimləyin. 

Şəkil 5-33: Yeni qat əlavə edin (Dördbucaqlı)

Şəkil 5-34: Dördbucaqlı (Quadrangle) ölçüsü 
və Qabaq fon rəngi

Şəkil 5-35: Dördbucaqlı ölçüsü və qabaq fon 
rəngi

Şəkil 5-36: Birdən çox düzbucaqlı çəkmək 
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5.5 Yeni qata (Floor/Mərtəbə) kölgə salın.  
1) Çanta (Bag) və Kvadrat (Square) qatı arasın-
dakı boşluqda yeni bir qat yaradın. 
• Qat adı: Floor
2) [Rectangular Marquee] aləti ilə ölçüsü 6 
kvadratdan daha böyük bir kvadrat çəkin. 
 - Stil: Sabit ölçü - en 21sm, hündürlük 14.5 sm
 - Ağ rəng ilə doldurun. 
3) Layer>Layer Style>Drop Shadow
• Qarışdırma rejimi: artan 
• Bucaq: 90°
• Məsafə: 15%
• Yayılma: 0%
• Ölçü: 50%

  
4) Qatın qeyri-şəffaflıq dərəcəsini “37%” edin.
 - Şəkilin tutqunluğuna görə arxa şəkil görünməz 
olur. 
 

5.6 “Thread.jpg” şəklini müvafiq formada tən-
zimləyin. 
1) “Thread.jpg” faylını açın.
 - Cəld seçim alətini (Quick Selection tool) seçin.

2) Seçim əlavə et düyməsi ilə seçim sahəsini 
düzəldin.

Şəkil 5-37: Yeni mərtəbə qatı əlavə etmək 

Şəkil 5-38: Kölgə salmaq

Şəkil 5-39: Qeyri-şəffaflıq parametrləri 

Şəkil 5-40: Cəld seçim aləti
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3) Arxa fonu silin.

5.7 Sapla uyğunlaşdırmaq üçün böcək hissəni 
silin. 
1) [Lasso] aləti ilə böcəyin aşağı sağ hissəsini 
seçin. 

 - Böcəyi kopyalanan sap qapağı ilə əvəz etmək 
üçün aşağı olan tərəfdə qapaqlardan birini seçin. 

2) [Ctrl (Command) + J] ilə yeni qat yaradın. 
 - Yeni qatı “Layer 1” kimi əlavə edin. 

3) Kopyalanmış hissələri əldə etmək üçün qatda 
yaranan fiqur istiqamətini fırladın.
 - Edit>Free Transform>Flip Vertical 

4) Böcəyi silməzdən qabaq mavi sapın küncünü 
dəyişin. 
a) Sol küncü seçin.
b) [Ctrl (Command) + J] ilə seçim sahəsində 
yeni qat yaradın. 

5) Əvvəlki addımın qatını çevirmək üçün  4 
“Soldan Sağa”:

Şəkil 5-41: Arxa fonun silinməsi

Şəkil 5-42: Qapağın seçilməsi. 

Şəkil 5-44: Şaquli çevirmək

Şəkil 5-43: Ctrl + J (Yeni kopya olunmuş 
qatın əlavə olunması)
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 - Qat 3-də [Move] alətini seçin. 
 - Edit>Transform>Flip Horizontal 
6) [Ctrl (Command) + T] ilə hissənin bucağı ilə 
yaşıl sapda hissələri yerləşdirərək fiquru tənzim-
ləyin.
 - “Free Transform” seçim sətirində bucağı 40° 
təyin edin. 

7)“Eraser” aləti ilə böcəyi silin.

5.8 Hissələri səliqəsiz şəkildə yerləşdirin. 
1) 5.7-ci bəndin 1 və 3-cü prosesindəki kimi 
böcəyin yerləşdiyi yerə kopyalanmış hissələri 
qoyun. 
2) Hissələrin ölçüsünü dəyişin. 
3) Şaquli xətti silmək üçün “Healing Brush” alə-
tini istifadə edin. 

a) Müvafiq fırçanı seçdikdən sonra  tənzimləmək 
üçün  [Alt] düyməsi ilə ən yaxın nöqtəyə klik 
edin.  
b) Xaç işarəsini görmək üçün nöqtəni sürüyün. 
(Möhür alətini istifadə etmək üçün də eyni qay-
danı tətbiq edin.)

Şəkil 5-46: Üfüqi çevirmə

Şəkil 5-45: Qat 2 (Layer 2)

Şəkil 5-48: Böcək hissənin silinməsi

Şəkil 5-49: Qapağı köçürmək

Şəkil 5-47: Sərbəst transformasiyanın 
tənzimlənməsi

4

6

5

7

1

3

a

d

dc

b
a

Lasso aləti

Klik 
Köçürmək2
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5.9 Qat 3 kimi “Images” qatını yaradın. 
1) “5.1”-“5.8”-də düzəldilmiş qatları linkə əlavə 
edin. 
2) “Layer pop-up list” ikonunda [New Group 
from Layers] vasitə-silə 3 qat yaradın. 
 - Ad: Images (Şəkillər)

6. Smart şəkildə düymələri yaradın. 
6.1 Düzbucaqlı fiquru üçün kvadrat düyməsini 
tənzimləyin.
1) Mənbə faylından “Square Button.eps” faylını 
açın. (Hazırlanmış və ya öz-özünə düzəlmiş 
şəkil)
 - File>Place Linked…-ə gedin. 

2) [Free Transform…] funksiyası ilə kvadratın 
fiqurunu dəyişin.   

6.2 Yeni mətnə qat stilini tətbiq edin.  
1) [Horizontal Type/Üfüqi yazı] aləti ilə biraz 
qara rəngdə  Package sözünü yazın. 
2) Mətnə mövcud qat stilini tətbiq etmək üçün:
 - Əsas menyuda “Piece of Cloth” ilə əhatə olu-
nan qatda siçanın sağ düyməsini klik edin. 
3) [Copy Layer Style]

Şəkil 5-50: Tamamlanmış şəkil

Şəkil 5-51: “Images” (şəkillər) qatı

Şəkil 5-52: Place Linked…funksiyası

Şəkil 5-53: Sərbəst transformasiya…

Şəkil 5-54: Qat stilinin kopyalanması

2

1

3

2

2

1

1

3

a
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‘Mark’ Qatını seçin.

4) “Package” qatını klik edərək [Paste Layer 
Style]-ı seçin.

5) Eyni şəkildə “Piece of Cloth Layer 3” və 
“Square Button” qatına aid olan “Mark” qatını 
tənzimləyin. 

6) “Square Button” qatının rəngini aşağıdakı 
kimi dəyişin:
 - Image>Adjustments>Hue/Saturation
 - [Hue/Saturation] panelində “Hue 10, Satura-
tion 0, Lightness 0” tənzimləmələrini edin. 

6.3 Qatları uyğun yerlərə ahəngli şəkildə yer-
ləşdirin.
1) Eyni şəkildə daha dörd qat da yaradın.
 - Hər birini müxtəlif rəngə boyayın.
2) Altı qatda ən uzaq sol və ən uzaq sağ sərhədi 
göstərin.  
3) Altı kopyalanmış kvadrat düyməsinə [Link]-i 
qurun. 
4) [Move] alətini seçin.  

5) Seçim sətrindən [Align Vertical Centers]-i 
seçin.

6) Seçim sətrində [Distribute Horizontal Cen-
ters]-i təyin edin. 

Şəkil 5-55: Qat stilinin yapışdırılması

Şəkil 5-56 Qat stilinin tənzimlənməsi

Şəkil 5-57:  Qat stilinin tənzimlənməsi

Şəkil 5-58: 6 düymənin bağlantısı

4

4

1

3

6

5

6 düyməli rink
Hər iki tərəfin sərhədi
2
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 - Düymələri yaxşı görünəcək şəkildə düzüb pay-
laşdırın.

6.4 Verilmiş şərtlərə əsasən qatları yaradın. 
1) [Text]-i 5 dəfə  yenidən kopyalayın və hər qatı 
yaradın.
2) İstifadəçi mətni dəyişən zaman:
a) Düyməni kilidli saxlayın.
b) Kopyalanmış mətni tənzimləyin.
c)  Mətni və düyməni bundan sonra olacaq dəy-
işiklikləri nəzərə alaraq olduğu kimi saxlayın.

3) 6 kvadrat düymə və 6 mətn qatı arasında əlaqə  
qurun. 
 - 6 düyməni Layer 3 kimi düzəldin.

7. Məlumat lövhəsini hazırlayın.
7.1 Qata sellofan effekti verin. 
1) Yeni qat kimi “The Right Square” ( sağ kvad-
rat) qatını yaradın. 
2) [Rectangular Marquee] aləti ilə sağ tərəfdə 
hündür düzbucaqlı çəkin. 
 - Fiquru R248, G231, B202 ilə doldurun.  
3) Qat qarışdırma rejimini [Multiply] edin.

7.2Müxtəlif yollarla fiquru dəyişdirin.
1) [Rounded Rectangle/ Dairəvi düzbucaqlı] alə-
tini seçin.

2) Seçim sətrindən radiusu “25pt” edin. 

Şəkil 5-60: Mətnin qatlarını kopyalamaq

Şəkil 5-59: Düymələrin düzülməsi və 
paylanılması

1

1

6

5
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3) Ağ rəngi təyin edin və çəkmək üçün nöqtəni 
klik edərək siçanı mümkün qədər  sürüyün. 

 
4) Fiquru dəyişdirmək üçün [Anchor Point] alə-
tini seçin.
 - Üfüqi xətti klik edərək iki nöqtə əlavə edin.

※ Qeyd
[Add Anchor Point Tool]- Bağlama nöqtəsi alə-
tini əlavə etmək
[Add Anchor Point   ] aləti bağlamaları əlavə edir 
və mövcud vektor fiqurlarını yenidən formaya 
salır.
• Alətlər qutusunda (Toolbox) Add Anchor Point  
alətini seçin. 
• ağlama nöqtəsini əlavə etmək üçün mövcud 
keçidi klik edin.
• Əlavə olunmuş bağlama nöqtəsini və ya xət-
ti yenidən formaya salmaq üçün onun istiqamət 
xəttini sürüyün.
• Bağlama nöqtəsi əlavə etmək üçün keçidi 
sürüyün və yenidən formaya salma xəttini dəy-
işin. 
5) [Direct Selection] alətinə nəzarət etməklə 
işarəni hərəkət etdirərək fiquru tənzimləyin. 
6) [Opacity] -ni “58%” edin.

7.3 Məlumatı lövhəyə əlavə edin. 
1) [Ellipse] aləti ilə dairə çəkin:
R150, G111, B74
2) [Horizontal Type/Üfüqi Yazı] aləti ilə [NEWS] 
nümunəsini yazın. 
- Hərflər arasında rəngi, ölçünü tənzimləyin.  
• N: White
• EW: R88, G61, B13  

Şəkil 5-61: Qat 3-ün (Layer 3) yaradılması

Şəkil 5-63: Dairəvi düzbucaqlı fiquru

Şəkil 5-64: Bucaq nöqtəsi alətinin ( Add An-
chor Point tool) əlavə olunması

Şəkil 5-62: Məlumat lövhəsinin (Bulletin 
Board) qurulması

4

2

2
1

3

3

3

Sürümək
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3) Məzmunu əlavə edin. 
• Kiçik düzbucaqlı: R255, G1, 38, B13
• Mətn rəngi: R150, G111, B74
※Mətnin xüsusiyyət tənzimləmələri (Text Char-
acter Setting)

※News (Xəbər) başlığı
• Big Sale: Season Event (Böyük endirim: Sezon 
tədbiri)
• Welcome New Customers (Yeni müştəriləri 
salamlamaq) 
• VIP Special Treatment (VIP xüsusi münasibət)
• New Product Arrival (Yeni məhsulların gəlmə-
si)
• X-Mas Sale Invitation (Yeni il endirim dəvəti)
• Season Off Corner (Sezon köşəsi)

7.4 “Work Path”-i “Path 1” kimi yaddaşa verin. 
1) [Horizontal Type] aləti ilə “QUILT” sözünü 
yazın.
 - [Ctrl (Command)] ilə “QUILT” qatını seçin: 
Köçürmə alətini seçin.

2) Mətni keçidə dəyişin:
 - Mövcud seçilən yeni qat (QUILT) üzərində 
siçanın sağ düyməsini klik edin. 
 - “Quilt” qatının alt menyusundan [Create Work 
Path] keçidinə gedin. 

Şəkil 5-67: Qeyri-şəffaflığın yenidən 
tənzimlənməsi

Şəkil 5-68: Mətnin əlavə olunması [News]

Şəkil 5-65: Fiqur tənzimləməsi 1

Şəkil 5-66: Fiqur tənzimləməsi 2 

6

5

7

2

1

Ctrl+Click
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Və ya “Path” panelində [Make Work Path…] 
3) “Make Work Path”-in giriş pəncərəsi 
görünəndə “Tolerance”-ı “0.5px” edin və [OK] 
düyməsini klikləyin. 

4) “Path” palitrasında “Path 1” kimi qeydiyyat-
dan keçən “Work Path”-i yaddaşa verin. 

7.5 “Path 1”-da çərçivə qutusunu tənzim-ləyin. 
1) “QUILT” qatından göz çəkin.
2) “Path” palitrasnda “Path 1”-ı aktivləşdirin.

3) [Direct Selection] alətini   seçin.
4) Aktivləşdirilmiş keçid görünəndə “Q” xarak-
terini daxil etmək üçün fiquru seçin. 
5) [Ctrl (Command) + T] ilə füquru düzəldin. 

7.6 Verilmiş şərtlərə uyğun digər mətn fiqurlarını 
tənzimləyin.  
1)Yeni qat əlavə edin.
2) “Path” palitrasında pop-up düyməsi-ni klik 
edərək [Make Selection] seçilir.
• Feather: 0 pixel
• Operation: New Selection

Şəkil 5-69: News başlığı

Şəkil 5-70: Mətnin xüsusiyyətləri 

Şəkil 5-71: İş keçidinin yaradılması 

Şəkil 5-73: Path 1 

Şəkil 5-72:  Path panelində Work Path 
yaradın.

33

4

2

2

2

1

Siçanın sağ 
düyməsini klik edin. 
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3) “Path” seçimini ləğv edin. “Path 1”-ı 
seçməmək üçün boş nöqtəyə klik edin.
- Qabaq fon rəngi ilə (ağ rəng) [Layer 1]-ı doldur-
maq üçün [Alt (Command) + Delete] seçilir.

4) Mətnin fiqurunu tənzimləmək üçün (7.4) 1 və 
3-cü addımları təkrar edin. 
• Qabaq fon rəngi: ağ 
• Qeyri-şəffaflıq: 30% 
5) “Q & A”-i aşağıdakı kimi daxil edin”
• Mətn “QA”: R255, G138, B13
• Simvol “&”: R130, G130, B130
• Layer>Layer Style>Bevel and Emboss
 [Pillow Emboss]

7.7 Kompozisiyanı tamamlayın.
1) Yekun olaraq “Text” –i əlavə edin.
- [2018 Baku School No.4 All Rights Reserved]
2) Qatların bütün hisslərini yoxlamaq üçün yer-
ləşdirin.

3) “Layer set” ilə birləşdirmək üçün Layers-i 
seçin.
4) Qatlara bağlantı qurun.
6) “Layer set” yaradın.
7) Faylı yaddaşa verin.

Şəkil 5-74: “Q”-nün transformasiyası

Şəkil 5-75: Yeni qat (New Layer)

Şəkil 5-76: İş keçidinin düzəldilməsi

Şəkil 5-77: Mətnin qabaq fon rəngi

4

2
1

3

1

3

sürüyün 
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Şəkil 78: Qeyri-şəffaflıq 30% 

Şəkil 5-79: Yastıq qabarması (Pillow Emboss)

Şəkil 5-80: Komponentlərin yerləşdirilməsi

Şəkil 5-81: Qat qrupları (Layer Groups) 

4

5



Photoshop

87

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Filtr alətinin effektini aydın şəkildə izah etdi?
2. Filtr tətbiqi vasitəsilə yeni və smart təsvirlər ilə təbii şəkildə ana 
səhifəni dizayn etdi?
3. Müxtəlif fiqurların vahid nümunəsini yaratdı?
4. Müxtəlif yollarla mətni keçidə dəyişdi?
5. İş şərtləri üçün şəkildə dəyişiklik etdi?
6. İstifadə məqsədi ilə gizli şəkildə dəqiqliyi dəyişdi? 
7. Şəkil xüsusiyyətini müvafiq formada dəyişmək üçün filtr funksi-
yasının ən yaxşısını tətbiq etdi?



Illustrator

Sənaye və İnnovasiyalar üzrə 
Bakı Dövlət Peşə Təhsil Mərkəzi

Səriştə əsaslı 
modul İKT
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Ön söz 

 İllüstrator əlaqəli mətn və ya fikir məzmununa uyğun olan vizual açıqlama ilə yazı inkişafında və 
ya konsepsiyaları aydınlaşdırmada ixtisaslaşmış proqramdır. İllüstrasiya çətin məzmunları aydın-
laşdırmaq və ya mətni olaraq təsvir edilməsi çətin olan obyektlərin açıqlanmasında istifadə olunur. 
Buna görə də illüstrasiyalara uşaqların kitablarında tez-tez rast gəlinir. İllüstrasiya, bir işlə məşğul 
olan və birbaşa diqqət tələb etmədən,  etdikləri işdən uzaqlaşmadan əlavə şəkil çəkmə sənətidir. 
Digər şey diqqət mərkəzidir və illüstrasiyanın rolu digər şeylə rəqabət etmədən xüsusiyyət əlavə 
etməkdir. 
 İllüstrasiya reklamlarda, memarlıq işlərində, təbrik açıqcalarında, posterlərdə, kitablarda, qrafik 
romanlarda, təsvirli hekayələrdə, fənn dərsliklərində, biznesdə, jurnallarda, video oyunlarda, tədris 
vasitələrində və qəzetlərdə istifadə olunur. Cizgi film illüstrasiyası hekayələrə və esselərə yumor 
hissi qata bilər.
 Bu modulun ən fərqli xüsusiyyəti “Piktorial Sistemi” qəbul etməsidir. Modul dərsliyin bu məz-
munu içərisində şəkillər yazılı cümlələrdən daha çox əsas açar məzmunu rolunu oynayır. Texniki 
tədris/təlim ilə bağlı olaraq şagird sözlərdən daha çox şəkillər vasitəsilə texniki məzmunu aydın 
şəkildə başa düşür. Faktiki olaraq söz şəkilin göstəricisini izah etmək üçün dəstəkləyici vasitədir. 
 Yekun olaraq mən çoxsaylı mənbələrə, xüsusilə YouTube, Yahoo, Wikipedia, “www.hrdbank.net” 
və Google saytlarına təşəkkür edirəm. Onlar mənə texniki təcrübə modulu dərsliyinin hazırlan-
masında köməklik etdilər.

                YUN, Hyung Soon, IKT üzrə Texniki Ekspert
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   İllüstrator proqramının komponentlərini izah edəcək;
2.   Müştərinin tələblərinə uyğun olaraq simvolu (loqonu) dəqiq şəkildə düzəltməyi biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   İllüstrator proqramı Qaynaq fayl 
3.   Media tədrisinə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. İllüstrator proqramının ekran tərtibatı 

1. Əyləncəli̇ si̇mvol markasi yaratmaq

Şəkil 1-1: Ekran elementləri 

1) Körpü 
və sənəd 
düzümü
2) Əsas 
menyu
3) Fayl adı
4) Alətlər 
paneli
5) İş lövhəsi
6) Panel
7) Status 
qeyd cərgəsi
8) Nəzarət 
paneli

1

4

7
8

5

2
3

6
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Şəkil 1-2: Pathfinder aləti 

Şəkil 1-3: Unite

2. Pathfinder
1)  Pathfinder-in göstərilməsi üçün şagird Windows>Pathfinder-i seçməlidir.

 1 

2 

3 

(Şəkil 1-2 ) Pathfinder aləti  
2> Path Finder tool 

2) İlk Shape Mode seçilmiş bütün obyektləri vahid geniş formada birləşdirən Unite-dir.

 

2 

3 

1 

(Şəkil 1-3 ) Unite 
2> Path Finder tool 

1

2

3

2

1

3
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3) İkinci Shape Mode kəsik açmaq üçün hər hansı bir üst obyekti istifadə etməyə imkan verir.

 

2 

1 

3 

(Şəkil 1-4 ) Minus Front 
2> Path Finder tool Şəkil 1-4: Minus Front

Şəkil 1-5: Intersect

4) Üçüncü seçim obyektlərin üst-üstə düşən hissələrini istifadə edərək yeni forma yaradan In-
tersect-dir.

 

2 

3 

1 

(Şəkil 1-5 ) Intersect 
2> Path Finder tool 

1

2

3

1

3
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Şəkil 1-6: Extrude

5) Sonuncu isə bir-birinə bənzəməyən hissələrdən birini çıxarmaq əvəzinə tam əksini edərək 
obyektlərin kəsişən hissələrindən azad olan Exclude-dur. 

 

1 

2 

3 

(Figure 1-6> Extrude 
2> Path Finder tool 

3. Qələm aləti (Pen tool)
3.1 Qələm alətinin növləri:
Qələm aləti alətlər panelində mövcud olub illüstratorda ən güclü rəsm alətlərindən biri hesab 

olunur. İstifadəçi bu alət vasitəsilə keçidləri yaradan bağlanma nöqtələrini formalaşdıra və redaktə 
edə bilər.

Konturları qurun və rəsmi çəkməzdən qabaq doldurun. 
Qələm aləti ilə işə başlamazdan qabaq alətlər panelindən qələm alətini seçin və xüsusiyyətlər 

panelində Strok çəkisini 1 pt-ə qədər, rəngi isə qaraya təyin edin.  
1) Düz xətlər yaradın.
1. Qələm aləti ilə düz xətləri yaratmaq üçün bağlanma nöqtəsini klik edin. İşarələyicini hərəkət 

etdirin. Daha sonra digər bağlama nöqtəsini yaradın. İstifadəçi keçid üçün müxtəlif yerlərdə 
klikləyərək daha çox bağlama nöqtəsi yarada bilər.

2. Keçidi bağlamaq üçün işarələyicini orijinal bağlama nöqtəsinin üzərinə gətirin. İşarələyici-
nin yanında dairə göründükdə Shift düyməsini sıxın və End point düyməsini klik edin. 

3. Keçidi bağlamadan çəkməyi dayandırmaq üçün Escape düyməsini sıxın. 
2) Əyri xətləri yaradın. 
Əyri xətt çəkmək və istiqamət tutacaqlarını yaratmaq üçün nöqtəyə basıb sürüyərək buraxın. 

İşarələyicini hərəkət etdirin, başqa bir bağlanma nöqtəsi yaratmaq üçün düyməni basıb sürüyün. 
Bağlanma nöqtəsi tutacaqlarını yaradarkən və ya redaktə edərkən nə qədər sürüsəniz keçidin əyrisi 
bir o qədər çox olacaq. 

3) Künc nöqtələrini yaradın. (Keçid istiqamətlərini dəyişin.)
Keçid istiqamətlərini dəyişmək və hamar nöqtə yaratmaq üçün düyməni sıxın və sürüyün. Siçan 

düyməsini buraxın. İşarələyicini tutacağın sonuna gətirin. Təsvir göründükdə Option (MacOS) və 
ya Alt key (Windows) düyməsini sıxın, yaxud onları ayırmaq üçün tutacağın sonunu sürüyün.  

4) İstiqamət tutacaqlarını ləğv edin. 
İstiqamət tutacaqlarını ləğv etmək üçün son bağlanma nöqtəsini klik edin. Daha sonra çəkməyə 

davam edin.  

1

3

2
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3.2 Funksiyalar:
1) Pen Tool (P)
• Düz seqmentlərlə keçid yaratmaq üçün iş 

lövhəsinə klik edin. Bezier əyriləri ilə keçid 
yaratmaq üçün siçanı klik edib  sürüyün.

2) Bağlanma nöqtəsi alətinin əlavə olunması 
(+)

• Bağlanma nöqtələrini əlavə etmək üçün 
keçid seqmentinə klik edin. 

3) Bağlanma nöqtəsi alətinin silinməsi (-)
• Keçiddən silmək üçün bağlanma nöqtəsinə 

klik edin. 

4) Bağlanma nöqtəsinin konvertasiya olun-
ması (Shift-C)

• Bağlanma nöqtəsinə klik edin və Bezier 
tutacaqlarını yaratmaq üçün sürüyün. Onları 
silmək üçün tutacaqlar ilə bağlama nöqtəsini 
klik edin.

• Əyri olaraq dəyişdirmək üçün bir keçid 
boyunca klik edin ve sürüyün.

Şəkil 1-7: Qələm aləti 

Şəkil 1-8: Bağlama nöqtəsi alətinin 
əlavə olunması 

Şəkil 1-9: Bağlama nöqtəsi alətinin silinməsi 

Şəkil 1-10: Bağlama nöqtəsinin 
konvertasiya edilməsi
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Şəkil 1-11: Qayçı aləti 

5) Qayçı aləti (C)
• Qayçı aləti qələm aləti qrupunun bir parçası 

olmasa da mütləq şəkildə onunla əlaqələndiril-
ir. Keçid seqmentinə klik edərək onu iki hissəyə 
bölün.  

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. İş mühitinin qurulması 
1) File>New hissəni klik edərək sənədin yaradıl-
ması:
1. İş lövhəsi parametrləri 
• Ölçü: A4
• En: 210mm
• Hündürlük: 297mm 
• Oriyentasiya: Portret 
• Rəng rejimi: CMYK  

Şəkil 1-12: İş lövhəsi parametrləri 

1

2

(Şəkil 1-12) İş lövhəsi parametrləri 

1

2
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2. Klik etmək (Yaratmaq)
2) İş vahidlərinin (Working Units) yaradılması: 
1. [Edit>Preferences>Units…]-i klik edin.
• General: Millimeters
• Stroke: Points
• Type: Points
2. [OK]-i klik edin. 

2. Ellips aləti ilə simvolun çəkilməsi
1) Təlimat xəttinin yaradılması
1. Ovalı geniş formada [Ellipse] aləti vasitəsilə 
sağdan və soldan çəkin. 
2. [View>Show Rulers] vasitəsilə xətkeşi iş 
sahəsində göstərin.
3. Xətkeş hissəsini sürüyərək təlimat xəttini 
yaradın.
- İlk olaraq [Select] aləti ilə Ellipse-i seçin.  

2) Formanın xəttinin çəkilməsi
1. [Pen] aləti ilə “   ” Formasını çəkin.

3) “2” mərhələdə çəkilmiş xəttin surətinin çıx-
arılması
1. Alt düyməsini basılı tutaraq əvvəlki 2 
mərhələdən çəkilən xəttin surətini çıxarın.
2. Xətti (Şəkil 1-15)-də olduğu kimi dəyişin.
3. [Direct Selection] aləti ilə üçüncü xəttin uzun-
luğunu artırmaq üçün nöqtəni sürüyün.

 
1 

(Şəkil 1-13) Unit parametrləri  

2> Path Finder tool 
Şəkil 1-13: Unit parametrləri 

Şəkil 1-14: Xətkeşlər və Ellips 

Şəkil 1-15: ‘   ’ hərfi

Şəkil 1-16: Nüsxəni çıxarmaq üçün Alt 
düyməsi

 

1 

2 

3 

(Şəkil 1-14) Xətkeşlər və Ellips  

2> Path Finder tool 

 

1 

(Şəkil 1-15) ‘ㄱ’ hərfi 

 

(Şəkil 1-16) Nüsxəni çıxarmaq üçün Alt 
düyməsi 

2 

1 

3 

1

1
2

3

1

1

2

3
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Şəkil 1-17: Bölgü sseçımləri

Şəkil 1-18: Reflect Tool

4)  Dağ formasına bənzər qalınlığın verilməsi
1. [Stroke]-u aktivləşdirin. 
-  [Windows>Stroke] menyusuna gedin. 
2. [Stroke] panelini qurun. 
• Weight (En): 60pt/40pt
• Cap (Papaq): Dairəvi
• Corner (Künc): Dairəvi

5) Şaquli xətt və əyrinin çəkilməsi
1. [Pen] aləti ilə [Stroke] panelinin sseçımlərinin 
qurulması:
• Weight (En): 60pt
• Cap (papaq): Dairəvi
• Corner (künc): Dairəvi
2. Şaquli xətt və əyrinin çəkilməsi
- Təlimat xəttinin mərkəzinin yaradılması.

6) Şaquli xətt və əyrinin çəkilməsi
1. [Ellipse] aləti ilə uzun ellipsi yuxarı və aşağıya 
doğru çəkin.
- Şaquli təlimat xətti bazasında
2. Çəkilmiş ellipsi [Alt] düyməsini sıxaraq aşağı 
çəkərək kopyalayın.
- Başqa bir obyektə köçürmək üçün
3. [Rotate] aləti ilə obyekti döndərin. 
- [Selection] alətindən obyekti seçin. 
- [Rotate] alətini seçin.
- [Shift] düyməsini sıxıb saxlayaraq obyekti 
soldan sağa çəkin. 

4. Obyekti kölgələmək üçün xəttin bir üz olması-
na diqqət edin. 
Sarı yaşıl xətti seçin. 
- [Object>Path>Outline Stroke] hissəsinə keçin.
5. [Reflect] alətini iki dəfə klik edin. 
• Axis: şaquli
• [Copy] düyməsini klik edin. 
6. [Shift] düyməsini tutub saxlayaraq kopyala-
nan obyekti şaquli olaraq sola daşıyın.

 

(Şəkil 1-17) Bölgü seçimləri 

Ctrl + F10 
1 

2 

 

5 

2 
3 

1 

4 

6 

(Şəkil 1-18) Reflect Tool 

2

1 2
3

5

4

6

Ctrl+F10
1
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1. Pathfinder-in icra olunması
1) Pathfinder paletini aktivləşdirmək 
1. [Window>Pathfinder]-ə gedin. 
2. Obyekti seçin.
• Forma növü: Substract

2) Şəkili aydın formada yerləşdirmək
1. [Object>Expand>Appearance] hissəsinə ge-
din.
2. Faylı “Gülməli simvol işarəsi yaratmaq” kimi 
yaddaşa verin. 

 1 

2 

(Şəkil 1-19) Pathfinder çıxarışı 

(Figure 1-2> Path Finder tool 

Şəkil 1-19: Pathfinder çıxarışı

Şəkil 1-20: Tamamlanmış simvol görünüşü 

1

2
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. İllüstrator proqramının komponentlərini inamla izah etdi?
2. Müştərinin ehtiyaclarına uyğun olaraq dəqiq şəkildə simvol 
(loqo) düzəltdi? 
3. Pathfinder funksiyalarını obyektə tətbiq etdi?
4. Qələm alətini sərbəst şəkildə istifadə etdi?
5. Shortcut (Qısa yol) düyməsindən istifadə etdi? 
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Simvol qeydiyyatı və forma alətlərinin funksiyalarını izah edəcək;
2.   Sərbəst şəkildə obyektə uyğun simvol yaratmağı biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylı
3.   Media tədrisinə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Düzbucaq
1) Çəkmək
1. Künc radiuslarını dəyişmək üçün künc kənarlarından hər hansı birini sürüyün. Maksimal 

2. Si̇mvoldan i̇sti̇fadə edərək koster yaratmaq  

Şəkil 2-1: Düzbucaqlı fiquru

Şəkil 2-2: Redaktə etmək

künc radiusuna çatdıqda qırmızı qövs meydana 
gələcək. 

※ Qeyd:
Tək bir küncü dəyişmək üçün bağlama 

nöqtəsini klik edərək birbaşa seçim alətini is-
tifadə edin və sonra redaktə üçün künc hissəni 
klik edərək sürüyün.

2. Səkkiz haşiyəli qutu tutacaqlarından biri-
ni sürüyərək düzbucaqlı düzəldin. Döndər-mək 
üçün döndərmək ikonu görünənə qədər kursoru 
küncdən uzaqlaşdırın və sürüyün.

3. Fiqurun mərkəzini tapmaq üçün mərkəz 
nöqtə hissəciyini istifadə edin.

2) Fiquru uyğun şəkildə redaktə etmək
1. Nəzarət panelindən düzbucaqlının 

ölçülərini, fırlanma və künc kimi  xüsusi-
yyətlərini dəyişmək üçün fiqura klik edin və 
yaxud Transform panelindəki xüsusiyyətləri 
tənzimləyin. 

※ Qeyd:
Fırladılmış fiquru və ya keçidi əvvəlki bu-

cağına qaytarmaq üçün poliqon bucağında və 
ya döndərmə sahəsində 0° -ni seçin. 

 

(Şəkil 1-1) Düzbucaqlı fiquru 

 

(Şəkil 1-2) Redaktə etmək 
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1.2 Ellips
1) Çəkmək
1. Çərçivələnmiş qutu tutacaqlarını istifadə 

edərək ellipsin ölçülərini dinamik şəkildə dəy-
işdirin.

2. Fiquru proporsional şəkildə yenidən 
ölçüləndirmək üçün qutu sərhədlərinin tut-
acaqlarını saxlayaraq sürüyün. Mərkəzdən 
proporsional olaraq ölçmək üçün Alt (Seçim) 
düyməsini basılı saxlayaraq sürüyün.

3. Ellipsi döndərmək üçün döndərmək 
ikonunu görənə qədər kursoru qutu çərçivə 
tutacaqlarından uzaqlaşdırın. Daha sonra 
döndərmək üçün sürüyün. Sürümə zamanı bu-
caq oxuma qutusu meydana çıxacaq. 

※ Qeyd: 45° bucağa döndərən zaman Shift 
düyməsini sıxın. 

 

(Şəkil 1-3) Ellips fiquru Şəkil 2-3: Ellips fiquru

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

1. Ürək fiqurunu simvol kimi qeydiyyata 
keçirmək
1) Yeni şəkil lövhəsinin qurulması
1. [File>New] = [Ctrl + N]-a gedin.

2. [New Document]-i qurun.
• Vahid: Millimeter
• En: 100mm
• Hündürlük: 100mm 
• Orientasiya: Portrait  
• Rəng: CMYK  
3.[Create]-i klik edin.

2) Koster rənginin qurulması
1. Üz rənginin təyin edilməsi
• C:80%, M:22%, Y:31%, K:0%
2. [Ellipse Tool] ilə, “100mm” radius ilə dairə 
çəkin. 
3. [OK] düyməsini klik edin. 

3) Hərəkət etməməsi üçün arxa fonun sabitləşdi-
rilməsi 
1. Dairəni seçin. 
2. [Ctrl +2] -ə klik edin.
-  Digər işlərə mane olmamaq üçün obyekti 
(dairəni) arxa fon kimi təyin edin. 
※ Qeyd:   
 Kilidi aktivləşdirmək: [Ctrl + 2]
 Kilidi açmaq: [Ctrl + Alt + 2] 

Şəkil 2-4: Şəkil lövhəsinin öncədən 
qurulması

Şəkil 2-5: Şəkil lövhəsinin öncədən 
qurulması

Şəkil 2-6: Dairənin sabitləşdirilməsi

 
1 

2 

(Şəkil 1-12) İş lövhəsi parametrləri  

 

 

1 

2 3 

(Şəkil 1-5) Ellips fiquru və rəng 

 

Ctrl + 2 
2 

Dairəni seçin 
1 

(Şəkil 1-6) Dairənin sabitləşdirilməsi 

1

2

3

1

23

2

Dairəni seçin

Ctrl + 2

1
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4) “ÜRƏK” (HEART) kimi yeni bir qat yarat-
maq
1. Layer panelindən [Create New Layer] ikonunu 
klik edin.
2. Layer hissəni iki dəfə klik edərək “HEART” 
adını qoyun. (Layer 1)
3. [Ellipse Tool]-u seçən zaman iş lövhəsini klik 
edin. 
4. [Ellipse] dialoq qutusundan sseçımləri aşağı-
dakı kimi qurun:
• En: 5mm
• Hündürlük: 5mm
5. [OK] düyməsini basın.

5) “4”-cü mərhələdəki metod kimi kiçik dairə 
çəkmək 
1. [Ctrl + Y ] düyməsini klik edin. 
2. Kiçik dairə çəkin:
• Radius: 2.5mm 
3. [Selection Tool]-u seçin. 
4. Shift düyməsini basılı saxlayaraq iki obyekt 
(iki dairə) seçin.  
5. Sol mərkəz nöqtəsində obyektləri sıralayın. 
 

6) Kiçik dairəni yenidən kopyalamaq
1. [Selection Tool]-u seçin.
2. Kiçik dairəni klik edin. 
3. [Alt] düyməsini saxlayaraq sağ istiqamətə 
sürüyün.

 

3 

5 

4 

2 

1 

(Şəkil 1-7) Yeni qat - HEART Şəkil 2-7: Yeni qat - HEART

Şəkil 2-8: İki dariənin düzümü

Şəkil 2-9: Kiçik dairənin kopyalanması

 Click [ Crtl + Y ] 1 

(Şəkil 1-8) İki dariənin düzümü 
 

 

1 

Alt  + Drag 

Kiçik dairəni seçin. 2 

(Şəkil 1-9) Kiçik dairənin kopyalanması 

3 

1

2
3

4

5

1

1
2

Click [ Crtl + Y ]

Kiçik dairəni seçin.

Alt  + Drag
3
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7) [Direct Selection Tool] ilə hissəni silmək 
1. [Direct Selection Tool]-u seçin.
2. Böyük dairənin yuxarı əsas nöqtəsini seçin.
3. [Delete] düyməsini basaraq silin. 

8) Böyük dairənin dəqiqləşdirilərək forma-
laşdırılması
1. [Anchor Point Tool]-u seçin. 
2. Böyük dairənin aşağı hissəsində daban 
nöqtəsinə klik edin.
- Böyük dairənin aşağı nöqtəsinin dəqiqliyini 
təmin edin.
- Bölgü ağırlığı: 0.25pt

9) Hər obyekt ilə bir qrupun yaradılması
1. [Ctrl + Y ] düyməsini basaraq keçid görünüşünü 
ləğv edin.  
2. [Selection Tool] ilə üç obyekti seçin. 
3. Film rəngini aşağıdakı kimi qurun:
• C: 0%
• M: 100%
• Y: 0%
• K: 0%
• Xətt rəngi: None
• [OK]-i klik edin. 
4. Seçilən obyekti qrupa əlavə edin.

Şəkil 2-10: Yeni qat - HEART

Şəkil 2-11: Aşağı daban nöqtəsinin 
dəqiqləşdirilməsi

Şəkil 2-12: Ürək fiqurunun doldurulması

 Silmək 3 

1 
2
1 

(Şəkil 1-10) Böyük dairənin yuxarı hissəsinin silinməsi 

 

(Şəkil 1-11) Aşağı daban nöqtəsinin dəqiqləşdirilməsi 

1 

2 

 

[ Ctrl + Y ] 
1 

2 

4 
3 

1 2

1

2

1

2

3
4

Silmək3

[ Crtl + Y ]
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10) Ürək fiqurunu tamamlayın. 
1. Ürək fiqurunu seçin. 
2. Obyekti[ Ctrl + C ] ilə kopyalayın.
- [Ctrl + V ] ilə yapışdırın.
3. Kopyalanmış ürəyin üz rəngini aşağıdakı kimi 
təyin edin:
• C: 0%
• M: 0%
• Y: 100%
• K: 0%
4. [Shift ] düyməsini basılı saxlayaraq obyektin 
ölçüsünü kiçildin.
- Sərhəd qutusunun nəzarət nöqtələrini içəriyə 
doğru çəkin. 
5. Sağ istiqamətdə sürüyün və çevirin. 

11) Simvol kimi ürəyin qeydiyyatdan keçirilmə-
si
1. İki ürək obyekti seçin.
2. Simvol kimi qeydiyyatdan keçirmək üçün  
[Symbols] panelinə sürüyün.
3. [Symbol Options] dialoq qutusunda:
- Ad və növü müəyyən edin.
Ad: HEART 
Növ: Qrafik
4. [OK] düyməsini klik edin. 

12) Simvolu qeyri-adi formada püskürtmək
1. [Symbol Sprayer Tools]

2. “[”, “]” ikonlarını sıxaraq fırçanın ölçüsünü 
müəyyənləşdirin.
3. Qeyri-adi formada simvolu püskürdün.

 

 

Register 

4 

3 

1 

2 

(Şəkil 1-14) Pattern (Naxış) qeydiyyatı 

Şəkil 2-13: Obyektlərin dəyişdirilməsi

Şəkil 2-14: Pattern (Naxış) qeydiyyatı

Şəkil 2-15: Püskürtmə naxışları 

 

Ctrl + C 

Ctrl + V 

1 

3 

4 
Shift 

düyməsi 

Fırlatmaq 5 

2 

(Şəkil 1-13) Obyektlərin dəyişdirilməsi 

 

Adjustment  

Spraying 

2 

3 

(Şəkil 1-15) Püskürtmə naxışları  

 

1

2

3

4

5

1

2

3

4

3

Shift 
düyməsi

Fırlatmaq

Ctrl + C

Ctrl + V

Register

Adjustment 

Spraying

2
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2. Şəklə mətn əlavə edin.
1) [Character] panelindən mətnin dekorasiya ol-
unması
1. [Windows>Type>Character] 
- [Character] panelində aşağıdakıları icra edin:
• Şrift: Commercial Script BT 
• Ölçü: 48pt
• Şriftin rəngi: Ağ
2. [Type Tool] yazı aləti
- Şəkil lövhəsinin sol mərkəzini klik edin. 
3. “Welcome to Azerbaijan/ Azərbayca-na xoş 
gəlmişsiniz” cümləsini yazın.

4. Tipoqrafiyanı dəyişdirmək üçün:
- [Warp Options] ikonundan [Effect>Wrap>Arc] 
menyusuna gedin. 
- Sseçımləri aşağıdakı kimi təyin edin:
• Stil: Arc
• Əyrilik: 50% 
• Üfüqi: 0%
• Şaquli: 0%
5. [OK] düyməsini klik edin. 

2) Kosterin tamamlanması
1. Panelin sol yuxarı tərəfinə mətn əlavə edin. 
• Şrift ölçüsü: 18pt, 
• Mətn: “Dear, Best Friends!!”
2. Bu şəkli “HEART” kimi qeyd edin. 

Şəkil 2-16: Simvol paneli

Şəkil 2-17: Qabarma sseçımləri

Şəkil 2-18: Tamamlanmış simvol markası  

 

1 3 
2 

(Şəkil 1-16) Simvol paneli 

 

5 

4 

 

1 

(Şəkil 1-18) Tamamlanmış simvol markası   

1
3

2

4

5

1
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Fiqur alətlərinin funksiyalarını və simvol qeydiyyatını aydın 
şəkildə izah etdi?
2. Sərbəst şəkildə obyektə uyğun simvol yaratdı? 
3. Simvolu qeydiyyatdan keçirmək üçün “Simvol” panelində meto-
du müəyyənləşdirdi?
4. Qələm alətini bacarıqla istifadə etdi? 
5. Verilən tapşırığa uyğun şəkildə tipoqrafiya növünü dəyişdi? 



İKT

110

 



İllustrator

111

İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Sadə plakatın tərtibatını inamla izah edəcək;
2.   Şəkil çəkmək üçün qarışıq forma funksiyalarını düzgün tətbiq etməyi bacaracaq

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Qarışdırma
1.1 Qarışdırılmış obyektlər 
• İstifadəçi iki obyekt arasında fiqurları yaratmaq və paylamaq üçün obyektləri qarışdıra bilər.
• İstifadəçi obyektlər arasında yeni keçid yaratmaq üçün, həmçinin iki açıq keçid arasında da 

qarışdırma edə bilər. 
• İstifadəçi müəyyən bir obyekt formasında rəng keçidlərini yaratmaq üçün obyektlərin və 

rənglərin qarışımını birləşdirə bilər. 
※ Qeyd: 
Qarışdırılmış obyektlər qarışdırma rejimi və ya şəffaflıq ilə eyni deyil. 
2) Qarışdırdıqdan sonra qarışıq obyektlər vahid bir obyekt kimi qəbul edilir. 
• Əgər istifadəçi orijinal obyektlərdən birini hərəkət etdirərsə  və ya orijinal obyektin bağlanma 

nöqtələrini redaktə edərsə dəyişikliklər ona uyğun qarışacaq. 
• Əlavə olaraq yeni obyektlər orijinal obyektlərlə qarışarsa orijinal obyektlərin öz bağlama 

nöqtələri aktiv qalmır. 
• İstifadəçi qarışımları fərqli obyektlərə bölmək üçün genişləndirə bilər. 
3) Aşağıdakı qaydalar qarışdırılmış obyektlərə və onlarla bağlı rənglərə aid edilir:

3. Sadə plakat hazırlamaq (küçə reklamı)
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(Şəkil1-1) Fiqurları yaymaq  

 

Şəkil 3-1: Fiqurları yaymaq   

Şəkil 3-2: Rəngləri yaymaq  

 

(Şəkil 1-2) Rəngləri yaymaq 

1. İstifadəçi şəbəkə obyektləri arasında qarışdırma edə bilməz. 
• Əgər istifadəçi əsas rənglərlə boyanmış bir obyekt ilə spot rənglərlə boyanmış digər obyekti 

qarışdırarsa şəkil qarışdırılmış proses rəngləri ilə boyanır. 
• Əgər istifadəçi iki müxtəlif spot rənglər arasında qarışım edərsə aralıq pillələri boyamaq üçün 

proses rənglərdən istifadə olunur.  
2. Əgər istifadəçi eyni spot rənglərin çalarları arasında qarışım edərsə, aralıqlar bütünlükdə spot 

rənglərin faiz hissələri ilə boyanır.
3. Əgər istifadəçi iki naxışlı obyektlər arasında qarışım edərsə qarışdırılmış pillələr yalnız üst 

qatdakı obyektin doldurulmasında istifadə olunacaq. 
4. Əgər istifadəçi şəffaflıq panelində qarışıq rejimi olan obyektlər arasında qarışım edərsə qa-

rışdırılmış pillələr yalnız üst obyektin qarışdırma rejimini istifadə edəcək.
5. İstifadəçi birdən çox görünüş xüsusiyyətləri olan obyektlər arasında qarışdırma edərsə (ef-

fektlər, doldurmalar və s.) illüstrator variantları qarışdırmağa çalışacaq. 
6. İstifadəçi eyni simvolun iki nümunəsi arasında qarışım edərsə qarışdırılmış mərhələlər bu 

simvolun nümunələri olmayacaq. 
7.  Qiyabi olaraq qarışıqlar şəffaflıq qruplarının nakautu kimi yaradılır. Belə ki, pillələrdən hər 

hansı biri üst-üstə düşən şəffaf obyektlərdən ibarət olarsa bu obyektlər bir-biri ilə göstərilməyəcək. 
İstifadəçi qarışdırmanı seçərək və şəffaflıq panelindən Knockout Group-u deaktiv edərək bu tən-
zimləməni dəyişə bilər. 

1.2 Qarışıqlar yaratmaq
Qarışdırma aləti və qarışdırma et əmri sizə iki və daha çox seçilmiş obyektlər arasında rənglər 

və aralıq obyektlər seriyası olan qarışıqlar yaratmağa kömək olacaq.

1) Qarışdırma aləti ilə qarışıq yaratmaq
1. Qarışdırma alətini seçin.  .
2. Aşağıda göstərilənlərdən birini edin:
• Döndərmə olmadan sırayla qarışdırma etmək üçün hər bir obyektdə istənilən yerdən klik edin, 
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amma bağlanma nöqtələrinə toxunmayın. 
• Obyektin spesifik bağlanma nöqtəsini qarışdırmaq üçün qarışdırma alətinə klik edin.  İşarəedi-

ci bağlanma nöqtəsinin üzərində olduqda o, mərkəzində qara nöqtə olacaq şəkildə ağ sahədən 
şəffaf sahəyə dəyişir. 

• Açıq keçidləri qarışdırmaq üçün hər bir keçidə 1 bitiş nöqtəsini seçin.
2. İstifadəçi qarışdırma üçün obyektləri əlavə etməyi yekunlaşdırdıqda qarışdırma alətinə 

yenidən klik edin.  

※ Qeyd:
Qiyabi olaraq illüstrator xoşagələn rəng keçidi yaratmaq üçün ən optimal pillə sayını hesablayır. 

Pillələr arasında məsafəyə nəzarət etmək üçün qarışdırma sseçımlərini tənzimləyin.

1.3 Qarışdırma aləti (Blend tool) ilə qarışığı yaradın. 
1. Qarışdırmaq üçün obyekti seçin.
2. Choose Object >Blend >Make 

2. Model 

2.1 Modelin yaradılması və tətbiq edilməsi 
• Modellər rəsmə tekstura və maraq qatır.   
• Rəngləri və formaları sınaqdan keçirərək 

fiqurlara modellər əlavə etməyi öyrənin.  

1) İş sahəsini qurmaq 
• Ekranın sağ yuxarı küncündə “Essentials” 

yazılan hissədə iş sahəsi menyusunu açmaq 
üçün klik edin. 

• Siyahıdan “Painting”-i seçin. Bu bir neçə 
müxtəlif paneldə açılacaq. Amma istifadəçi bu 
modulda yalnız nümunələri və qatları istifadə 
edə bilər.   

• Layers panelində seçim üçün “Patterns” 
qatını klik edin. 

2) Modeli tətbiq edin. 

 

(Şəkil 1-3) Naxış nümunələri Şəkil 3-3: Naxış nümunələri  

Şəkil 3-4: İş sahəsinin qurulması 
 

(Şəkil 1-4) İş sahəsinin qurulması  
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• Seçim alətini istifadə edin və illüstrasiyada 
seçim üçün çəhrayı kaktus şəklinə klik edin. 

• “Swatches” panelinin yuxarısında öndə ol-
maq üçün çəhrayı dolğulu sahəyə klik edin. 

• Paneldə sonuncu nümunə “pink cactus” 
adlı modeldir. Bu nümunə üzərində klik edərək 
seçilmiş şəkli model ilə doldurun. 

• İş sahənizin boz sahəsini klik edərək şəkili 
ləğv edin. 

3)  [Blob Brush]-ın istifadə olunması
• [Blob Brush Tool]-u tapın və iki dəfə klik 

edin.  
• Burada alətin parametrləri görünəcək. 
• Ölçü diyircəyini hərəkət etdirin və dəyəri 

7 pt-ə qurun. 

4) Rəngi seçmək 
• “D” düyməsini sıxın və ya alətlər panelinin 

aşağısından “Default Fill and Stroke” ikonunu 
klik edin.  

• Bu faktiki olaraq dolğu və cizgiləri ağ 
dolğu və qara cizgi ilə əvəz edəcək. 

5) Boyanmış model obyektinin yaradılması
• Təsvirin yanındakı şəkil lövhəsinə baxın. 
• Şəkil lövhəsinin yuxarısında boş qutuya 

diqqət yetirin. Qutuda olan fiqurun rənglənməsi 
üçün fırça alətini seçin.  

• Əgər istifadəçi yaxınlaşdırma və ya 
uzaqlaşdırma etməlidirsə əmr et düyməsini klik 
edin. Daha sonra “+” və “-” düymələrini sıxın. 

6) Hər hansı bir obyektdən model nümunəsi-
ni yaratmaq

• Seçim alətinə tez keçmək üçün “V” 
düyməsini sıxın. 

Şəkil 3-5: Applying pattern Modelin tətbiq

Şəkil 3-6: Alət parametrləri

Şəkil 3-7: Rəng seçimi

Şəkil 3-8: Rənglənmiş nümunə

 
(Şəkil 1-5) Applying pattern Modelin tətbiq  

olunması  

 

(Şəkil1-6) Alət parametrləri 

 
(Şəkil 1-7) Rəng seçimi 

 

(Şəkil 1-8> Rənglənmiş nümunə 
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• Seçim üçün fiqura və ya şəklə klik edin. 
Sonra fiquru sürüyərək Swatches və ya nümunə 
panelinə çəkin. 

• Yeni bir nümunənin yarandığından əmin 
olun. İstifadəçi bunu seçilmiş obyektə tətbiq 
etdikdə o, avtomatik olaraq sizin çəkdiyiniz 
fiqurun modelini təkrarlayacaq.  

7) Öz modelinizi redaktə etmək 
• Ləğv etmək üçün şəkildən uzaqlaşdırma 

edin. 
• Nümunə panelində Pattern Options-u aç-

maq üçün model nümunələrini iki dəfə klik 
edin.  

• Paneldə istifadəçi nümunəni adlandıra, mo-
zaik növünü dəyişə, ölçünü müəy-yənləşdirə 
bilər.

• İstifadəçi nümunədən razı qaldıqda mon-
itorun yuxarısından “Done” düyməsini klik 
edin. 

8) Təcrübə
• İstifadəçi unikal nümunələri yaratmaq 

üçün nəzərdə tutulan formaları istifadə edərək, 
nümunə sseçımlərini istifadə edərək və nü-
munələri tətbiq edərək təsvirdə digər obyektləri 
yarada bilər. 

• Sonda hər bir istifadəçi təsvirə yekun tox-
unuşları edərək təsviri daha əyləncəli edə bilər. 

• Baxış üçün [Layers]-dən “Detail Overlay” 
alətini görünən hala gətirin.

 
(Şəkil1-9) Pattern Swatch 

 Şəkil 3-9: Pattern Swatch

Şəkil 3-10: Nümunənin redaktə olunması

Şəkil 3-11: Nümunənin redaktə olunması

 (Şəkil 1-10) Nümunənin redaktə olunması 
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Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Blend və ya qarışdırma funksiyası ilə bali-
na çəkmək
1) Yeni sənədin yaranması 
1. [File>New( Ctrl + N )-ə gedin.
2. [New Document] dialoq qutusundan aşağıda-
kı sseçımləri edin:
• Ad: Whale Poster
• Ölçü: A4
• En: 297mm
• Hündürlük: 210mm 
• Orientasiya: Landşaft  
3. [Create] düyməsinə klik edin. 

2. Arxa fonu şəkil lövhəsi qədər geniş etmək
1. [Rectangular Tool]
2. Üz rəngini aşağıdakı kimi edin:
• C:3%
• M:74%
• Y:59%
• K:0%
• Xətt rəngi: None
3. Arxa fonu düzəltmək üçün sürümə edin.

Şəkil 3-12: Yeni sənədin tərtib edilməsi

Şəkil 3-13: Arxa fon parametrəri 

 (Şəkil 1-12) Yeni sənədin tərtib edilməsi 

Ctrl + N 1 

2 

3 

 

(Şəkil 1-13> Arxa fon parametrəri  

Sürümək  

1 

3 2 

1

2

3

1

2
Sürümək

3
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3) Faylın mənbə qovluğundan alınması
1. Mənbə qovluğundan “Whale Poster.ai” adlı 
faylı açın. 
2. Onu iş pəncərəsinə sürüyün.

4) Qələm alətinin tərtib olunması
1. “Fill color” alətindən [None]-u seçin.
2. Balinanın mədəsini iki hissəyə ayırmaq üçün 
[Pen Tool]-u seçin. 
3. Balinanın mədəsinin mərkəzi boyunca əyri 
çəkin. 
• Əyrini çəkmək üçün siçanı klik edin və sürüyün. 
4. [Control] panelindən [Stroke]-u “3pt” edin. 

5. Bundan sonra [Line Color] aşağıdakı formada 
dəyişin:
• [Line] arxa fonunu iki dəfə klik edin:
C: 100%
M: 95%
Y: 13%
K: 10%
6. [Weight] “1pt” təyin edin. 
7. Balinanın cizgisinin aşağısı boyunca əyri 
çəkin. 

5) Şəklə qarışıq effekt vermək

 

(Şəkil 1-15) Qələm aləti 

1 

2 

3 

4 

Şəkil 3-15: Qələm aləti

Şəkil 3-16: Əyriin çəkilməsi

Şəkil 3-14: Faylın açılması

 

Faylı açın 1 

Faylı sürüyün 2 

(Şəkil 1-14) Faylın açılması 

1

2

Faylı açın

Faylı sürüyün

4

3

2

 (Şəkil 1-16> Əyriin çəkilməsi 

 En: ‘1pt’ 

 7 
  5 

 2 

3 
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1. [Blend Tool], [Blend Options] dialoq qu-
tusunu açın.
2. Parametrləri aşağıdakı kimi edin:
• Boşluq: Specified Steps
• Dəyər: 15
3. [OK] düyməsini klik edin.

4. Ağ əyrini klik edin. 

5. Mədənin aşağı hissə boyunca mavi əyrini klik 
edin. 

2. Balina şəklinə nümunələr əlavə etmək
6) Balina şəklinin tamamlanması:
1. Ctrl + Y] düymələrini basaraq [Path]-i göstərin.
2. [Ellipse Tool]-u seçin. 
3. Ekranın yuxarı sağ hissəsində balinanın gö-
zlərini çəkin. 
4. Üz rəngini aşağıdakı kimi təyin edin:
• Qara və ağ

 

2. Balina şəklinə nümunələr əlavə etmək
1) Dairələri kopyalayaraq dalğa forması yarat-
maq
1. Ekran rejimini [Preview] edin. 
2. Üz rəngini aşağıdakı kimi təyin edin;
• C:65%
• M: 26%
• Y: 40%
• K: 8%
3. [Ellipse Tool] ilə dairə çəkin. 
4. [Selection Tool] ilə dairə seçin. 
• Dəfələrlə kopyalayın. 
5. Dalğa forması yaradın. 

2) Təbii olaraq üst-üstə düşməsi üçün nümunənin 

Şəkil 3-18: Drawing the Whale’s eye

Şəkil 3-19: Dalğa formasında dairə çəkilməsi

Şəkil 3-20: Fiqurları qruplaşdıraraq 
kopyalayın

 

(Şəkil 1-18) Drawing the Whale’s eye 

 [ Ctrl + Y ] düyməsini basmaq 

“Göz” çəkmək 

Rəngi təyin etmək  

1 
2 

3 

4 

 

(Şəkil 1-19) Dalğa formasında dairə çəkilməsi 

[ Ctrl + Y ] düyməsini basın  

Kopyalayın 

1 

2 

5 

3 

4 

 

[Alt + sürümək]  

[Ctrl + G] düyməsi ilə 
qruplaşdırın 

(Şəkil1-20) Fiqurları qruplaşdıraraq kopyalayın 

1 

2 
3 

 [ Ctrl + Y ] düyməsini basmaq

“Göz” çəkmək

Rəngi təyin etmək 

[ Ctrl + Y ] düyməsini basın 

Kopyalayın

[Ctrl + G] düyməsi ilə 
qruplaşdırın

[Alt + sürümək]

1

2

2

4

5

2

1

3
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yaradılması
1. Dairələri seçin və onları [ Ctrl + G ]ilə qruplar 
şəklində yığın. 
2. [Alt] düyməsini basılı saxlayaraq dairələri 
küncdə kopyalayın. 
3. Rəngləri aşağıdakı kimi təyin edin:
• Xətt 1:C 54%, M 18%, Y 36%, K 2% 
• Xətt 2:C 58%, M 29%, Y36%, K 10%    
• Xətt 3: C 63%, M 5%, Y 23%, K 0%
4. (Şəkil 1-20)-də olduğu kimi nümunənin üst-
üstə düşməsini təmin edin. 

3) Plakat şəkli ilə harmoniyada mətn əlavə etmək 
1. [Rectangle Tool]-u seçin. 
2. [Pen Tool] ilə nitq qabarcığının çəkilməsi 
3. [Pen Tool] ilə şəkli nitq qabarcığına çevirin.
• Qabarcıq rəngi: 
C 87%, M 48%, Y 65%, K 62%
• Mətn rəngi:
C 72%, M 0%, Y 23%, K 0%

4) Şəkil lövhəsindəki xətlərin dizayn olunması
1. Ekran rejimini keçidə çevirin.
• [Ctrl + Y ] düymələrini sıxın.
2.  [Knife Tool]-u seçin. 
3. [Knife Tool] ilə şəkil lövhəsindən xətləri kəsib 
silin.  
• [Alt + Shift + Drag] ilə düz kəsim xəttini çəkin.

3. [Selection Tool]-u seçin. 
• Silinəcək hissəni seçin.

5) Tamamlanmış plakatı şəkil kimi yaddaşa ver-
in. 

 

(Şəkil 1-21) Nitq qabarcığı və mətn 

1 

2 3 

Şəkil 3-21: Nitq qabarcığı və mətn

Şəkil 3-22: Bıçaq aləti

Şəkil 3-22: Kəsilmiş şəkil

 

(Şəkil 1-24) Bıçaq aəti 

 [Ctrl + Y]  1 

3 

2 

4 

 

 [ Shift + Alt + 
sürümək]  

 [Ctrl + Y] 

 [ Shift + Alt + sürümək] 

12

4

3
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Fayl adı : Ai 03 Poster_Whale 

Fayl növü : JPEG(*JPG) 

File> Export> Export As… 

(Şəkil 1-26) Export>Save As… 

1 

2 

3 

1. [File>Export>Export As…] 
2. [Export] dialoq qutusunda
• [*.JPEG ( *.JPG)] təyin edin. 
3. [Export] düyməsini klik edin. 

6) [JPEG Options] dəyərlərini qurun. 
1. Ekran rejimini keçidə dəyişin. 
• Keyfiyyət: Maximum
• Görüntü imkanı: Yüksək (300 ppi)

2. [OK] düyməsini klik edin.

Şəkil 3-23: Export>Save As…

Şəkil 3-24: Setting File type…

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Sadə plakatın düzəldilməsini izah etdi? 
2. Təsvirin düzgün çəkilməsi üçün qarışıq effektini təmin etdi?
3. Simvol panelində qeydiyyatdan keçmiş nümunəni dəqiq şəkildə 
istifadə etdi?
4. Mətni danışan qabarcığa müvafiq şəkildə əlavə etdi?
5. Qısa yol (shortcut) düyməsini tez-tez istifadə etdi?
6. Faylı aydın şəkildə yaddaşa vermək üçün “Export As…” seçimi-
ni istifadə etdi?

File> Export> Export As…

Fayl adı : Ai 03 Poster_Whale

Fayl növü : JPEG(*JPG)

1

2

3
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Obrazın komponentlərini detallı şəkildə izah edəcək;
2.   Maraqlı bir obraz yaratmağı bacaracaq.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Forma qurucu alətlərinin növləri
1. 3D Obyektinin yaradılması 

1) 3D effektləri ikiölçülü şəkildən (2D) üçölçülü (3D) obyektlər yaratmağa imkan verir.  
• İstifadəçi 3D obyektlərin görüntüsünə işıqlandırma, kölgə vermə, fırlatma və digər funksi-

yalarla nəzarət edə bilər.
•  İstifadəçi həmçinin 3 D obyektin hər bir səthinə şəkil əlavə edə bilər.
• 3D obyekti yaratmaq üçün 2 metod var: ixrac etmə və fırlatma.
• Əlavə olaraq istifadəçi 2 D və 3 D obyekti üç ölçüdə çevirə bilər.  
• Mövcud 3D effekti üçün 3D effektlərini tətbiq etmək və ya dəyişmək üçün obyekti seçərək 

görünüş panelində effekti iki dəfə klik edin. 

1.1 3D Ekstruziya 
1) Ekstruziya obyektə dərinlik əlavə etmək üçün ob-yektin Z oxu boyunca 1, 2D obyektlərini 

uzadır.
• Misal üçün əgər istifadəçi 2D ellipsini uzadırsa bu, silindr olur.

4. Sadə plakat hazırlamaq (küçə reklamı)

 

(Şəkil 4-1) Obyektin uzadılması Şəkil 4-1: Obyektin uzadılması
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2) Ekstruziya prosesi 
1. Obyektin seçilməsi 
2. [Effect>3D>Extrude & Bebel]-i seçin. 
• Seçimlər siyahısını bütünlükdə görmək üçün [More Options]-ı klik edin.
• Əlavə sseçımləri gizlətmək üçün daha az seçimi klik edin. 
3. Sənəd pəncərəsində effektlərə öncədən baxış etmək üçün [Preview]-nu seçin. 
4. Sseçımləri göstərin
• Mövqe - obyektin necə fırlanmasını tənzimləyir və sizin nöqteyi nəzərinizdən perspektivləri 

müəyyən edir.
• Extruziya & Əyri - obyektin dərinliyini, obyektə əlavə edilən və ya kəsilən hər hansı əyrilik 

dərəcəsini müəyyən edir.
• Səth - mat və kölgəsiz səthlərdən plastikə bənzər parlaq və işarələnmiş səthlərə qədər müx-

tə-lif səthləri yaradır. 
• İşıqlandırma - bir və ya daha çox işıqların əlavə olunması, işıq intensivliyinin dəyişməsi, 

obyektin kölgə rənglərinin dəyişməsi, dramatik effekt üçün obyektin ətrafında işıqların hərəkətini 
təmin edir. 

• Xəritə - obyektin səthinin üzərində xəritə şəkilləri yaradır. 
5. [OK] düyməsini klik edin. 

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Qələm ilə obrazın eskizini hazırlamaq
1) File>New-nu klik edərək sənədi tərtib edin.  
1. İş lövhəsində aşağıdakı sseçımləri edin: 
• Ad: Ai 00_ Character 
• Ölçü: A3
• En: 297mm
• Hündürlük: 420mm 
• Orientasiya: Üfüqi  
• Rəng rejimi: CMYK  
2. [Create Document] düyməsini klik edin. 

 

(Şəkil 4-2) Yeni layihənin yaradılması  

1 

2 

Şəkil 4-2: Yeni layihənin yaradılması 

1

2
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2) Ellips obyektini dəyişdirin. 
1. [Color] panelini seçin. 
2. Rəngləri aşağıdakı kimi tənzimləyin:
• C: 80%, M: 40%, Y 45%, K: 15%
• Xətt rəngi: None 
3. [Ellipse Tool]-u seçin.
4. Siçanı yuxarı sol küncdən aşağı sağ küncə 
dartın. 
• Dairəni yastı fiqur formasında çəkin. 
((Şəkil 4-4))
5.[Control] panelində [Transform]-u seçin. 
• En: 182mm
• Hündürlük: 136mm

3) Verilmiş şərtlərə uyğun olaraq bağlama 
nöqtələrini tənzimləyin.
1. [Direct Selection Tool]-u seçin.  
2. Dairənin yuxarı orta nöqtəsini seçin. 
3. [   ] ikonunu sıxaraq dairəni çevirin.
• C: 80%, M: 40%, Y 45%, K: 15%
• Xətt rəngi: None
4. [Ellipse Tool]-u seçin.
5. Siçanı yuxarı sol küncdən aşağı sağ küncə 
dartın. 

4) Obrazın ayağını sərbəst şəkildə çəkmək
1. [Layers] panelindən “1-ci qat”-ı “BODY 
Area” olaraq adlandırın. 
2. Yeni qat yaradın. 
• Yeni qatı “LEG Area”-yə dəyişin. 
3. Siçanı aşağıya dartın və bədən bölgəsi qatını 
seçin. Shift + X düymələrini sıxaraq üz və xətt 
rəngini dəyişin.
4. Qələm alətini seçin.  
5. Sol aşağı tərəfdən obrazın ayağını çəkin.

Şəkil 4-3: Ellipsin çəkilməsi

Şəkil 4-4: Ellips çəkilməsi

Şəkil 4-5: Ayaq bölgəsinin çəkilməsi

 

(Şəkil 4-3> Ellipsin çəkilməsi 

Rəng panelini seçin  1 

Dartm
aq  

3 

4 

5 

 

(Şəkil 4-4) Ellips çəkilməsi 

 
1 
 Bir neçə dəfə 

1 

2 

3 

4 

5 

 

(Şəkil 4-5) Ayaq bölgəsinin çəkilməsi 

1 

3 

2 

4 

4 

Shift + X 

[Qatlar] 
paneli 

Ayaq hissəsini çəkmək  

1

2

4

1

2

3

4

5

Rəng panelini seçin 

Bir neçə dəfə

[Qatlar] 
paneli

Ayaq hissəsini çəkmək 

Shift + X

Dartm
3

1

2

3

5

4
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5) Sol tərəfdən obraz xüsusiyyətlərinin tamam-
lanması 
1. [Shift + X ] düymələrini sıxaraq üz rəngi və 
xətt rəngini dəyişin. 
2. Ayaq bölgəsinin yuxarısında “HAND Area” 
adlı yeni qat yaradın.  
3. Əl şəklini çəkmək üçün qələm alətini seçin. 
4. Obrazın sol qol şəklini çəkin. 
• Obrazın sol tərəfinin şəklini tamam-layın. 

 
1. Obraz üçün kub rejiminin göstərilməsi
1) Obrazın  sol tərəfinin yuxarısında kölgə 
hissəni çəkin. 
1. Bədən qatının yuxarısında yeni qat yaradın. 
• Yeni qat adını “BODY” olaraq dəyişin. 
2. Xətt rəngini ağ rəngə dəyişin. 
3. [Pen Tool] ilə sol yuxarı tərəfdə kölgə hissəni 
çəkin. 

2) Mövcud görünüşə kölgə hissələrin əlavə ol-
unması
1. [Selection Tool]-u seçin. 
2. [Alt + Shift] düymələrini sıxıb siçanı basılı 
saxlayaraq bir az içəriyə doğru çəkin. 
• Əvvəlkindən daha kiçik hissə yaradın. 
3. [Color] panelində üz rəngini aşağıdakı kimi 
təyin edin:
• C:65%, M:24%, Y: 35%, K: 0% 
• Xətt rəngi: None

3) Qatları istifadə edərək sahənin daha parlaq 

 

Ayaq hissəni dartın 

Shift + X 

(Şəkil 4-6> Əl bölgəsinin çəkilməsi  

1 

2 

3 

4 

Şəkil 4-6: Əl bölgəsinin çəkilməsi 

 

(Şəkil 4-7) Bədən hissəsinin çəkilməsi 

2 

3 

1 

Şəkil 4-7: Bədən hissəsinin çəkilməsi

Şəkil 4-8: Kiçik obyektlərin qurulması

 

(Şəkil 4-8) Kiçik obyektlərin qurulması 

Alt + Shift + Drag 

1 

2 

3 

Shift + X

Ayaq hissəni dartın

Alt + Shift + Drag

1

2

3

4

2
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edilməsi
• [Layers] panelinin kölgələndirmə mərhələsini 
aşağıdakı kimi dəyişin: [“A-1”, “A-2”] 
1. [Color] panelində üz rəngini aşağıdakı kimi 
dəyişin: 
• C: 50%, M: 35%, Y: 20%, K: 0%
2.[A-2] qatının yuxarısında qələm aləti ilə 
obyekti (sərbəst əyri) çəkin.
• Qat 3-ü “A-3”-ə dəyişin. 
3. Digər obyektləri eyni şəkildə çəkin. 
• A-4:C:36%, M:0%, Y: 12%, K: 0%
• A-5:C:18%, M:0%, Y: 5%, K: 0%
• A-6:C:5%, M:0%, Y: 0%, K: 0%

4) Kölgələndirmənin bütün mərhələlərini 
göstərmək 
1. Hər bir  xətt rəngini aşağıdakı kimi təyin edin:
• Xətt : None 

5) Hər bir qatda qarışdırma effektini (Blending 
Effect) göstərmək 
A növləri:
1. Qradient təsirini təbii şəkildə göstərmək üçün 
[Blend Tool]-u seçin.  
2. “A-1” və “A-2” qatına qarışdırma effekti tət-
biq edin. 
3. Daha sonra “A-3”, “A-4”, “A-5”, “A-6” qat-
larına qarışdırma effekti tətbiq edin. 

6) Qarışdırılmış effektlərinin dəyişdirilməsi 
1. Tamamlanmış kölgəyə iki dəfə klik edin. 

Şəkil 4-9: Kölgələndirmə mərhələsi

Şəkil 4-10: Xətsiz

Şəkil 4-11: Qarışdırma effekti

 

(Şəkil 4-9> Kölgələndirmə mərhələsi 

Qələm aləti ilə fiqurun çəkilməsi 

1 

3 

2 

4 

 

(Şəkil 4-10) Xətsiz 

 1 

 

 ‘A-1’, ‘A-2’-ə klik 
edin. 

1 

2 

3 

(Şəkil 4-11) Qarışdırma effekti 

Qələm aləti ilə fiqurun çəkilməsi

‘A-1’, ‘A-2’-ə klik 
edin.

1

3

2

4

1

1

2

3
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• [Body]-[Blend]-in redaktə rejiminə gedin. 
2. Təbii olmayan obyektin seçilməsi 
3. [Pen Tool]-un seçilməsi
• Keçidi klik edin. 
4. Obyektin keçidində bağlama nöqtəsini əlavə 
edin. 

7) Qarışdırma funksiyası tətbiq ediləcək obyek-
tin kopyalanması 
1. Qarışdırma funksiyası tətbiq olunan obyektin 
seçilməsi 
2. [Ctrl + C] düyməsini sıxaraq obyekti kopya-
layın. 
3. [Layers] panelində “Body” hissənin yuxarısın-
dan yeni qat seçin. 
• Ad: Layer 5
4. “Body” obyektinin sağ tərəfində [Ctrl + 
V] düymələrini sıxaraq yeni yaradılmış qatı 
yapışdırın. 
5. [Shift] düyməsini sıxaraq [Blend of Layer 5] 
“1-6” qatlarını seçin. 
6. Qarışdırma qrupuna əlavə etmək üçün qa-
rışdırma effektini ləğv edin. 

8) Hər bir kölgələndirmə mərhələsində rəng 
sxeminin hazırlanması
1. Alətlər panelindən [Ellipse Tool]-u seçin. 

 

(Şəkil 4-12) Qarışdırma effektinin dəyişdirilməsi 

 

Bədən hissəyə 2 dəfə klik edin 

Obyekti seçin  

     Bağlama nöqtələrini 
əlavə edin 

1 

2 

3 

4 

Şəkil 4-12: Qarışdırma effektinin 
dəyişdirilməsi

Şəkil 4-13: Qarışdırma effektinin ləğv 
olunması

 
Qarışdırılmış obyektin 

seçilməsi  

Ctrl + C 

Ctrl + V 

Ctrl + V 

 

 

ı  

1 

2 

3 

4 

5 

Holding down  Shift] 
key 

Drag it up 

6 

Qarışdırılmış obyektin 
seçilməsi

Ctrl + C

Ctrl + V

Holding down  Shift] Drag it up

Bədən hissəyə 2 dəfə klik edin

Obyekti seçin 

Obyekti seçin 

 

Bədən hissəyə 2 dəfə klik edin 

Obyekti seçin  

     Bağlama nöqtələrini 
əlavə edin 

1 

2 

3 

4 
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2

3

4

5
6



İKT

128

2. [Shift] düyməsini basılı saxlayaraq boş hissədə 
dairə çəkin. 
3. Bir neçə dəfə kopyalayın. 
4. [Eyedropper Tool] ilə hər birini kölgələndirmək 
üçün altı mərhələni seçin.
• Rəng sxemini tərtib edin. 

9) Yeni yaradılmış qat adının başqa ada dəyişdi-
rilməsi 
1. “Qat 5” adını “Palitra” adına dəyişin. 
2. Palitra qatının ikonunu klik edin. 
3. “Body” qatını seçin. 
4. [Pen Tool] ilə dodaqların ətrafına və sağ tərəfə 
kölgələr çəkin. 

5. [Blend Tool] ilə tünd hissədən açıq hissəyə 
klik edərək təbii qradient effekti göstərin.   
• Tünd hissənin rəngləri:
C:83%M: 49%, Y: 54%, K: 29%  

10) Şəklə qarışdırma effektinin uyğunlaşdırıl-
ması  
1. [Layers] panelində ayaq hissənin yuxarısından 
yeni qat əlavə edin. 
Yeni qatın adını “Ayaq qatı”na dəyişin. 
2. Ayaq qatına yaxın kölgələndirmə qatını çəkin. 
3. (Şəkil 4-16)-da olduğu kimi ayaq hissəni 
rəngləyin. 
4. [Blend Tool] ilə şəklə qarışdırma effektini ver-
in. 
11) Sol qolu və ayağı tərsinə qoyun. 
1. Bəzi obyektləri tərsinə çevirmək üçün [Selec-
tion Tool] ikonunu seçin. 

 

(Şəkil 4-14) Parlaqlıq mərhələsinin yaradılması 

1 

4 

3 

4 

Şəkil 4-14: Parlaqlıq mərhələsinin 
yaradılması

Şəkil 4-15: Siçan üçün qarışdırma effekti

Şəkil 4-16: Ayaq qarışdırma effekti

 

(Şəkil 4-15) Siçan üçün qarışdırma effekti 

1 2 
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(Şəkil 4-16) Ayaq qarışdırma effekti 

Kölgə pilləsini çəkin  

 

Ayaq hissənin 
rənglənməsi  
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Ayaq hissənin 
rənglənməsi 

Kölgə pilləsini çəkin 
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2. Qrupda ayaq qatları (Leg layers) və ayaq 
hissənin (Leg Part) obyektlərini seçin. 

3. [Ctrl + C] ilə obyektləri kopyalayın. 
• Yeni qat adını “Ayaq” adına dəyişin. 
4. Ayaq qatı üzərində yeni bir qat yaradın. 
• Yeni qatın adını “Ayaq 2” qoyun. 
5. [Shift + Ctrl + V] ilə kopyalanmış obyektlərin 
olduğu yerə yapışdırın. 

12) Yapışdırılmış ayağın tərsinə kopyalanması
1. Yapışdırılmış ayağın seçilməsi halında siçanın 
sağ düyməsini klik edin. 
2. [Reflect]-in dialoq qutusunda [Transform>Re-
flect]-ə gedin.
• Ox: Şaquli
3. [Copy] düyməsini klik edin. 

13) Əl qatına (HAND layer) qarışdırma effekti-
nin verilməsi
1. Əl hissəsi qatının yuxarısına yeni qatın əlavə 
edilməsi
• Yeni qatın yuxarısına “Əl qatı” adını verin. 

2. Sağ ayaq kimi sol əli də eyni şəkildə tərsinə 
qoyun.
• Kopyalayın və onu sağ tərəfə yerləşdirin.  
3. [Pen Tool] ilə kölgələndirmə qatını düzəldin. 
4. [Blend Tool] ilə şəklə qarışıq effekt verin.

 
Seçim aləti  

(Şəkil 4-17) Ayaq hissəsinin kopyalanması  

1 

3 
4 5 

Şəkil 4-17: Ayaq hissəsinin kopyalanması 

Şəkil 4-18: Ayaq üçün üfüqi əksetdirmə

Şəkil 4-19: Əl üçün şaquli əksetdirmə

 Siçanın sağ düyməsini klik edin 

(Şəkil 4-18) Ayaq üçün üfüqi əksetdirmə 

 

 

 

 

 

(Şəkil 4-19) Əl üçün şaquli əksetdirmə 
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Seçim aləti 

Siçanın sağ düyməsini klik edin
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14) Siçan qarışığı obyektinin ən parlaq sahəsini 
qeyd edin. 
1. Dodaq hissəni iki dəfə klik edin. 
• Bədən (BODY) qatını [Blend]-ə əlavə edin. 
2. Ən parlaq bölgəni seçin. 
3. [Ctrl + C] əmri ilə onu kopyalayın. 

15) Kopyalanmış obyekt kimi eyni yerə 
yapışdırın. 
1. Bədən qatının (BODY layer) yuxarısında yeni 
bir qat yaradın. 
• Onu “Dodaq qatı” kimi (LIP layer) adlandırın. 
2. [Shift + Ctrl + V] ilə kopyalanmış obyekt kimi 
onu eyni yerə yapışdırın. 

16) Obrazda təbii qradasiya təsirini tamamlayın.
1. Qələm aləti ilə (Şəkil 4-22) -də olduğu kimi 
kopyalanmış obyektin içərisinə kölgə qatını 
əlavə edin. 
2. [Blend Tool] ilə obraza təbii qradient təsirini 
tətbiq edin.  

3. Gözlərin, burun və dodağın tamamlanması
1) Qələm aləti ilə göz bölgəsinin çəkilməsi 
1. Qatlar panelində dodaq qatının (LIP layer) 
üzərində yeni bir qat yaradın. 
• Yeni qata “Gözlər qatı” (EYES Area) adını ver-
in. 

Şəkil 4-20: Siçan şəklinin kopyalanması

Şəkil 4-21: Dodaq qatı

Şəkil 4-22: Dodaq hissəsinin redaktə 
olunması

 

(Şəkil 4-20) Siçan şəklinin kopyalanması 
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2 

Ctrl + C düymələrini sıxın. 3 

 

(Şəkil 4-20) Dodaq qatı 

1 
2 

 

(Şəkil 4-22) Dodaq hissəsinin redaktə olunması 
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          Ctrl + C düymələrini sıxın.
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2. Üz rəngini Ağ (White) rəng edin. 
3. [Pen Tool] ilə gözləri şəkil (Şəkil 4-23)də old-
uğu kimi çəkin. 

2) Əksolunma (Reflect) funksiyasının yaradıl-
ması
1. [Selection Tool] paneli ilə göz şəklinin 
seçilməsi 
2. [Selection Tool] ikonundan [Transform→ Re-
flect]-ə gedin. 
3. Əksolunma (Reflect) dialoq qutusunda 
sseçımləri aşağıdakı kimi qurun:
• Ox: Şaquli xətt
4. [COPY] düyməsini klik edin. 
5. Obyekti kopyaladıqdan sonra şəkil (Şəkil 
4-24)də olduğu kimi asimmetrik şəkildə düzüm 
edin. 

3) Kölgə təbəqəsinin bir-bir çəkilməsi
1. Qatlar panelində göz bölgəsinin yuxarısında 
yeni bir qat yaradın. 
• Yeni qata “Gözlər qatı” (EYES layer) adını ver-
in. 
2. Kölgə təbəqələrini bir-bir çəkin. 
Kölgə düzümü: Çöldən içəri: 
• S1: C 74%, M 60%, Y 58%, K 47%
• S2: C 31%, M 22%, Y 22%, K 0%
• S3: C 0%, M 0%, Y 0%, K 0%

4) Yeni qatın “Göz bəbəyi qatı” (PUPIL layer) 
adlandırılması
1. [Ctrl + C] ilə göz bölgəsi (Eye Area) obyekti-
nin kopyalanması  
• [Selection Tool]-dan ilk olaraq göz bölgəsini 
(Eye Area) seçin.

 

(Şəkil 4-23) Gözlərin çəkilməsi 

1 
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3 

Şəkil 4-23: Gözlərin çəkilməsi

Şəkil 4-24: Gözün əks olunması

Şəkil 4-25: Gözlər qatı

 

(Şəkil 4-24) Gözün əks olunması 

Seçim alətini klik edin.  
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(Şəkil 4-24) Gözlər qatı 
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2. [Layers] panelində göz qatının (EYE layer) 
yuxarısında yeni bir qat yaradın. 
• Yeni qata “Göz bəbəyi” (PUPIL layer)  qatı 
adını verin. 
3. [Shift + Ctrl + V] ilə nömrə 4-dən kopyalanan 
obyekt kimi eyni yerə tapışdırın. 
4. Qara göz bəbəyi çəkin. 
5. [Shift] düyməsini sıxıb saxlayaraq göz böl-
gəsini və göz bəbə-yini seçin. 
  

5) Seçilmiş obyektlərə “Pathfinder”-in uyğun-
laşdırılması 
1. [Pathfinder] panelində “Divide” ikonunu klik 
edin. 
• Üst-üstə düşən üzü silmək üçün [Divide]-ı klik 
edin.
2. [Shift + Ctrl + G ] düymələrini sıxaraq obyek-
tərin yerini dəyişin. 
3. Gözlər bölgəsindən kənar hissələri seçin.
• [Delete] düyməsini klik edin. 

4. [Pen Tool] ilə kölgə təbəqələrini yaradın. 
5. [Blend Tool] ilə obyektlərə qradient effekti 
verin.

6) Sarı-yaşıl konturların şəffaflığı üçün bu-
lanıqlığı (Opacity) 0% edin.
1. Göz bəbəyində olduğu kimi eyni yolla daha 
iki göz bəbəyi çəkin. 
2. [Pathfinder] panelində bölmək (Divide) ikonu 
ilə göz bəbəyi düzəldin. 

Şəkil 4-26: Göz bəbəyi qatı

Şəkil 4-27: Qarışdırma effekti

 

 Ctrl + C 

  Shift + Ctrl + V 

(Şəkil 4-25) Göz bəbəyi qatı 

1 

2 
3 

4 

5 

 
  Shift + Ctrl + G 

Silmək 

1 

2 

3 

4 

5 

  Shift + Ctrl + V

  Shift + Ctrl + V

Silmək

 Ctrl + C1

2
3

4

5

1

2

3

4
5



İllustrator

133

3. [Control] panelində sarı-yaşılın kontur 
his-sələrini seçin.  
• Bulanıqlığı 0% edin. 

7) Göz bəbəyinə (pupil) qarışdırma effektinin 
tətbiq olunması
1. [Blend Tool] ikonunu iki dəfə klik edin. 
2. [Blend Options] dialoq qutusunda aşağıdakı 
sseçımləri edin:
• Boşluq: “Müəyyən olunmuş addımlar/8”
4. [OK] düyməsini klik edin. 
5. Göz bəbəyi qatlarına bir-birinin ardınca köl-
gələndirmə edərək qarışdırma effektini verin. 

8) Qrup yaratmaq üçün qatların kopyalanması
1. “Göz bəbəyi” və “Gözlər” qatının hədəf ikon-
larını klik edin. 
2. Müvafiq təbəqələri seçərək onları kopyalayın. 
• [Ctrl + C] düyməsini sıxın. 

3. “Göz bəbəyi” qatının yuxarısında yeni bir qat 
yaradın. 
• Qatın adını  “EYE 2 layer”-ə dəyişin. 

4. [Shift + Ctrl + V] ilə kopyalanmış obyekt kimi 
eyni yerə yapışdırın. 
5. [ Ctrl + G] ilə qrup kimi təyin edin. 

9) [Horizontal Align Right]
1. Yapışdırımış göz bəbəyini seçərək [Reflect 
Tool]-a klik edin. 
• Obyekti soldan sağa əks etdirin. 
2. Göz bəbəyini sol tərəfə sürüyün. 
3. [Shift] düyməsini basılı saxlayaraq obyektləri 

 

(Şəkil 4-27) Opacity “0%” 

İki göz bəbəyinin 
çəkilməsi 
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1 

Şəkil 4-28: Opacity “0%”

Şəkil 4-29: Qarışdırma parametrləri

Şəkil 4-30: Yeni qat (Eye 2)
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seçin.
• Tərs obyekti (sağdakı obyekt ) qoymaq üçün 
“Eye 2 layer” və “Eyes Area” qatlarını seçin.
4. “Eyes Area” qatını bir daha seçin. 
5. [Control] panelində [Horizontal Align Right] 
ikonunu klik edin. 
• Seçilmiş qatlar üfüqi şəkildə sağa düzüm 
hissədə yerləşdirilir. 

10) “Gözlər bölgəsi” qatının obyektlərinə xarici 
parıltı effektini uyğunlaşdırın. 
1. “Gözlər bölgəsi” qatında “Target” ikonunu 
klik edin. 
2. [Effect→Stylize→Xarici parıltı] menyusuna 
gedin. 
3. Dialoq qutusundan sseçımləri aşağıdakı kimi 
qurun:
• Rejim: Multiply
• Dumanlı-lıq: 90%
• Bulanıqlıq: 3mm 
• [OK]- i klik edin.

11) Gözlərin işıqlandırılması vasitəsilə obrazın 
tamamlanması.
1. [Layers] panelində “Eye 2 layer”-in yuxarısın-
da yeni bir qat yaradın. 
•  “LIGHT” qatının adını dəyişin. 
2. Gözlərin işıqlandırılması vasitəsilə obrazı 
tamamlayın. 

12) Tamamlanmış obrazı şəkil kimi yaddaşa ver-
mək
1. [File]–[Export]–[Save for Web (legacy)] Men-
yularını icra edin. 
• Web kimi digər yolla yaddaşa vermək üçün 
[Alt +Shift+Ctrl+S] düymələrini sıxın.  
2. [Save for Web] dialoq qutusunda sseçımləri 

Şəkil 4-31: Əksetdirmə aləti

Şəkil 4-32: Xarici parıltı

Şəkil 4-33: İşıqlandırma

 

(Şəkil 4-30) Əksetdirmə aləti 
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(Şəkil 4-30) Xarici parıltı 
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(Şəkil 4-31> işıqlandırma 
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aşağıdakı şəkildə edin:
• Ad (Preset): PNG-24
• [Artboard] qutusuna giriş edin.

 1 

2
1 

3
1 

Fayl adı: Ai-04 Character_fini 

Fayl növü: Yalnız şəkil 
Yaddaşa 
vemək  

(Şəkil 4-33) Optimallaşdırılmış şəkildə yaddaşa vermək   

 

Şəkil 4-35: Optimallaşdırılmış şəkildə 
yaddaşa vermək  

Şəkil 4-35: Web üçün yaddaşa vermək

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Obrazın komponentlərini detallı şəkildə izah etdimi?
2. Maraqlı və gülməli obraz yaratdımı?
3. Qələm aləti ilə fiqur çəkdimi?
4. Obyektə dəqiq şəkildə qarışdırma effektini tətbiq etdimi?
5. Uyğun yerdə və düzgün şəkildə yeni qat yaratdımı?
6. İş rejimi vəziyyətinə görə Transform panelini dəqiq şəkildə tətbiq 
etdimi?  
7. Verilmiş şərtlərə əsasən müvafiq şəkildə əksetdirmə alətini isti-
fadə etdimi?

 

[Fayl] – [Eksport] – [Web üçün yaddaşa vermək] 

(Şəkil 4-32) Web üçün yaddaşa vermək 

1 

2 

3 

Web üçün yaddaşa vermək

Fayl adı: Ai-04 Character_fini

Fayl növü: Yalnız şəkil
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vemək 
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Qrafikə dəqiq təsir etmək üçün stil vermək funksiyasını izah edəcək;
2.   İnamla və zövqə uyğun gündəlik plan dizayn etməyi bacaracaq.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1.Stil vermək 
Effect>Stylize

1.1 Xarici parıltı 
1.  Hər hansı bir obyekt və ya qrup seçin (Və ya qatlar panelində bir qatı hədəfləyin).
2. [Choose Effec >Stylize>Inner Glow] və ya [Effect>Stylize>Xarici parıltı]-u seçin.
3. Parıltı rəngini müəyyən etmək üçün qarışdırma rejimi menyusunun yanında rəng önizləmə 

kvadratını klik edin.  
4. Digər sseçımləri qurun və [OK]-i klik edin. 

1.2 [Xarici parıltı] dialoq qutusunun sseçımləri
1. Rejim
• Parlaqlıq üçün qarışıq rejimi müəyyənləşdirin. 
2. Dumanlılıq
• Parlaqlıq üçün istədiyiniz dərəcədə dumanlılığı müəyyən edin. 
3. Bulanıqlıq
• Hər hansı bir bulanıqlığın yaradılmasını istədiyiniz yerin mərkəzindən və ya kənarlarından 

məsafə müəyyənləşdirin. 
4. Mərkəz (Yalnız daxili parıltı)
• Seçimin mərkəzindən gələn parıltını tətbiq edin. 
5. Kənar (Yalnız daxili parıltı)
• Seçimin daxili kənarlarından gələn parıltını tətbiq edin. 

1.3 Feather obyektin kənarlarının düzəldilməsi
1. Hər hansı bir obyekti və ya qrupu seçin. (Və ya qatlar panelində qatı hədəfləyin.)
2. Choose Effect>Stylize>Feather

5. Gündəli̇k plan yaratmaq 
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3. Qeyri-şəffaflıqdan şəffaflığa doğru obyektin solma məsafəsini müəyyən edin və OK-i klik 
edin. 

 

2. Obyektlərin və ya qatların kilidə salınması və kilidin açılması 
Obyektləri onları seçməkdən və redaktə etməkdən qorumaq üçün kilidə salmaq mümkündür. 

İstifadəçi üst qatları kilidə salaraq birdən çox keçidi, qrupları və alt keçidləri cəld şəkildə kilidə 
sala bilər. 

 İstədiyiniz qatı və ya obyekti qatlar panelində kilidə salmaq üçün redaktə sütunu düyməsini 
klik edin. (göz ikonunun sağında) 

1. Çoxsaylı məlumatları kilidə salmaq üçün çoxsaylı redaktə sütunu düymələrini sürüyün. Alter-
nativ olaraq kilidə salmaq istədiyiniz obyektləri seçin və sonra Object>Lock>Selection düymələri-
ni basın. 

2. Obyektlərin kilidini açmaq üçün, qatlar panelində kilid   ikonuna klik edin.   

2.1 İstifadəçi, həmçinin obyektləri kilidə salmaq və kiliddən açmaq üçün aşağıdakı əm-
rləri istifadə edə bilər:

1. Seçilmiş obyektin ərazisində üst-üstə düşən və eyni qatdakı bütün obyektləri kilidə salmaq 
üçün obyekti seçin və daha sonra Object>Lock>All Artwork Above-ı seçin.

2. Hər hansı seçilmiş qrupdan ibarət olan qatdan başqa bütün qatları kilidə salmaq üçün Ob-
ject>Lock>Other Layers-i klik edin və ya qatlar menyu panelindən [Lock Others]-ı seçin.

3. Bütün qatları kilidə salmaq üçün onların hamısını seçin və sonra panel menyusundan [Lock 
All Layers]-i klikləyin.  

4. Sənəddə bütün obyektləri kiliddən çıxarmaq üçün Object>Unlock All  menyusunu seçin. 
5. Qrup içində bütün obyektləri kiliddən açmaq üçün kiliddən açılmış və görünən obyekti seçin.  

[Shift+Alt] (Windows) və ya [Shift+Option] (Mac OS) düymələrini basıb saxlayın və ya Ob-
ject>Unlock All-u seçin.

6. Əgər istifadəçi bütün qatları kilidə salırsa onları kiliddən açmaq üçün [Unlock All Layers]-i 
seçin.

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

 

 

(Şəkil 5-1) Feather Şəkil 5-1: Feather
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Təcrübə mərhələləri

1. İş mühitinin qurulması 
1) [File→New] klik edərək yeni sənəd yaradın. 
1. İş lövhəsinin tənzimləmələri
• Ölçü: A4
• En: 210mm
• Hündürlük: 297mm 
• Oriyentasiya: Portrait  
• Rəng rejimi: CMYK  
2.  [Create] düyməsini klik edin. 

2)  “Source” qovluğundan faylı açın.
1. Fayla “seashore scene.jpg” adını verin. 
2. Onu iş pəncərəsinə sürüyün.

3) İş lövhəsinin ölçüsü üçün uyğun şəklin 
yenidən ölçüləndirilməsi
1. Şəkilin ölçüsünü uyğunlaşdırmaq üçün [Art-
board Tool]-u seçin.  
• Əmr:[Shift + O]
2. Şəkil ölçüsünə uyğunlaşdırın.
• İş lövhəsinin ölçüsünü şəklə uyğun kiçildin. 

4) Qradient təsiri ilə düzbucaqlı fiqurunun tətbiq 
olunması
1. [Tools] panelində [Rectangle Tool]-u seçin. 
2. Siçanı sürüyərək iş lövhəsinin ölçüsünə uyğun 
düzbucaqlı fiquru çəkin. 
3. Düzbucaqlı fiquruna qradaient effekti verin. 

5) Siçanı yuxarı və aşağı sürüyərək qradientin 

Şəkil 5-2: Sənəd parametrləri

Şəkil 5-4: İş lövhəsinin ölçüləndirilməsi 

Şəkil 5-5: İş lövhəsində qradient effekti

Şəkil 5-3: Dənizkənarı mənzərənin 
sürünməsi

 

(Şəkil 5-2) Sənəd parametrləri 
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(Şəkil 5-3) Dənizkənarı mənzərənin sürünməsi 
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(Şəkil 5-4) İş lövhəsinin ölçüləndirilməsi  
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(Şəkil 5-5) İş lövhəsində qradient effekti 
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Şəkil 5-6: Gradient parametrləri

Şəkil 5-8: Qruplaşdırma və kilidə salmaq

Şəkil 5-7: Qeyri-şəffaflıq parametrləri

istiqamətini dəyişin. 
1. “Windows” əsas menyu hissədən [Gradient] 
panelinə gedin. 
2. [Gradient] panelində tipi [Radial] kimi təyin 
edin. 
3. Tənzimləmə nöqtəsinə iki dəfə klik edərək 
seçimlərə nəzarət edin.
• Sol tənzimləmə nöqtəsində:
K: 100%,
Location: 60% 
• Sağ tənzimləmə nöqtəsində:
Location: 0% 
4. [Tools] panelində [Gradient Tool]u seçin. 
5. Siçanı düzbucaqlı fiqurunun mərkə-zindən 
yuxarı sağ küncə doğru sürüyün. 

6) Şəkilə dərinlik əlavə edin. 
• Qradient ilə tənzimlənən düzbu-caqlı vəzi-
yyətində [Control] pane-linin qeyri-şəffaflıq və 
ya dumanlı-lığını seçin.   
• Qeyri şəffaflıq və ya dumanlılığın yeni qu-
tusunu açmaq üçün [Opacity]-ni iki dəfə klik 
edin. 
1. Sseçımləri aşağıdakı kimi qurun:
• Qarışdırma rejimi: Artan
• Opacity: 85%

7) Bütün obyektlərin kilidə salınması 
1.[Ctrl+C] düyməsini basaraq düzbucaqlı 
fiqurunu kopyalayın. 
2. Kopyalanmış düzbucaqlı fiqurunu [Shift+C-
trl+V] ilə eyni yerə yapışdırın.
3. Üz rəngini ağ edin.
4. Nəzarət panelindən dumanlılığı seçin. 
• Qarışdırma rejimi: Rəng
• Dumanlılıq: 40%
5. [Ctrl+A] düymələri ilə bütün obyektləri seçin. 
6. [Ctrl + 2] düyməsi ilə bütün obyektləri kilidə 
salın.

2. Dairə qrafiki aləti ilə gündəlik planın dizayn 
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(Şəkil 5-7) Qeyri-şəffaflıq parametrləri 
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(Şəkil 5-8) Qruplaşdırma və kilidə salmaq 
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olunması
1) İlk olaraq dairə qrafikinin seçilməsi 
1. Gündəlik plan dizayn etmək üçün ilk olaraq 
[Tools] panelindən [Pie Graph Tool]-u seçin.
2. İş lövhəsində boş hissəyə klik edin. 
• En: 70 mm 
• Hündürlük: 70 mm
3. Gündəlik tapşırığınıza əsasən  məzmu-nu 
“Yuxu vaxtı”ndan data giriş pən-cərəsinə daxil 
edin.
4. Dairə qrafikini yaratmaq üçün [Apply] 
ikonunu     klik edin. 

2) Çevrilə bilən qrafik yaratmaq 
1. Qrafik üzərində siçanın sağ düyməsini klik 
edin.
2. [Transform]→[Rotate] menyusuna gedin. 
3. [Rotate] dialoq qutusunda aşağıdakıları tən-
zimləyin:
• Bucaq: 30° (Saatda 12-dən 15°-ə çevirin)
4. [OK] düyməsini klik edin. 

3) Üz rənginin hazırlanması 
1. Rəngi ağ edin. 
2.  [Direct Selection Tool]-u seçin.  

4) Qeyri-şəffaflığın qrafikin bütün hissələrinə 
tətbiq edilməsi 
1. Qrafikin hissələrini bir-bir seçin. 
2. [Control] panelində qeyri-şəfaffığı ən böyük 
hissədən ən kiçik hissəyə tətbiq edin. (Saat is-
tiqamətində)
• 100%, 40%, 60%, 80%, 90%, 65%, 40%

 

(Şəkil 5-9) Dairəvi qrafik  
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Giriş məlumatları 
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Şəkil 5-9: Dairəvi qrafik 

Şəkil 5-10: Çevirmə və ya fırlatma

Şəkil 5-11: Rəngin ağ edilməsi

Şəkil 5-12: Nəzarət panel 

 

(Şəkil 5-10) Çevirmə və ya fırlatma 

Siçanın sağ düyməsini klik edin 
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[Transform] - [Çevir] 
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(Şəkil 5-11) Rəngin ağ edilməsi 
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(Şəkil 5-12) Nəzarət panel  
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5) Qrafikə xarici parıltının verilməsi
1. [Tools] panelində [Selection Tool]-u seçin. 
2. Effekti tənzimləmək üçün [Effect]→[Styl-
ize]→[Xarici parıltı] əmrini seçin. 
3. [Xarici parıltı] dialoq qutusunda seçim-ləri 
aşağıdakı kimi qurun:
• Rejim: Artan
• Rəng: Qara
• Dumalılıq: 50%
• Bulanıqlıq: 4mm
4. [OK] düyməsini klik edin. 

6) Düzbucaqlı qatının kiliddən açılması
1. [Layers] panelini seçin.
2. Kilid ikonunu klik edərək düzbucaqlını kilid-
dən açın. 

3. Bulanıq effekt vermək üçün şəkli seçin. 
4. [Effect]→[Blur]→[Gaussian Blur]
• Radius: 3.4 pixel
5. [OK] düyməsini klik edin.
6. Ctrl + 2] düyməsi ilə qatı kilidə salın.

7) Siçanı dartıb sürüyərək xətti kopyalayın.
1. Gündəlik planı bəzəmək üçün [Line Tool] 

Şəkil 5-13: Xarici parıltı

Şəkil 5-14: Qatların kiliddən açılması

Şəkil 5-15: Qaus bulanıqlığı

 

[Effekt] – [Stil vermək] – [Xarici parıltı] 
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(Şəkil 5-14) Xarici parıltı 

 

(Şəkil 5-15) Qatların kiliddən açılması 
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(Şəkil 5-16) Qaus bulanıqlığı 

Şəkili seçin 

s 

[Effekt] – [Blur] – [Gaus Blur] 

s 

Ctrl + 2  

s 

3 

4 

5 

6 

1

3

4

1

2

5

3

[Effekt] – [Stil vermək] – [Xarici parıltı]

[Effekt] – [Blur] – [Gaus Blur]

Şəkili seçin Ctrl + 2 

2

4

6



İllustrator

143

ikonunu seçin.
2. Xətt rəngini ağ edin. 
3. (Şəkil 5-17)-də olduğu kimi şəkilin yuxarı 
hissəsində üfüqi xətti soldan sağa çəkin. 
4. Kopyalamaq üçün [Alt+Shift] düyməsini 
basılı saxlayaraq siçanı aşağıya doğru sürüyün. 

8) Üst sətirdə başlıq yazılması 
1. [Character] panelini seçin. Əgər görünmürsə 
yuxarı sağ küncdən [Pop-up] menyusunu seçin.

2. Seçilənləri aşağıdakı kimi qurun:
• Şrift stili: Vivaldi Italic
• Şrift ölçüsü: 24pt
3. [Type Tool] ilə yuxarı sətirə başlıq əlavə edin. 
• Başlıq: My Winter Vəcation Plan

9) Dairənin mərkəzində mətnin çevrilməsi
1. [Character] panelində verilmiş şərtlərə əsasən 

 

(Şəkil 5-17) Ağ xəttin çəkilməsi 

Drag 
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Alt + Shift + Drag 

s 

Şəkil 5-15: Ağ xəttin çəkilməsi

Şəkil 5-16: Mətnin daxil edilməsi
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(Şəkil 5-18) Mətnin daxil edilməsi 
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sseçımləri müəyyənləşdirin. 
• Şrift Ailəsi: Showcard Gothic
• Ölçü: 12pt
2. Daxil olunmuş nömrə: 12 (yuxarı və aşağı, 6 
(sol və sağ) 
3.(Şəkil 5-16)-da olduğu kimi dairənin mərkəzi 
üzərində çevirmə edin. 

4. [Line Segment Tool]-u seçin.
5. Yuxarı sol tərəfdə siçanı sürüyərək düz xətt 
çəkin. 
6. [Control] panelində bölgünü “1pt” edin. 

10) Gündəlik tapşırıq üçün ehtiyac olan qədər 
obyekti sürüyərək kopyalamaq 
1. Obyekti kopyalayıb seçmək üçün  [Selection 
Tool]-u klikləyin. 
2. [Alt] düyməsini basılı saxlayaraq detallı 
gündəlik plan üçün obyekti ehtiyac olan qədər 
kopyalayın. 

11) [Type Tool]-u istifadə edərək detallı plan 
tərtib edin.  

Şəkil 5-17: Rəqəmin daxil edilməsi

Şəkil 5-18: Xəttin çəkilməsi

Şəkil 5-19: Alt düyməsi ilə obyektin 
kopyalanması

 

‘12’daxiledilmə 
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 ‘6’ daxiledilmə 
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(Şəkil5-19) Rəqəmin daxil edilməsi 

1 

2 

 
4 

5 

6 

(Şəkil 5-20) Xəttin çəkilməsi 

 

(Şəkil 5-21) Copying the object by Alt key 
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1. Şrift stilini və şrift ölçüsünü təyin edin. 
• Şrift stili: Sərbəst 
• Şrift ölçüsü: Sərbəst
2. Zaman xətti üzrə cədvəl tərtib edin. 
3. Sətrin altından detallı planı yazın. 
• pm 10:00: Sleeping/ Writing a diary (Yatmaq/
Gündəlik yazmaq)
• am 06:00: Rising/ Wash up, footbath (Ayağa 
qalxmaq/Yuyun-maq, ayaq vannası)
• am 07:00: Workout/ Going to Health Club till 
0730, bycycling (İdman/07:30-a qədər sağlamlıq 
klubuna getmək, velosibetə minmək)
• am 10:00: Self-Studying/ Walking to Library, 
present on time (Sərbəst çalışmaq/ Kitabxanada 
vaxt keçirmək)
• pm 03:00: Free time/ Homework, jogging with 
a puppy dog (Sərbəst vaxt/ Ev tapşırığı, balaca it 
ilə gəzinti)
• pm 07:00: Dinner time/Diet (Şam yeməyi/
Pəhriz)
• pm 08:00: Clocking on TV/ Take a shower, 
reading a book  (Tv-ə baxmaq/Duş almaq, kitab 
oxumaq)

12) Xətt və dairəvi qrafika ilə gündəlik tapşırığın 
aşağı xəttinə bağlanma
1. [Line Segment Tool] ikonunu seçin. 
2. Obyektəri birləşdirmək üçün xətt çəkin. 
(dairəvi qrafikin tapşırıqlar və vaxt sətri arasın-
da)

3. Düzbucaqlı içərisində [Bucket List] hazırlayın 
və  şrift rəngi və şrift ölçüsünü  müəyyən edin. 

 

(Şəkil 5-22) Detallı tapşırıqlar 
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Şəkil 5-20: Detallı tapşırıqlar

Şəkil 5-21: Xəttə bağlanma 

 

(Şəkil 5-23) Xəttə bağlanma  
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• Şrifti stili: Elephant və ya Consolas/Times New 
Roman 
• Şrift ölçüsü: 10pt və ya sərbəst 
4. Siçanı sürüyərək qrafikin aşağısındakı sahədə 
düzbucaqlı çəkin.  
5. Üz rəngini aşağıdakı kimi müəyyənləşdirin:
• Üz rəngi: Ağ
• Xətt rəngi: None
6. [Control] panelində “Opacity”-ni 20% edin. 
• Düzbucaqlıya bulanıqlığı uyğun-laşdırın. 

13) Ediləcəklər siyahısının məzmununu daxil 
edərək gündəlik planın tərtib olunması
1. Şrift stilini və şrift ölçüsünü müəyyənləşdirin.
• Şrift stili: Sərbəst (İstifadəçinin istəyinə uyğun)
• Şrift ölçüsü: Sərbəst
2. Düzbucaqlının içərisində detallı şəkildə 
ediləcəklər listini yazmaq 
1. Diyetaya nail olmaq
2. Kürək çantası ilə dünyaya səyahət 
3. “Bungee Jump” edilməsi 
4. Musiqi dinləmə saatı 
5. Sağlam həyata sahib olmaq 
6. Velosiped gəzintisi
7. Gecə dəniz mənzərəsinə baxmaq 
8. Gündəlik yazmaq
9. Gəmi ilə səyahətə getmək 
10. Ayda dörd kitab oxumaq 

14) “Export” menyusunun dəqiqliklə yerinə ye-
tirilməsi 
1. [File→Export] menyusuna gedin. 
2. Eksport dialoq qutusunda sseçımləri aşağıdakı 
kimi tənzimləyin:
• Fayl növü: *JPEG(*JPG)
3. “Use Artboards”u istifadə edin və qeydiyyat-
dan keçin.
4. [Export] düyməsini klik edin.  

15) “JPEG Options” tənzimləmələri ilə faylın 
yaddaşa verilməsi

Şəkil 5-23: Detallı ediləcəklər siyahısı

Şəkil 5-22: Bucket List Sxemi

Şəkil 5-24: Faylın eksport olunması

 

Obraz 
Şrift stili: Sərbəst 
Şrift ölçüsü: 8pt 
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(Şəkil 5-25) Detallı ediləcəklər siyahısı 

 

‘Use Artboard/İş lövhəsi’ 
qutusunda qeydiyyat  

(Şəkil 5-26) Faylın eksport olunması 
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(Şəkil 5-27) JPEG Parametrləri 
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Şrift stili: Elephant, etc 
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1. Şəklin JPEG sseçımlərindən aşağı-dakıları 
seçin:
• Rəng modeli: RGB
• Keyfiyyət: Maksimum
2. JPEG sseçımlərindən aşağıdakıları seçin:
• Sıxılma metodu: Alt cizgi (Standart)
• Dəqiqlik: Yüksək (300 ppi)
3. [OK] düyməsini klik edin. 

Şəkil 5-25: JPEG Parametrləri

 

‘Use Artboard/İş lövhəsi’ 
qutusunda qeydiyyat  

(Şəkil 5-26) Faylın eksport olunması 
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(Şəkil 5-27) JPEG Parametrləri 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Qrafikə təsir etmək üçün stil vermək funksiyasını dəqiqliklə izah 
etdimi? 
2. Hər hansı bir şəxsin zövqünə uyğun gündəlik planı dizayn et-
dimi? 
3. Xarici parıltı effekti prosesini dəqiq şəkildə tətbiq etdimi?
4. Obyektlərin və qatların vaxtında kilidə salınması və kiliddən 
açılmasını təmin etdimi?
5. Şəkildə uyğun iş lövhəsini müvafiq formada qurdumu?
6. Həmçinin şəklə qradient effektini tətbiq etdimi?
7. Üz rəngini sətir rənginə uyğun şəkildə dəyişdimi?

3

1

2
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.    GRID effektlərini dəqiq şəkildə izah edəcək;
2.   Mağaza (Store) ticarət loqosunu yaratmağı bacaracaq.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Xətkeşlər 
1) Xətkeşlər istifadəçiyə illüstrasiya pəncərəsində və ya hər hansı bir iş lövhəsində obyektlərin 

düzgün ölçülməsinə və yerləşdirilməsinə köməklik edir.  
• Hər xətkeşdə “0” nöqtəsinə xətkeş başlanğıc nöqtəsi deyilir.
2) İllüstrator sənədlər və iş lövhələri üçün ayrı-ayrı xətkeşlər təmin edir.
1.  Qlobal xətkeşlər illüstrasiya pəncərəsinin sol və yuxarı tərəflərində olur.  
• Mövcud xətkeş başlanğıcları illüstrasiya pəncərəsinin yuxarı sol küncündə yerləşir. 
2. İş lövhəsi xətkeşləri aktiv iş lövhəsinin yuxarı sol tərəflərində yerləşir. 
• Mövcud iş lövhəsi xətkeşlərinin başlanğıcı iş lövhəsinin yuxarı sol küncündə yerləşir. 
3) İş lövhəsi xətkeşi ilə qlobal xətkeş arasında fərq budur ki, əgər istifadəçi iş lövhəsi xətkeşini 

seçərsə başlanğıc nöqtə aktiv iş lövhəsinə əsasən dəyişir.
• Əlavə olaraq istifadəçinin iş lövhəsi xətkeşləri üçün başlanğıc nöqtələri fərqli olur. 
• Əgər istifadəçi iş lövhəsinin xətkeş başlanğıcını dəyişirsə iş lövhəsi üzərində obyektlərdə 

doldurulmuş naxış dəyişilmir. 

6. Krali̇ça gülü loqosunun hazırlanması

 
(Şəkil 6-1) Xətkeşlərin göstərilməsi Şəkil 6-1: Xətkeşlərin göstərilməsi
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4) Qlobal xətkeş üçün mövcud başlanğıc nöqtəsi ilk iş lövhəsinin yuxarı sol küncündədir və iş 
lövhəsi xətkeşləri üçün mövcud başlanğıc müvafiq iş lövhəsinin yuxarı sol küncündə yerləşir. 

※ Qeyd: 
Xətkeşləri göstərmək və ya gizlətmək üçün View>Rulers>Show Rulers və ya View>Rul-

ers>Hide Rulers-i seçin.  
5) İş lövhəsi xətkeşləri və qlobal xətkeşlər arasında keçid yaratmaq üçün:
• Choose View>Rulers>Change to Global Rulers və ya View>Rulers>Change to Artboard Rul-

ers-ə klikləyin.
6) Video xətkeşləri göstərmək və ya gizlətmək üçün View>Show Video Rulers və ya View>Hide 

Video Rulers-i seçin. 
7) Xətkeşin başlanğıcını dəyişmək üçün işarəni cədvəllərin kəsişdiyi yuxarı sol küncə gətirin və 

yeni xətkeş üçün istədiyiniz yerə sürüyün.
• Bu zaman pəncərədə və xətkeşlərdə artma xətti dəyişən qlobal xətkeş başlanğıc nöqtəsini 

göstərir. 
※ Qeyd: 
Qlobal xətkeş başlanğıc nöqtəsini dəyişdirdikdə obyektlərdə olan naxışlar dəyişir. 
8) Mövcud xətkeş başlanğıcını bərpa etmək üçün xətkeşlərin kəsişdiyi yuxarı sol küncə iki dəfə 

klik edin. 
     
2. Məlumat kitabı 
İllüstrasiya pəncərəsində istifadəçinin işinin arxasında şəbəkə görünür. O, çap olunmur. 
1) Bu şəbəkələri göstərmək və gizlətmək üçün View>Show Grid və ya View>Hide Grid-i seçin. 
2) Obyektləri şəbəkələrə uyğunlaşdırmaq üçün View>Snap To Grid-i seçin 
• Köçürmək istədiyiniz obyekti seçin və istədiyiniz yerə sürüyün. 
• Obyektin kənarları şəbəkənin 2 pikselinə gəldikdə həmin nöqtəyə söykənir.
※Qeyd:
Əgər siz View>Piksel önbaxış-ı seçsəniz şəbəkəyə uyğunlaşma pikselə uyğunlaşma ilə əvə-

zlənəcək.
3) Şəbəkə xətləri, şəbəkə stili, şəbəkə rəngi və şəklin arxa və ya qabaq fonunda şəbəkələrin 

görünməsi arasında məsafənin təyin olun-ması
• Edit>Preferences>Guides & Grid & (Windows) yaxud Illustrator>Preferences >Guides & 

Grid & (Mac OS)-i seçin. 

3. Məlumat kitabları və ya təlimatlar
Təlimatlara çevrilən vektor obyektləri
1) İstifadəçi iki təlimat arasından seçim edə bilər: nöqtələr və xətlər. Eyni zamanda  istifadəçi 

Şəkil 6-2: Şəbəkələrin göstərilməsi

 

(Şəkil 6-2> Şəbəkələrin göstərilməsi 
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təlimatların rəngini əvvəlcədən tamamlanmış rənglə və ya rəng pikseli istifadəsini seçərək dəyişə 
bilər.

1. Qiyabi olaraq təlimatlar kiliddən açılır. Belə ki, siz onu hərəkət edə, dəyişdirə, silə və çevirə 
bilərsiniz. Amma istifadəçi onları kilidə salmağı da seçə bilər. Şəbəkələri göstərmək və ya gizlət-
mək üçün View>Guides>Show Guides və ya View>Guides>Hide Guides -ı seçin. 

2. Təlimat parametrlərini dəyişmək üçün Edit>Preferences>Guides & Grid (Windows) və ya 
Illustrator>Preferences>Guides & Grid (Mac OS) seçilir.

3. Kilidə salmaq üçün View>Guides>Lock Guides-ı seçin.

3.1 Təlimatların yaradılması
1. Əgər xətkeşlər görünmürsə View>Show Rulers-i seçin. 
2. Şaquli təlimat üçün işarəni sol xətkeş üzərinə və ya horizontal təlimat üçün yuxarı xətkeşə 

qoyun. 
3. Təlimatı sürüyün. 
• Vektor obyektlərini təlimatlara dəyişmək üçün onları seçin və View>Guides>Make Guides 

sseçımlərini edin.
※ Qeyd: 
Birdən çox təlimatla işləmək üçün onları ayrıca bir qata köçürün.
4. Bütün sahə əvəzinə yalnız iş lövhəsi üzərində təlimatları məhdudlaşdırmaq üçün iş lövhəsi 

alətini seçin və təlimatları onun üzərinə sürüyün.
3.2 Təlimatların yerini dəyişmək, silmək və azad etmək
1. Choose View>Snap To Point
2. Yerini dəyişmək istədiyiniz obyekti seçin və işarəni bağlama nöqtələri və təlimatlarla sıralam-

aq istədiyiniz dəqiq nöqtə üzərinə gətirin.
 ※ Qeyd: 
Düzüm nöqtəyə uyğunlaşdıqda sürünən obyektin künclərindən yox, işarənin istiqamətindən 

asılı olur.  
3. Obyekti istədiyiniz yerə sürüyün. 
• İşarə bağlama nöqtəsinin 2 piksel daxilində olduqda həmin nöqtəyə uyğunlaşır.  
• Əgər uyğunlaşma olarsa işarə dolu ox ucundan boş ox ucuna çevriləcək. 
3.3  Obyektləri bağlama nöqtələrinə uyğunlaşdırmaq 
1. View>Snap To Point seçilir. 
※ Qeyd: 
Yerini dəyişmək istədiyiniz obyekt seçilir və dəqiq nöqtə üzərinə qoyulur.  

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

1. Şəbəkənin göstərilməsi 
1) File>New-nu klik edərək sənədi tərtib edin. 
1. [Ctrl + N]i-klik edin. 
2. İş lövhəsi tənzimləmələri 
• Ölçü: A4
• En: 297mm
• Hündürlük: 210mm 
• Orientasiya: Landscape  
• Rəng rejimi: RGB

3. [Create Document]-i klik edin. 

2) Mənbə qovluğundan eskiz faylını seçin.  
1. Açmaq üçün eskiz faylını seçin. 
• [Shift + Ctrl + P] [Place]
Və ya  [File→Place]-ə gedin. 
2. [Template]-i qeydiyyata alın. 
•  [Link]-ə çıxış edin. 
3. [Place]-i klik edin. 

3) Eskiz faylını arxa fon kimi edin. 
1. [Layers] panelində 1-ci qatın altında avtoma-
tik olaraq “Template” [Image] qatını yaradın. 
• Şəkil (Şablon) qatının kilidlənməsi 

 Menyu sütunu: 
[Windows]-[Layers]:F7 

4) Qrafik işi üçün tətbiq olunan şəbəkələrin 
göstərilməsi 
1. Arxa fon şəklinin altında şəbəkəni göstərin.
•  [View]-[Show Grid]-ə gedin. 
Keçid düyməsi: Ctrl + “

Şəkil 6-3: Yeni sənəd

Şəkil 6-4: Eskizi yerləşdirmək

Şəkil 6-5: Şablon qatı (Kilid)

Şəkil 6-6: Şəbəkənin göstərilməsi

 

(Şəkil 6-3) Yeni sənəd 

Ctrl + N 

3 

1 

2 

 

(Şəkil 6-4) Eskizi yerləşdirmək 

1 

3
2 

2 

 

(Şəkil 6-5) Şablon qatı (Kilid) 

1 

 

(Şəkil 6-6) Şəbəkənin göstərilməsi 

Ctrl + “ 

3

1

2

3

1

2

1

Ctrl + N
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5) Arxa fon şəklində şəbəkənin nümayiş olun-
ması  
1. Ctrl + K düyməsini klik edin. 
•  [Edit]-[References]-ə gedin.  
2. [Guides & Grid] menyusunu seçin. 
3. [Grid in Back]-ə çıxış edin.  
4. [OK] düyməsini klikləyin. 

 
2. Şəbəkələr ilə qrafikin işlənməsi
1) Yekun eskizi almaq üçün qrafik işinin başlan-
ması 
1. [Ctrl+N] düymələrini basaraq yeni sənəd açın.
2. [Shift+Ctrl+P] düymələri ilə [Place] dialoq 
qutusunu açın. 
3. [Sketch_Queen’s Burger.jpg] faylını seçin. 
4. [LINK]- ə çıxış edin. 
[TEMPLATE]-ə çıxış edin. 
5. [Place] düyməsini klikləyin. 
 Menyu sütunu: [File]-[Place]

2) Rejimin göstərmək və ya gizlətmək olduğunu 
təsdiq etmək üçün şəbəkənin göstərilməsi  
1. [View] menyusunda olduğunu yoxlayın. 
2. [Show Grid]-i aktivləşdirin.  

 Keçid düyməsi: 
Şəbəkəni göstər: [Ctrl+“]
Şəbəkəyə uyğunlaşdırmaq üçün: [Shift+Ctrl + “]

3) [Snap to Grid] aktiv olmayan yerdə xətkeşlərin 
göstərilməsi 
1. [Rulers]-i göstər, [Ctrl+R] düyməsini klik 
edin. 
2. Eskizin mərkəzində görünmək üçün siçan 
işarəsini sürüyərək yerini dəyişin.  
•  [Snap to Grid] aktiv olmayan yerə siçanı 
sürüyün. 

 

(Şəkil 6-7) Arxada şəbəkə 

1 

4 

2 

3 

Ctrl + K 

Şəkil 6-7: Arxada şəbəkə

Şəkil 6-8: Dialoq qutusunun yerləşdirilməsi

Şəkil 6-9: Şəbəkənin göstərilməsi və gi-
zlədilməsi

Şəkil 6-10: Xətkeşlərin göstərilməsi və 
Şəbəkənin tənzimlənməsi

 

(Şəkil 6-8) Dialoq qutusunun yerləşdirilməsi 
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Shift + Ctrl + P 
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(Şəkil 6-9) Şəbəkənin göstərilməsi və gizlədilməsi 
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(Şəkil 6-10) Xətkeşlərin göstərilməsi və Şəbəkənin 
tənzimlənməsi 
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 Keçid düyməsi: 
Xətkeşləri göstərmək: [Ctrl+R] düy-məsi

4) İşləməyi asanlaşdırmaq üçün ekranın yaxın-
laşdırıb uzaqlaşdırılması 
1. Ekranı genişləndirmək üçün Ctrl+Space 
bar düymələrini basılı saxlayaraq siçanı ekran 
üzərində klik edin. 
2. L düyməsi ilə [Ellipse Tool]-u seçin.  
3. [Alt+Shift] düymələrini basılı saxlayaraq 
obyekt mərkəzinə əsasən dairəni siçanla sürüyün. 
• Ekranı yenidən kiçiltmək üçün [Alt+ 
Ctrl+Space bar] düymələrini basılı saxlayaraq 
siçanı klik edin. 

5) Ellipsi uzunlamasına çəkmək  
1. L düyməsi ilə [Ellipse Alətini] seçin. 
2. [Alt] düyməsi ilə aşağı nöqtədə basılı saxla-
yaraq ellipsi sürüyün. 
3. A düyməsi ilə [Direct Selection Tool]-u seçin. 
4. Ellips sahəsinin bir hissəsini sürüyün. 
5. S düyməsi ilə [Scale Tool]-u seçin. 
6. Sol obyektdən bir qədər aşağıya doğru siçanı 
sürüyün. 

6) Eskiz şəklinə uyğun olaraq Ellipin ölçüsünün 
tənzimlənməsi  
1. [Selection Tool]-u seçin.  
• Ellipsi klik edin.
• Sola sürümək üçün kopyalayın. 
2. Kopyalanan obyektin ölçüsünü Eskiz şəklinə 
uyğun ölçüdə tənzimləyin. 

Şəkil 6-11: Yaxınlaşdırmaq və 
uzaqlaşdırmaq & Dairə

Şəkil 6-12: Oval dairə 

Şəkil 6-12: Ellipsin kopyalanması

 

(Şəkil 6-11) Yaxınlaşdırmaq və uzaqlaşdırmaq & Dairə 
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(Şəkil 6-12) Oval dairə  
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(Şəkil 6-13) Ellipsin kopyalanması 
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7) Siçanı sürüyərək ellipsi yerləşdirin. 
1. [Selection Tool]-da sol ellipsi seçin.
2. Azacıq sürüyərək ellipsi yerləşdirin. 
• Künc istiqamətinə hərəkət etdikdə siçan işarəsi 
oxun yuvarlanma istiqa-məti ilə dəyişir. 

8_ Kopyalamaq ellipsin ikili simmetriyası old-
uğu deməkdir. 
- Tac fiqurunun düzəldilməsi
1. Sol ellips seçimində [Reflect Tool]-u seçin.
• Digər şəkildə O düyməsini klik edin.  
2. [Alt+Click] düymələrini klik edərək [Reflect] 
pəncərəsinin sseçımlərini açın. 
• Siçan nöqtəsini ellipslərin ortasında olacaq 
obyektin mərkəzinə gətirin. 
3. Oxu şaquli edin. 
4. [Copy] düyməsini klikləyin. 

9) [Zig Zag] seçimi ilə tacın aşağısında dalğa 
fiqurunun göstərilməsi  
- Tacın aşağısında dalğa fiqurunu düzəltmək 
üçün:
1. [Line Segment Tool]-u seçin. 
• Digər şəkildə W düyməsini basın.   
2. Shift düyməsini basılı saxlayıb siçanı soldan 
sağa sürüyərək xətti çəkin. 
3. Alətlər panelində [Selection Tool]-u seçin.   
• Digər şəkildə V düyməsini sıxın.  
4. Əvvəlki addımda çəkilən “Xətt” obyektinə 
klik edin. 
5. [Effect]-[Distort &Transform &  Transforma-
siya]-[Zig Zag] seçiminə gedin. 

 
O 1

2 

Alt + Klik 2 
4 

3 

Şəkil 6-12: Dialoq qutusunun əks etdirməsi

Şəkil 6-13: Əymək və transformasiya

Şəkil 6-14: Zig Zag fiqurunun çoxaldılması  

 

(Şəkil 6-16) Əymək və transformasiya 
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(Şəkil 6-18) Zig Zag fiqurunun çoxaldılması   
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10) Dialoq qutusundan [Zig Zag]-ın sseçımlərini 
tənzimləyin.  
- [Points]-i işarələmək üçün
1. [Smooth]-a nöqtələri qeyd edin. 
2. Küncə görə kənarları [5]-ə qurun.
3. Ölçünü [0.4mm] - [1.4mm] edin. 
4. [OK] düyməsini klikləyin. 

11. Növbəti işləri asanlaşdırmaq üçün “Ağıllı 
təlimatlar”ın aktivləşdirilməsi  
1. [Selection Tool]-[V] düyməsini seçin. 
2. Dalğa fiqurunu klik edin. 
3. Alt düyməsini basılı saxlayıb siçanı sürüyərək 
aşağıda bir daha kopya yaradın. 
4. [View] menyusundan [Smart Guides]-ı ak-
tivləşdirin: [Ctr +U]

12) [Zig Zag] tətbiq olunmuş obyektin dalğa 
fiqurlu obyektə dəyişdirilməsi.  
1. [Selection Tool]-useçin: [V ] düyməsi
2. İki obyekti seçin: [Shift + Click]
3. Menyuda [Object]–[Expand Appearance]-i 
tənzimləyin.
4. Bir obyekti seçdikdən sonra;
• Siçan nöqtəsini çərçivə qutusunun kənarına 
gətirin. 
• Bükülmüş ox fiqurunun görünür.
• [Shift + Drag] ilə 180° çevirin. 

Şəkil 6-15: Görünüşün böyüdülməsi  

Şəkil 6-16: Dalğanın dərinliyi

Şəkil 6-17: Əsas xəttin silinməsi

 V  1 

Shift+ Klik 
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(Şəkil 6-21> Əsas xəttin silinməsi 
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V 
1 

Klik 
2 

Siçanın sağ düyməsini klik edin 
3 

4 

13) Obyekti aşağı sürüyərək dalğanın dərinliyini 
tənzimləyin. 
1. [Selection Tool] ilə iki dalğa fiquru obyektinin 
seçilməsi: [V] düyməsi
2. Siçan nöqtəsini üst hissənin mərkəzinə gətirin. 
• Ox görünəndə, aşağı sürüyərək dalğanın enini 
tənzimləyin. 

14) Düzbucaqlı dördbucaq və yarı dairə es-
kiz kimi hamburqer çörəyi formasında fiqurun 
yaradılması üçün iş. 
1. M düyməsi ilə [Rectangle Tool]-u seçin. 
2. Alt düyməsini sıxaraq Hamburqer obyektinin 
mərkəzindən sürüyərək düzbucaqlı dördbucaq 
çəkin. 
3. Düzbucaqlı dördbucaqlının əsas xəttini silmək 
üçün [Direct Selection Tool]-u seçin; A düyməsi
4. Əsas xətti sürüyün. 
5. Delete düyməsini sıxın. 

15) Ellipsin lazımsız xəttinin seçilərək silinməsi. 
1. L düyməsi ilə [Ellipse Tool]-u seçin. 
2. [Smart Guides] ilə düzbucaqlı dördbucağın 
hər iki küncünə uyğun Ellipsin çəkilməsi.  
3. [Direct Selection Tool]-u seçərək, ellipsin 
yuxarısını silin. 
4. Ellipsin yuxarı nöqtəsini klik edin. 
5. Delete/Silmək düyməsi ilə yuxarı əyrini silin. 

Şəkil 6-17: Ellipsin yuxarı xəttinin silinməsi

Şəkil 6-17: Əsas obyekt

 

(Şəkil 6-23) Əsas obyekt 
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16) Heç bir düyməni istifadə etməyərək hədəf 
obyekti klik edərək [Key Object]-i düzəldin. 
1. V düyməsi ilə [Selection Tool]-u seçin. 
2. Shift düyməsini sıxıb saxlayaraq düzbucaqlı 
dördbucağı klik edin və yarım ellipsi seçin. 
3. Heç bir obyekti seçmədən düzbucaqlı dördbu-
cağı klik edin. 
• [Step 3] ilə [Key Object]-i düzəldin.  

17. Yarım ellipsin düzbucaqlı dördbucaqda xəta 
olmadan düzülməsi 
1. [Align] panelində [Vertical Distribute Space]-i 
tənzimləyin.
2. [Windows]-[Align]-[Show Options]

18) [Live Corners] ilə çörək kimi yumrulanmış 
obyektin yaradılması
1. A düyməsi ilə [Direct Selection Tool]-u seçin. 
2. Shift düyməsini basılı saxlayaraq iki nöqtəni 
klik edin. 
3. [Live Corners] göründükdə yuvarlaqlıq səvi-
yyəsini tənzimləyin. 
•  [Corners Radius]-u “0.5mm”-ə dəyişin. 

19) İki obyektin bir obyektdə birləşdirilməsi
1. V düyməsi ilə [Selection Tool]-u seçin.   
2. Shift düyməsini basılı saxlayaraq üst- üstə 
düşən iki obyekti seçin.  
3. [Pathfinder] panelində [Unite] funksiyası ilə 
iki obyekti bir obyektdə birləşdirin. 
• [Windows]-[Pathfinder]
• Tac demək olar ki, yekunlaşdı.

 

A 1 

Shift +Klik 2 

(Şəkil 6-25> Hərəkətli künclər Şəkil 6-19: Hərəkətli künclər

Şəkil 6-20: Pathfinder
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Şəkil 6-21: Düzbucaqlı dörbucaq və Ellips
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(Şəkil 6-27) Düzbucaqlı dörbucaq və Ellips 

Şəkil 6-22: Yumrulanmış düzbucaqlı 
dördbucağın kopyalanması
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20) Tacın aşağısında gül tumurcuğunu düzəlt-
mək
1. [Snap to Grid]-i aktivləşdirərək düzbu-caqlı 
dördbucaq alətini seçin.
2. (Şəkil 6-27)-də göstərildiyi kimi siçanı müm-
kün qədər geniş şəkildə sürüyərək gül tumur-
cuğunu çəkin.
3. Ellips alətini seçin: [L+Alt+Sürümək] ilə 
dairəni çəkin. 

21. Yumrulanmış düzbucaqlı dördbucağın bir da 
kopyalanması
1. [Rounded Rectangle Tool]-u seçin. 
2. Siçanı yuxarı və aşağı doğru sürüyərək yuvar-
laq fiquru tənzimləyin.
3.  [Alt+Shift] düymələrini sıxaraq və sürüyərək 
yumrulanmış düzbucaqlı dördbucağın bir daha 
kopyalayın. 

22) Eksiz işini tamamilə yekunlaşdırmaq 
1. [Ctrl+O] ilə mövcud görünüşü “All View”-ya 
əlavə edin. 
2. Növbəti işi daha rahat etmək üçün [Shift+C-
trl+“] ilə [Snap to Grid]-i ləğv edin. 
3. [Ctrl+“] ilə [Show Grid]-i ləğv edin.
23) İstifadə olunan eskizin görünməməsi üçün 
gizlədilməsi
1. [Layers] panelində eskiz qatının [Toggles Vis-
ibility] ikonunu (göz simvolu) klik edin. 

 

Şəkil 6-23: Eskizin tamamlanması

Şəkil 6-24: Görünmə dərəcəsinin 
dəyişdirilməsi  

Şəkil 6-25: Rəngin tənzimlənməsi

 Ctrl + O 

Shift + Ctrl + “ 

Ctrl + “ 

1 

2 

3 
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3. Rəngləri tənzimləmək üçün qruplaşma
1) Bölgü işarəsi qalınlığına nəzarət edilməsi 
1. Tac tumurcuqlarını görmək üçün [Selection 
Tool: V] -ni seçin.
2. Tac tumurcuq eskizinin yuxarısından aşağısı-
na doğru siçanı sürüyün.
3. Xətt qalınlığını  “1.5pt” edin. 

2) Dolğu/Xətt rəngini obyektə görə dəyişin. 
1. Aşağı hissənin bütün obyektlərini seçin.
2. Dolğu rəngini ağ edin. 
• Xətt rəngini qara edin. 

3) Arxaya göndərmək üçün obyektin hərəkət et-
dirilməsi 
1. [Selection Tool: V]
2. Çiçək tumurcuğunun tutacağı olan düzbucaqlı 
dördbucağı seçin. 
3. Siçanın sağ düyməsini klik edin. 
4. [Arrange]-[Send to Back]-i seçin. 

4) Silmək funksiyası ilə Tac fiqurunun kəsilməsi 
1. Tac fiqurunu kəsmək üçün sol ellipsi seçin.
2. [Scissors Tool: C]-ni seçin. 
3. Dalğa şəklində sırayla kəsişən iki hissəni klik 
edin. 
4. Lazım olmayan hissəni silmək üçün [Selec-
tion Tool: V] -ni seçin. 
5. Lazım olmayan hissəni klik edin.
6. Delete/Silmək düyməsini klikləyin. 

Şəkil 6-26: Tac obyektinin dizayn olunması  

Şəkil 6-27: Silmə və rəng dəyişdirmə

Şəkil 6-28: Obyektlərin yerləşdirilməsi  
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(Şəkil 6-34) Tac obyektinin dizayn olunması   
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(Şəkil 6-35) Silmə və rəng dəyişdirmə 
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5) Lazımsız hissələrin silinməsi üçün qalan pros-
eslərin edilməsi 
1. Yerdə qalan lazımsız hissələri silin. 
.2 Dairənin bəzəyinin rəngini qara edin. 

6) Üz rənginin lazım olan rəngə dəyişdirilməsi
1. [Selection Tool: V]-ni seçin.
2. Aşağıdan kəsmək üçün iki ellips seçin. 
• Siçanın sağ düyməsini basın. 
2. [Arrange]-[Send to Back]-i seçin. 
3. Üç ellips və bir dalğa rəngini dəyişdirin. 
• Üç ellipsin üz rəngini ağ edin. 
• Dalğa fiquru: Rəng mövcud deyil 

7) Dalğa fiqurunun sonunu qüsursuz şəkildə 
düzəltmək
1. [Selection Tool: V]-ni seçin. 
2. İki dalğa fiqurunu seçin. 
3. [Stroke]-u klikləyin. 
• Eni “1.5pt”təyin edin. 
4. [Cap] seçimində [Rounded Cap]-i seçin. 
• Qoyun.

 
 

 

6 

 

(Şəkil 6-37) Bölgünün qurulması  

İki fiquru seçin. 
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Şəkil 6-29: Bölgünün qurulması 

Şəkil 6-30: Faylı yerləşdirin

Şəkil 6-31: Mətnin təsvirini çəkmək
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5. Tac fiquru ilə bağlı olan
   bütün obyektləri seçin. 
6. [Ctrl+G] düymələri 
ilə seçilmiş obyektləri qurup-
laşdırın. 

 
1. Mətn ilə loqo tipinin işlənməsi
1) [Place] ilə “Sketch_Queens eng.bmp”-nin 
açılması  
1. [File]-[Place] ilə “Sketch_Queens emg.bmp” 
faylını açın. 
2. Şəbəkələrin görünməyi üçün [Show Grid]-i 
aktivləşdirin.  
• [View]-[Show Grid]

2) [Pen Tool] ilə kənar xətt boyunca qrafik işinin 
hazırlanması
1. [Pen Tool: P]-ni seçin. 
2. [Ctrl+Space Bar] basıb saxlamaqla siçanı klik 
edərək iş sahəsini nisbətən genişləndirin. 
• [Alt+Ctrl+Space Bar] düymələrini basıb saxla-
yaraq siçanı sürüyün. 
3. [Pen Tool] ilə skan olunmuş mətn boyunca 
kənar xəttləri çəkin.

3) Əl yazısı mətni, ingiliscə mətn və altyazı mət-
nlərinin birləşdirilməsi 
1. Ödənişsiz hissəyə baxış 
• Tərtibat
• Rəng
• Ölçü və s.

Şəkil 6-30: Yoxlama nöqtəsinə baxış

Şəkil 6-31: Kəsim aləti

Şəkil 6-32: Transformasiya

 

(Şəkil 6-40) Yoxlama nöqtəsinə baxış 
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(Şəkil 6-41) Kəsim aləti 

Klik  

Seçmək 

Çəkmək 

1 

3 

2 

4 
5 

 

(Şəkil 6-42) Transformasiya 
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4) Təbii görünüş əldə etmə üçün mətnin yer-
ləşməsini dəyişmək 
1. [Selection Tool: V]-ni seçin. 
2. “Queens” mətn qutusunu seçin.
3. [Q] simvolunu klik edin. 
4. Ölçü alətini uzun şəkildə sıxaraq  [Shear 
Tool]-u seçin.  
5. “Queens” mətnini biraz sağa doğru sürüşdürün. 
• Tac çubuğunu mətnə yaxın yerləşdirin. 

5) Tac çubuğunu əyib biraz da söykəyərək işin 
tamamlanması
1. [Selection Tool: V]-ni seçin.  
2. “Queens Crown bar”-ı seçin.  
3. [Effect]-[Distort & Transform]-a gedin. 

6) Real vaxtda dəyişikliyi yoxlamaq üçün öni-
zləməni seçin.
1. [Transform Effect]-də [Preview]-nu yox-layın.   
2. [Transform Effect] dialoq qutusu:
• [Rotate] seçimində [Angle]-ı “-22°” edin.  
3. [OK] düyməsini klik edin. 

7) Tamamlanmış nümunənin qruplaşdırılması
1. Müştəriyə göndərmək üçün nümunəni tama-
mlayın. 

 

(Şəkil 6-42) Transform effect (-22°) 
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Şəkil 6-33: Transform effect (-22°)

Şəkil 6-34: Tamamlanmış loqo

 

(Şəkil 6-43) Tamamlanmış loqo 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Şəbəkə effektlərini dəqiq şəkildə izah etdi?  
2. Mağaza ticarət loqosu hazırladı? 
3. Obyektləri müvafiq şəkildə çəkmək üçün xətkeşlərdən istifadə 
etdi?
4. Tapşırıqları səmərəli şəkildə həyata keçirmək üçün təlimatları 
tətbiq etdi?
5. Doğru vaxtda qısa yol düyməsini istifadə etdi?
6. Obyekti dəqiq şəkildə çəkmək üçün qələm alətini tətbiq etdi?
7. Obyektə Pathfinder effektini dəqiq şəkildə tətbiq etdi?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Keçid alətinin istifadəsini (Path tool) aydın şəkildə izah edəcək;  
2.   Qalın xətt istifadə edərək loqo hazırlamağı bacaracaq. 

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Sadə seçim
• Əlavə nöqtələri silmək üçün Object>Path>Simplify əmri tərtib olunub.
• Əyri xətt dəqiqlik dəyərləri 90%-ə və bucaq kandarı 0-a bərabər olduqda istifadəçi çox yaxşı 

nəticə əldə edir. 
• Nöqtələrin sayı 50%-dən çox azaldılmışdır və hazırkı vəziyyətdə bu, 10-dur.

1) [Simply Path]-[Curve Precision] 
1. Əyrilik həssaslığı (Curve Precision) - xətt üçün dəqiqlik mənasında başa düşülür.  
2. Faiz yüksəkdirsə əyrini orijinal keçidə yaxın tənzimləmək mümkündür. 
3. [Curve Precision] seçimində parametr dəyəri 100% olarsa o, əyrini orijinal keçid ilə maksi-

mum saxlaya bilir.  

2) [Simply Path]-[Angle Threshold] 
1. Bucaq kandarı bucaq limit dəyəri deməkdir. 
2. Bu, nöqtələri səlis şəkildə 0 ~ 180° aralığında tənzimləyə bilir. 
3. Orijinal element başlanğıc nöqtəsi rəqəmləridir. 
4. Cari element sadələşdirilmiş nöqtələrin rəqəmləridir.  

3) [Options]-[Angle Threshold] 
1. Bucaq kandarı bucaq limit dəyəri deməkdir. 
2. Bu, nöqtələri səlis şəkildə 0 ~ 180° aralığında tənzimləyə bilir. 
3. Orijinal seçim başlanğıc nöqtəsi rəqəmləridir. 
4. Cari seçim sadələşdirilmiş nöqtələrin rəqəmləridir.  

4) [Options]-[Straight Lines] 
1. Düz xətlər nöqtələr arasındakı xətti yaradır.

7. Krali̇ça gülü loqosunun hazırlanması
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2. Bucaq kandarının dəyəri nə qədər aşağı olsa da nöqtələr saxlanılır.

5) [Options]-[Show Original] 
1. [Show Original] orijinal keçidi göstərir.
2. Qirmızı xətt orijinal xətt fiqurudur. 
3. Mavi rəng seçimlə tənzimlənən sadələşdirilmiş xətdir. 

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. İş mühitinin yaradılması
1) File>New-ya klik edərək yeni sənəd yaradın. 
1. İş lövhəsi tənzimləmələri
• Ölçü: A4
• En: 210mm
• Hündürlük: 297mm 
• Oriyentasiya: Portret  
• Rəng rejimi: CMYK 
 
2. [Create]-i klik edin. 

2) Mənbə qovluğundan eskiz faylının açılması
1. Yeni sənəd açmaq üçün [Ctrl+N] düyməsini 
sıxın. 
2. Eskizi açmaq üçün seçin. 
• [Shift+Ctrl+ P ] [Place]
Və ya  [File→Place]-ə gedin. 
3. [Template]-i yoxlayın. 
• [Link]-i təsdiqləyin.
4. [Place] düyməsini klik edin. 

Şəkil 7-1: İş mühitinin yaradılması

Şəkil 7-2:Yerə görə faylı açmaq

 

(Şəkil 7-1) İş mühitinin yaradılması 
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(Şəkil 7-2) Yerə görə faylı açmaq 

Ctrl + N 1 

3 

2 

4 

3

4

1 2Ctrl+N



İKT

168

Şəkil 7-3: Eskizin yapışdırılması

Şəkil 7-4: Eskiz hissənin böyüdülməsi

Şəkil 7-5: Kənar xətlərin çəkilməsi

Şəkil 7-6: Xəttin kəsilməsi

3) “Blossom Café” adlı eskizin seçilməsini təs-
diq etmək 
1. [Selection Tool: V]-ni seçin. 
2. Seçilmiş eskizi təsdiq edin. 

4) Bütünlükdə göstərərək eskiz hissəsinin 
böyüdülməsi
1. Böyütmək üçün [Ctrl+Space Bar] ilə eskiz 
hissəni klik edin. 

5) [Pen Tool] ilə antena hissəsinin çəkilməsi
1. [Pen Tool]-u seçin. 
2. Qanad hissəni çəkin.
3. Enter düyməsini sıxın. 
• Qanad hissə yaxın keçid deyil.
4. Antenanı yenidən çəkin. 

6) Tutacaqları sürüyərək əyri xəttin kəsilməsi  
1. [Direct Selection Tool: A]-nı seçin. 
2. Arxa fon ekranının boş hissəsinə klik edin. 
3. Birbaşa seçim aləti seçimində obyektin əyri 
hissəsini (xətti) klik edin. 
4. Tutacaqları sürüyərək xətti kəsin. 

 
V 

1 

Click 2 

 

(Şəkil 7-4) Eskiz hissənin böyüdülməsi 

Ctrl + Space Bar + Click 1 

 

(Şəkil 7-5) Kənar xətlərin çəkilməsi 
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7) Tutacaqları sürüyərək əyri xəttin kəsilməsi
1. [Selection Tool: V]-ni seçin. 
2. Siçani sürüyərək bütün obyektləri seçin. 
3. Xəttin xüsusiyyətini dəyişin:
• [Stroke]-u “1pt” edin. 
• [Stroke] seçimini klik edin. 
4. “Cap”-i (Papaq) “Round Cap” (dairəvi papaq) 
kimi qurun.
5. “Corner”-i (künc) “Round Join” (dairəvi 
birləşmə) edin. 

8) Siçanı sürüyərək xəttin eninin tənzimlənməsi 
1. İlk olaraq iş üçün obyekti seçdikdə  [Width 
Tool: Shift+W]-nu seçin. 
2. Sürüyərək xəttin enini tənzimləyin. 
• Xəttin bir tərəfini tənzimləmək üçün Alt 
düyməsini klik edin. 

9) Xəttin enini tənzimlədikdən sonra lazımsız es-
kizin silinməsi
1. Qatlar panelindən [Template Şablon] qatına 
klik edin. 
2. Onu qatlar panelinin aşağısında silmək seçimi 
(Delete Selection) ikonuna sürüyün. 

 

(Şəkil 7-7) Xətlərin xüsusiyyətləri 
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Şəkil 7-7: Xətlərin xüsusiyyətləri

Şəkil 7-8: En aləti

Şəkil 7-9: Şablonun (Şəkilin) silinməsi
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(Şəkil 7-8) En aləti 
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(Şəkil 7-9) Şablonun (Şəkilin) silinməsi 
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10) Xəttin üzə dəyişdiriməsi
1. Xətt obyektini üz fiquruna dəyişdirmək üçün 
bütün obyekti seçin. 
1. [Object]-[Path]-[Outline Stroke]
• [Line]-ı [Face]-ə dəyişin. 
2. [Pathfinder] panelində [Unite]-i seçin. 
• Bir üzü bütün üzlərlə birləşdirin. 

11) Rahat işləmək üçün lazım olmayan hissələrin 
silinməsi. 
1. Obyekti seçdikdən sonra
• [Object]-[Path]-[Simplify]-ə gedin. 
2. [Simplify] seçim pəncərəsində aşağıdakı-ları 
seçin:
• Əyri xətt dəqiqliyi: 100%
• Bucaq kənarı: 139°
3. Baxış: Yoxlamaq
4. [OK]-i klik edin. 

12) Canlı kimi görünən simvolun tamamlanması 
1. Obyekti mükəmməl şəkildə yerləşdirin. 
• [Symplify] seçimi ilə obyekt xəttinin enini dəy-
işin.  

Şəkil 7-10: Pathfinder

Şəkil 7-11: Sadələşdirmək

 

  Bütün obyektləri 
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(Şəkil 7-10) Pathfinder 
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(Şəkil 7-11) Sadələşdirmək 
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13) Loqo şrifti və Simvolun birləşməsi ilə işin 
tamamlanması

2. Sloqan fiqurunun dekorasiyası
1) File>New-ya klik edərək yeni sənədin tərtib 
olunması
1. İş lövhəsi tənzimləmələri
• Ölçü: A4
• En: 210mm
• Hündürlük: 297mm 
• Oriyentasiya: Portret  
• Rəng rejimi: CMYK
 
2. [Create Document]-i klik edin.

2) [Ctrl+U] ilə ağıllı təlimatların aktiv-ləşdir-
ilməsi.
1. [Ellipse Tool: L]-i seçin. 
2. Shift düyməsini basılı saxlayaraq dairəni 
çəkin.  
• Dairəni çəkin: Shift+Sürümək
3. [Type Tool]-u seçin.  
4. [Ctrl+U] ilə smart təlimatları (Smart Guides) 

Şəkil 7-12: Tamamlanmış simvol

 

(Şəkil 7-12) Tamamlanmış simvol 

 

 

(Şəkil 7-13) Tamamlanmış simvol 
Şəkil 7-13: Tamamlanmış simvol

Şəkil 7-14: Setting Up Workspace

 

(Şəkil 7-14) Setting Up Workspace 
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aktivləşdirin. 
• Menyu çubuğundan:
[View]-[Smart Guides]

3) [Type on a Path] funksiyasını aktivləşdirin. 
1. [Type Tool]-da siçan işarəsinin yerini 
dəyin. 
• Siçanın vəziyyətini aşağıdakı kimi dəyişin:
Yuvarlaq fiqur  
2. İstifadəçi [Alt] düyməsini sıxdıqda siçanın 
işarəsi dalğa fiquruna dəyişir. 
• Bu zaman Alt düyməsini basılı saxlayaraq 
siçanı klik edin. 

4)  “FRAGNANT CAFÉ” mətninin yazılması
1. Mətni aşağıdakı kimi yazın:
• Mətn: “FRAGNANT CAFÉ” 
2. [Ctrl+C] ilə mətni kopyalayın.  
3. İstifadəçi mətni kopyaladıqda mətn başıaşağı 
şəkildə görünür. 
• [Selection Tool: V]-ni seçin.  
• Siçanı çərçivə qutusunun küncünə aparın.4. 
Siçan fiquru əyri ox şəklinə dəyişəndə 
• [Shift+Sürüək] ilə mətnin yerləşmə vəziyyətini 
dəyişin. 

5) Mövcud mətnin silinməsindən sonra isti-
fadəçinin istədiyi mətnin yazılması
1. Əvvəlki mərhələdə kopyalanmş dairə obyekti-
ni [Ctrl+F ilə kopyalayın.
2. Mətni iki dəfə klik edin. (mətni sürüyərək 
bloklamaq)
3. Yeni mətni istədiyiniz vəziyyətdə yazın. 

6) Mətnin dairə xaricinə köçürülməsi 

Şəkil 7-15: Ellips və mətn

Şəkil 7-16: Keçid üzərində yazı
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(Şəkil 7-15) Ellips və mətn 
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(Şəkil-16) Keçid üzərində yazı 

Şəkil 7-17: Shift + Drag/Sürümək

 

(Şəkil7-17) Shift + Drag/Sürümək 
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1. Üst tərəfdə mətni dik şəkildə göstərmək üçün 
başı aşağı mətni seçin. 
2. [Type]-[Type on a Path]-[Type on a Path Op-
tions] 
3. [Type on a Path Options] seçim pəncərəsində
• [Flip] seçim qutusunu yoxlayın.
• Mətn başı aşağı olacaq.
 
4. [Preview] seçimini yoxlayın.
5. [Align to Path]-[Ascender] ilə mətni dairədən 
kənara çıxarın. 
6. [OK] düyməsini klik edin. 

7) Loqo şəklinin mərkəzində simvol işarəsinin 
daxil edilməsi
• Simvol işarəsi və sloqanı düzgün şəkildə de-
korasiya edin. 

8) Loqo və sloqanın birləşdirilməsi

Şəkil 7-18: Yeni mətn daxil etmək

Şəkil 7-19: Flip effekti

Şəkil 7-20: Hərfin üst çıxıntısı

 

(Şəkil 7-18) Yeni mətn daxil etmək 
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(Şəkil 7-19) Flip effekti 
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(Şəkil 7-20) Hərfin üst çıxıntısı 
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(Şəkil 7-21) Mətnin dekorasiya olunması 

 

Şəkil 7-21: Mətnin dekorasiya olunması
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Keçid alətinin istifadəsini aydın şəkildə izah etdi?
2. Qalın xətti dəqiq şəkildə istifadə edərək loqo hazırladı?
3. Sadə keçid sseçımlərini obyektə düzgün şəkildə tətbiq etdi?  
4. Hissəni detallı şəkildə işləmək üçün böyütmək funksiyasından 
istifadə etdi?
5. Sloqan yaratmaq üçün keçid üzərində yazı funksiyasını istifadə 
etdi? 
6. Flip seçimi ilə dəqiq şəkildə sloqan hazırladı? 
7. Hərfin üst və alt çıxıntısı sseçımlərini düzgün şəkildə istifadə 
etdi?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   3D dövrü sseçımlərini dəqiq şəkildə izah edəcək;
2.   Kiçik nöqtə ilə nöqtə loqosu növünü yaratmağı bacaracaq.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. 3D Obyektlərin yaradılması 
※ Qeyd:
3D alətləri Perspektiv Şəbəkə Alətlərindən azaddır və 3D obyektlər perspektivdə hər hansı 

digər obyekt kimi işlədilir. 
1) 3D effektlər ikiölçülü şəkillərdən (2D) üçölçülü obyektlər (3D) yaratmağa imkan verir. 
• İstifadəçi işıqlandırma, kölgə vermə, dəyişmə və digər xüsusiyyətlər ilə 3D obyektlərin 

görünüşünə nəzarət edə bilir.
• İstifadəçi, həmçinin 3D obyektin hər bir səthinə təsvir də çəkə bilər. 
2) 3D obyektləri yaratmaq üçün iki variant var:  Ekstruziya (sıxıb çıxarma) və ya çevirmə
• Əlavə olaraq istifadəçi üçölçülü obyektləri 2D və ya 3D obyektlərə dəyişə bilər. 
• Mövcud 3D obyekt üçün 3D effektlərin tətbiq olunması zamanı obyekti seçin və görünüş pan-

elindən effekti iki dəfə klikləyin.
※ Qeyd:
3D obyektlər ekranda üst-üstə düşməyən süni iş nümayiş etdirə bilər, amma bu işlər web üçün 

optimallaşdırılmış şəkillərdə və printdə görünməyəcək.  
1.1 Ekstruziya ilə 3D obyektlərin yaradılması
1) Ekstruziya - obyektə dərinlik vermək üçün onun [z] oxları boyunca 2D obyekti genişləndirir. 
• Misal üçün, əgər istifadəçi 2D obyekti sıxıb çıxarısa o, silindir olur.  
※ Qeyd: 
Obyektin oxları həmişə onun ön səthinə perpendikulyar şəkildə uzanır və əgər obyekt 3D 

seçimlər qutusunda çevrilirsə o, obyektə tərəf hərəkət edir.  

8. Ki̇çi̇k nöqtə i̇lə nöqtə loqosu növünün 
hazırlanması
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1. Obyekti seçin. 
2. Choose Effect>3D>Extrude & Bevel
3. Bütün seçimlər siyahısını görmək üçün “More Options”-a, əlavə sseçımləri gizlətmək üçün 

“Fewer Options”-a klik edin. 
4. Öncədən baxış üçün sənəd pəncərəsində Preview-nu seçin.  
5. Sseçımləri müəyyənləşdir:                                
• Vəziyyət
     Obyektin baxdığınız mövqedən necə fırlandığını seçin. (bax: 3D fırlatma və yerləşmə vəzi-

yyəti sseçımləri)
• Ekstruziya & Əyri
     Obyektin dərinliyini, əlavə olunmuş və ya kəsilmiş əyrinin dərəcəsini müəyyən edin. (bax:  

Ekstruziya & Əyri sseçımləri)
• Səth
     Zərif və kölgələndirilməmiş mat səthlərdən plastikə bənzəyən seçilmiş parlaq səthlərə qədər 

bir sıra müxtəlif səthlər yaradın. (bax: Səth kölgə sseçımləri)
• İşıqlandırma
     Dramatik effektlər üçün bir və ya daha çox işıq əlavə edib onun intensivliyini dəyişin. 

Obyektin kölgə rəngini dəyişib ətrafında işıqları hərəkət etdirin. (bax: İşıqlandırma sseçımləri)
• Xəritə 
     Xəritə şəkillərini 3D obyektinin səthinə çəkin. (bax: 3D obyekti üçün xəritə sseçımləri)
6. [OK] düyməsini klikləyin. 

1.2 Çevrilmə ilə 3D obyektin yaradılması 
1) Kürəsəl ox ətrafında [y] dairəvi yöndə 3D obyekti yaratmaq üçün profili çevirin. 
• Dönən ox şaquli istiqamətdə sabitləndiyindən istifadəçinin istədiyi 3D obyektinin profilinin 

yarısının şaquli və qarşıya baxan vəziyyətdə (açıq və qapalı keçidlər) çevrilməsi tələb olunur. 
• Daha sonra istifadəçi effektlər dialoq 3 qutusunda 3D obyektlərinin yerləşmə vəziyyətini dəy-

işə bilər.

 

(Şəkil 8-1) Obyektin ekstruziyası 
 Şəkil 8-1: Obyektin ekstruziyası

Şəkil 8-2: Obyektin ekstruziya olunması

 

(Şəkil 8-2) Obyektin ekstruziya olunması 
 

[Nümunə] 

- Sol: Ekstruziya olunmuş obyekt, əyri 
küncü 

- Orta: “Bevel Extent In” ilə obyekt  
- Sağ: “Bevel Extent Out” ilə obyekt 

[Nümunə]
- Sol: Ekstruziya olunmuş obyekt, əyri 
küncü
- Orta: “Bevel Extent In” ilə obyekt 
- Sağ: “Bevel Extent Out” ilə obyekt
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1. Obyekti seçin.
※ Qeyd: 
3D Revəlve (çevirmə) effektini eyni anda bir və ya bir neçə obyektə tətbiq etmək eyni zamanda 

hər bir effekti öz ətrafında döndərir.  
Hər bir obyekt öz 3D sahəsində mövcud olur və digər 3D obyektləri ilə kəsişmir. 
Revəlve (çevirmə) effektinin bir hədəf qrup və ya qata tətbiq edilməsi digər tərəfdən obyektləri 

tək bir ox ətrafında döndərir.  
※ Qeyd: 
Doldurulmuş keçidin bölgü işarəsiz çevrilməsi əks vəziyyətdən daha tez olur. 

2. Effect>3D>Revəlve> 3D>Çevirməyi seçin.
3. Sənəd pəncərəsində effekti əvvəldən görmək üçün [Preview]-nu seçin.
4. Bütün seçimlər siyahısını görmək üçün [More Options], əlavə sseçımləri gizlətmək üçün 

[Fewer Options]+[I]-ı klik edin.
• Yerləşmə vəziyyəti
Obyektin baxdığınız mövqedən necə fırlandığını seçin. (bax: 3D fırlatma və yerləşmə vəziyyəti 

sseçımləri)
• Çevirmək
Obyekt ətrafındakı keçidi üçölçülü vəziyyətə gətirmək üçün keçidin hansı şəkildə ediləcəyini 

müəyyən edin. (bax: Çevirmə sseçımləri)
• Səth
Zərif və kölgələndirilməmiş mat səthlərdən plastikə bənzəyən seçilmiş parlaq səthlərə qədər bir 

sıra    müxtəlif səthlər yaradın. (bax: Səth kölgə sseçımləri).
• İşıqlandırma
           Dramatik effektlər üçün bir və ya daha çox işıq əlavə edin, işığın intensivliyini dəy-

işin,  obyektin kölgə rəngini dəyişin və obyekt ətrafında işıqları hərəkət etdirin. (bax: İşıqlandırma 
sseçımləri)

• Map
   Xəritə şəkillərini 3D obyektinin səthinə çəkin. (bax: 3D obyekti üçün xəritə sseçımləri)
5. [OK] düyməsini klik edin. 

2. Sseçımlərin tənzimlənməsi 
2.1 3D fırlanma mövqeyi sseçımlərini qurun.
1. Aşağıdakılardan hər hansı birini tətbiq edin:
• Yerləşmə menyusundan (Position menu) faktiki yerləşmə vəziyyətini seçin.  
• Sərhədsiz fırlanma üçün bir kubun üz hissəsini sürüyün. Obyektin qarşısı kubun mavi üzü, 

obyektin yuxarı və aşağı üzü açıq boz, kənarları yarı boz və arxa üzü tünd boz ilə nümayiş olunur. 
• Fırlanmanı ümumi ox boyunca məhdudlaşdırmaq üçün üfüqi (ümumi y oxu) və şaquli (ümumi 

x oxu) sürüyən zaman Shift-i basıb saxlayın. Obyekti ümumi z oxu boyunca fırlatmaq üçün kubla 

 

(Şəkil 8-3) Obyektin Çevrilməsi 
 Şəkil 8-3: Obyektin Çevrilməsi
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əhatə olunan mavi lent boyunca sürüyün.  
• Obyekt oxu ətrafında fırlanmanı məhdudlaşdırmaq üçün kub kənarında sürümə edin.  İşarə 

ikitərəfli oxa   dəyişir və kub kənarı obyekt ətrafında dönəcəyi oxu müəyyən etmək üçün rəngini 
dəyişir. Qırmızı kənarlar obyektin x oxunu, yaşıl kənarlar y oxunu, mavi kənarlar isə obyektin z 
oxunu təmsil edir.

• Mətn qutularında üfüqi (x) oxunda  , şaquli (y) oxunda   və dərinlik (z) oxunda  
(-180) və (+180) arasında dəyərlər əlavə edin. 
• Perspektivi tənzimləmək üçün Perspektiv mətn qutusunda 0 və 160 arasında dəyər əlavə edin. 

Daha kiçik bucaq telefotoaparat obyektivinə, daha böyük bucaq isə daha geniş bucaqlı kamera 
obyektivinə bənzəyir. 

  

2.2 Ekstruziya və əyri sseçımləri
• Ekstruziya dərinliyi - 0 və 2000 arası dəyərləri istifadə etmək üçün obyektin dərinliyini 

müəyyənləşdirir. 
• Papaq (Cap) - obyektin dolğun (Revəlve Cap On  ) və ya içi boş göründüyünü (Revəlve Cap 

Off  ) müəyyən edir.
• Əyri - obyektin dərinliyi (z oxu) boyunca seçdiyiniz əyri kənar növlərini tətbiq edir.  
• Hündürlük - hündürlüyü 1 və 100 arası müəyyənləşdirir. Əyri hündürlüyü obyekt üçün çox 

böyük olduqda  obyektin öz-özünə kəsişməsinə və gözlənilməz nəticələrə səbəb ola bilər.
• Bevel Extent Out  -   əyrini obyektin original fiquruna əlavə edir.
• Bevel Extent In  -   əyrini obyektin orijinal fiqurundan çıxarır.

2.3 Çevirmə sseçımləri

Şəkil 8-4: Obyekt oxu və ümumi ox 

Şəkil 8-5: Ekstruziya olunmuş obyekt

[Nümunə]
- Obyekt oxu (qara) obyektlə hərəkət 
edir. 
- Ümumi ox (boz) sabitdir.

- Papaqsız (top right)
- Əyri kənarsız obyekt (aşağı sol)
- Əyri kənarlı obyekt (aşağı sağ)

 

(Şəkil 8-4) Obyekt oxu və ümumi ox  
 
 

[Nümunə] 

- Obyekt oxu  (qara) obyektlə hərəkət 
edir.  

- Ümumi ox (boz) sabitdir.  

 

(Şəkil 8-5) Ekstruziya olunmuş obyekt 
 

[Nümunə] 

- Papaqlı ekstruziya olunmuş obyekt  
(yuxarı sol) 

-  
- Papaqsız (top right) 
- Əyri kənarsız obyekt (aşağı sol) 
- Əyri kənarlı obyekt (aşağı sağ) 
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• Bucaq - keçidi çevirmək üçün dərəcə rəqəmlərini 0 və 360 arası təyin edir.
• Papaq - obyektin dolğun (Revəlve Cap On  ) və ya içi boş göründüyünü (Revəlve Cap 
Off  ) müəyyən edir. 
• Başlanğıc - misal üçün, üzük formalı obyekt yaratmaq üçün çevirmə oxu və keçid arasında 

məsafə əlavə edir. İstifadəçi 0 və 1000 arasında dəyər əlavə edə bilər. 
• Qaynaq - obyektin çevrildiyi sol və ya sağ kənar ətrafında oxları müəyyənləşdirir.

2.4 Səth kölgələndirmə sseçımləri
• Səth - istifadəçi səth kölgələndirməsi üçün istifadə bilər.
• Dizayn tərtibatı - obyektin həndəsi konturlarını təsvir edir və hər bir səthi şəffaflaşdırır. 
• Kölgəsiz - obyektə yeni səth xüsusiyyətləri əlavə etmir. 3D obyektinin rəngi original 2D 

obyektinin rəngi ilə eynidir.  
• Yayılmış kölgə - obyektin işığı yüngül və yayılmış şəkildə əks etdirməsini təmin edir. 
• Plastik kölgələndirmə - obyektin işığı parlaq və çox parlaq materialdan hazırlanmış kimi əks 

etdirməsini təmin edir. 
※ Qeyd:
Seçiminizdən asılı olaraq müxtəlif işıqlandırma sistemləri mövcuddur. Əgər obyekt yalnız 3D 

fırlanma effektini istifadə edirsə mövcud olan səth sseçımləri yalnız yayılmış kölgə və kölgəsiz 
seçimlərdir. 

• İşıq intensivliyi - işıq intensivliyini 0% və 100% arası tənzimləyir.
• Ətraf işıq - bütün obyekt səthlərinin parlaqlığını bərabər şəkildə dəyişdirən ümumi işıqlandır-

maya nəzarət edir. 0% və 100% arası dəyər əlavə etmək mümkündür. 
• İntensivliyi vurğulamaq - obyektin işığı 0% və 100% aralığında nə qədər əks etdirdiyinə 

nəzarət edir. Aşağı dəyərlər mat, yuxarı dəyərlər parlaq görünüşlü bir səth yaradır. 
• Vurğu ölçüsü - vurğunun ölçüsünə çoxdan (100%) aza (0%) nəzarət edir. 
• Qarışdırma addımları - kölgələndirmənin obyektin səthində nə qədər qüsursuz görünəcəyinə 

nəzarət edir. 1 və 256 arasında dəyər əlavə etmək mümkündür. Yüksək rəqəmlər aşağı rəqəm-
lərdən daha yumşaq kölgələr və daha çox keçidlər yaradır. 

• Gizlədilmiş üzlərin çəkilməsi - obyektin gizli arxa üzlərini göstərir. Arxa üzlər obyekt şəffaf 
olduğu və ya genişlənib hissə-hissə olduğu zaman görünür.

※ Qeyd: 
Əgər sizin obyekt şəffafdırsa və siz gizlədilmiş arxa üzün şəffaf qabaq üzdən görünməsini istəy-

irsinizsə 3D effektini tətbiq etməzdən qabaq Object>Group əmrini tətbiq edin.  
• Spot rənglərini qorumaq  (“Ekstruziya & Bevel” effekti, Çevirmə effekti və Fırlatma effekti) 

- istifadəçi obyektdə spot rənglərini qorumalıdır. Kölgələndirmə rəng seçimi üçün Custom, yəni 
istəyə görə seçim seçilirsə spot rəngləri qoruna bilmir.

2.5  3D-də obyektin fırladılması

  

 

[Nümunə] 

A. Dizayn tərtibatı 

B. Kölgəsiz 

C. Yayılmış kölgə 

D. Plastik 
kölgələndirmə  

 

 
(Şəkil 8-6) Müxtəlif səth kölgələndirmə seçimləri Şəkil 8-6: Müxtəlif səth kölgələndirmə sseçımləri

[Nümunə]
A. Dizayn tərtibatı
B. Kölgəsiz
C. Yayılmış kölgə
D. Plastik kölgələndirmə 
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Şəkil 8-7: İş mühitinin yaradılması

1. Obyekti seçin.
2. Choose Effect>3D>Rotate 
3. Sənəd pəncərəsində effekti əvvəlcədən görmək üçün [Preview]-nu seçin.
4. Bütün seçimlər siyahısını görmək üçün “More Options”, əlavə sseçımləri gizlətmək üçün 

“Fewer Options”-a klik edin.
5. Sseçımləri müəyyənləşdirin
• Yerləşmə - obyektin baxdığınız mövqedən necə fırlandığını seçir. (bax: 3D fırlatma və yer-

ləşmə vəziyyəti sseçımləri)
• Səth - zərif və kölgələndirilməmiş mat səthlərdən plastikə bənzəyən parlaq səthlərə qədər bir 

sıra    müxtəlif səthləri yaradır. (bax: Səth kölgə sseçımləri)
6. [OK] düyməsini klik edin.

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. İş mühitinin yaradılması
1) File>New-ya klik edərək yeni sənəd yaradın.
1. İş lövhəsi tənzimləmələri 
• Ölçü: A4
• En: 297mm
• Hündürlük: 210mm 
• Oriyentasiya: Landscape 
• Rəng rejimi: CMYK  

2. [Create Document] düyməsini klik edin. 

1) İş sahəsində  “LOVING BAKU” (Bakını se-
virəm) mətnin yazılması 

 
1 

2 

1

2
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2. [Type Tool: T]-ni seçin.  
3. Məzmunu aşağıdakı kimi yazın:
4. “ LOVING BAKU ”
• Şrift: Nueva Std
• Şrift ölçüsü: 48pt
• Məzmun: LOVING BAKU

5. “Walking in the Future” (Gələcəkdə gəzinti) 
yazın.
• Şrift: Nueva Std
• Şrift ölçüsü: 24pt 
• Məzmun: Walking in the Future

6. Hər hansı mənbədən mətbəx şəkillərinin 
kopyalanması 

2) Əlifbanın “O” mətnində arının uçan hərəkə-
tini təcəssüm etdirmək üçün nöqtənin verilməsi
1. [Ellipse Tool: L] 
2. Dialoq qutusunda “Background” ekranını klik 
edin:
• En: 45mm
• Hündürlük: 59mm
3. [OK] düyməsini klik edin.
4. [Direct Selection Tool: A]-nı seçin. 
• Seçimi aradan qaldırmaq üçün arxa fonun boş 
sahəsini klik edin. 
5. Ellipsin sağ nöqtəsi üzərində klik edin. 
6. Delete düyməsini klik edin. (Ellipsin yarı 
hissəsi qalacaq)

3) Yarım dairənin yuxarı hissəsinin böyüdülməsi
1. [Direct Selection Tool: A]-nı seçin.
2. Sol tərəfin orta nöqtəsinə klik edin. 
3. Nöqtəni bir az yuxarı doğru sürüyün.
4. Yarım dairənin rəngini aşağıdakı kimi təyin 

 

 

(Şəkil 8-2) Mətnlərin yazılması   

 1 

2 

Şəkil 8-8: Mətnlərin yazılması  

Şəkil 8-9: Mətbəx şəklinin qoyulması image 

Şəkil 8-10: Yarım dairənin düzəldilməsi

 

 

(Şəkil 8-3) Mətbəx şəklinin qoyulması image  

3 

 

L 

 

A + Arxa fona klik edin  

 Klik 

 

Silmək 

 

1 

2 

3 

4 

5 6 

 

(Şəkil 8-4> Yarım dairənin düzəldilməsi 
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edin:
• Üz rəngi: Yoxdur
• Xətt rəngi : Boz

4) Yarım dairənin 3D çevirmə sseçımlərinin tə-
yin olunması
1. [Effect]-[3D]-[Revəlve] 

2. 3D Çevirmə Sseçımləri (3D Revəlve Options) 
pəncərəsi 
• Öncədən baxış: Yoxlama
3. [Right Edge]-ı təyin edin. 
4. [OK] düyməsini klik edin.

5) Eni uzunundan daha böyük olan düzbucaqlı 
(dördbucaqlı) çəkin. 
1. [Rectangle Tool: M] 
• Arxa fonun boş sahəsinə klik edin. 
• En: 40mm
• Hündürlük: 2mm 
2. [OK] düyməsini klik edin.
6) [Ctrl+D] düymələrini basıb saxlamaqla beş 
ədəd düzbucaqlı kopyalayın. 
1. [Selection Tool: V] 
• Arxa fonun boş sahəsinə klik edin.
2. Düzbucaqlını yuxarıdan aşağıya sürüyün.
• [Alt+Shift] düymələrini basıb saxla-yaraq 
siçanı sürüyün. 
• Obyekti şaquli olaraq kopyalayın. 
7) [Ctrl+D] düymələrini üç dəfə basıb saxlamaq-
la beş düzbucaqlı kopyalayın. 

8) Beçinci obyektin sağ dabanındakı daban 
nöqtəsini müəyyənləşdirin. 
1. [Selection Tool: V] ilə beş düzbucaqlı seçin. 
2. [Shear Tool]-u seçin. 
• [Qısayol düyməsi: S] 
• [Scale Tool]-[Alt] (və ya [Scale Tool]) kliklə-
yin.  

Şəkil 8-11: Ellips fiqurunun dəyişdirilməsi 

Şəkil 8-12: 3D Çevirmə sseçımləri

Şəkil 8-13: Düzbucaqlı çubuğu

Şəkil 8-14: [ Ctrl + D] düyməsi

 

 

(Şəkil 8-5> Ellips fiqurunun dəyişdirilməsi  
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(Şəkil 8-6) 3D Çevirmə seçimləri 
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3. Əsas nöqtə kimi sağ daban nöqtəsini müəyyən 
edin. 

9) Bütün obyektin sol tərəfə söykənməsi 
1. Əsas nöqtə kimi beşinci obyektin sağ daban 
nöqtəsini müəyyən edin. 
2. Aşağıdan hərəkət edən nöqtə kimi  ikinci düz-
bucaqlının sol kənar nöqtəsini təyin edin. 
3. Siçan nöqtəsini aşağıda olan sol daban 
nöqtəsinə sürüyün. 

10) Lazım olmayan çəpəki obyektlərin gi-
zlədilməsi
1. Çəpəki xətt ilə söykənən düzbucaqlıları seçin. 
2. Seçilmiş obyekti [Symbols] panelinə sürüyün. 
• [Windows]-[Symbols] : [Shift + Ctrl + F11]
3. [Symbol Options] pəncərəsində
• Simvol kimi qeydiyyatdan keçmək üçün [OK] 
düyməsini klik edin. 
4. Lazımsız çəpəki obyekti  [Ctrl+3] düyməsi ilə 
gizlədin. 
11) Real zamanda dəyişən obyekti yoxlamaq 
üçün iş
1. 3D çevirmə (3D Revəlve) effekti ilə düzəldi-
lmiş yumurta fiquru obyektini seçin. 
2. [Appearance] panelində [3D Revəlve]-u seçin. 
3. [3D Revəlve Options] pəncərəsində
• Preview: Yoxlayın
4. [Map Art]-ı klik edin. 

12) Obyekt üzərində qeydiyyatdan keçmiş sim-
volun görünməsi
1. [Map Art] pəncərəsinin [Symbol] seçimində 
qeydiyyatdan keçmiş çəpəki simvolu seçin. 
2. [Preview] qutusunu yoxlayın. 
3. Obyekti simvol ilə doldurmaq üçün [Scale to 
Fit ] düyməsini klik edin. 
4. [Invisible Geometry]-ni seçin. 
• Obyekti gizlədin. 
5. [OK] düyməsini klikləyin.  

13) 3D Çevirmə sseçımlərinin yaradılması
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1. Sseçımləri aşağıdakı kimi təyin edin:
• X oxu: -22°
• Y oxu: -23°
• Z oxu: 43°
2. [OK] düyməsini klik edin. 

14)  “Expand Appearance” funksiyasının tən-
zimlənməsi
1. [Selection Tool: V] ilə obyekti klik edərək 
yarım dairəni göstərin. 
2. 3D çevirmə effekti ilə əks olunan mövcud 
obyekti [Expand Appearance] ilə tənzimləyin. 
• [Object]-[Expand Appearance] 

15) “Merge” ilə obyektlərin vahid şəkildə təşkil 
olunması 
1. [Pathfinder] panelinə gedin. 
• [Window]-[Pathfinder]
2. [Merge]-i klik edin.

16) [Color Rəng] panelində loqo üçün obyekt 
rəngini dəyişin. 
1. (Şəkil 8-23)-də olduğu kimi [Fill/Line col-
or]-u dəyişin. 
2. [Direct Selection Tool: A]-nı seçin. 
• Arxa fon ekranının boş hissəsinə klik edin.
• Boş sahəyə klik edərək seçimi ləğv edin. 
3. Kəskin (bükülmüş) fiqurun içərisində kopya-
da yaranan obyekti seçin.
4. Delete düyməsi ilə seçilmiş obyekti silin. 
17) Eskizə əsasən obyektin yerləşdirilməsi
1. [Pen Tool: P]-ni seçin.

Şəkil 8-19: Gözə görünməyən həndəsi fiqur

Şəkil 8-20: Əyrini tənzimləmək

Şəkil 8-21: Görünüşü böyütmək

Şəkil 8-22:  Pathfinder

 

(Şəkil 8-19) Gözə görünməyən həndəsi fiqur 
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(Şəkil 8-20) Əyrini tənzimləmək 
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(Şəkil 8-21) Görünüşü böyütmək 
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• İlk olaraq [Smart Guides: [View]-[Smart 
Guides]-ı aktivləşdirin. 
2. Üst-üstə gələn hissəni silmək üçün sahəni 
bölün. 
• Sahəni (Şəkil 8-24)-də olduğu kimi çəkin. 
3.  Seçim Alətini seçin: V 
4. Sahəni bölmək üçün nöqtə obyektini və xətti 
seçin. 

18) Loqonu tamamlamaq üçün lazımsız 
hissələrin silinməsi
1. [Shift + M]-i seçin. 
•  [Tools panel]-[Shape Builder Tool]

2. Silmək üçün Alt düyməsini basıb saxlayaraq 
sahəyə klik edin. 
• [Alt + Click] 
• Alt düyməsini basıb saxlayaraq aşağı hissənin 
qalan sahəsinə klik edin. 
3. Delete düyməsi ilə lazım olmayan hissələri 
silin. 
4. [Selection Tool: V]-ni seçin.

5. Sahəni bölmək üçün istifadə olunan xətti silin.  
• Nöqtə obyekti saxlanılır 

19) Nöqtə stili loqosunun tamamlanması 
1. Loqo tipi ilə birlikdə nöqtə obyektini yerləşdi-
rin.
2. Nöqtə stili ilə loqonu tamamlayın. 

 A 

B C 

(Şəkil 8-23) Lazımsız hissələrin silinməsi  
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Şəkil 8-23: Lazımsız hissələrin silinməsi 

Şəkil 8-24: Xəttin bölünməsi

Şəkil 8-25: Fiqur yaradıcı  
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(Şəkil 8-25) Fiqur yaradıcı   
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Şəkil 8-26: Tamamlanmış şəkil

 

(Şəkil 8-26) Tamamlanmış şəkil 

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. 3D çevirməsinin (3D Revəlve) sseçımlərini dəqiq şəkildə izah 
etdi?
2. Kiçik nöqtə ilə bütöv şəkildə nöqtə loqosu növü yaratdı?
3. 3D effekti haqqında biliklər əldə etdi?
4. Obyektin 3D çevirmə (3D Revəlve) sseçımlərini dəqiq şəkildə 
izah etdi?
5. Obyektin 3D fırlanma funksiyasını tam şəkildə istifadə etdi? 
6. Nümunəni simvol panelinə düzgün şəkildə qeydiyyat etdi?
7. Pathfinder və qələm alətini istifadə etdi? 
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Seçim parametrləri vasitəsilə xüsusiyyət panelini izah edəcək; 
2.   Vaxtı dəqiq şəkildə nümayiş etdirmək üçün vaxt yarlığını yaratmağı bacaracaq.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Simvol və paraqraf stilləri  
1) Simvol Stili seçilmiş mətnə tətbiq oluna bilən simvol formalaşdırma xüsusiyyətlərinin toplu-

sudur. 
2) Paraqraf Stili hər iki xüsusiyyəti özündə birləşdirir (simvol formalaşdırma xüsusiyyətləri) 

və seçilmiş paraqrafa və ya paraqraf aralığına tətbiq oluna bilər. Simvol və paraqraf stillərinin 
istifadəsi vaxta qənaət edir və ardıcıl formalaşdırmanı təmin edir.  

3) İstifadəçi Simvol və paraqraf stilləri panelini istifadə edərək simvol və paraqraf stillərinin 
yaradılması və tətbiq edilməsini təmin edir. 

• Stili tətbiq etmək üçün panellərin hər hansı birində mətni seçin və stil adını klik edin. 
• Əgər istifadəçi hər hansı mətni seçməyibsə stil istifadəçinin yaratdığı yeni mətnə tətbiq olunur.

4) Əgər istifadəçi mətni seçirsə və ya kursoru mətnə əlavə edirsə, Simvol stilləri və paraqraf 
Stilləri panelində aktiv stillər seçilir.  

• Misal üçün, sənəddə hər bir simvol Normal Simvol, hər bir paraqraf isə Normal Paraqraf Stili 
kimi təyin olunur.  

• Bu ilkin stillər istifadəçinin yaratdığı digər bütün stillər üçün təməl sayılır.  

9. Ki̇çi̇k nöqtə i̇lə nöqtə loqosu növünün 
hazırlanması

 

(Şəkil 9-1) Paraqraf stilləri paneli 
 

A. Stil adı  
B. Əlavə format ilə stil 
C. Panel menyusu  
D. Yeni stil düyməsi 
E. Silmək ikonu  
 

Şəkil 9-1: Paraqraf stilləri paneli

A. Stil adı 
B. Əlavə format ilə stil
C. Panel menyusu 
D. Yeni stil düyməsi
E. Silmək ikonu 
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5) Stil adının yanında üstəgəl işarəsi göstərir ki, stildə nəzərə alınmayan məqamlar var. 
• Bu, stil ilə müəyyən olunan atributlara uyğun gəlməyən hər hansı bir formatdır.  
• İstifadəçi simvol və açıq növ panelində parametrləri dəyişən zaman faktiki olaraq simvol 

stilində nəzərə alınmamalar yaradır. Eyni şəkildə istifadəçi paraqraf panelində parametrləri dəy-
işəndə faktiki olaraq paraqraf stilində də bu hal yaranır. 

1.1 Simvol və paraqraf stillərinin yaradılması
1. Əgər istifadəçi mövcud mətnin formatı üzərində yeni stil qurmaq istəyirsə mətni seçin.
2. Simvol stilləri və paraqraf stilləri panelində aşağıdakıları tətbiq edin:
• İlk olaraq ad ilə stil yaratmaq üçün [Create New Style] düyməsini klik edin. 
• Xüsusi bir ad ilə stil yaratmaq üçün panel menyusunda [New Style]-i klik edin. [a name] yazın 

və [OK] düyməsini klik edin. 
※ Qeyd : 
Simvol və ya paraqraf stilinin kopyasını yaratmaq üçün stili yeni stil düyməsinə sürüyün. 

1.2 Simvol və paraqraf stillərinin redaktə olunması
1) İstifadəçi mövcud simvol və paraqraf stillərini və həmçinin yeni yaratdığı stilləri dəyişə bilər. 
2) İstifadəçi stilin təyinatını dəyişdikdə bütün mətn yeni stilə uyğunlaşır. 
1. Simvol stilləri panelində və paraqraf stilləri panelində aşağıdakıları edin:
• Paneldə [Style]-ı seçin və [Character Styles] panel menyusundan [Character Style Options]-u 

və ya  [Paragraph Styles] panel menyusundan [Paragraph Style Options]-u seçin. 
• Stil adını klik edin.  
※ Qeyd: 
Klik etməklə hər hansı seçilmiş mətnə stil tətbiq edin. Əgər heç bir mətn seçilməyibsə isti-

fadəçinin yazdığı hər hansı mətnə stil tətbiq edin. Əgər istifadəçi stil tətbiq etmək istəmirsə [Shift 
+ Ctrll (Windows) və ya Shift + Command (Mac OS) düymələrini basıb saxlamalıdır.

2. Dialoq qutusunun sol tərəfində format sseçımləri kateqoriyasını seçin və istifadəçinin istədiyi 
sseçımləri təyin edin.

• İstifadəçi müxtəlif kateqoriyaları seçərək format sseçımlərinin müxtəlif qrupuna keçə bilər. 

1.3 Nəzərə alınmayan növün silinməsi
1) Simvol növləri və ya simvol stillərinin qarşısında üstəgəl işarəsi varsa bu, stildə nəzərə alın-

mamaların olduğunu göstərir. 
2) Bu, eyni zamanda stil tərəfindən müəyyən olunan atributlara uyğun gəlməyən hər hansı bir 

format hesab olunur. 

• Mətni stilin müəyyən etdiyi görünüşə qaytarmaq üçün menyu panelindən [Clear Overrides]-ı 
seçin.

• Müxtəlif stillərdən təmizləmək üçün [Alt+klik] (Windows) və ya  [Option+klik] (Mac OS) 
seçin.

※ Qeyd:
Əgər istifadəçi cari formatı saxıamaq istəyirsə o zaman bu seçimlərdən uzaq qalmalıdır. 

1.4 Simvol və ya paraqraf stillərinin silinməsi
1) İstifadəçi stilləri sildikdə stilə etiketlənmiş simvolların görünüşləri dəyişmir, amma onların 

formatları bu prosesdən sonra stil ilə əlaqəli olmur.
1. Simvol stilləri panelində və ya paraqraf stilləri panelində stil adını və ya adlarını silin. 
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2. Aşağıdakılardan birini tətbiq edin:
• Panel menyusundan simvol stilini silmək və ya paraqraf stilini silməyi seçin.
• Panelin aşağısından [Delete] ikonunu klik edin.    
• Stili panelin aşağısından [Delete] ikonuna sürüyün. 
※ Qeyd: 
İstifadə olunmayan bütün stillərin silinməsi üçün [Select All] funksiyasını seçin və daha sonra 

[Delete] ikonuna klik edin. 

1.5 Digər illustrator sənədindən simvol və paraqraf stillərinin yüklənməsi
1. Simvol stilləri panelində və paraqraf stilləri panelində aşağıdakılardan birini tətbiq edin:
• Panel menyusundan simvol stillərini yükləməyi və ya paraqraf stillərini yükləməyi seçin.
• Həm simvol, həm də paraqraf stillərini yükləmək üçün menyu panelinden bütün stilləri 

yükləmək funksiyasını seçin.
 Daxil etmək istədiyiniz stillərdən ibarət illustrator sənədini iki dəfə klik edin. 
2. Mövcud klaviatura qısayol (Shortcuts) düymələri 
2.1 Ən çox istifadə olunan qısa yol düymələri

Qısayol düymələri (Shortcuts) Windows MacOS

Geriyə qaytarmaq Ctrl + Z Command + Z

Təkrar icra etmək Shift + Ctrl + Z Shift + Command + Z

Kəsmək Ctrl + X Command + X

Kopyalamaq Ctrl + C Command + C

Yapışdırmaq Ctrl + V Command + V

Qarşı tərəfə yapışdırmaq Ctrl + F Command + F

Arxaya yapışdırmaq Ctrl + B Command + B

Yerində yapışdırmaq Shift + Ctrl + B Shift + Command + B

Bütün iş lövhələrinə yapışdırmaq Alt + Shift + Ctrl + B Option + Shift + Command + B

Yazılışın yoxlanması Ctrl + I Command + I

Rəng parametrləri dialoq qu-
tusunun açılması

Shift + Ctrl + K Shift + Command + K

Klaviatura qısa yol dialoq qu-
tusunun açılması

Alt + Shift + Ctrl + K Option + Shift + Command + K

Seçimlər dialoq qutusunun açıl-
ması

Ctrl + K Command + K
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Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Vaxtı göstərmək üçün saat çəkilməsi 
1) File>New-ya klik edərək yeni sənəd yaradın. 
• Yeni iş lövhəsinin yaradılması 
• Ad: Ai 09 dərs saatı
• Ölçü: A4
• En: 297mm
• Hündürlük: 210mm 
• Oriyentasiya: Üfüqi  
• Rəng rejimi: CMYK
• Skan Effektləri: Yüksək (300ppi)

1. [Create Document] ikonunu klik edin. 

2) Ellips aləti ilə kiçik dairə çəkin. 
1. [Ellipse Tool: L]-i seçin. 
2. İş lövhəsini (ekranı) klik edin. 
3. [Ellipse] dialoq qutusunda
• En: 8mm
• Hündürlük: 8mm
4. [OK] düyməsini klik edin. 
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Şəkil 9-2: Yeni iş lövhəsinin yaradılması

Şəkil 9-3.: Mətbəx şəklinin qoyulması

 

(Şəkil 9-3) Mətbəx şəklinin qoyulması 
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3) [Shift+Alt+Sürümək] ilə obyektin kopya-lan-
ması. 
1. [Selection Tool: V]-ni seçin. 
• Dairə seçin. 
2. [Ctrl+C] düyməsini basıb saxlayın. 
• [Ctrl+Shift+V] düyməsini dörd dəfə sıxaraq 
dairəni kopyalayın. (dairələrin ümumi sayı 5 ol-
malıdır) 
3. Kopyalanmış hər bir obyekti seçin. 
• [Shift+Alt] düyməsini basıb sax-lamaqla 
obyekti sürüyərək ölçünü tənzimləyin. 
4. [Shift+Alt] düymələrini basıb saxlayaraq 
obyektləri sağ tərəfə sürüyüb kopyalayın. 

4) [Character] panelinin parametrlərini tənzim-
ləyin. 
1. [Character] panelini aşağıdakı kimi təyin edin: 
• Şrift: Wide Latin
Şrift ölçüsü: 29pt
• Dolğu rəngi: C 0%, M 0%, Y 0%, K 60%
2. [Type Tool: T] ilə mətni yazın.
• Mətn: “SCHOOL HOUR” (Məktəb saatı)
3. [Character] panelində altyazı seçimini aşağı-
dakı kimi təyin edin:  
• Şrift: Nueva Std
• Şrift ölçüsü: 15pt
4. Mətni yazın: “BEGINNING AM” (Başlama), 
“CLOSING PM” (Bitmə)
5. Vaxt şrifti üçün [Character]-i qurun.  
• Şrift: Dutch 801 Rm BT (Roman)
• Şrift ölçüsü: 15pt
6. Mətni yazın: “09:00”, “15:00”

5) Obyektlərin dairənin ortasından kənarına doğ-
ru yerləşdirilməsi.  
1. [Selection Tool: V]-ni seçin. 
2. Hər bir dairəni seçib dolğu rəngini aşağıdakı 
kimi təyin edin;
• 1-ci: C0%, M0%, Y0%, K80%
• 2-ci: C0%, M0%, Y0%, K0%
• 3-cü: C21%, M12%, Y46%, K0%
• 4-cü: C0%, M74%, Y84%, M0%
• 5-ci: C0%, M0%, Y0%, K100%  
3. [Shift + Ctrl + ]] düyməsi ilə obyektləri yer-

Şəkil 9-4.:  Dairələrin kopyalanması

Şəkil 9-5:  Mətnlərin yazılması

Şəkil 9-6:  Rəng tənzimləmələri
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ləşdirin.

6) Sağdakı dairələrin rənginin soldakılar kimi tə-
yin edilməsi
1. [Eyedropper Tool: I]-ni seçin.
2. Sağdakı dairələrin rəngini soldakı dairələrin 
rəngi ilə eyni edin. 
3. Bütün obyektləri seçin. 
4. [Ctrl + 2] düyməsini sıxın. 

7) Xətti 12 saat istiqamətinə çəkin.
1. Keçidi görmək üçün [Ctrl+Y] düymələrini 
klik edin.  
• Xətkeşi göstərmək üçün [Ctrl+R] düyməsini 
sıxın. 
2. Sol xətkeşi mərkəzə sürüyün. 
3. Xətkeşi sağ dairənin mərkəzinə sürüyün.
4. [Pen Tool: P]-ni seçin. 

5. Xətti düzəltmək üçün beşinci dairə üzərində 
12 saat istiqamətinin nöq-təsini klik edin.
6. Xətti düzəltmək üçün ikinci dairə üzərində 12 
saat istiqamətinin nöq-təsini klik edin.

8) Birinci kiçik dairənin mərkəz nöqtəsi 
təməlində xətti fırladın. 
1. [Ctrl + Y] düyməsini bir daha sıxın. 
•  [View]-[Outline]-a gedin. 
2. Xətti seçin.
3. [Rotate Tool: R]-ni seçin.  
4. Alt düyməsini basıb saxlayaraq əsas dairənin 
mərkəzini klik edin.
5. [Rotate] dialoq qutusunda parametrləri aşağı-
dakı kimi təyin edin:
• Öncədən baxış: Yoxlamaq
6. Bucaq: 30°
7. [Copy] düyməsini klik edin.

 

(Şəkil 9-7) Gözdamcısı pipeti 
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9) Dairəni bölmək üçün xəttin çəkilməsi 
1. [Ctrl + D]-ni 10 dəfə klik edin. 

2. Saat, dəqiqə əqrəbinin çəkilməsi
1) [Layers] panelində yeni qat yaradın.
1.  [Create New Layer] düyməsini klik edin.
2. [Ctrl + “] ilə şəbəkəni göstərin. 
3. Qat 1-də gözü gizlədin.
4. [Rectangle Tool: M] ilə düzbucaqlı çəkin. 
• Dolğu rəngi: C0%, M0%, Y0%, M60%
• Xətt rəngi: None
• En: 2.5mm
• Hündürlük: 48mm
5. [OK] düyməsini klik edin.

2) Poliqon aləti ilə üçbucaqlının çəkilməsi
1. [Tools] panelindən [Polygon Tool]-u seçin.
2. Düzbucaqlının aktındakı nöqtəni klik edin.
3. Poliqon dialoq qutusunda aşağıdakı para-
metrləri tənzimləyin:
• Radius: 4.5mm
• Tərəflər: 3 
4. [OK] düyməsini klik edin.

3) Yuvarlaq künclərlə künc dairənin yaradılması 
1. [Selection Tool: V] üçbucaqlı obyektini seçin. 
2. [Effect]-[Stylize]-[Round Corners]-ə gedin. 
3. [Round Corners] dialoq qutusunda para-
metrləri aşağıdakı kimi qurun:
• Radius: 3mm
4. Öncədən baxış: Yoxlamaq
5. [OK] düyməsini klik edin. 

4) [Polygon Tool] ilə üçbucaqlının çəkilməsi  

Şəkil 9-10:  Saat/ Dəqiqə əqrəbi

Şəkil 9-12:  Stil effekti

Şəkil 9-13:  Stil effekti
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1. Shift düyməsini basılı saxlayaraq düzbu-
caqlını seçin.
2. [Horizontal Align Center] ikonunu klik edərək 
mərkəzə düzüm edin. 
3. [Polygon Tool]-u seçin. 
4. Düzbucaqlının yuxarı nöqtəsinə klik edin. 
5. [Polygon] dialoq qutusunda parametrləri 
aşağıdakı kimi qurun:
• Radius: 3mm
• Tərəflər: 3
6. [OK] düyməsini klik edin. 

5) [Pathfinder] paneli ilə obyektlərin birləşdir-
ilməsi
1. Obyekt keçidini göstərmək üçün [Ctrl+Y] 
düymələrini sıxın. [Selection Tool: V]-ni seçin. 
2. Alt düyməsini basılı saxlayaraq siçanı sürüyüb 
seçilmiş obyekti kopyalayın. 
3. Poliqon obyektinin çərçivə qutusunu 180° 
dərəcə döndərin:
• Onu hərəkət etdirin və obyekti romb şəklində 
yerləşdirin.
4. [Pathfinder] panelində [Unite] ikonunu klik 
edin:
• Obyektləri birləşdirin. 

6) Romb fiqurunun künclərinin tənzimlənməsi
1. [Direct Selection Tool: A]-nı seçin. 
2. Rombun sağ əsas nöqtəsini seçin.  
3. [Control] panelində parametrləri aşağı-dakı 
kimi təyin edin:
• Künclər: 2mm

7) Rombun böyüdülməsi 

 

(Şəkil 9-14) Dəqiqə əqrəbinin çəkilməsi 
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1. [Control] panelində eyni şəkildə sol əsas 
nöqtəni seçin:

• Küncləri 2mm təyin edin.
• Əsas nöqtəni 1mm yuxarı və aşağı tənzimləyin.
2. [Selection Tool: V] ilə rombu seçin.
• Obyekti kopyalamaq üçün [Shift+Alt] 
düymələrini basılı saxlayaraq obyekti sürüyün.
3. (Şəkil 9-17)-də olduğu kimi rombu böyüdün.

8) Obyekin üfüqilik mərkəzində düzülməsi
1. [Ctrl+Y] düyməsini sıxın.
2. [Selection Tool] ilə dörd obyekt seçin.
3. [Align] panelində 
• [Horizontal Align Center] ikonunu klik edin. 
• Obyektləri üfüqilik mərkəzində düzün. 

9) Saatın mərkəzinə dəqiqə əqrəbinin ucunu yer-
ləşdirin.  
1. [Layers] panelindən qat 1-in göz ikonunu klik 
edin. 
• Mətni və saat şəklini göstərin.
2. Saatın mərkəzinə dəqiqə əqrəbinin ucunu yer-
ləşdirin.  

10) Kopyalanmış saat əqrəbinin dolğu rənginin 
müəyyən olunması
1. [Selection Tool: V] ilə dəqiqə əqrəbini seçin.
2. [Rotate Tool: R]-ı seçin. 
3. Alt düyməsini basıb saxlayaraq saatın mərkəz-
ini klik edin. 
4. [Rotate] dialoq qutusunda
• [Preview] qutusunu yoxlayın. 
• [Angle]-ı “90°” dərəcə edin.
5. [Copy] düyməsini klik edin.  

Şəkil 9-17: Horizontal düzüm mərkəzi

Şəkil 9-18: Dəqiqə əqrəbinin yerləşdirilməsi

Şəkil 9-19: Fırlatmaq və kopyalamaq
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6. [Fill color]-ı aşağıdakı kimi təyin edin:
• C 0%, M 0%, Y 0%, K 90%

11) Üfüqi olmaq üçün saat və dəqiqə əqrəbi 
ucunun fırladılması
1. Sağ saatın saat əqrəbi və dəqiqə əqrəbi ucunun 
yerini dəyişin və eyni şəkildə kopyalayın.
2. Şaquli olması üçün saat əqrəbini və dəqiqə 
əqrəbin ucunu fırladın. 

[ Digər şəkildə]
11.1  Saat əqrəbini 270° dərəcə fırladın.

1. [Rotate Tool: R]-ı seçin.
2. Alt düyməsini basılı saxlayaraq saatın mərkəz-
ini seçin.   
3. [Rotate] dialoq qutusu
• [Preview] qutsunu yoxlayın.
• [Angle]-ı “270°” qurun.
4. [OK] düyməsini klik edin.

12) İki saatın tənzimlənməsi
1. [Fill color]-ı dəyişin. 
• Ağ rəngi təyin edin.
2. [Character] panelindən Şrifti təyin edin. 
• Şrift ölçüsü: 12pt
3. [Type Tool: T] ilə rəqəmləri daxil edin.

Şəkil 9-20: Sağ saat əqrəbi_A növü

Şəkil 9-20: Sağ saat əqrəbi_A növü

Şəkil 9-22: Məktəb saatı şəklinin 
tamamlanması
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• Sol saatda yazı “9” 
• Sağ saatda yazı “3” 
4. Məktəb saatını tamamlayın.

13) Tamamlanmış şəkilin yaddaşa verilməsi
1. [File]-[Export]-a gedin.
2. [Export] dialoq qutusunda
• Fayl növü: *.JPEG (*.JPG)
3. [Export] düyməsini klik edin.

14) “JPEG” parametrlərinin təyin olunması 
1. [JPEG Options] dialoq qutusunda
2. Keyfiyyət: Maksimum
3. Dəqiqlik: High (300ppi)
4. [OK] düyməsini klik edin. 

 

Şəkil 9-23: JPEG parametrləri
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Transformasiya alətinin aydın şəkildə izah etməyi bacaracaq;
2.   Mövcud tekstura ilə banneri mükəmməl şəkildə yaratmağı biləcək. 

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Effektlər 
1) İllüstrator istifadəçinin obyektə, qrupa və ya hər hansı bir qata onun xüsusiyyətlərini dəy-

işmək üçün tətbiq etdiyi müxtəlif effektlərdən ibarətdir. 
1. İstifadəçi obyektə effekt tətbiq etdikdə həmin effekt görünüş panelində meydana çıxır.
2. Görünüş panelindən effekti redaktə etmək mümkündür. Redaktəyə köçürmək, çoxaltmaq, 

silmək və ya qrafik stilinin bir hissəsi kimi yaddaşa vermək daxildir. 
3. İstifadəçi effekti istifadə etdikdə əvvəlcə obyekti böyütməli və ya genişləndirməlidir. 

2) Effektlər menyusunun yuxarı yarısındakı effektlər vektor effektlərdir. 
1. İstifadəçi bu effektləri yalnız vektor effektlərində və ya görünüş panelində nöqtəli təsvir (bit-

map) obyektini doldurmaq üçün tətbiq edə bilər. 
2.  Aşağıdakı effektlər və yuxarı sıradan effekt xüsusiyyətləri bu qaydanın istisnalarıdır. Həm 

vektor, həm də nöqtəli təsvir (bitmap) obyektinə tətbiq oluna bilər.
• 3D effektləri, SVG filtrləri, Warp effektləri, transformasiya effektləri, kölgə düşməsi, Feather, 

daxili parıltı və xarici parıltı
3) Effektlər menyusunun aşağı yarısındakı effektlər raster-skan effektləridir. İstifadəçi onları 

vektor və ya bitmap obyektinə tətbiq edə bilər. 

1.1 Effektin tətbiq olunması
1. Obyekt və ya qrupu seçin. (Və ya qatlar panelinden hədəf qatı seçin)
• Əgər istifadəçi obyektin spesifik simvoluna effekt tətbiq etmək istəyirsə əvvəlcə obyekti daha 

sonra isə görünüş panelindən simvolu seçməlidir. 
2. Aşağıdakılardan birini edin: 
• Effektlər menyusundan bir əmr seçin.
• Görünüş panelindən [Add New Effect]   -i, daha sonra isə istədiyiniz effekti seçin. 
3. Dialoq qutusu meydana çıxırsa parametrləri tənzimləyin və [OK] düyməsini klik edin. 

10. Canlı tekstura i̇lə banneri̇n yaradılması
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※ Qeyd: 
Ən son istifadə edilən parametrləri və effekti tətbiq etmək üçün Effect>Apply [Effect Name]-i 

seçin. 

1.2 Raster-Skan effekti 
1) Raster-Skan effektləri vektor məlumatları yerinə piksel yaradan effektlərdir.
• Raster-skan effektinə SVG filtrləri, effektlər menyu panelinin aşağı hissəsində olan bütün ef-

fektlər daxildir. Eyni zamanda? kölgə düşməsi, daxili parıltı, xarici parıltı da həmçinin.
• Və Effect>[Stylize submenu]-da Feather əmri

2) İllüstratorda RIE (Resolution Independent Effects) vasitəsi aşağıdakıları etməyə imkan verir:
• Sənəd Raster-Skan Effektləri Parametrlərində (DRES) dəqiqlik dəyişildikdə effektlərdə para-

metrlər başqa dəyər qazanır. Belə ki, effektin görünüşündə minimal dəyişiklik olur və ya heç bir 
dəyişiklik olmur.  

• Effekt dialoq qutusunda yeni dəyişiklik tətbiq olunmuş dəyərlər əks etdirilir. 
• Bir parametrdən daha çox effekt almaq istədikdə illüstrator yalnız skan effektlərinin həlli ilə 

bağlı parametrlərə yenidən məna verir.

3) Misal üçün, Halftone Pattern dialoq qutusunda müxtəlif parametrlər var. Amma Raster-Skan 
Effektləri Parametrləri dəyişildikdə yalnız ölçü dəyəri dəyişilir.

4) İstifadəçi Effect>[Document Raster Effects Settings]-i seçərək sənəd üçün pikselləşdirmə 
parametrlərini aktiv edir. 

※ Qeyd: 
Əgər effekt ekranda yaxşı görünürsə, amma çap edildikdə detalları və görünüşü itirirsə sənədin 

raster-skan effektləri dəqiqliyini artırın. 

1.3 Pikselləşdirmə parametrləri
• İstifadəçi sənəddə piksel effektləri üçün və ya vektor obyektini pikselləşdirən zaman aşağıdakı 

parametrləri tənzimləyə bilər:
1) Rəng modeli
1. Pikselləşdirmə zamanı istifadə olunan rəng modelini seçir. 
2. İstifadəçi RGB və ya CMYK rəng görünüşündə boz rəng çalarları və ya 1 bit görünüşü 

(seçilən parametrdən asılı olaraq qara, ağ və qara və ya şəffaf) yarada bilər. 

2) Pikselləşdirmə
1. Pikselləşdirilmiş şəkildə inch-ə görə piksellərin rəqəmini təyin edir. 
2. Vektor obyektini pikselləşdirən zaman ümumi dəqiqlik parametrlərini istifadə etmək üçün 

Raster-Skan Effektləri dəqiqliyini istifadə etməyi seçin.

3) Arxa fon
1. Vektor qrafiklərinin şəffaf sahəsinin piksellərə necə konvert olunmasını müəyyən edin. 
2. Şəffaf sahələri ağ piksel ilə doldurmaq üçün ağ, arxa fonu şəffaf etmək üçün isə şəffaf rəngləri 

seçin.
3. Əgər istifadəçi şəffafı seçirsə o,1 alfa kanalı yaradır (1 bit təsvirlərindən başqa bütün təsvirlər 

üçün) 
• Şəkil Photoshopa eksport olunursa alfa kanalı saxlanılır. (Bu, şəkilin fərqli tonda piksellərə sa-

hib sahəsinin kənarında ara tonlara sahib piksellər yaratmaq, qırpma maskasından daha yaxşıdır).
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4) Anti-alias
1. Pikselləşdirilmiş şəkildə çıxıntılı kənarların görünüşünü azaltmaq üçün tətbiq olunur.
2. Sənəd üçün pikselləşdirmə parametrlərini tətbiq etdikdə incə xətlərin Canlılığını saxlamaq 

üçün bu seçimi ləğv edin.
3. Vektor obyektini pikselləşdirdikə anti-aliasing tətbiq etməmək üçün və pikselləşdirdikdə xət-

tin kəskin kənarlarını saxlamaq üçün None-nı seçin.  
4. Yazı olmadan şəklə ən çox uyğun olan anti-aliasing tətbiq etmək üçün Art Optimized seçilir.

5) Kəsim maskasının yaradılması
1. Pikselləşdirilmiş şəklin arxa fonunun şəffaf görünməyi üçün maska yaradın.
2. Əgər istifadəçi arxa fon üçün şəffaflığı seçirsə kəsim maskasını yaratmağa ehtiyac yoxdur.

6) Obyekt ətrafının əlavə olunması
• Pikselləşdirilmiş təsvir ətrafına müəyyənləşdirilmiş piksel rəqəmlərini əlavə edərək sərhəd və 

ya dolğunu (araqat) əlavə edin. Nəticədə meydana çıxan görüntünün ölçüləri orijinal ölçülər olaraq 
və obyekt ətrafının əlavə olması parametr dəyərləri ilə görünür. 

1. İstifadəçi bu parametrləri məsələn, anlıq görüntü effekti (snapshot) yaratmaq üçün istifadə 
edir. 

• Ətraf obyekt əlavə olunması parametrləri üçün dəyəri müəyyənləşdirin ağ arxa fonu seçin, 
amma kəsim maskasının yaradılmasını seçməyin.

• Orijinal obyektə əlavə olunmuş ağ sərhəd təsvirin görünən sərhədi olur. 
• İstifadəçi orijinal şəkili təsvirə bənzətmək üçün xarici parıltı və kölgə düşməsi effektlərini 

tətbiq edə bilər. 

1.4 Bitmap təsvirlərinə effektlərin tətbiq edilməsi 
1) Effektlər bitmap şəkillərinə və həmçinin vektor obyektlərinə xüsusi görünüş verməyə şərait 

yaradır. 
• Misal üçün, istifadəçi işıqlandırma dəyişikliyini tətbiq edə, şəkilləri təhrif edə və digər maraqlı 

vizual effektlər yarada bilər. 
2) Xüsusilə bitmap obyektlərinə effektləri tətbiq etdikdə aşağıdakı məlumatları nəzərə alın:
1. Effektlər bir-biri ilə əlaqəli olan bitmap obyektlərində işləmir.
• İstifadəçi bağlı bitmap üçün effekt tətbiq etdikdə həmin effekt orijinal bitmap əvəzinə qa-

tışdırılmış kopyaya tətbiq olunur.
• Effekti orijinala tətbiq etdikdə istifadəçi orijinal bitmapi sənəddə saxlamalıdır.
2. Adobe Illustrator Adobe Photoshop məhsullarından və Adobe olmayan proqram təminatın-

dan plug-in effektlərini dəstəkləyir. 
• Quraşdırılan zaman effekt menyusunda əksər plug-in effektləri meydana çıxır və built-in ef-

fektləri ilə eyni qaydada işləyir.
3. Xüsusilə yüksək pikselli bitmap şəkillərinə tətbiq edilən zaman bəzi effektlərin yaddaşı çox 

ola bilər.  

1.5 Effektivliyin artırılması
1) Bəzi effektlərin yaddaşı çoxdur. 
2) Bu effektləri tətbiq edən zaman aşağıdakı texnikalar effektivliyin artırılmasına köməklik 

göstərəcək:
1. Arzu olunmayan nəticələrin qarşısını almaq üçün və vaxta qənaət etmək üçün effekt dialoq 

qutusundan öncədən baxışı seçin. 
1. Tənzimləmələri dəyişin. Bəzi əmrlərin (Glass kimi) yaddaşı çoxdur.
• Surəti artırmaq üçün müxtəlif parametrləri yoxlayın. 
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2. Əgər siz boz rəng çalarlarını çap etməyi planlayırsınızsa effektləri tətbiq etməzdən qabaq 
bitmap təsvirinin kopyasını boz rəng çalarına konvert edin. 

• Qeyd etmək lazımdır ki, bəzi hallarda effektin bitmap təsvirinə tətbiq edilməsi və onun boz 
rəng çalarına konvert edilməsi eyni effektin birbaşa şəklin boz rəng çalarına tətbiq edilməsi ilə 
eyni nəticəni verməyə bilər. 

1.6 Effekti dəyişdirmək və silmək
1) İstifadəçi görünüş panelini istifadə edərək effekti dəyişdirə və ya silə bilər.
1. Effektləri istifadə etmək üçün obyekt və ya qrupu seçin.
2. Aşağıdakılardan birini tətbiq edin:
• Effekti dəyişdirmək üçün görünüş panelində altından xətt çəkilmiş mavi adı seçin. Effektlər 

dialoq qutusunda istədiyiniz dəyişiklikləri edin və daha sonra [OK] düyməsini klikləyin. 
• Effekti silmək üçün görünüş panelində sadalanmış effekt siyahısını seçin və silmək düyməsini 

klik edin. 

4) Əgər istifadəçi mətni seçirsə və ya kursoru mətnə əlavə edirsə, Simvol stilləri və paraqraf 
Stilləri panelində aktiv stillər seçilir.  

• Misal üçün, sənəddə hər bir simvol Normal Simvol, hər bir paraqraf isə Normal Paraqraf Stili 
kimi təyin olunur.  

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. PhotoShop ilə mətnin dizayn olunması
1) [Photoshop]-u istifadə etmək. 
1. Mənbə faylından “BKhouse_Neonsign.psd” 
adlı nümunə faylını açın.
2. Kərpic arxa fonu və mətn formalı obyekti əv-
vəlcədən təmin edin.

2) “Type copy” adlı qatın yaradılması
1. [Type] qatını seçin.
2. Qatı kopyalamaq üçün  [Ctrl+J] düymələrini 

Şəkil 10-1: Photoshop faylı

 

(Şəkil 10-1) Photoshop faylı 
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Şəkil 10-2: Yeni qat

Şəkil 10-3: Opacity 36%

Şəkil 10-4: Opacity 100%

Şəkil 10-5: Add a layer Style

sıxın. 
3. [Type copy] qatını yaradın. 

3) Yazı qatının parametrlərini dəyişdirmək
1. [Type] qatını seçin.
2. [Blending Mode]-a gedib [Opacity]-ni “36%” 
edin. 

4) “Type copy” qatının parametrlərini dəyişin. 
1. [Type copy] qatını seçin.
2 Blending Mode]-u [Linear Light] edin.
3. [Opacity]-ni “100%” edin.

5) “Type” qatına “Inner Glow” effektinin ver-
ilməsi
1. [Type] qatını seçin. 
2. [Add a layer Style]-ı klik edin.
3. [Inner Glow] alt menyusunu seçin. 

 

Ctrl + J  

(Şəkil10-2) Yeni qat 

2 

1 3 

 (Şəkil 10-3> Opacity 36% 

1 

2 

 

2 

 Qatlar panelindən ‘Type Copy’ qatını seçin. 1 

3 

(Şəkil 10-4) Opacity 100% 

 

(Figure 10-5) Add a layer Style 

1 

2 

3 
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3

1
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Ctrl+J

Qatlar panelindən ‘Type Copy’ qatını seçin.
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6) [Layer Style] pəncərəsindən [Inner Glow] 
parametrlərini tənzimləyin.
1. Qarışdırma rejimi: Ekran (Screen) 
2. Qeyri-şəffaflıq: 80%
3. Rəng: #F27EA8
4. Mənbə: Mərkəz (Center)
5. Ölçü: 15px
6. Kontur: Xətti (Linear)
7. Aralıq: 50%
8. [OK] düyməsini klik edin.

7) [Layer Style] pəncərəsindən [Xarici parıltı] 
parametrlərini tənzimləyin.
1. Qarışdırma rejimi: Linear Light (Xətti işıq)
2. Qeyri-şəffaflıq: 57%
3. Rəng : # EF4889
4. Yayılma: 21%
5. Ölçü: 76px
6. Kontur: Linear  
7. Aralıq: 50%
8. [OK] düyməsini klik edin.

8) Mətnə yayılma şəklində işıq effektinin tətbiq 
olunması

2. Ellips aləti ilə simvolun çəkiləsi
1. Bələdçi xəttinin çəkilməsi
2.  [Ellipse] aləti ilə ovalı geniş formada sağa və 
sol tərəfə çəkin.
3. Kopyalanmış obyekti sol tərəfə köçürün.
 
 
3. Pathfinder-in icra edilməsi
1) Pathfinder palitrasının aktivləşdirilməai
1. [Window> Pathfinder]-ə gedin.
2. Obyekti seçin
• Fiqur rejimi 

2) Şəkili aydın şəkildə yerləşdirin.
1. [Object> Expand> Appearance]-ə gedin.
2. Faylı ‘Make a funny symbol mark’ kimi yadd-
aşa verin.

 

(Şəkil 10-6) Daxili parıltı 
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4 
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Şəkil 10-6: Daxili parıltı

Şəkil 10-7: Xarici parıltı

Şəkil 10-8: Xarici parıltı

Şəkil 10-9: Bevel Emboss submenu
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(Figure 10-9> Bevel Emboss submenu 
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Yarım dairə kontur

Şəkil 10-10: Daxili əyri parametrləri

Şəkil 10-11: Kontur parametrləri

Şəkil 10-12: Daxili parıltı parametrləri

Şəkil 10-13: Daxili parıltı parametrləri

3) [Layers] panelindən Bevel Emboss para-
metrlərinin tənzimlənməsi
1. [Layers] panelindən [type copy] qatını seçin.
2. [Add a layer Style] düyməsini klik edin. 
3. [Bevel Emboss]-a gedin. 

4) [Layer Style] pəncərəsində [Inner Bevel]-i 
tənzimləyin.
1. Stil: Daxili əyri (Inner Bevel)
2. Dərinlik: 100%
3. İstiqamət: Yuxarı ( Up)
4. Ölçü: 10px
5. Bucaq: 0°
6. Hündürlük: 85
7. Parlaq kontur: Xətti (Linear)
8. Vurğulama rejimi: Xətti işıq (Linear Light)
9. Qeyri-şəffaflıq: 100%
10. Kölgə rejimi: Artan (Multiply)
11. Qeyri-şəffaflıq: 50%

5) [Layer Style] dialoq pəncərəsində [Bevel Em-
boss]-un sol siyahısından [Contour]-u tənzimlə-
yin. 
1. [Contour]-u yoxlayın.
2. Kontur: Yarım dairə

6) [Layer Style] pəncərəsində [Inner Glow]-un 
tənzimlənməsi.
1. [Inner Glow]-u yoxlayın.
2. Qarışdırma rejimi:  Xətti işıq (Linear Light)

 

3 
2 

1 

(Şəkil 10-11) Kontur parametrləri 

 

Yarım dairə kontur 

 

(Şəkil10-12> Daxili parıltı parametrləri 
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(Şəkil 10-13) Daxili parıltı parametrləri 
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3 Qeyri-şəffaflıq: 59%
4. Rəng: #F9C4DB
5. Mənbə: Mərkəz (Center)
6. Ölçü: 11px
7. Kontur: Yuvarlaq addımlar (Rounded Steps)
8. Aralıq: 50%

137ow]-nun tənzimənməsi
1. [Drop Shadow]-nu klik edin.
2. Qarışdırma rejimi: Artan (Multiply)
3. Qeyri-şəffaflıq: 79%
4. Bucaq: 21°
5. Ümumi işıqdan istifadə: Yoxlayın (Check IN)
6. Məsafə: 8px
• Yayılma: 0%
Ölçü: 15px
7. Kontur: Xətti (Linear)
8. [OK] düyməsini klik edin.

8) Mətn obyektinə neon işarə effektinin tətbiq 
olunması
1. Faylı [BKHouse.psd] kimi yaddaşa verin.
• [Ctrl + S ] düyməsini sıxın. 

4. Sement divarı kimi arxa fonun hazırlan-
ması
1) Yeni iş lövhəsinin yaradılması
1. İş lövhəsi parametlərini tənzimləyin.
• Ad: Ai 10
• Ölçü: A4
• Orientasiya: Şaquli
• Rəng rejimi: CMYK
• Pikselləşdirmə effektləri: Yüksək (300ppi)
2. [Create Document] düyməsini klik edin.
2) 10% ölçü kiçiltmədə Banner çərçivəsinin 
hazırlanması
1. [Rectangle Tool: M ]-i seçin.
2. [Rectangle] obyektini çəkin.
• En: 60mm
• Hündürlük: 180mm

 

Yaddaşa vermək: Ctrl + S  

(Şəkil 10-14) Neon işarə effekti 

 

(Şəkil10-15) Yeni sənəd 

1 

2 

Şəkil 10-14: Neon işarə effekti

Şəkil 10-15: Yeni sənəd

Şəkil 10-16: Banner çərçivəsi

Şəkil 10-17:  Şəbəkə

 

(Şəkil 10-16) Banner çərçivəsi 
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(Şəkil 10-17) Şəbəkə 

Qısayol düyməsi V 

Klik 

1 

3 

2 

1

2

3

1

2

3

1

2

Yaddaşa vermək: Ctrl + S 

Klik

Qısayol düyməsi V
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3. [OK] düyməsini klik edin.
4. Rəngi dəyişin:
• C0%, M0%, Y0%, K100%

3) Düzbucaqlıya şəbəkə effekti vermək 
1. [Selection Tool: V]-ni seçin. 
2. Düzbucaqlı obyektini seçin.
3. [Effect] menyusuna gedin.
• [Sketch]-[Reticulation]-a gedin.

4) [Reticulation] dialoq qutusunda parametrlərin 
tənzimlənməsi
1. [Reticulation] sseçımlərini aşağıdakı kimi tə-
yin edin:
• Sıxlıq: 16
• Ön plan səviyyəsi: 50
• Arxa fon səviyyəsi: 31
2. [OK] düyməsini klik edin.

5) Düzbucaqlıya [Reticulation] effektinin ver-
ilməsi
1.  [Selection Tool: V]-ni seçin. 
2. Düzbucaqlı obyektini seçin. 
3. [Effect]-ə gedin.
• [Texture]-[Craquelure]-ə gedin. 

6) [Craquelure] dialoq qutusunda parametrləri 
tənzimləmək
1. [Craquelure] parametrlərini aşağıdakı kimi tə-
yin edin:
• Çat boşluğu: 100

Şəkil 10-18:  Şəbəkə parametrləri 

Şəkil 10-19:  Kraklür  

Şəkil 10-20:  Teksturaların növü

Şəkil 10-21:  Kraklür parametrləri

Şəkil 10-22:  Barelyef

Kraklür effekti (Divarabənzər)

 

(Şəkil 10-18) Şəbəkə parametrləri  

1 

2 

 

(Şəkil10-19) Kraklür   

Shortcut Key: V 

Klik 

3 

1 
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(Şəkil10-20) Teksturaların növü 

 

Kraklür effekti (Divarabənzər) 

 

1 

2 

(Şəkil 10-21) Kraklür parametrləri 

 

   Qısayol düyməsi: V 1 

Klik 2 

(Şəkil10-22) Barelyef 
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2 Klik

Qısayol düyməsi V1
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• Çat dərinliyi: 4
• Çat parlaqlığı: 10
2. [OK] düyməsini klik edin. 

7) Düzbucaqlı obyektinə [Bas Relief] vermək
1. [Selection Tool: V]-ni klik edin. 
2. Düzbucaqlı obyektini seçin.
3. [Effect] menyusuna gedin
• [Sketch]-[Bas Relief]

8) [Bas Relief] dialoq qutusunda parametrlərin 
tənzimlənməsi
1. [Bas Relief] parametrlərini aşağıdakı kimi tə-
yin edin:
• Detal: 14
• Hamarlılıq: 2
• İşıq: Aşağı (Bottom)
2. [OK] düyməsini klik edin.

9) Dəyişdirilmiş arxa fonun ilk dəfə se-
mentəbənzər şəkildə düzəldilməsi
1.  [Rectangle Tool: M]-i seçin.
2. Düzbucaqlının sol yuxarı nöqtəsinə klik edin. 
3. [Rectangle] seçim pəncərəsində (dialoq qutu-
su) parametrləri aşağıdakı kimi dəyişin:
• En: 60mm
• Hündürlük: 180mm
4. [OK] düyməsini klik edin.
5. [Fill color]-ı aşağıdakı kimi dəyişin:
• C 0%, M 0%, Y 0%, K 100%
• Xətt rəngi: None

10) Düzbucaqlı obyektinin parametrlərinin tən-
zimlənməsi
1. [Selection Tool: V]-ni seçin.
2. Qara düzbucaqlını seçin
3. Düzbucaqlının yuxarısından [Opacity]-ə
• Qarışdırma rejimi:  Artan (Multiply)

 

1 

2 

Şəkil 10-23:  Barelyef parametləri

Şəkil 10-24:  Sementəbənzər düzbucaqlı

Şəkil 10-25: Qeyri-şəffaflıq və qarışdırma 
rejimi

Barelyef təsiri (Sementəbənzər qara)

 

(Şəkil10-24) Sementəbənzər düzbucaqlı 
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Qısayol düyməsi: V 1 

Klik 2 

 

Barelyef təsiri (Sementəbənzər qara) 

 

(Şəkil 10-25) Qeyri-şəffaflıq və qarışdırma rejimi 

Qısayol 
düyməsi: V 
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4. Qeyri-şəffaflıq: 85%

※ [Object] vəziyyətində
• Bir və ya birdən çox obyekti ifadə etmək üçün 
[Effect] və ya [Blend Mode] funksiyalarını isti-
fadə edin.

11) Obyektlər ilə qrup yaratmaq
1. Boş sahədən seçmək üçün bütün obyektləri 
sürüyün. 
2. Obyektləri seçin. (iki obyekt)
3. Ayrılmamaq üçün bir qrup obyekt düzəldin.

5. Müxtəlif teksturaları nümayiş etdirməklə 
Bannerin dizayn olunması
1) “Place”-i istifadə edərək Photoshop faylının 
(*.psd) açılması
1. [Shift + Ctrl + P] düymələrini basın.
•  [File]-[Place] menyusuna gedin. 

2. [Place] seçim pəncərəsində 
• Mənbə faylından [BKHouse.psd] faylını alın. 
3. [Link]-ə klik işarəsi qoyun.
4. [Place] düyməsini klikləyin.  

2) Mətnin Photoshopdan alınması 
1. Photoshop ilə düzəldilmiş mətnin istədiyiniz 
yerdə və istədiyiniz ölçüdə yerləşdirilməsi

3) Bannerin məzmununu ardıcıl olaraq yazmaq 

Şəkil 10-26: Obyektlərin qruplaşdırılması

Şəkil 10-27: Yerləşdirmək parametri

Şəkil 10-28: Photoshop faylının 
əlaqələndirilməsi

 

İki obyekt Sürümək 1 

3 

2 

Ctrl + G 

(Şəkil10-26) Obyektlərin qruplaşdırılması 

 

(Şəkil10-27) Yerləşdirmək parametri 
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(Şəkil 10-28) Photoshop faylının 
əlaqələndirilməsi 
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1. [Text Tool: T]-ni seçin. 
2. Mətni yazın.
• Mətn 1: “DESIGNER WORLD”, 18pt 
C 35%, M 86%, Y 0%, K 0%
• Mətn 2: “2020.12.31”, 30pt
C 0%, M 0%, Y 0%, M 0%
• Mətn 3: “BAKU STUDIO 123”, 21pt
C 0%, M 0%, Y 0%, K 0%
• Mətn 4: “+994 12 111 1111”, 18pt
C 38%, M 93%, Y 36%, K 10%
3. Mətn əmrini bitirmək üçün Ctrl düyməsi ilə 
birgə arxa fonun boş sahəsinə klik edin.
4. Mətn rəngini dəyişdirin.

4) [Key Object] ilə mətn obyektinin düzülməsi
1. Bütün obyektləri seçin.
2. Arxa fon obyektinə bir daha klik edin.
3. [Key Object]-i aşağıdakı kimi müəyyən edin:
• [Align] panelini seçin.
• [Horizontal Align Center] parametrini tənzim-
ləyin.
 

5) Faylı [Include Linked Files] kimi yaddaşa 
vermək
1. Faylı yaddaşa vermək üçün  [Ctrl+S] qısa yol 
düyməsini klik edin.  
2. [Save As] seçim pəncərəsində
• Yaddaşa vermək üçün yer müəyyənləşdiricini 
təyin edin. 
3. Fayl adını müəyyən edin. 
4. [Save] düyməsini klik edin.
5. [Illustrator Options] pəncərəsində
• [Include Linked Files]-ni seçin. 
※ Qeyd:
Yaddaşa verilmiş fayl sənədi  [Link] para-
metrində yerləşdirilmiş Photoshop şəklini 
özündə birləşdirir.
6. [OK] düyməsini klik edin.

 

T 1 

  Klik edin və sonra mətni yazın 2 

(Şəkil 10-29) Mətnlərin 
yazılması Şəkil 10-29: Mətnlərin yazılması

Şəkil 10-30: Əsas obyekt

 

Arxa fon obyektinə klik edin. 
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Hamısını seçin 1 

(Şəkil10-30) Əsas obyekt 
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  Klik edin və sonra mətni yazın2
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6. Şəkilin EPS fayl kimi yaddaşa verilməsi
1) 10% kiçildilmiş obyektin real ölçüyə tənzim-
lənməsi
1. [Ctrl+A ] düyməsi ilə bütün obyektləri seçin.
2. [Transform] panelində
• [Proportion Constrain]-ni 
klik edin.
3. [Width]-ə “600mm” daxil 
edin.
4. [Enter] düyməsini basın.

2) A4 iş lövhəsinin “600mm x 1800mm” real 
ölçüsünə tənzimlənməsi
1. [Shift+O] ilə [Artboard Tool]-u seçin. 
2. Nəzarət rejimində
• Alt düyməsini basılı saxlayaraq siçanı iş lövhə-
si sərhəd qutusunun kənarından çölə doğru 
sürüyün.  
3. V düyməsini sıxaraq tənzimləmələri tamam-
layın.

3) Mətni haşiyələmək üçün [Create Outlines]-ın 
tətbiq edilməsi
1. [Ctrl+A] ilə bütün obyektləri seçin.

Şəkil 10-32: Ölçünü real ölçüyə dəyişdirmək

Şəkil 10-31: Əlaqələndirilmiş faylların 
daxil edilməsi.

 

Kimi yaddaşa vermək: Ctrl + S 
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(Şəkil10-31) Əlaqələndirilmiş faylların daxil edilməsi. 

 Save Locator: 2 

Yaddaşa 
vermək 

Fayl  adı: Ai_10 Banner 3 
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(Şəkil10-32) Ölçünü real ölçüyə dəyişdirmək 
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2. Obyektlərə [Create Outlines]-ı tətbiq edin. 
• [Shift+Ctrl+O] qısa yol düyməsini istifadə 
edin. 
• [Type]-[Create Outlines]

4) En və hündürlükdə 2 mm haşiyə yaratmaq 
1. Arxa fon obyektini klik edin.
2. [Transform] panelində
• Məhdudiyyət nisbətini ləğv edin. 
3. Eni və hündürlüyü tənzimləyin. 
• En: 602mm
• Hündürlük: 1802mm
4. [Reference Point]-i [Center]-ə tənzim-ləyin. 

5) Arxa fona [Rasterize] effektinin tətbiq olun-
ması 
1. Arxa fon obyektinə və neon işarə şəklinə klik 
edin. 
2. [Object], [Rasterize]-ı seçin.
3. [Rasterize] parametr pəncərəsi göründükdə 
• Rəng rejimi: CMYK
• Dəqiqlik: Yüksək (300ppi)
• Arxa fon: Ağ
4. [Options] bölməsində
• [Create Clipping Mask]-ı klik edin. 
5. [Ok] düyməsini basın. 

6) Pikselləşdirilmiş şəkilin qaydaya salınması
1. Bir şəkildə pikselləşdirilən bütün obyektəri 
qaydaya salın. 

 V    Shift + O 

   Alt + sürümək 

(Şəkil 10-33) İş lövhəsi (600mm x 1800mm) 

1 

2 

3 

Şəkil 10-33: İş lövhəsi (600mm x 1800mm)

Şəkil 10-34: Haşiyənin yaradlması

Şəkil 10-35: Kəsim ölçüsü

 
   Ctrl + A 

   Haşiyələrin yaradılması [Shift + Ctrl + O] 

(Şəkil 10-34) Haşiyənin yaradlması 
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(Şəkil 10-35) Kəsim ölçüsü 
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7) Fayl ilə bağlı xətaları yoxlamaq üçün [Docu-
ment Info] panelini seçin. 
1. [Ctrl+A] ilə bütün obyektləri seçin. 
2. [Windows] menyusundan [Document Info] 
panelini seçin. 
3. [Document Info]-nun yuxarı sağ tərəfində  
Pop-up alt menyusunu seçin. 
4. [Objects]-i seçin.  
5. Əgər xəta yoxdursa bütün obyektləri seçin.
• [Ctrl+G] ilə qrup yaradın.

8) Şəkli real ölçüdə kəsmək üçün kəsim xəttinin 
düzəldilməsi
1. [Rectangle Tool: M]-i seçin.
• Arxa fon ekranının boş hissəsinə klik edin. 
2. [Rectangle] seçim pəncərəsində
• En: 600mm
• Hündürlük: 1800mm
3. [OK] düyməsini klik edin. 
4. [Fill color] və [Line color] üçün None seçin. 

9) Qruplaşdırılmış dizayn və yeni yaradılmış kə-
sim xəttinin düzülməsi
1. Qruplaşdırılmış dizaynı seçin. 
2. Yeni yaradılmış kəsim xəttini seçin.
• Kəsim xəttini [Shift+Click] ilə klikləyin. 
3. [Align] panelində
• Seçilmiş obyektə [Horizontal Align Center] və 
[Vertical Align Center]-i tətbiq edin. 
4. [Fill color] və [Line color] üçün None seçin. 

Şəkil 10-36: Effekti pikselləşdirmə

Şəkil 10-37: Şəkillərin növləri

Şəkil 10-38: Document Info.

(Ümumi rejim)      (Eskiz rejimi)

 

(Şəkil 10-36) Effekti pikselləşdirmə 
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10) Faylın [Illustrator EPS] kimi yaddaşa ver-
ilməsi 
1. İşlənən faylı yaddaşa vermək üçün  [Shift+C-
trl S] düymələrini sıxın. 
2. Yaddaşa vermək üçün [Locator]-ı təyin edin. 
3. əkilə uyğun [File Name] yazın.
4. [File Format]-ı “Illustrator EPS” kimi təyin 
edin.
5. [Save] düyməsini klik edin. 
6. [EPS Parametrləri] dialoq qutusunda variant-
ları “10 EPS-dən daha aşağı” kimi tənzimləyin.
7. [OK] düyməsini klik edin. 

 

(Şəkil 10-39) Həqiqi kəsim xəttinin müəyyən edilməsi  

1 

2 

3 4 

Şəkil 10-39: Həqiqi kəsim xəttinin 
müəyyən edilməsi 

Şəkil 10-40: Obyektlərin düzülməsi

Şəkil 10-41: Illustrator EPS kimi yaddaşa 
vermək
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(Şəkil 10-40) Obyektlərin düzülməsi 
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(Şəkil 10-41) Illustrator EPS kimi yaddaşa vermək 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Transformasiya alətini aydın şəkildə izah etdi?
2. Canlı tekstura ilə mükəmməl şəkildə banner yaratdı?
3. Obyekt üçün dəqiq şəkildə effekt menyusunun növlərini tətbiq 
etdi?
4. Görünüş panelində aydın şəkildə effekti sildi?
5. Qat (Layer) stil dialoq qutusunda xarici parıltı (Xarici parıltı) 
parametrini tətbiq etdi?
6. Qatlardan “Bevel Emboss” parametrini dəqiq şəkildə tətbiq etdi?
7. Arxa fon rəngini aydın şəkildə digər rəngə dəyişdirdi?
8. Mətn xəttinə düzgün şəkildə rəng təyin etdi?
9. Arxa fona pikselləşdirmə effektini verdi?
10. Tamamlanmış banneri Illustrator EPS faylı kimi yaddaşa verdi?
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Premiere

Sənaye və İnnovasiyalar üzrə 
Bakı Dövlət Peşə Təhsil Mərkəzi

Səriştə əsaslı 
modul İKT
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İKT

Ön söz 

 “Adobe Premiere Pro” Adobe Systems tərəfindən yaradılan və Adobe Creative Cloud lisen-
ziyalaşdırma proqramının bir hissəsi kimi dərc edilən video redaktə proqramıdır. 2003-cü ildə 
yaradılan “Adobe Premiere Pro” Adobe Premiere-in (1991-ci ildə yaradılıb) davamçısıdır. 
Bu proqram peşəkar videoların redaktə edilməsinə yönəlib, “Adobe Premiere Elements” isə 
müştəri bazarını hədəfləyir.   
 CNN Adobe Premiere-in ilk tətbiqedicisidir. BBC departamentləri Premiere-i ilk dəfə 2007-ci 
ildə qəbul ediblər. Bu proqram “Deadpool”, “Gone Girl”, “Captain Abu Raed”, “Monsters”  kimi 
filmləri və “Maddonun Etiraflar Turu” bədii filmini redaktə etmək üçün istifadə edilib. 
Premiere Pro həm RGB, həm də Yuvda kanal rəngi üzrə 32 bitə qədər (10,240×8,192) yüksək 
səviyyəli görüntü imkanı üçün video redaktəni dəstəkləyir. 
 Səs nümunə səviyyəli redaktə, VST audio plug-in dəstəyi və çevrəsəl səs düzəni mövcuddur.  
Premiere Pro-nun plug-in arxitekturası MacOS və Windowsda video və audio fayl formatlarını 
dəstəkləyən QuickTime və ya DirectShow tərəfindən dəstəklənən formatlardan əlavə digər for-
matları da idxal və ixrac edir. Adobe Premiere “Cineform's Neo” ilə istifadə zamanı sol və sağ göz 
tənzimləmələrini edərkən 2D monitorları istifadə edərək 3D redaktəni dəstəkləyir. 
 Professional bazarı hədəfləyən Premiere Pro-nun multikamera redaktoru, vaxtın təkrarlanması, 
əhatə dairəsi, qabaqcıl rəng düzəldici alətlər və qabaqcıl audio mikser interfeysi də daxil olmaqla 
Premiere Elements üzərində üstünlükləri var. 
 Bundan başqa Premiere Pro daha detallı DVD and Blu-ray Disc yazarlıq seçimi ilə diskə birbaşa 
qeyd üçün OnLocation seçiminə sahibdir. Qeyd edək ki, Encore-un buraxılması “Adobe Creative 
Cloud” tərəfindən dayandırılıb.
 Bu modulun əsas fərqləndirici xüsusiyyəti piktorial sistemi qəbul etməsidir. Bu modul dərsliyinin 
konsepsiyası içərisində rəqəmlər yazılan cümlələrdən daha vacib rol oynayır. 
 Texniki təhsilə/təlimə bağlı olaraq tələbələr sözlərdən daha çox rəqəmlər ilə texniki məzmunu 
daha aydın başa düşür. Faktiki olaraq söz rəqəmin performansını izah etmək üçün dəstəkləyici 
vasitədir. 
 Yekun olaraq mən çoxsaylı mənbələrə, xüsusilə YouTube, Yahoo, Wikipedia, “www.gilbut.co.kr”, 
“www.hyejiwon.co.kr” və Google saytlarına təşəkkür edirəm. Onlar mənə texniki təcrübə modulu 
dərsliyinin hazırlanmasında köməklik etdilər. 

                YUN, Hyung Soon, IKT üzrə Texniki Ekspert
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Premiere alətinin komponentlərini əminliklə izah edəcək;
2.   Müxtəlif yollarla hərəkətli animasiya düzəltməyi biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Premiere proqramının ekran elementləri   

1. Ki̇çi̇k nöqtə i̇lə nöqtə loqosu növünün 
hazırlanması

 

(Şəkil 1-1) Ekran elementləri 
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Şəkil 1-1: Ekran elementləri
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○,1 Menyu: 8 əmrdən ibarətdir.
○,2 Panel menyusunun növləri: Panel Menyularının növlərindən ibarətdir. 
○,3 Audio klip qarışdırma paneli: Nəzarətlər 
○,4 Mənbə paneli: Audio, video və s. toplayır. 
○,5 Layihə paneli: Mənbəyə nəzarət edir. Şəkil redaktəsi və onların göstərilməsi üçün qaynaq 
və elementə nəzarət edir.  
○,6 Alətlər paneli:
○,7 Proqram monitor paneli:
○,8 Timeline paneli:
○,9 Audio meter paneli:
○,10 Effektlər paneli: 
○,11 Başlıq xüsusiyyətləri paneli:

2. Layihə paneli (Project Panel)
2.1 Layihə paneli görünüşlərinin dəyişilməsi
1) İstifadəçi aktivi əldə etdikdən sonra onun adı proyekt panelində görünür. 
• Layihə paneli istifadənin layihəsi haqqında, hər bir aktiv haqqında detallı məlumatı si-

yahılaşdırır. 
• İstifadəçi aktivləri List view və ya Icon view-da çeşidləyə və görüntüləyə bilir. 
• List view hər bir aktiv haqqında əlavə məlumatlar nümayiş etdirir. 
• İstifadəçi layihənin ehtiyaclarını qarşılamaq üçün göstərdiyi məlumatları fərdiləşdirə bilər.  

Şəkil 1-2: Layihə paneli seçimləri
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Şəkil 1-2: Layihə panelinin əsas elementləri

    A. List view B. Zoom slider C. Automate to sequence D. Find E. New Bin F. New item G. 
Clear

2.2 Layihə panelinin əsas şərtləri 
1) Bir görünüşdən digərinə keçmək üçün List View   düyməsini və ya panelin aşağısından 

Icon View   düyməsini klik edin. Alternativ olaraq View>List və ya Project Panel menyusundan 
View>Icon-u klik edin. 
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A. List view B. Zoom slider C. Automate to sequence D. Find E. New Bin F. New item G. Clear 
H. Icon   view I. Clip used in a sequence J. Clip contains both audio and video K. Playhead for 
scrubbing the thumbnail 

3. Timeline panel funksiyası
3.1 Timeline animasiya iş axışı
1) Timeline rejimində qat (layer) məzmununu animasiya etmək üçün
• İstifadəçi Timeline panelində əsas çərçivəni yaradır və cari vaxt indikatorunu digər fərqli vaxt 

çərçivəsinə dəyişir. Daha sonra istifadəçi qatın yerləşmə mövqeyini, qeyri-şəffaflığını və ya stilini 
dəyişir. 

• Photoshop avtomatik olaraq iki çərçivə arasındakı bir sıra çərçivəni əlavə edir və dəyişdirir. 
Hərəkət və ya transformasiya görünüşü yaratmaq üçün yeni çərçivələr arasında qat xüsusiyyətləri-
ni (yerləşmə mövqeyi, qat xüsusiyyətləri və qeyri-şəffaflıq) dəyişdirin. 

2) Misal üçün, əgər hər hansı bir qatı qaraltmaq istəyirsinizsə qeyri-şəffaflığı başlanğıc çərçivədə 
100% olaraq qurun və qat üçün xronometri klik edin. 

• Cari vaxt indikatorunu vaxt/çərçivəyə dəyişin və qeyri-şəffaflığı eyni qat üçün 0% qurun. 
• Photoshop avtomatik olaraq başlanğıc və son çərçivələr arasında çərçivələri interpolasiya edir 

və qatın qeyri-şəffaflığı yeni çərçivələrə bərabər azaldılır.
3) Photoshop-un animasiyadakı çərçivələrə interpolasiya etməsinə icazə verməklə yanaşı isti-

fadəçi boş video qatında əllə çəkilmiş animasiya da yarada bilər.  

※ Qeyd: 
Əgər SWF format animasiyası yaratmaq istəyirsinizsə Adobe Flash, Adobe After Effects və ya 

Adobe Illustrator istifadə edin. 

3.2 Timeline əsaslı animasiya yaratmaq üçün aşağıdakı ümumi qayları istifadə edin.

1) Yeni sənəd yaradın.
1. Ölçü və arxa fon məzmunlarını müəyyənləşdirin. 
• Ölçülərin və Piksel aspekt əmsalının istifadəçi animasiyasına uyğun olduğundan əmin olun. 
• Rəng rejimi RGB olmalıdır. 
• İstifadəçinin dəyişiklik etmək üçün xüsusi səbəbi olmadıqda düzbucaqlıda dəqiqliyi 72 piksel/

inch, dərinliyi 8 bpc edin. 
2. Timeline panelinin açıq olduğundan əmin olun. 
• Əgər lazımdırsa aşağı düşən oxu panelin ortasına klik edin və menyudan Create Video Time-

line-nı seçin.
• Sonra oxun solundakı düyməni klik edin. 
• Əgər Timeline paneli çərçivə animasiya rejimindədirsə, panelin aşağı sol küncündə Convert 

To Video Timeline ikonunu klik edin.  
2) Panel menyusunda Timeline Frame Rate funksiyasını seçin. 
1. Müddət və çərçivə dərəcəsini müəyyənləşdirin. 
3) Qat əlavə edin.
1. Arxa fon qatları animasiya oluna bilməz. 
2. Əgər istifadəçi məzmunu animasiya etmək istəyirsə ya arxa fon qatını normal qata dəyişməli, 

ya da aşağıdakılardan birini əlavə etməlidir:
• Əlavə olunan məzmun üçün yeni qat
• Video məzmunu əlavə etmək üçün yeni video qatı
• Məzmunu kopyalamaq və ya əllə çəkilmiş animasiyalar formalaşdırmaq üçün yeni boş video 

qatı
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4) Qata məzmun əlavə edin.
5) Qat örtüyü yaratmaq (istəyə bağlı olaraq)
1. Qat örtüyü qatın məzmununun bir hissəsini aşkar etmək üçün istifadə edilə bilər.
• İstifadəçi qatın məzmununun müxtəlif hissələrini müəyyən etmək üçün qat örtüyünü anima-

siya edə və ya canlandıra bilər. 
6) Cari vaxt göstəricisini ilk əsas çərçivəni qurmaq istədiyiniz yerə köçürün.
7) Qat xüsusiyyətləri üçün əsas çərçivələməni (keyframing) aktiv edin. 
1. Qat adının qarşısındakı üçbucağı klik edin. 
• Aşağı işarəedicisi olan üçbucaq qat xüsusiyyətlərini nümayiş etdirir. 
2. Sonra istifadəçinin canlandırmaq istədiyi qat xüsusiyyətləri üçün xronometri klik edərək ilk 

əsas çərçivəni qurun. 
• İstifadəçi, eyni zamanda birdən çox qat xüsusiyyətləri üçün əsas çərçivəni qurur.
8) Cari vaxt göstəricisini köçürün və qat xüsusiyyətlərini dəyişin.
1. Cari vaxt göstəricisini qat xüsusiyyətlərinin dəyişdiyi çərçivəyə köçürün. 
2. İstifadəçi aşağıdakılardan birini və ya bir neçəsini edə bilər:
• Qat məzmununun yerini dəyişmək üçün qatın yerləşmə mövqeyini dəyişin.
• Məzmunun qaralması və ya işıqlanması üçün qatın qeyri-şəffaflığını dəyişin. 
• Qatın müxtəlif hissələrini müəyyən etmək üçün qat örtüyünün yerləşmə mövqeyini dəyişin. 
• Qat maskasını açın və bağlayın. 
3. Obyekt rənginin dəyişdirilməsi, çərçivədə məzmunun tamamilə dəyişdirilməsi kimi anima-

siyanın bəzi növləri üçün istifadəçinin yeni məzmun ilə əlavə qatlar yaratmasına ehtiyac yaranır.
※ Qeyd: 
Fiqurları canlandırmaq üçün istifadəçi Vector Mask Position və ya Vector Mask Enable xrono-

metri istifadə edərək fiqur qatına əlavə olaraq vektor qatını canlandırır. 

9) Məzmun ilə başqa qatlar əlavə edin və onların qat xüsusiyyətlərini ehtiyac olan şəkildə re-
daktə edin. 

10) Qatın animasiyada nə zaman görünəcəyini müəyyən etmək üçün qat müddəti sətrini nizam-
layın.

11) Animasiyaya öncədən baxış
1. Animasiyaları hərəkət etdirmək üçün Timeline panelində nəzarətləri istifadə edin. 
• İstifadəçi veb brazuerində animasiyaya öncədən baxış edin. 
• İstifadəçi həmçinin animasiyaya Save For Web dialoq qutusunda öncədən baxa bilər. 
12) Animasiyanın yaddaşa verilməsi
1. İstifadəçi animasiyanı Save for Web əmrini istifadə edərək canlandırılmış GIF kimi və ya 

Render Video əmrini istifadə edərək şəkil sıralaması kimi yaddaşa verə bilər. 
2. İstifadəçi onu həmçinin Adobe After Effects-ə import olunan PSD format kimi də yaddaşa 

verə bilər. 

4. Effekt nəzarətləri panelinin tənzimlənməsi
4.1 Hərəkət effektinin nəzarət sseçımləri
• Effekt nəzarətləri paneli yerləşmə, ölçü, qeyri-şəffaflıq və s. kimi video klipin əsas effektlərini  

tənzimləyir.
1. Yerləşmə: Piksel vahidində hündürlük və enə nəzarət edir. 
2. Şkala və ya ölçü: Faiz vahidində video ölçüsünə nəzarət edir.
3. Birnövlü ölçü: İşarəyə (ikon) nəzarət etsəniz genişlik və hündürlük ölçüsünü fərqli olaraq 

təyin edə bilərsiniz. 
4. Fırlatma və ya çevirmə: Videoları fırladan zaman vahid [rotation numberrotation angle] ilə 

işarə olunur. 
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5. Künc nöqtəsi: Videonun mərkəz oxunu tənzimləyir. [Program Monitor panel]-dən bucaq 
nöqtəsini yoxlamaq üçün monitora klik edin.

6. Titrəməyə qarşı filtr: Videonun titrəyən görüntüsü olduqda ‘0~1’ aralığını silərək effekti təyin 
edin.

4.2 Qeyri-şəffaflıq sseçımlərini bilmək
• Qeyri şəffaflıq və qarışdırma rejimlərində (Opacity and Blend mode) görünüşün başlanğıcını 

və son səhnə dəyişimini ifadə etmək mümkündür.
• Qarışdırma rejimi (Blend mode) ilə istifadəçi bir çox şəkili üst-üstə qoyaraq müxtəlif görüntü 

rejimləri yaradır. 

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Hərəkətli şəkil düzəltmək
1) Yeni layihə yaradılması
1. [Project] paneli boşluğunda iki dəfə klik edin. 
• Əsas menyu sətrindən [Ctrl+I], [File]-[Im-
port]-a gedin. 
2. İşləmək üçün mənbə faylından faylı seçin. 
• Faylı import edin: ‘basketball.png’
3. [Ctrl+N] düymələrini basın və ya
• Basketbol şəkli üzərində siçanın sağ düyməsini 
klik edərək yeni seçim ikonunu seçin.
4. [Sequence…] seçiminə gedin. 

2.) Sequence] sseçımlərinin tənzimlənməsi
1. [Settings]-i seçin. 
2. [Settings] seçimlər pəncərəsində 
• Redaktə rejimi: Custom

 4 

2 

3 

1 

(Şəkil 1-3) Yeni layihə 
Şəkil 1-3: Yeni layihə

3

4

1
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• Timebase: 30.00frames/second
• Çərçivə ölçüsü: 1920/1080
• Piksel ölçüsü: Square Pixels (1.0)
• Sequence Adı: Position_01
3. [OK] düyməsini klik edin. 

3) ‘basketball.png’ elementini şəkildəki kimi 
sürüyün. 
1. ‘Project’ panelində daxil edilmiş ‘basketball.
png’-ni klik edin.
2. [Timeline] panelinin ‘V1’ sətrinə elementi 
sürüyün.

4) ‘Effect Controls’ panelində [Scale]-i tənzim-
ləyin. 
1. ‘Timeline’ panelindən ‘basketball.png’-ni 
seçin.
2. [Effect Controls] panelində şkalanı ‘15’ edin. 
• [Effect Controls]-[Scale] 

5) ‘Program Sequence 01 Panel-01’-ın yuxarı 
sol küncündə obyekti hərəkət etdirin. 
1. [00;00;00;00 yerləşməsində ‘Toggle anima-
tion’ ikonunu    aktivləşdirin. 
• [Effect Controls]-[Motion]-[Position]
2. [Position]-ı ‘150/215’-ə qurun. 

Şəkil 1-4: Sequence (Sıralama) parametrləri

Şəkil 1-5: Elementin sürünməsi 

Şəkil 1-6: Şkala (Scale Option) 
parametrlərinin tənzimlənməsi
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6) ‘Timeline View’-da avtomatlaşdırılmış əsas 
çərçivəni düzəldin. 
1. Cari vaxt indikatorunu [00;00;02;00]-ə tən-
zimləyin. 
2. [Position] seçimini ‘1750/240’ edin. 
• ‘Timeline View’ menyusunda avtomat-
laşdırılmış əsas çərçivəni (Automate Keyframe) 
düzəldin.   
3. [Program Monitor] panelində şəkilin yerləşmə 
yerini yoxlayın.

7) Cari vaxt indikatorunun köçürülməsi
1. Cari vaxt indikatorunu [00;00;01;00]-a qurun. 
2. [Position] seçimini‘1000/960’ edin.
3. [Program Monitor] panelində şəkilin yerləşmə 
yerini yoxlayın.

8) ‘Program Monitor’ panelində ‘Motion’ 
(hərəkət) keçidinin yoxlanması
1. [Effect Controls] panelində [Motion] seçimini 
klik edin.  

2. Qatın düzgün olmayan hərəkətini yoxlayın.
• Başlanğıc və sonda əsas çərçivəyə Bezier əyrisi 
tətbiq edin.  

9) ‘Spatial Interpolation’-dan ‘Linear’ funksi-
yasının işlədilməsi 
1. Shift düyməsini basılı saxlayaraq birinci və 
üçüncü əsas çərçivəni seçin. 
2. Üzərində siçanın sağ düyməsini klik edin.  

 

(Şəkil 1-7) Yerləşmə mövqeyi seçiminin tənzimlənməsi 
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Şəkil 1-7: Yerləşmə mövqeyi seçiminin 
tənzimlənməsi

Şəkil 1-8: İkinci yerləşmə mövqeyinin 
tənzimlənməsi

Şəkil 1-9: Üçüncü yerləşmə mövqeyinin 
tənzimlənməsi

 

1
S
q
u
e
r 

2
S
q
u
e
r 

3
S
q
u
e
r 

(Şəkil 1-8> İkinci yerləşmə mövqeyinin tənzimlənməsi 
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• [Spatial Interpolation]-[Linear]-ə gedin. 

3. [Linear]-ı klik edin. 

10) Hər ikisinin təbii olub-olmadığını yoxlamaq 
üçün ‘Program Monitor’ panelində başlanğıc və 
son nöqtəni yoxlayın. 
1. [Program Monitor] panelində Bezier əyrisini 
redaktə edin. 
• Parabolik keçidi daha gözəl şəkildə çəkmək 
üçün Bezier tutacağını genişləndirin.
2. Enter düyməsini basaraq ‘Rendering’-i işlə-
din.  
3. Spacebar düyməsini sıra ilə basaraq ‘Pre-
view’-nu (öncədən baxış) işlədin.

 
2. Ölçünü dəyişmək üçün animasiya düzəlt-
mək
1) ‘Scale Effects’-in (Şkala effektləri) para-
metrlərini tənzimləyərək şəkil ölçüsünə nəzarət 
edin. 
• [% unit] ilə video ölçüsünə nəzarət edin. 
• Şəkil ölçüsünü dəyişin. 
• ‘Zoom In/Out’ effektini istifadə edin. 
• Şəkil ölçüsünü sağa, sola, yuxarı və aşağı 
genişləndirin və kiçildin. 
1. Şkala hündürlüyü (Scale Height): Şəkilin yux-
arı və aşağı ölçüsünə nəzarət edir. 
2. Şkala eni: Şəkilin sağ və sol ölçüsünə nəzarət 
edir.
3. Vahid şkala: Element incələndikdə şəkilin sağ 
və sol ölçüsünə birlikdə nəzarət etmək müm-
kündür. 

2) Yeni layihənin yaradılması
1. [Project] panelinin sahəsində iki dəfə klik 

Şəkil 1-9: Motion (hərəkət) keçidi

Şəkil 1-10: Linea rfunksiyasının işlədilməsi

Şəkil 1-11: Animasiyanın hərəkət etdirilməsi
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edin.
• Əsas menyu sətrindən [Ctrl+I], [File]-[Im-
port]-a gedin. 
2. Mənbə qovluğundan faylı seçin.
• Faylı import edin: ‘ballon.png’
3. [Ctrl+N] düyməsini sıxın və ya
• Top şəkli üzərində siçanın sağ düyməsini klik 
edərək ‘New Item’ ikonunu seçin. 
4. [Sequence…] seçimini işlədin.

3. [Sequence] seçiminin tənzimlənməsi 
1. [Settings]-i seçin. 
2. [Settings] seçimlər pəncərəsində 
• Redaktə rejimi (Editing Mode): Custom
• Timebase: 30.00frames/second
• Çərçivə ölçüsü (Frame Size): 1920/1080
• Piksel Aspekt əmsalı (Pixel Aspect Ratio): 
Square Pixels (1.0)
3. Sıralama adı (Sequence Name): Position_01
4. [OK] düyməsini klik edin. 

4) ‘ballon.png’-ni Timeline mərkəzinə sürüyün.
1. ‘Project’ panelində daxil edilmiş ‘ballon.png’ 
elementini klik edin.
2. Elementi [Timeline] panelinin ‘V1’ sırasına 
sürüyün.
3. [Timeline] panelində [ballon.png]-ni klik edin. 

 

(Şəkil 1-11) Şkala (Scale) seçimləri 
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Şəkil 1-12: Şkala (Scale) sseçımləri

Şəkil 1-13: Yeni layihə

Şəkil 1-14: Sıralama (Sequence) Sseçımləri
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5) ‘Effect Controls’ panelində şkalanın tənzim-
lənməsi
1. Cari vaxt indikatorunu [00;00;00;00]-a dəy-
işin.
2. [Scale] seçimində ‘Toggle Animation’   
ikonunu dəyişin. 
• [Motion]-[Scale]-ə gedin. 
3. [Effect Controls] panelində [Scale]-i ‘30’-a 
qurun.
• [Effect Controls]-[Scale] 

6) Program panelində ikinci əsas çərçivənin tən-
zimlənməsi
1. Cari vaxt indikatorunu [00;00;01:;0]-a dəy-
işin.
2. [Scale]-i ‘300’-ə qurun.
• Avtomatik olaraq yeni əsas çərçivə yaradın.

7) Program panelində üçüncü əsas çərçivənin 
tənzimlənməsi.
1. Cari vaxt indikatorunu [00;00;02;00]-ə dəy-
işin.
2. [Scale] ‘30’-a qurun. 

8) Topun daha böyük və daha kiçik olması üçün 
animasiya hərəkətini təsdiqləyin. 
1. Əsas çərçivəni [00:00:00:00] nöqtəsinə 
köçürün. 
2. Top ölçüsünün dəyişimini yoxlamaq üçün 

Şəkil 1-15: Şəkilin sürünməsi

Şəkil 1-16: Tənzimləmə şkalası

Şəkil 1-17: İkinci əsas çərçivənin 
tənzimlənməsi

Şəkil 1-18: Üçüncü əsas çərçivənin 
tənzimlənməsi

 

(Şəkil 1-14) Şəkilin sürünməsi 
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[Spacebar] düyməsini sıxın.

 
3. Fırlanan animasiyanın çevrilməsi
1) Fırlatma effektlərinə nəzarət edilməsi
• [Rotation numbers x Rotation Angle] ilə şəkili 
çevirin. 
• Künc nöqtəsi ilə şəkili müxtəlif istiqamətlərə 
fırladın. 
1. Fırlatma və ya döndərmə: [rotation number x 
rotation angle] ilə vahid işarə olunur və videolar 
fırladılır.  
2. Künc nöqtəsi: Videonun mərkəz oxunu təyin 
edir. Yoxlamaq üçün [Motion] seçiminə klik 
edin. 
3. Titrəməyə qarşı filtr: Videonun titrəyən 
görüntüsü olduqda ‘0~1’ aralığını silərək effekti 
təyin edin.
2) Bir neçə dəfə dönən təsvir yaratmaq
1. [Project] panelinin sahəsində iki dəfə klik 
edin. 
• Əsas menyu sətrindən  [Ctrl+I], [File-[Import]- 
a gedin.
2. Mənbə faylından işləmək üçün faylı seçin.  
• Faylı import edin: ‘billiard.png’
3. [Ctrl+N] düyməsini sıxın və ya
• Top şəkli üzərində siçanın sağ düyməsini klik 
edərək ‘New Item’ ikonunu seçin.
4. [Sequence…] seçimini təyin edin.

3) [Sequence] sseçımlərinin tənzimlənməsi
1. [Settings]-i seçin.
2. [Settings] seçimlər pəncərəsində 
• Redaktə rejimi: Custom
• Timebase: 30.00frames/second
• Çərçivə ölçüsü: 1920/1080
• Piksel aspekt əmsalı: Square Pixels (1.0)

 

(Şəkil 1-18) Şəkil ölçüsünü dəyişən animasiya  
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3. Sequence Adı: Pr-01 Rotation_03
4. [OK] düyməsini klik edin. 

4) ‘billiard.png’ elementini timeline-a sürüyün.
1. Layihə panelinə daxil edilmiş ‘billiard.png’-ni 
klik edin.
2. [Timeline] panelinin ‘V1’sırasına ‘Billiard’ el-
ementini sürüyün. 
3. [Timeline] panelində [Billiard.png] klipini 
klik edin. 
4. [Effect Controls] panelinə [Scale]-i ‘30’-a tən-
zimləyin. 

5) ‘Program Monitor’ panelində tel çərçivə və 
bağlama nöqtəsinin göstərilməsi 
1. [Effect Controls] panelindən [Motion] ele-
mentini klik edin. 
2. [Anchor Point]-i ‘640/1280’ edin.
• Bilyard mərkəzinin aşağısına getdiyi yeri yox-
layın. 
6) ‘Toggle animation’ ikonu ilə əsas çərçivənin 
(Keyframe) düzəldilməsi
1. [Effect Controls] panelində [Position] seçimi-
ni ‘960/500’ edin.
2. Cari vaxt göstəricisini klipin başlanma 
nöqtəsinə köçürün. 
3. ‘Toggle animation’ ikonu   ilə əsas çərçivənin 
düzəldin. 

7) ‘Rotation’ (fırlatma) bucağının tənzim-lənmə-
si.
1. Cari vaxt göstəricisini [00;00;01;15] edin. 
2. [Rotation]-i [1080°]-ə qurun. 

Şəkil 1-22: Sıralama (Sequence) 
sseçımlərinnin tənzimlənməsi 

Şəkil 1-23: Setting Scale

Şəkil 1-24:Künc nöqtəsinin tənzimlənməsi

Şəkil 1-25: Əsas Çərçivə ( Keyframe)
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(Figure 1-22> Setting Scale 
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(Şəkil 1-23) Künc nöqtəsinin tənzimlənməsi 
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(Şəkil 1-24>Əsas Çərçivə ( Keyframe) 
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8) Fırlatma bucağının tənzimlənməsi
1. Cari vaxt göstəricisini [00;00;03;00]-a 
köçürün.
2. [Rotation] [0°] təyin edin.

9) Animasiya hərəkətinin yoxlanılması
1. Cari vaxt göstəricisini [00;00;00;00]-a 
köçürün. 
2. [Spacebar] düyməsini basın.
• [Program Monitor] panelində bir neçə dəfə an-
imasiya fırlanmasını yoxlayın.

 

(Şəkil 1-25) 1080° fırlatmanın tənzimlənməsi 

2 

1 

Şəkil 1-26: 1080° fırlatmanın tənzimlənməsi

Şəkil 1-27: 0° fırlatmanın tənzimlənməsi 

Şəkil 1-28: Fırladılmış şəkil
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(Şəkil 1-26) 0° fırlatmanın tənzimlənməsi  
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(Şəkil 1-27)Fırladılmış şəkil 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Premiere alətinin komponentlərini əminliklə izah etdi?
2. Müxtəlif yollarla hərəkətli animasiya düzəltdi? 
3. Layihə panelini aydın şəkildə istifadə etdi?
4. Timeline panel funksiyasını dəqiqliklə istifadə etdi?
5. Effect Control panelini müvafiq şəkildə istifadə etdi?
6. Proqram parametrlərinə aydın şəkildə nəzarət etdi?
7. “Swift Toggle Animation” ikonu ilə animasiyanı işlətdi?
8. Spacebar açar funksiyasından düzgün şəkildə istifadə etdi?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Animasiyada qeyri-şəffaflığı dəyişmək üçün metodu izah edəcək; 
2.   Qeyri-şəffaflığı dəqiqliklə dəyişmək üçün animasiya yaratmağı biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2. Mənbə faylı
3. Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Premiere proqramının ekran elementləri  

2. Qeyri̇ şəffaflıq dəyi̇şmək üçün ani̇masi̇ya 
yaratmaq

 

(Şəkil 1-1) Ekran elementləri 
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Şəkil 2-1: Qeyri-şəffaflığa nəzarət
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1.1 Şəkilin qeyri-şəffaflığının tənzimlənməsi
1) Funksiyalar
1. Klip qeyri-şəffaflıq nəzarəti ilə ya yox olur, ya da şəkil görünüşü meydana çıxır.
2. Üst-üstə düşən ekranlarla şəkildəki transformasiya effektini göstərin. 

2) Aralığın tənzimlənməsi 
1. Qeyri-şəffaflıq dəyəri [%] ilə müəyyən olunur.  
2. Videonun 0 ~ 100% aralığı olur. 

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Davamlı dəyişiklik üçün transparan effekt 
yaratmaq
1) Yeni layihə yaradılması
1. [Project] panelinin sahəsində iki dəfə klik 
edin. 
• Əsas menyu sətrindən [Ctrl+I], [File]-[Import] 
seçiminə gedin.  
2. İşləmək üçün mənbə qovluğundan faylı seçin. 
• Faylı import edin: ‘light.png’
3. [Ctrl+N] düyməsini sıxın və ya
• ‘light.image’ üzərində siçanın sağ düyməsini 
klik edərək ‘New Item’ ikonunu seçin. 
4. [Sequence…] seçimini klik edin. 

2) [Sequence] parametrlərinin tənzimlənməsi
1. [Settings]–i seçin.
2. [Settings] parametrləri pəncərəsində
• Redaktə rejimi (Editing mode): Custom
• Timebase: 30.00frames/second

Şəkil 2-2: Qeyri-şəffaflığa nəzarət üçün 
yeni layihə

Şəkil 2-3: Sequence parametrləri
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(Şəkil 2-2) Qeyri-şəffaflığa nəzarət üçün yeni layihə 

 

(Şəkil 2-3) Sequence parametrləri 
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Şəkil 2-4: Opacity- 0%

Şəkil 2-5: Opacity-nin 100%-ə tənzimlənməsi

Şəkil 2-6: Keyframeslərin kopyalanması

Şəkil 2-7: Kopyalanmış əsas çərçivələri 
yapışdırmaq

• Çərçivə ölçüsü (Frame Size): 1920/1080
• Piksel aspekti əmsalı (Pixel Aspect Ratio): 
Square Pixels (1.0)
3. Sıralama adı (Sequence Name): Pr 02 Opac-
ity_01
4. [OK] düyməsini klik edin. 

3) ‘light.png’ elementini Timeline sahəsinə 
sürüyün. 
1. [Project] panelinə əlavə olunmuş ‘light.png’-
ni klik edin. 
2. Elementi [Timeline]-nin ‘V1’ sətrinə sürüyün.

4) ‘Effect Controls’ panelində ‘Opacity’-nin 
(qeyri-şəffaflığın) tənzimlənməsi 
1. ‘Timeline’ panelindən ‘lightl.png’ klipini 
seçin. 
2. [Effect Controls] panelində ölçünü [Scale] 
‘70’-ə qurun.  
3. Cari vaxt göstəricisini başlama nöqtəsinə 
köçürün. 
4. [Opacity]-ni ‘0%’ təyin edin. 

5) [Opacity]-nin ‘100%’-ə tənzimlənməsi
1. Cari vaxt göstəricisini [00;00;00;00] nöqtəsinə 
köçürün.
2. [Opacity]-ni ‘100%’ təyin edin. 

6) Əsas çərçivənin ‘Rotation’ panelinə kopyalan-
ması
1. Cari vaxt göstəricisini [00;00;01;10]-a 
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2 

 sürüyün 

 

(Şəkil2-5) Opacity-nin 100%-ə tənzimlənməsi 
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köçürün. 
2. [Opacity] -ni‘10%’ təyin edin. 
3. [00;00;00;00] və [00;00;01;10]-nı iki ana 
çərçivəni sürümək üçün seçin. 
4. Onları [Ctrl+C] düyməsi ilə kopyalayın.

7) Cari vaxt göstəricisinin yeni nöqtəyə 
köçürülməsi
1. Cari vaxt göstəricisini [00;00;01;20]-ə 
köçürün.
2. Daha əvvəl kopyalanmış əsas çərçivələri 
yapışdırın. 

8) Cari vaxt göstəricisinin yeni nöqtəyə 
köçürülməsi
1. Cari vaxt göstəricisini [00;00;02;10]-a 
köçürün.
2. [Opacity]-ni ‘100%’ təyin edin. 

9) Cari vaxt göstəricisinin yeni nöqtəyə 
köçürülməsi
1. Cari vaxt göstəricisini [00;00;03;15]-ə 
köçürün.
2. [Opacity]-ni ‘0%’ təyin edin. 

10) Animasiya hərəkətinin yoxlanılması
1. Cari vaxt göstəricisini [00;00;00;00]-a 
köçürün. 
2.[Spacebar] düyməsini sıxın. 
• [Program Monitor] panelində davamlı olaraq 

 

(Şəkil 2-8> Vaxt göstəricisi [00;00;02;10] 

1 2 

Şəkil 2-8: Vaxt göstəricisi [00;00;02;10]

Şəkil 2-9: Vaxt göstəricisi [00;00;03;15]

Şəkil 2-10: Tamamlanmış şəkil

Şəkil 2-11: Effektlər paneli

 

2 
1 

(Şəkil 2-9> Vaxt göstəricisi [00;00;03;15] 

 

(Şəkil 2-10) Tamamlanmış şəkil 

 

(Şəkil 2-11) Effektlər paneli 

12

1
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qeyri-şəffaflığı dəyişmək üçün animasiyanı yox-
layın.

 

2. Ağ/qara rəngdən rəngliyə dəyişmək üçün 
animasiya təsvirinin düzəldilməsi
• Təsvirə ‘Effect’ panelindən müxtəlif effektləri 
tətbiq edin. 
• ‘Effect Controls’ panelində əsas çərçivə təsvirə 
daha detallı effektlər tətbiq edə bilir.

1) Effektlər paneli
1. Video effektlər, audio effektlər, keçid və s. 
daxil edin. 
2. Təsvirə müxtəlif effektlər tətbiq edin. 

2) Effekt nəzarətləri paneli (Effect Controls pan-
el)
1. Tətbiq olunmuş video effektləri tənzimləyin.  
2. Effektlərə daha detallı nəzarət edin. 

 

1) Yeni layihə yaradılması
1. [Project] panelinin sahəsində iki dəfə klik 
edin. 
• Əsas menyu sətirindən [Ctrl+I], [File]-[Im-
port]-a gedin. 
2. Faylı işləmək üçün mənbə qovluğundan seçin. 
• Faylı import edin: ‘jump.mp4’
. ‘jump.mp4’ elementini ‘New Item’ ikonuna   

Şəkil 2-12: Effekt nəzarətləri (Effect 
Controls) paneli

Şəkil 2-13: Dragging Jump.mp4

Şəkil 2-14: Rəng tonunun (Tint) tətbiqi  

Şəkil 2-15: Rəngin ağ/qaraya dəyişilməsi

 

(Şəkil2-12) Effekt nəzarətləri (Effect Controls) paneli 

 

(Şəkil 2-13> Dragging Jump.mp4 
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(Şəkil 2-14) Rəng tonunun (Tint) tətbiqi   

 

(Şəkil 2-15) Rəngin ağ/qaraya dəyişilməsi 
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sürüyərək sıralamanı element ilə eyni edin. 
• jump.mp4’ şəkili üzərində siçanın sağ düyməsi-
ni klik edərək ‘New Item’ ikonunu seçin.
2. [Timeline] panelinin ‘V1’ sətrinə ‘jump.mp4’ 
elementini daxil edin. 
• Ad: Jump

2) [Sequence] parametrlərinin tənzimlənməsi 
1. ‘Effects’ panelində [Tint] effektini göstərin. 
2. [jump.me4] klipinə ‘Tint’ effektini qoyun.

3)  ‘Create 4-point Polygon Mask’      ikonunu 
aktivləşdirin. 
1. Ağ/qara rəngə dəyişdirilmiş şəkili yaddaşa 
verin. 
2. Cari vaxt göstəricisini klipin başlanğıc 
nöqtəsinə qoyun.
3. [Effect Controls] panelində [Tint] effektini 
seçin. 
4. ‘Create 4-point Polygon Mask’      ikonunu 
klik edərək maska elementini aktivləşdirin. 

4) ‘Mask Path’-da ‘Toggle animation’           ikonunu 
klik edin. 
1. ‘Program Monitor’ panelində [Wire Frame]-i 
genişləndirin. 
2. [Mask Path]-da [Toggle animation]         ki-
nonunu klik edin. 

5) Şəklə tətbiq olunmuş effektin təsdiq olunması
1. Cari vaxt göstəricisini [00;00;03;20]-ə dəy-
işin.
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      (Şəkil 2-16) 4-nöqtəli Polygon maskası Şəkil 2-16: 4-nöqtəli Polygon maskası

Şəkil 2-17: Dəyişdirilmiş animasiya

Şəkil 2-18: Rəng dəyişimi (Ağ-qara 
texniki rəngi)

Şəkil 2-19: Tamamlanmış şəkil
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(Şəkil 2-17> Dəyişdirilmiş animasiya 

 Drag 
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(Şəkil 2-18)Rəng dəyişimi (Ağ-qara texniki rəngi) 

 

(Şəkil 2-19) Tamamlanmış şəkil 
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2. Tel çərçivəni sağ tərəfə köçürün.
• ‘Mask Path’-ın əsas çərçivəsini avtomatik 
olaraq düzəldin. 
3. [Mask (1)] effekt elementini klik edin. 

3. [Timeline] panelində işarəni [00;00;00;00]-ə 
köçürün.
4. [Program Monitor] panelində Spacebar 
düyməsini sıxaraq dəyişən hərəkəti yoxlayın.

 
1. Kəsilmiş təsvirin düzəldilməsi
1) Yeni layihənin yaradılması
1. [Project] panelinin sahəsində iki dəfə klik 
edin. 
• Əsas menyu sətrindən [Ctrl+I], [File]-[Im-
port]-a gedin. 
2. Faylı işləmək üçün mənbə qovluğundan seçin. 
• Faylı import edin: ‘Dance.mp4’
3. ‘jump.mp4’ elementini ‘New Item’ 
ikonuna      sürüyərək sıralamanı element ilə eyni 
edin. 
4. ‘Dance.mp4’-u [Timeline] panelinin 
‘V1’sırasına daxil edin. 
• Ad: Dance (Rəqs)

2) Klipi [V2] sırasına kopyalayın. 
1. Effektlər panelində [Crop] effektini göstərin.  

Şəkil 2-20: Kəsim effekti üçün yeni layihə 

Şəkil 2-21: [V2] sırasında kopyalanmış klip 

Şəkil 2-22: [V1] sıranın seçimi

Şəkil 2-23: Hərəkət (Motion) effektinin 
parametrlərinin tənzimlənməsi 

 

(Şəkil 2-20) Kəsim effekti üçün yeni layihə  
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(Şəkil 2-21> [V2] sırasında kopyalanmış klip  

 

(Şəkil 2-22) [V1] sıranın seçimi 
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 <Figure 2-21> Copied Clip in [V2] track 

 

(Şəkil 2-23) Hərəkət (Motion) effektinin parametrlərinin 
tənzimlənməsi  
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2. ‘Crop’ effektini [Dance.me4] klipinə qoyun.
3. [Timeline] panelinin [V1] sətrinə daxil edilm-
iş ‘Dance.mp4’ klipini Alt düyməsini basıb sax-
layaraq [V2]-ə sürüyün.

3) ‘Timeline’ panelindən daxil edilmiş ‘Dance.
mp4’ klipinin seçilməsi.
1. Timeline’ panelində [V2]-nin göz ikonunu gi-
zlədin. 
• Yalnız[V1] sətri göstərin. 
2. [V1]-da ‘Dance.mp4 klipini seçin.

4) ‘Effect Controls’ panelində hərəkət effektinin 
parametrlərinin tənzimlənməsi. 
1. Parametrləri aşağıdakı kimi dəyişin:
• Dəyəri dəyişmək üçün [Motion]-[Position]/
[Scale]-ə gedin. 
• Yerləşmə mövqeyi (Position): ‘960/315’
• Ölçü (Scale): ‘180’

5) Şəkilə‘Crop’ effektinin tətbiq olunması
1. [V2] sətrində göz ikonunu göstərin
3. [V2] sətrinə daxil edilmiş ‘Dance.mp4’ klipini 
seçin. 
3. [Effect Controls] panelində [Crop] effektini 
tətbiq edin. 
• Yuxarı: 35%
• Aşağı: 10%

6) ‘Crop’ effekti tətbiq olunmuş təsvirin təsdiq 
olunması
1. [Anchor Point] və ya bağlama nöqtəsini 
‘960/650’ edin.
• Dəyəri dəyişmək üçün: [Motion]-[Anchor 
Point]
2. Vaxt göstərici işarəsini başlanğıc nöqtəsinə 
köçürün. 
3. Spacebar düyməsini basıb saxlayaraq Crop ef-
fektini yoxlayın. 

 

Spacebar 
Drag 

1 

2 

(Şəkil 2-25) Tamamlanmış kəsim təsviri Şəkil 2-25: Tamamlanmış kəsim təsviri

Şəkil 2-24: [V2] Sətir parametrlərinin 
tənzimlənməsi 

(Şəkil 2-24> [V2] Sətir parametrlərinin tənzimlənməsi 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Animasiyada qeyri-şəffaflığı dəyişmək üçün metodu aydın 
şəkildə izah etdi? 
2. Qeyri-şəffaflığı (Opacity) dəyişmək üçün dəqiq şəkildə animasiya 
düzəltdi? 
3. Qısa yol (Shortcut) düyməsini səmərəli şəkildə istifadə etdi? 
4. Verilmiş şərtlərə uyğun olaraq dəqiq şəkildə qeyri-şəffaflığı tən-
zimlədi?
5. “Rotation” panelindən iki əsas çərçivəni kopyaladı?
6. Təsvirə müvafiq şəklə hərəkət (motion) effektini tətbiq etdi?
7. Şəkilə kəsim (crop) effektini düzgün şəkildə tətbiq etdi? 
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.    Xüsusi rəng effektini əminliklə izah edəcək;
2.   Kinofilmlərdə, monoxrom filmlərdə və xüsusi kamerada rəng duyumunu düzgün şəkildə ifadə 
etməyi biləcək. 

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Simvol və paraqraf stilləri  
Lumetri standartları
• Lumetri rəng paneli və effektləri Premiere Pro-nun ən yaxşı effektlərindəndir.
• İnsterfeysi istifadə edərək video redaktorları və hərəkət dizayn qrafikləri sonra istifadə üçün 

rəng  standartlarını yaddaşa verə və paylaşa bilər. 
1) Premiere Pro CC-də (2017) LUT-nin tətbiq olunması
1. Əgər istifadəçi istifadəçi metrajına LUT tətbiq edirsə brauzer funksiyasını istifadə etmək ən 

asan yanaşma hesab olunur.
2. İstifadəçinin yükləmələr qovluğundan LUT-ni seçin.
3. Premiere Pro-nun yuxarı mərkəz hissəsində rəng işarəsini klik edərək rəng iş sahəsini (Color 

workspace) açın. 
2) Premiere Pro-da LUT-ni necə əlavə etmək olar?
1. İstifadəçinin işləyəcəyi kəsim üzərində klik edin. 
2. Lumetri panelində Basic Correction tabı açın.
3. Basic Correction-ın altında Input LUT dropdown menyusunu seçin.
4. Brauzerə klik edin.

3. Xüsusi̇ rəng standartlarını tətbi̇q etmək
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Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Musiqi videosunun rənginin ifadə olunması
1) Yeni layihəsinin yaradılması 
1. [Project] panelinin sahəsində iki dəfə klik 
edin. 
• Əsas menyu sətrindən [Ctrl+I], [File]-[Im-
port]-a gedin. 
2. İşləmək üçün mənbə qovluğundan faylı seçin. 
• Faylı import edin: ‘Apple Tree.mp4’
3. ‘Apple Tree.mp4’ elementini ‘New Item’ 
ikonuna   sürüyərək sıralamanı element ilə eyni 
edin. 
• ‘Apple Tree.mp4’ şəkili üzərində siçanın sağ 
düyməsini klik edərək ‘New Item’ ikonunu seçin. 
4.  [Timeline] panelinin ‘V1’ sətrinə ‘Apple Tree.
mp4’ elementini daxil edin. 
• Ad: Apple Tree (Alma ağacı)

2) ‘Project’ paneldən ‘Adjustment Layer’-in 
(Tənzimləmə qatı) işlədilməsi
1. [Project] panelində ‘New Item’ ikonunu klik 
edin.
2. [Adjustment Layer]-i seçin. 
3. [Adjustment Layer] seçim pəncərəsində [OK] 
düyməsini klik edin. 

3) [Timeline] panelinin ‘V2’ sətrinə ‘Adjustment 
Layer’-in daxil edilməsi
1. [Timeline] panelinin [V2] sətrinə [Project] 

Şəkil 3-1: Musiqi video rəngi üçün 
yeni layihə

Şəkil 3-2: Tənzimləmə qatı (Adjustment 
Layer)

 

(Şəkil 3-1) Musiqi video rəngi üçün yeni layihə 

2
1 

sürümək 3
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(Şəkil 3-2) Tənzimləmə qatı (Adjustment Layer) 
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Şəkil 3-3: Adjustment Layer-in uzunluq 
kəsimi

Şəkil 3-4: Adjustment Layerin klip uzunluğu

Şəkil 3-5: White Balance tənzimləmələri 

Şəkil 3-6: RGB əyrisi

panelin [Adjustment Layer]-ni daxil edin.  
2.n‘Adjustment Layer’-in klip müddətinə [V1] 
sətrinin [Apple Tree.mp4] klip uzunluğu ilə eyni 
şəkildə nəzarət edin.  

4) ‘Adjustment Layer’ klipinə Lumeri standartı 
effektinin tətbiq edilməsi
1. [Effects] panelinə gedin. 
• [Lumetri Presets]-[Filmstocks]-dən [Fuji F125 
Kodak 2395 (by Adobe)]-u klik edin.  
2. Onu [V2] sətrinin tənzimləmə qatına sürüyün. 

5)  [Effect Controls] panelində Lumetri Standar-
tlarının tənzimlənməsi 
1. [Fuji 125 Kodak 2395 (by Adobe0)-dən [Ba-
sic Correction] seçimini klik edin. 
2. [White Balance]-ı klik edin.
3. Parametrləri aşağıdakı kimi təyin edin:
• Temperatur: ‘20’
• Rəng tonu: ‘50’

6) RGB əyrisində Luma və Qırmızı rəng qrafiki-
nin tənzimlənməsi 
1. Dartaraq luma rəng qrafikini tənzimləyin. 
2. Dartaraq qırmızı rəng qrafikini tənzimləyin. 
• ‘Effect Controls’ panelində [‘Lumetri Color’ 
(Fuji F125 Kodak 2395 (by Adobe))]-[Cur-
ves]-[RGB Curves]-ə gedin. 

 

7) Saturasiya əyrisi rəng tonunu tənzimləmək 
1. Tünd və açıq bənövşəyi rəngi seçin.
• ‘Effect Controls’ panelində [‘Lumetri Color’ 
(Fuji F125 Kodak 2395 (by Adobe))]-[Cur-
ves]-[Hue Saturation Curves]-ə gedin.  
2. Bağlama nöqtələrini dartaraq qrafiki tənzim-
ləyin.

 

(Şəkil 3-2) Tənzimləmə qatı (Adjustment Layer) 
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(Şəkil 3-4)Adjustment Layerin klip uzunluğu 
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(Şəkil 3-5) White Balance tənzimləmələri  
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(Şəkil3-5) RGB əyrisi 
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8) Lumetri rənginin tətbiq olunduğu və olun-
madığı şəkili müqayisə edin.  
1. Lumetri rənginin tətbiq olunmadığı şəkil
• Toggle Effekti: sönülü
2. Lumetri rənginin tətbiq olunduğu şəkil
• Toggle Effekti: yanılı

 
2. Universal Studio filmlərinin rənginin ifadə 
olunması
1) Yeni layihə yaradılması
1. [Project] panelinin sahəsinə iki dəfə klik edin. 
• Əsas menyu sətrindən [Ctrl+I], [File]-[Im-
port]-a gedin.
2. Mənbə qovluğundan işləmək üçün faylı seçin.
• Faylı import edin: ‘Trams.mp4’

3. [OK] düyməsini klik edin. 

2) Eyni sıralamanın ‘Trams.mp4’ kimi düzəldi-
lməsi.
1. ‘Trams.mp4’ elementini “New Item’          konuna   
sürüyərək sıralama elementi ilə eyni edin.  
• ‘Trams.mp4’ şəkili üzərində siçanın sağ 
düyməsini klik edərək ‘New Item’ ikonunu seçin. 

3) [Timeline] panelinin ‘V1’ sətirinə ‘Trams.
mp4’ elementinin daxil edilməsi.
1. [Timeline] panelinin ‘V1’ sətrinə ‘Trams.mp4’ 
elementini daxil edin. 
2. [New Item] ikonunu        klik edin.
3. [Adjustment Layer]-i tətbiq edin.  
4. [Adjustment Layer] seçim pəncərəsində [OK] 

Şəkil 3-7: Saturasiya əyrisi rəng tonu

Şəkil 3-8: Toggle effektini sönülü olduqda

Şəkil 3-9: Toggle effekti yanılı olduqda

Şəkil 3-10: Yeni faylın import olunması

 

(Şəkil 3-6) Saturasiya əyrisi rəng tonu 
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Dartmaq 
Drag 
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(Şəkil3-7) Toggle effektini sönülü olduqda 

 

(Şəkil 3-8) Toggle effekti yanılı olduqda 
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(Şəkil 3-9) Yeni faylın import olunması 
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düyməsini klik edin. 

4) [Timeline] panelinin ‘V2’ sətrinə ‘Adjustment 
Layer’-in əlavə edilməsi
5) [Timeline] panelinin ‘V2’ sətrinə ‘Adjustment 
Layer’-i əlavə edin. 
1.  

2. ‘Adjustment Layer’-in klip müddətinə [V1] 
sətrinin [Trams.mp4] klip uzunluğu ilə eyni 
şəkildə nəzarət edin.  

6) ‘Adjustment Layer’ klipinə Lumetri standar-
tının tətbiq olunması
1. [Effects] panelinə gedin. 
• [Lumetri Presets]-[SpeedLocks]-[Univer-
sal]-dan [SL Gold Western]-i klik edin.
2. Onu [V2] sətrinin tənzimləmə qatına sürüyün.

7) ‘Lumetri standartı ilə dəyişdirilmiş rəngin 
yoxlanılması
1. ‘Timeline’ panelində [V2]-nin tənzimləmə qa-
tına klik edin. 
2.  Lumetri rəng effektini ‘ON/OFF’-a qurun.
• [Effect Controls]-[Lumetri Color]-[SL Gold 
Western (Universal)]-a gedin.
3. [Program Monitor] panelində şəkili dəy-
işib-dəyişməməyi təsdiq edin.

8) ‘White Balance’ seçimindən rəng tonlarının 
tənzimlənməsi
1. ‘Lumetri Color Western (Universal)’-dən [Ba-
sic Correction]-nı seçin.
• ‘Effects Controls’ panelindən [Lumetri Gold 
Western (Universal)]-[Basic Correction]-[White 

 

Şəkil 3-11: ‘Trams.mp4 elementinin 
kopyalanaraq çoxaldılması 

Şəkil 3-12: Adjustment Layer-in yaradılması

Şəkil 3-12: Adjustment Layer-in yaradılması

Şəkil 3-13: SL Gold Western tətbiqi
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(Şəkil 3-10) ‘Trams.mp4 elementinin kopyalanaraq 
çoxaldılması  

 

(Şəkil 3-11) Adjustment Layer-in yaradılması 
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(Şəkil 3-11) Adjustment Layer-in yaradılması 
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Balance]-a gedin. 
2. [Tint]-i ‘5’təyin edin.

9) ‘Basic Correction’ seçimində tonun tənzim-
lənməsi
1. ‘Lumetri Color Western (Universal)’-dan [Ba-
sic Correction]-ı seçin.
• ‘Effects Controls’ panelindən [Lumetri Gold 
Western (Universal)]-[Basic Correction]-a ge-
din.
2. Tonu aşağıdakı kimi təyin edin
• Kontrast/Vurğulama/Kölgə (Contrast/High-
light/Shadows) : ‘10’
• Qara (Black): ‘-10’

10) ‘Creative’ seçimində ‘Adjustments’ tənzim-
ləmələri
1. ‘Creative’ seçimindən [Adjustments] seçilir.
• ‘Effects Controls’ panelindən [Lumetri Gold 
Western (Universal)]-[Creative]-[Adjust-
ments]-a gedin. 
2. [Adjustments] aşağıdakı kimi təyin olunma-
lıdır:
• Solğun film (Faded Film): ‘20’
• Vibrasiya (Vibrance): ‘-10’

11) Lumetri rənginin tətbiq olunduğu və ya ol-
unmadığı şəkil arasındakı fərqlərin yoxlanılması
1. ‘Lumetri (SL Gold Western: Universal)’  rəng 
effektinin tətbiq olunmadığı şəkil
• ‘Toggle’effektinin tətbiq olunması: Sönülü 
(OFF)
2. ‘Lumetri (SL Gold Western: Universal)’  rəng 
effektinin tətbiq olunduğu şəkil
• Toggle effekti: Yanılı (ON)

 

(Şəkil 3-11) SL Gold Western tətbiqi 
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Şəkil 3-14: SL Gold Western tətbiqi

Şəkil 3-15: Tint və ya rəng tonu parametrləri 

Şəkil 3-16: Əsas düzəltmələrdən ton effekti

Şəkil 3-17: Tənzimləmə effektləri 

 

(Şəkil 3-12) Tint və ya rəng tonu parametrləri  
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(Şəkil 3-13) Əsas düzəltmələrdən ton effekti 
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Şəkil 3-18: Effekt (On)  

 

(Şəkil 3-14) Effekt (On)   

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Xüsusi rəng effektini əminliklə izah etdi?
2. Kinofilmlərdə, monoxrom filmlərdə və xüsusi kamerada rəng 
duyumunu düzgün şəkildə ifadə etdi?
3. Lumetri rəng paneli haqqında bilikləri əldə etdi?
4. Adjustment Layer (Tənzimləmə qatı) seçimini istifadə etdi?
5. White Balance seçiminin rəng tonlarını dəqiqliklə təyin etdi?
6. Basic Correction seçiminin tonlarını aydın şəkildə təyin etdi? 
7. Creative seçimdə tənzimləmələri düzgün şəkildə müəyyən etdi?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Simvol komponentlərini detallı şəkildə izah edəcək;
2.   Başlığa müxtəlif effektləri tətbiq etməyi biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   İllüstrator proqramı 
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Simvol və paraqraf stilləri  
1) Başlıq (Title) pəncərəsi 
1. Başlıq pəncərəsini göstərmək üçün [File] – [New] – [Legacy Title]-a gedin. 
• [File] – [New] – [Title] : [Ctrl + T]
2. Əsas menyu sətrində ‘New Title’ istifadə edərək çoxlu növ başlıq yaratma mühitini forma-

laşdırın.
 
 

2) Başlıq pəncərəsi paneli
• Başlığı yaradın və ona nəzarət edin. 

4. Başlıqlara effektlər tətbi̇q etmək

 

(Şəkil 4-1) Başlıq pəncərəsi Şəkil 4-1: Başlıq pəncərəsi

Şəkil 4-2: Başlıq pəncərə paneli
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1. Seçim aləti: Obyekti seçir.
2. Yazı aləti: Mətni üfüqi formada daxil edir.
3. Şaquli yazı aləti: Mətni şaquli formada daxil edir.
4. Keçid yazı aləti: Çəkilmiş keçid boyunca mətni daxil edir.
5. Qələm aləti: Keçidi daxil edir və ona nəzarət edir.
6. Bağlama nöqtəsi alətini silən: Keçiddə bağlama nöqtələrini silir.
Fiqur alətləri ○,7 ~○,10, ○,17 ~ ○,20
7. Düzbucaqlı aləti: 
8. Kənarları düz olan düzbucaqlı aləti: 
9. Kənarları yumru olan düzbucaqlı aləti:
10.Dairəvi düzbucaqlı aləti:
11. Fırlatma aləti: Obyekti fırladır və ya döndərir.
12. Sahə yazı aləti: Mətni daxil etmək üçün sahəni müəyyənləşdirir, kənar mətn sahədən görün-

məz olur. 
13. Şaquli sahə yazı aləti: Mətni şaquli formada daxil etmək üçün sahəni müəyyən edir. 
14. aquli keçid yazı aləti: Şaquli formada çəkilmiş keçid boyunca mətni daxil edin. 
15. Bağlama nöqtəsi alətini əlavə etmək: Keçidə bağlama nöqtəsini əlavə edir. 
16. Konvertasiya bağlama nöqtəsi aləti: Keçidi əyri formada hamar şəkildə düzəldir.
17. Çarx aləti:
18. Qovs aləti:
19. Ellips aləti:
20. Xətt aləti: 
  ○,21 Stil izləyicisi: Seçilən obyektin şrift və stilinə əvvəlcədən baxmaq mümkün olur.

3.) Başlıq fəaliyyət paneli (Title Action Panel)
• Mətn və fiquru düzmək üçün müxtəlif funksiyalar var. 
1. Düzmək (Align): Mətn və fiquru sıra ilə düzür. 
2. Mərkəz (Center): Obyektləri ekranın mərkəzində yerləşdirir.
3. Paylamaq (Distribute): Obyektlər arasında boşluğu müəyyən edərək
 obyekti yerləşdirin.

 

(Şəkil 4-3) Başlıq fəaliyyəti 
(Title Action) panel   
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Şəkil 4-3: Başlıq fəaliyyəti (Title Action) 
panel  
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Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. TV proqramda tez-tez göstərilən transfor-
masiya başlığının yaradılması
1) Əvvəldən hazırlanmış şəkilin açılması 
1. Mənbə qovluğundan ‘City.mp4’ şəkilini açın.
2. [Timeline] panelinin [V1] sətrində onu qey-
diyyatdan keçirin.
• ‘City.mp4’ şəklini ‘New Item’ ikonuna sürüyün.
3. [Title] menyu sətrində yeni başlıqdan [Default 
Still] funksiyasını seçin. 

4. ‘New Title’ dialoq qutusunda [OK] düyməsini 
klik edin.  

2) ‘Title’ panelində mətnin yazılması  
1. Şəkilin mərkəz hissəsində mətni yazın.
• Mənt: Welcome

3) ‘Color’ seçimindən mətn rənginin tənzimlən-
məsi
1. Rəng xüsusiyyətlərində mətn rəngini ağ edin. 
2. [Shadow] xüsusiyyətlərində klik işarəsini 

Şəkil 4-4: [V1] sətirində şəkilin qeydiyyatdan 
keçirilməsi   

Şəkil 4-5: Yeni başlığın (New Title) yaradıl-
ması  

Şəkil 4-6: 'Welcome' yazısı 

 

(Şəkil 4-4) [V1] sətirində şəkilin qeydiyyatdan keçirilməsi   

sürüyün 
Drag 

 Ctrl + I 
Drag 
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(Şəkil 4-5) Yeni başlığın (New Title) yaradılması   
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(Şəkil 4-6) ‘Welcome’ yazısı  
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qoyun.
3. [Color] seçimini klik edin. 

4) ‘Color Picker’ pəncərəsində rəngin müəyyən 
olunması
1. Qara rəngi seçin.
2. [OK] düyməsini klik edin.

5) ‘Timeline’ panelinin başlıq kəsiminə ‘Corner 
Pin’ effekti tətbiq edilməsi 
1. ‘Timeline’ panelinin [V2] sətrinə ‘Title’ adlı 
elementi sürüyün.
2. Başlıq şəklinin zaman sətrini şəhər təsviri ilə 
bərabər tənzimləyin.
3. Effektlər panelindən [Corner Pin] effektini tət-
biq edin. 

6) Title kəsiminin nəzarət nöqtəsinin tənzimlən-
məsi
1. [V2] sətrində [Title] kəsimini seçin.
2. [Effect Controls] panelini açın.

3. [Corner Pin] effektinin ad hissəsini klik edin. 

 

(Şəkil4-7) Rəng xüsusiyyətləri  
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Şəkil 4-7: Rəng xüsusiyyətləri 

Şəkil 4-8: Rəng təyini  

Şəkil 4-9: Corner Pin effekti 

Şəkil 4-10: Corner Pin Effekti 

 

(Şəkil 4-8) Rəng təyini   

 

(Şəkil 4-9) Corner Pin effekti  
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(Şəkil 4-10) Corner Pin Effekti  
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• Nəzarət tutacağını gördükdə [Select Zoom 
Level]-i klik edin.
4. ‘Title’ kəsiminin dörd küncündə nəzarət 
nöqtəsini (Control point)      tənzimləyin. 

7) ‘Effect Controls’ panelində ‘Crop’ effekti 
üzərində əsas çərçivənin yaradılması 
1. [Crop] effektini ‘Timeline’ panelində [Title] 
kəsiminə sürüyün.
• [Crop] effektini tətbiq etmək üçün ‘Effects’ pan-
elində [Video Effects] – [Transform] – [Crop]-a 
gedin. 
2. ‘Effect Controls’ panelində [Crop] effektinin 
sağ hissəsində əsas çərçivə yaradın. 
• Toggle animation ikonuna klik edin : Yanılı 
(ON)

8) Sağ nəzarət tutacağının mətnin görünmədiyi 
yerləşmə mövqeyinə yerləşdirilməsi
1. Başlanma nöqtəsində ‘Playback’ başlığını yer-
ləşdirin.
• Playback - cari vaxt göstəricisi
2. [Crop] effektinin ad sahəsini klik edin.  
3. Proqram monitorunda görünən sağ nəzarət 
tutacağını sol tərəfdə görünməyən mətn olan 
yerə sürüyün.

9) Mətni keçmək üçün sağ nəzarət tutacağını 
sürüyün.
1. Oynatma başlığını [00;00;04;29]-a köçürün.
2. Bütün mətn blokunu görmək üçün sağ nəzarət 
tutacağını sağ tərəfə sürüyün. 

Şəkil 4-11: Mətnin nəzarət tutacağı 

Şəkil 4-12: Əsas çərçivənin yaradılması 

Şəkil 4-13: Crop effekti  

Şəkil 4-14: Bütün mətnin göstərilməsi
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(Şəkil 4-11) Mətnin nəzarət tutacağı  
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(Şəkil 4-12) Əsas çərçivənin yaradılması  

 

(Şəkil 4-13) Crop effekti   
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(Şəkil 4-14) Bütün mətnin göstərilməsi 

1 

2 

1
2

2

3

1

1

2

2

    Sürümək

Nəzarət tutacağı

1



İKT

260

10) Görünən mətni bir-bir yoxlayın.
1. Klipi oynadın.
2. Mətn bir-bir görünməyə başlayır.

11)VBaşqa formada işləmək üçün digər klipin 
əlavə olunması
1. ‘City 2.mp4’ faylını açın.

2. [V1] sətrində ‘City.mp4’-dən sonra yer-
ləşdirmək üçün sürüyün.

12) ‘You are Owner’ kimi mətnin yazılması
1. Əsas menyu sətrindən [Title]-[New Title]-dan 
[Default Still]-i seçin.

• Yeni başlığı [Pr 04-2 Title] kimi müəyyən edin. 
2. [Type Tool] alətini seçin, ‘You are the Owner’ 
mətnini daxil edin. 
3. Dolum rəngini ağ edin. 

13) [V2] sətrində ‘Pr 04-2 Title’ klipinin qey-
diyyatdan keçirilməsi
1. [Pr 04-2 Title] elementini seçin
2. [V2] sətrində ‘City.mp4’ başlayan eyni 
nöqtəyə [Pr 04-2 Title]-ı əlavə edin.

14) ‘Turbulent Displace’ effekti tətbiq olunan 

 

(Şəkil 4-15) Klipin oynadılması 

1 

2
1 

Şəkil 4-15: Klipin oynadılması

Şəkil 4-16: City 2.mp4-ün qeydiyyatdan 
keçirilməsi  

Şəkil 4-17: Mətnin daxil edilməsi  

Şəkil 4-18: Yeni elementin qeydiyyatı 

 

 

 

1 

 

1 

 

(Şəkil 4-16) City 2.mp4-ün qeydiyyatdan keçirilməsi   

2 

 

2 

3 

(Şəkil 4-17) Mətnin daxil edilməsi   

 

1 

2 

(Şəkil 4-18) Yeni elementin qeydiyyatı  

Sürümək 
Drag 

3

1

1

1

2

2

2

1

2

Sürümək
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nəticəni yoxlayın.
1. [V2] sətrində [Pr 04-2 Title] klipinə [Turbu-
lent Displace] effekti tətbiq edin. 
2. [Video Effects] – [Distort] – [Turbulent Dis-
place] 
3. Tətbiq olunan nəticəni yoxlayın.

15) Dağ şəklinin mərkəzində görünən mətni 
yaradın.
1. ‘Effect Controls’ panelindən [Motion] effekti-
ni klik edin.
2. [Program Monitor]-da ‘Clip’-i sürüyün ki, 
mətn şəkilin mərkəzində görünə bilsin. 

16) ‘Evəlution’ xüsusiyyətində əsas çərçivənin 
yaradılması
1. [Pr 04-1 Title] başlanğıc nöqtəsinə ‘Playback 
head’ qoyun. 
• [Video Effects] – [Turbulent Displace] – 
[Evəlution] effekti
2. [Turbulent Displace] effektinin [Evəlution] 
xüsusiyyətində əsas çərçivəni yaradın.
• Toggle animasiyasını aktivləşdirin.

17) ‘Program Monitor’da mətn tranformasiya 
yerləşməsini dəyişmək üçün yoxlayın.
1. ‘Title’ kəsiminin mərkəzində ‘Playback head’ 
yerləşdirin.
2. [Evəlution] xüsusiyyətini ‘40’ təyin edin.

18) ‘Program Monitor’-da davamlı olaraq mət-
nin transformasiya yerləşməsini dəyişmək üçün 
yoxlayın.
1. ‘Başlıq kəsiminin sonuna ‘Playback head’ 

Şəkil 4-19: Turbulent Displace Effekti  

Şəkil 4-20: Əsas çərçivənin yaradılması

Şəkil 4-21: Evəlution ‘40’ 

Şəkil 4-22: Evəlution ‘0’ 

 

Drag 
Drag 

1 

2 

(Şəkil 4-19) Turbulent Displace Effekti   

 

(Şəkil 4-21) Əsas çərçivənin yaradılması 

1 2 

 1 

2 

(Şəkil 4-22) Evolution ‘40’  

 

(Şəkil 4-23) Evolution ‘0’  

1 

2 

1

1

2

2

1

1

2

2

Drag
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(Şəkil4-20) Mətnin yerləşməsini köçürmək 

1 

2 

Şəkil 4-21: Mətnin yerləşməsini köçürmək

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Simvol komponentlərini detallı şəkildə izah etdi?
2. Başlığa müxtəlif effektlər tətbiq etdi?  
3. Proqramı işlətmək üçün başlıq pəncərəsini düzgün şəkildə işlət-
di?
4. Verilmiş şərtlərə əsasən dəqiq şəkildə yeni başlıq yaratdı? 
5. Fəaliyyət panelinin (Action panel) sseçımlərini aydın şəkildə 
təyin etdi?
6. Müvafiq iş üçün rəng seçim (Picker window) pəncərəsini tətbiq 
etdi?
7. Başlıq kəsimi üçün Crop effektindən istifadə etdi?
8. Mətnə dəqiq şəkildə Turbulent Displace effekti verdi?

1

2

qoyun.
2. [Evolution] xüsusiyyətini ‘0’-a dəyişin.
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   VR şəklinin redaktə yollarını dəqiqliklə izah edəcək;
2.   Müxtəlif üsullardan istifadə edərək VR şəklini redaktə etməyi biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Qaynaq fayl 
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar
2.   Premiere proqramı
3.   VR redaktə proqramı
4.   Dərslik & Dizayn məlumat kitabı 
5.   Proyektor

Mövzu ilə əlaqəli biliklər

1. VR redaktə proqramı 
1.1 YouTube/Facebook/Vimeo-ya yükləmə edin. 
• Yeni filminizi doğru proqram ilə birbaşa YouTube, Vimeo və Facebooka yükləyin. 
1.2  Məşhur formatlara konvertasiya edin.
• Videoları MP4, AVI, MTS, FLV, MOV, M4V, MPEG, WMV, TS, VəB kimi bütün məşhur-

laşmış formatlara konvertasiya edin.
1.3  Mobil avadanlıqlara eksport edin. 
• Onu iPhone, iPad, Samsung, Amazon, HTC və PSP kimi hər hansı məşhur ağıllı telefon və ya 

tabletdə paylaşın. 
1.4 TV-də izləyin. 
• Videolarınızı yüksək keyfiyyət ilə DVD-ə yazın. Sonra o, TV-də göstərilməyə hazırdır. DVD 

media, DVD qovluq və ya ISO şəkil formatları da həmçinin mövcuddur.

2. Videoları kəsib qısaldın, birləşdirin, bölün və fırladın.
• Videoya sadə redaktələr etmək çox asandır: Videonu timeline-da göstərmək üçün Scene Detec-

tion funksiyasını istifadə edin. Videonu fırladıb çevirmək üçün iki dəfə klik edin. Kəsib qısaltmaq 
üçün işarəedicini videonun əvvəlinə və sonuna sürüyün. Kəsmək üçün qayçı və kəsim ikonunu 
klik edin. Birləşdirmək üçün yalnız faylları timeline-a sürüyün. 

3. Format növləri
3.1 Giriş formatları 

5. VR şəkli̇ni̇ redaktə etmək
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Media rejimi Format növü

Video MP4, AVI, FLV, MKV, M4V, MOV, MPG, MPEG, VəB, DAT, TS, M2TS, WMV, ASF, 
DV, DIF, NUT, H264, NSV, PSP, 3GP, EVə, RM, TP, TRP, DVR-MS, etc.

Audio AAC, APE, AIF, AIFF, FLAC, APE, CUE, AU, AMR, OGG, WAV, DPE, MKA, M4V, 
M4A, MPA, MP2, MP3, RA, WMA

Foto AAC, APE, AIF, AIFF, FLAC, APE, CUE, AU, AMR, OGG, WAV, DPE, MKA, M4V, 
M4A, MPA, MP2, MP3, RA, WMA

3.2 Çıxış formatları
 

Media rejimi Format növü
HD Video MP4, MPG, WMV, TS, TRP, AVI, MOV

Common Vid-
eo/Audio

MP4 Video(AVC), MP4 Video(Xvid), MP4 Video(MC), WMV, AVI, MOV, FLV, MKV, 
ASF, M4V, Xvid, DV, MPEG-1 NTSC, MPEG-1 PAL, MPEG-1 SECAM, MPEG-2 
NTSC, MPEG-2 PAL, MPEG-2 SECAM, DVD-Video NTSC, DVD-Video PAL, HTML5, 
DVD-Video SECAM, MP3

DVD DVD disc, DVD folder, ISO image file

Vasitələr

iPhone, iPhone 3G, iPhone 3GS, iPhone 4, iPhone 4S, iPhone 5, iPhone 5 C, iPhone 5S, 
iPhone 6, iPhone 6 Plus, iPhone 7, iPhone 7s

iPod nano, iPod touch, iPod classic

iPad, iPad 2

HTC, Galaxy S series

PSP, PS3, Wii, Xbox 360, Zune, Zen, Archos

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

a. VR şəklinin redaktə olunması
1) Yeni layihənin yaradılması 
1. [Project] panelinin sahəsində iki dəfə klik 
edin. 
• [Ctrl + I], [File] – [Import]-a gedin. 
2. İşləmək üçün mənbə qovluğundan faylı seçin. 
• Faylı import edin: ‘Alleys.mp4’
3. ‘Alleys.mp4’ elementini [New Item] ikonuna   
sürüyərək sıralamanı elementlə eyni edin. 
• Alleys.mp4’ şəkili üzərində siçanın sağ 
düyməsini klik edərək ‘New Item’ ikonunu seçin. 
4.  [Ctrl + N] düyməsini basın. 
• [Sequence] – [Sequence Settings…]

2) ‘New Sequence’ panelinin tənzimlənməsi
1. Sadə məlumatları təyin edin. 
• Redaktə rejimi (Editing Mode): ‘Custom’
• Timebase: ‘30.00frames/second’
2. Video Sektorun qurulması
• Çərçivə ölçüsü (Frame Size): ‘4096x2048’
• Sahə (Field): No fields (Progressive Scan)
• Piksel aspekt əmsalı (Pixel Aspect Ratio): 
‘Square Pixel(1.0)’
3. VR xüsusiyyətləri sektorunun qurulması (VR 
Properties sector)  
• Əks etdirmə (Projection): ‘Equiretangluear’
• Kənar xətt (Layout): ‘Monoscope’
4. Adı ‘Alleys_VR’ təyin edin.
5. [OK] düyməsini klik edin. 

3) Obyekti yuxarı-aşağı və sola-sağa hərəkət et-
dirərək 360° şəkili təsdiq edin.  
1. ‘Alleys.mp4’ elementini [Timeline] panelinin 
V1’ sətrinə daxil edin. 

2. Əvvəlcə [Program Monitor] paneli üzərində, 
sonra alt-menyu siyahısında siçanın sağ düyməsi-
ni klik edin.
• [VR Video] – [Enable]-a gedin.

Şəkil 5-1: Yeni faylı import etmək 

Şəkil 5-2: Sıralama funksiyaları

 

(Şəkil5-1) Yeni faylı import etmək  

Ctrl + I 
Drag 

1 
2 

3 

4 

 
1 

2
1 

3 

4 

5 

(Şəkil 5-2) Sıralama funksiyaları 

3

3

4

4

5

1

1

2

2

Ctrl+J
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3. Siçanı sağa-sola hərəkət etdirərək ‘360°’ şəkili 
təsdiq edin. 

4) Bucaq görünüşünü göstərmək, rəqəm dəyəri-
ni gizlətmək üçün ‘Hide Controls’ funksiyasını 
tətbiq edin.
1. Siçanın sağ düyməsini klik edin.
• [VR Video]-[Hide Controls]-a gedin.

2. Bucaq göstərmə nəzarətçisini gizlədin.

5) Obyektləri yuxarı-aşağı, sağa-sola hərəkət et-
dirərək 360° şəkili təsdiq edin. 
1. ‘Sequence’ seçim pəncərəsindən ‘Sequence 
Settings’-i icra edin.
2. [VR Properties] parametrlərini təyin edin. 
• Layout (Kənar xəttlər) : Stereoscopic-Over/
Under
• [OK] düyməsini klik edin.

[Program Monitor] panelindən sonra alt menyu 
siyahısında siçanın sağ düyməsini klik edin.
• [VR Video] – [Enable]-ə gedin. 

3. Siçanı sağa-sola hərəkət etdirərək 360° şəkili 
təsdiq edin. 

6) Stereoskop görünüşü üçün dəyişdirilmiş şəkili 
təsdiq edin. 

Şəkil 5-3: Sıralama parametrləri

Şəkil 5-4: Nəzarətlərin gizlədilməsi 

Şəkil 5-5: Stereoskop  seçimlər (Over/ Under) 

 

sürüyü
n 

Drag 

Alleys.mp4 1 

Siçanın sağ düyməsini 
klik edin. 

2 

3 

(Şəkil 5-3) Sıralama parametrləri 

 

(Şəkil 5-4) Nəzarətlərin gizlədilməsi  

   Siçanın sağ   düyməsini 
kllik edin. 

1 

2 

 

(Şəkil 5-5) Stereoskop  seçimlər (Over/ Under)  

1 

2 

 3
1 

3

1

2

1

2

2

Sürüyün

Alleys.mp4

   Siçanın sağ   düyməsini 
kllik edin.

   Siçanın sağ   düyməsini 
kllik edin.

1
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1. [Program Monitor] üzərində siçanın sağ 
düyməsini klik edin. 
2. [VR Video] – [Settings]-ə gedin. 
• Stereoskop: View
3. Dəyişdiriləcək şəkili yoxlayın.
• Stereoskop görünüşü: Left, Right, Anaglyph 

7) ‘Sequence Settings’-dən parametrlərin tən-
zimlənməsi
1. Layout sektorunun təyin olunması
• Stereoskop: Side by side (Yan yana)
2. [OK] düyməsini klik edin. 

8) Dəyişdirilmiş şəkili təsdiq edin. 
1. [Program Monitor]-da siçanın sağ düyməsini 
klik edin. 
2. [VR Video] – [Settings]-ə gedin. 
• Stereoskop görünüşü: Left, Right, Anaglyph

 

4
1 

(Şəkil 5-6) Stereoskop üçün imkan Şəkil 5-6: Stereoskop üçün imkan

Şəkil 5-7: Stereoskop görünüşü

Şəkil 5-9: Yan-yana stereoskop seçimi

 

2
1 

(Left> 
Drag 

(Right> 
Drag 

(Anaglyph> 
Drag (Şəkil 5-7) Stereoskop görünüşü 

Proqram Monitoru 1
1 

3
1 

 

(Şəkil 5-8) Stereoskop görünüşü 

1
1 

2
1 

 

(Şəkil 5-9) Yan-yana stereoskop seçimi 

(Left> 
Drag 

(Right> 
Drag 

(Anaglyph> 
Drag 

3

4

1

2

1

2

Proqram Monitoru
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. VR şəkilini redaktə etmək yollarını dəqiqliklə izah etdi?
2. Müxtəlif üsullar ilə VR şəkilini redaktə etdi?
3. VR şəkili ilə bağlı format növlərini əminliklə ifadə etdi?
4. Müxtəlif istiqamətlərdə 360° şəkilini təsdiq etdi?
5. Hide controls (nəzarətləri gizlət) parametrini müvafiq şəkildə 
işlətdi?
6. Stereoskop görünüşü seçimini aydın şəkildə təyin etdi? 
7. Program Monitor panelində Stereoskop görünüşü parametrlərini 
təkrar-təkrar yoxladı?
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b. VR şəklinin çıxarılması
1) Yeni layihə yaradılması
1, [Project] panelinin sahəsində iki dəfə klik 

edin. 
• Əsas menyu sətrindən- [Ctrl+I], [File]-[Im-

port]-a gedin.
2. İşləmək üçün faylı mənbə qovluğundan 

seçin.
• Faylı import edin: ‘Winter.mp4’
3. ‘AWinter.mp4’ elementini [New Item] 

ikonuna  sürüyərək sıralamanı elementlə eyni 
edin.

• Winter.mp4’ şəkili üzərində siçanın sağ 
düyməsini klik edərək ‘New Item’ikonunu seçin. 

4. [Ctrl + N] düyməsini basın.
• [Sequence] – [Sequence Settings…]

2) ‘Timeline’ panelində çıxış şəklinin uzun-
luğunu müəyyən edin. 

1. Çıxış şəklinin uzunluğunu müəyyən edin. 
• Başlama nöqtəsi: ’00;00;01;00’
• Bitmə nöqtəsi: ’00;00;04;00’

3) ‘Export Setting’ pəncərəsində müxtəlif 
standartların yoxlanılması

1. [File] – [Export] – [Media] 
• [Ctrl + M] düyməsini basın.
2. [Format] seçimini ‘H.264’ kimi müəyyən 

edin. 
3.  [Preset] seçimini aşağıdakı kimi təyin edin:
• ‘Custom’, və ya
• ‘Match Source- High Bitrate’
4. Çıxış adı (Output name): ‘Winter_VR.mp4’
5. [Video] seçimi: [Video] – [Basic Video 

Settings] – [Match Source]

b. VR şəklinin çıxarılması 

 

(Şəkil 5-9) Yeni faylın import olunması 

Ctrl + I 
Drag 

1 
2 

3 

4 

Şəkil 5-10: Yeni faylın import olunması

Şəkil 5-11: Çıxış şəklinin uzunluğu

Şəkil 5-12: Export parametrləri 1 

 

1 

(Şəkil 5-10) Çıxış şəklinin uzunluğu 

 

(Şəkil 5-11) Export parametrləri 1  

1 

2 

3 

4 

5 

3

4
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3

5

4

1
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2
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4) ‘Video’ seçiminin davamlı olaraq tənzim-
lənməsi 

1. [Bitrate Settings] elementində ‘Bitrate En-
coding’ seçimini ‘CBR’-ə təyin edin.  

• Target Bitrate [Mbps] (hədəf bit sürəti): ‘70’
2. ‘VR Video’ elementində və [Video is VR] 

yoxlama qutusunda klik işarəsi qoyun. 
3. [Frame Layout]-‘Monoscopic’. 
4. [Export] düyməsini klik edin. 

5) ‘Winter_FIN_VR’-ın açılması
1. [Project] panelinin sahəsində iki dəfə klik 

edin. 
• Əsas menyu sətrindən [Ctrl + I], [File]-[Im-

port]-a gedin. 
2. Mənbə qovluğundan işləmək üçün faylı 

import edin. 
• Faylın import olunması: ‘Winter_FIN_

VR.mp4’
3. ‘Apple Tree.mp4’ elementini [New Item] 

ikonuna  sürüyərək sıralamanı elementlə eyni 
edin.

•  Winter.mp4’ şəkili üzərində siçanın sağ 
düyməsini klik edərək ‘New Item’ikonunu seçin. 

4. [Ctrl + N] düyməsini basın.
• [Sequence] – [Sequence Settings…]
5. [Program Monitor] panelində çıxış şəkilini 

yoxlayın.

 

(Şəkil 5-12) Export parametrləri 2  

1 

2 

3 

4 

Şəkil 5-13: Export parametrləri 2 

Şəkil 5-14: Faylın import olunması

Şəkil 5-15: Tamamlanmış çıxış VR şəkili.

 
İki dəfə klik edin 

Faylı import edin 

1 

2 

3 

4 

(Şəkil 5-13) Faylın import olunması 

 

(Şəkil 5-14) Tamamlanmış çıxış VR şəkili. 

5 

3

4

1

2

3

4

5

1 İki dəfə klik edin

Faylı import edin2
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Yeni layihə prosedurlarını dəqiq şəkildə müşahidə etdi?
2. Timeline panelində əminliklə çıxış şəklinin uzunluğunu təyin 
etdi?
3. Timeline panelində dəqiq şəkildə açar çərçivəni təyin etdi?
4. Export tənzimləmələri pəncərəsində standart seçimini (preset 
option) yoxladı? 
5. Video parametrlərini davamlı olaraq tənzimlədi?
6. Mənbə qovluğundan faylı dəqiq şəkildə import etdi?
7. Proqram monitorunda çıxış şəkli nəticəsini yoxladı?
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Mövzu ilə əlaqəli biliklər
1) 360° videolara baxmaq üçün sizin kompüterinizdə son versiya Chrome, Opera, Firefox və ya 

MS Edge-ə ehtiyacınız var. Mobil cihazlarda son versiya YouTube app istifadə edin.
2) YouTube Chrome, Firefox, MS Edge və Opera brazuerləri 360° kürəşəkilli videoların yüklən-

məsi və göstərilməsini dəstəkləyir.
3) 360° video faylı yükləmək üçün yükləmədən qabaq sizin faylı skript və app ilə dəyişdirməy-

inizə ehtiyac var.
4) Siz 360° videolara həmçinin YouTube app-da da baxa bilərsiniz. Daha dərin təcrübə üçün 

kartondan istifadə edərək geniş məlumat əldə edə bilərsiniz.
360-dərəcə videoları yükləmək üçün proses

Addım 1: Videonu yaratmaq
- YouTube ilə uyğun olan çoxlu 360° videolar mövcuddur.
- Ən yaxşı nəticə üçün videonu Youtube-un inkişaf etmiş xüsusiyyətlərinə uyğun olaraq yüksək 

dəqiqliklə kodlaşdırın. YouTube hal-hazırda saniyədə 24, 25, 30, 48, 50, 60 çərçivəli 360° video-
ları dəstəkləyir. Biz 360° videoların 7168x3584 və ya daha yüksək 8192x4096-ə qədər dəqiqliklə 
yüklənməsini məsləhət görürük. (2:1 əmsalı ilə bərabər formada)

- Kolor Autopano kimi xüsusi kamera qurğularını istifadə edərək 360° videoları düzəldə 
bilərsiniz.  

Addım 2: Yükləmə üçün hazırlıq
• Videonuzun 360° göstərilməsinə imkan vermək üçün siz müvafiq metadataları əlavə etməlis-

iniz. Yeni fayla vacib metadatanı əlavə edən App-i quraşdırmaq üçün aşağıdakı göstərişləri edin:
▒ 360-aktivləşdirilmiş faylın app ilə yaradılması
1. Mac və ya Windows üçün 360° Video Metadata app-ni yükləyin.
2. Faylı və daha sonra 360 Video Metadata app-ni açın. Əgər siz Mac-dasınızsa əvvəlcə app-i 

sağda klik edin və sonra Open-ı klikləyin. 
3. Video faylı seçin. 
4. Sferik (kürəşəkilli) video üçün yoxlama qutusunu seçin və Save As düyməsini klik edin. 

"3D Top-bottom" qutusunu seçməyin. Daha detallı məlumat üçün virtual reallıq videoları üçün 
göstərişləri yükləyin.

5. Yaradılacaq fayl üçün ad daxil edin.
6. Faylı yaddaşa verin. Eyni yerdə orijinal fayl kimi yeni bir fayl yaradılacaq.
7. Yeni faylı YouTube-a yükləyin.
8. 360° effekt prosesi üçün gözləyin. Bu bir saata qədər vaxt apara bilər.
※ Siz həmçininn metadatanı Python script-i istifadə edərək əlavə edə bilərsiniz.

Addım 3: Faylı yükləmək
※ Bu alətlər hal hazırda 360° videoları dəstəkləmir: YouTube Video Editor (Video redaktor), 

Enhancements tools (Genişləndirmə alətləri) və End screens (son ekranlar)
- Dərc etməzdən öncə videoya baxmaqla faylın 360° video olmasını yoxlaya bilərsiniz. Bu 

proses bir saata qədər vaxt apara bilər.  
- 360° videoların yuxarı sol tərəfində düymə olur. WASD düymələrini istifadə edərək videonu 

çevirə və fırlada bilərsiniz. Bu, sizin videonun 360° olduğunu təsdiq edir. 
1) YouTube hesabının yaradılması 

c. VR təsvirinin YouTube-a yüklənməsi
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1. İlk olaraq‘YouTube’ saytına qoşulun.
(Məsələn: https://github.com)
• https://www.youtube.com/
2. Əgər hesabınız artıq mövcuddursa
• İstifadəçi adı və ya e-mail adresi [User-

name or email address]: EhYHS
• Şifrə (Password): *********…
3. [Sign In] düyməsini klik edin.
4. Əgər hesabınız yoxdursa o zaman [Create 

an account]-a gedin.
Cf: ID yhsoon1116@gmail.com
   Pw: !1happyliz
   ID: yhs0605@gmail.com
  
   ID: yhs123@gmail.com
   

5. 1-ci addımda [Create your personal ac-
count] ilə şəxsi hesabınızı yaradın. 

• İstifadəçi adı (Username): EhYHS
• Email Address: hsoon123@naver.com
• Şifrə (Password): *********… 
• Mesajı təsdiq edin [Verify account]  

6. [Create an account] düyməsinə klik edin.  
• [next Step 2]-ə gedin. 

2) Şəxsi planınızın seçilməsi
- Hər bir plan GitHub-ın ən çox sevilən xü-

susiyyətləri ilə gəlir.
1. [Free] seçimini seçin.
2. [Continue] düyməsini klik edin. 
  
3) ‘Spatial Media Metadata injector’ pro-

qramının yüklənməsi
1. [360. Video Metadata Tool.win.zip]-i 

seçin.
• Əgər istifadəçi ‘Mac’ OS istifadə edirsə 

‘360 Video Metadata Tool.mac.zip’-i seçin.
2. ‘360 Video Metadata Tool.win.zip’-i 

yükləyin.

4) ‘Spatial Media Metadata injector’ pro-

 
https://github.com 1 

2 

3 

4 

Şəkil 5-16: Sign In (hesab artıq 
mövcuddursa)

Şəkil 5-17: Yeni hesabın yaradılması

Şəkil 5-18: Yeni hesabın yaradılması

Şəkil 5-19: Proqramın yüklənməsi 

 

(Şəkil 5-16) Yeni hesabın yaradılması 

5 

 

(Şəkil 5-17) Yeni hesabın yaradılması 

 

(Şəkil 5-18) Proqramın yüklənməsi  

1 

3

4

5

1

2

1



Premiere

277

qramının yüklənməsi
1. ‘Windows’-da [360 Video Metadata Tool.

win.zip] proqramını yükləyin. 
• Quraşdırmaq üçün proqramı açın.
2.  Faylı [Spatial Media Metadata Injector] 

kimi açın.

• Proqramı işlədin.

3. ‘Premiere Pro’-da yaddaşa verilmiş mən-
bə qovluğundan [Forest_VR.mp4] faylını seçin. 

• [Open] düyməsini klik edin. 

5) Yaddaşa vermək üçün faylın adını ‘For-
est_VR_Injected_mp4’ kimi müəyyən edin. 

1. [My video is spherical (360)] yoxlama qu-
tusunda klik işarəsi qoyun. 

2. [inject metadata] düyməsini klik edin.

3. Qovluq adını [Export] təyin edin.
4. Fayl adını [forest_VR_injected.mp4] tə-

yin edin.
5. [Save] düyməsini klik edin. 

6) Təsvirin açıq aralığını müəyyənləşdirin. 
1. YouTube-de [Log in/Sign up] edin. 
2. [Create a video or post] ikonunu klik edin.
3. [Upload Video]-nu klik edin. 

7) ‘Create channel’ ilə təsviri yükləyin. 
1. [Create Channel]-i klik edin.
2. [Open Range]-i ‘Private’ kimi müəyyən 

Şəkil 5-20: Proqramn işlədilməsi

Şəkil 5-21: Inject Metadata

Şəkil 5-22: ‘forest_VR_injected. mp4’-ün 
yaddaşa verilməsi

 

1 

(Şəkil-19) Proqramn işlədilməsi 

 

2 

3 

 

(Şəkil 5-20) Inject Metadata 

2 

1 

 
Yaadaş lokatoru : Export 
Drag 

Yaddaşa 
vermək  

Fayl adı: forest_VR_injected.mp4 
Drag 

3 

5 4 

(Şəkil 5-21) ‘forest_VR_injected. mp4’-ün yaddaşa verilməsi 

 

3

1

2

3

4 5

1

2
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edin.
3. [Files to upload] simvolunu klik edin. 
8) YouTube ekranında faylın açılması

1. Save Locatordan (Export qovluğu)  [for-
est_VR_injected.mp4] faylını açın. 

• Başqa yolla faylı YouTube ekranına 
sürüyün.

2. [Open] düyməsini klik edin. 
• Faylı avtomatik olaraq yükləyin. 
 

9) Təsvirin sərbəst şəkildə izah olunması
1. Açıq aralıq səviyyəsini müəyyən edin. 
2. [Description]-i yazın.
• ‘'Premiere Pro & AfterEffects CC 2018', 

Gilbet-dən alınan məlumatların öyrənilməsi
3. VR təsvirini seçin [Preview]
• [Video Thumbnails]-ə gedin.
4. [Done] düyməsini klik edin.
• Yekun yükləməni tamamlayın. 

10) Şəkilin paylaşıldığı səhifədə VR təsviri-
nin təsdiq edilməsi

1. [https://youtu.be/KVjZKfv05mc]-i klik 
edin. 

2. Veb səhifədə şəkili yoxlayın. 

 

(Şəkil 5-22) VR təsvirinin yüklənməsi 

 Log In/Sign Up 
Drag 
1 

2 

3 

Şəkil 5-23: VR təsvirinin yüklənməsi

Şəkil 5-24: Setting Open range

Şəkil 5-25: VR təsvirinin yüklənməsi

 

(Figure 5-23> Setting Open range 

1 

2 

3 

 

Açmaq 
Drag 

Fayl adı 
Drag 

1 

2 

(Şəkil 5-24> VR təsvirinin yüklənməsi 

3

1
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Şəkil 5-26: VR təsvirinin yüklənməsi

Şəkil 5-27: Tamamlamış şəkil

 

1 

3 

4 

2 

(Şəkil 5-25> VR təsvirinin yüklənməsi 

 
1 

2 

(Şəkil 5-26) Tamamlamış şəkil 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Şəxsi ‘YouTube’ hesabını dəqiqliklə yaratdı?
2. ‘360° Video Metadata Tool.win.zip’ faylını əminliklə yüklədi?
3. ‘My video is spherical (360)’ qutusunda işarəni dəqiqliklə qeyd 
etdi? 
4. YouTube-a düzgün şəkildə giriş etdi?
5. Açıq aralığı (Open Range) özəl olaraq təyin etdi?
6. Simvolu klik edərək faylları yüklədi?
7. YouTube-da VR təsvirini təsdiq etdi? 
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Mövzu ilə əlaqəli biliklər
1) 360° videolara baxmaq üçün sizin 

kompüterinizdə son versiya Chrome, Opera, 
Firefox və ya MS Edge-ə ehtiyacınız var. Mo-
bil cihazlarda son versiya YouTube app istifadə 
edin.

2) YouTube Chrome, Firefox, MS Edge və 
Opera brazuerləri 360° kürəşəkilli videoların 
yüklənməsi və göstərilməsini dəstəkləyir.

3) 360° video faylı yükləmək üçün 
yükləmədən qabaq sizin faylı skript və app ilə 
dəyişdirməyinizə ehtiyac var.

4) Siz 360° videolara həmçinin YouTube 
app-da da baxa bilərsiniz. Daha dərin təcrübə 
üçün kartondan istifadə edərək geniş məlumat 
əldə edə bilərsiniz.

360-dərəcə videoları yükləmək üçün pros-
es

Addım 1: Videonu yaratmaq
- YouTube ilə uyğun olan çoxlu 360° video-

lar mövcuddur.
- Ən yaxşı nəticə üçün videonu You-

tube-un inkişaf etmiş xüsusiyyətlərinə uyğun 
olaraq yüksək dəqiqliklə kodlaşdırın. You-
Tube hal-hazırda saniyədə 24, 25, 30, 48, 50, 
60 çərçivəli 360° videoları dəstəkləyir. Biz 
360° videoların 7168x3584 və ya daha yüksək 
8192x4096-ə qədər dəqiqliklə yüklənməsini 
məsləhət görürük. (2:1 əmsalı ilə bərabər for-
mada)

- Kolor Autopano kimi xüsusi kamera qurğu-
larını istifadə edərək 360° videoları düzəldə 
bilərsiniz.  

d. VR təsvirinin YouTube-a yüklənməsi

 

Sürüyün 
Drag 

Ctrl + I 
Drag 

3 

1 

2 

(Şəkil 5-27) Yeni faylın import olunması Şəkil 5-28: Yeni faylın import olunması

Şəkil 5-29: İş sahəsi sətiri 

Şəkil 5-30: Media seçminin idarə olunması

 

1 

(Şəkil 5-28) İş sahəsi sətiri  

 

(Şəkil 5-29) Media seçminin idarə olunması  

Ctrl + M 
Drag 

   File Name: Dinosaur_VR_YouTube.mp4     

Save 
Drag 
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Ctrl + I

Sürüyün

Ctrl+M

File Name: Dinosaur_VR_YouTube.mp4    

Save  
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Addım 2: Yükləmə üçün hazırlıq
• Videonuzun 360° göstərilməsinə im-

kan vermək üçün siz müvafiq metadataları 
əlavə etməlisiniz. Yeni fayla vacib metadatanı 
əlavə edən App-i quraşdırmaq üçün aşağıdakı 
göstərişləri edin:

▒ 360-aktivləşdirilmiş faylın app ilə yaradıl-
ması

1. Mac və ya Windows üçün 360° Video 
Metadata app-ni yükləyin.

2. Faylı və daha sonra 360 Video Metada-
ta app-ni açın. Əgər siz Mac-dasınızsa əvvəlcə 
app-i sağda klik edin və sonra Open-ı klikləyin. 

3. Video faylı seçin. 
4. Sferik (kürəşəkilli) video üçün yoxlama 

qutusunu seçin və Save As düyməsini klik edin. 
"3D Top-bottom" qutusunu seçməyin. Daha de-
tallı məlumat üçün virtual reallıq videoları üçün 
göstərişləri yükləyin.

5. Yaradılacaq fayl üçün ad daxil edin.
6. Faylı yaddaşa verin. Eyni yerdə orijinal 

fayl kimi yeni bir fayl yaradılacaq.
7. Yeni faylı YouTube-a yükləyin.
8. 360° effekt prosesi üçün gözləyin. Bu bir 

saata qədər vaxt apara bilər.
※ Siz həmçininn metadatanı Python script-i 

istifadə edərək əlavə edə bilərsiniz.

Addım 3: Faylı yükləmək
※ Bu alətlər hal hazırda 360° videoları 

dəstəkləmir: YouTube Video Editor (Video re-
daktor), Enhancements tools (Genişləndirmə 
alətləri) və End screens (son ekranlar)

- Dərc etməzdən öncə videoya baxmaqla 
faylın 360° video olmasını yoxlaya bilərsiniz. 
Bu proses bir saata qədər vaxt apara bilər.  

Şəkil 5-31: Şəkil çərçivə ölçüsünün 
tənzimlənməsi

Şəkil 5-32: Bitrate elementlərinin 
tənzimlənməsi

Şəkil 5-33: Frame Layout tənzimləmələri

Şəkil 5-34: YouTube-a daxil olmaq

 

1 2 

(Şəkil 5-30) Şəkil çərçivə ölçüsünün tənzimlənməsi 

 

(Şəkil 5-31) Bitrate elementlərinin tənzimlənməsi 

1 

 1 

2 

(Figure 5-32) Frame Layout tənzimləmələri 

 

(Şəkil 5-33) YouTube-a daxil olmaq 
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1 
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(Şəkil 5-34) VR təsvirinin eksport olunması Şəkil 5-35: VR təsvirinin eksport olunması

Şəkil 5-36: YouTube VR Şəkili

 

(Şəkil 5-35) YouTube VR Şəkili 

- 360° videoların yuxarı sol tərəfində düymə 
olur. WASD düymələrini istifadə edərək vide-
onu çevirə və fırlada bilərsiniz. Bu, sizin vide-
onun 360° olduğunu təsdiq edir. 1

2
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Çıxış üçün VR şəklinin uzunluğunu dəqiqliklə təyin etdi?
2. Şərtlərə əsasən ‘Media’ seçim pəncərəsini təyin etdi?
3. ‘Basic Video Settings’ (Əsas video parametrləri) elementini 
əminliklə tənzimlədi?
4. ‘Bitrate Encoding’ (bit ölçüsü əmsalını) müəyyən etdi?
5. ‘Open Level’-i ‘Privacy’-ə dəqiqliklə dəyişdi?
6. Öz YouTube adresinizdə VR şəklini yoxladı? 
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1)Yeni layihə yaradılması 
1. [Project] panelində sahəyə iki dəfə klik 

edin. 
• Əsas menyu sətirindən-[Ctrl + I], [File]-[Im-

port]-a gedin. 
2. İşləmək üçün mənbə qovluğundan faylı 

seçin. 
• Faylı import edin: ‘Intense Rock Trailer.

mp3’
• ‘Intense Rock Trailer.mp3’ elementini [New 

Item] ikonuna  sürüyərək sıralamanı elementlə 
eyni edin.

• ‘Intense Rock Trailer.mp3’ faylı üzərində 
siçanın sağ düyməsini klik edərək ‘New Item’ 
ikonunu seçin. 

※ [Ctrl + N] düyməsini basın.
• [Sequence] – [Sequence Settings…]

2) Yaddaşa verilmiş keçidin müəyyən edilmə-
si

1. ‘Intense Rock Trailer.mp3’-ü [Timeline] 
panelinin [A1] sətrinə daxil edin. 

2. [Project] panelinin ‘Intense Rock Trailer’ 
sırasında

• [Edit] – [Edit in Adobe Audition] – [Se-
quence]-ə gedin.  

3. [Edit in Adobe Audition] pəncərəsində
• Seçimi [Browse]-ə təyin edin. 
4. [Select Folder] pəncərəsində
• Yaddaşa verilmiş keçidi ‘DC 03 Premier> 

Export’ kimi təyin edin.

5. [Select Folder] düyməsini klik edin.  
6. [Open in Adobe Audition] seçiminin qa-

rşısına klik işarəsi qoyun.  

e. VR şəklini səs yoxlaması ilə 
əlaqələndirimək

 

Sürümək 
Drag 

Ctrl + I 
Drag 

3 

1 

2 

(Şəkil 5-36) Yeni layihə Şəkil 5-37: Yeni layihə

Şəkil 5-38: Yaddaşa verilmiş keçidin 
təyin edilməsi

 1 
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3
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(Şəkil 5-37) Yaddaşa verilmiş keçidin təyin edilməsi 
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7. OK] düyməsini klik edin.

`3) Premiere Pro-nu Audition (Səs yoxlaması) 
proqramı ilə əlaqələndirərək ekran pəncərəsini 
açın. 

1. (Şəkil 5-40)-da olduğu kimi pəncərəni açın.

4) Adobe Audition’-da ‘Clip’ or ‘Edit Clip’ 
funksiyalarının icra olunması 

1. Premiere Pro proqramının ‘Project’ pane-
lində [Intense Rock Trailer.mp3]-ni seçin.

2. [Edit] – [Edit in Adobe Audition] – [Clip]-i 
seçin.

3.  ‘Timeline’ panelinin [A1] sətrində [In-
tense Rock Trailer.mp3] üzərində siçanın sağ 
düyməsini klik edin.

• [Edit Clip in Adobe Audition]-ı seçin.

5) Premiere Pro-nu Audition ilə 
əlaqələndirərək ekran pəncərəsinin açılması

1.[Intense Rock Trailer Audio Extracted_1.
wav] yaradılmasını yoxlayın. 

Şəkil 5-39: Adobe Auditionda kəsimin redak-
tə olunması

Şəkil 5-40: Adobe Auditionda kəsimin 
redaktə olunması

 

Siçanın sağ düyəsini klik 
edin 
Drag 

1 

2 

3 

(Şəkil 5-39) Adobe Auditionda kəsimin redaktə olunması 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Mənbə qovluğundan əminliklə audio faylı açdı? 
2. Sequence (sıralama) tənzimləmələrini etdi?
3. Yaddaşa verilmiş keçidi müvafiq şəkildə təyin etdi?
4. Sequence ilə düzgün şəkildə Premiere Pro faylını Audation (səs 
yoxlaması) ilə əlaqələndirdi?
5. Yekun olaraq audio faylın (*.wav) yaradılmasını və ya yaradılma-
masını yoxladı? 
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HTML - JAVASCRIPT

Sənaye və İnnovasiyalar üzrə 
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Ön söz 

 Hypertext Markup Language (HTML) veb səhifə və tətbiqlər üçün standart işarə dilidir.  Kaskad 
stillər cədvəli (CSS) və JavaScript World Wide Web (ümumdünya hörümçək toru) üçün təməl 
texnologiya üçlüsü formalaşdırır. 
 Veb brauzerlər HTML sənədlərini veb serverdən, yaxud lokal yaddaşdan alırlar və sənədləri mul-
timedia veb səhifələrinə çevirirlər. HTML semantik olaraq sənədin görünüşü sahəsini saxlayaraq 
veb səhifənin strukturunu təsvir edir.
 HTML veb səhifənin məzmununa təsir edə bilən JavaScript kimi skript dilində yazılmış proqram-
ları yerləşdirə bilir. 
 CSS-in daxil edilməsi məzmunun görünüşünü və yerləşməsini müəyyən edir. HTML və CSS 
standartlarını saxlayan World Wide Web Consortium (W3C) 1997-ci ildən bəri HTML üzərindən 
CSS istifadəsini dəstəkləyir.  
 JS olaraq qısaldılan JavaScript yüksək səviyyəli proqramlaşdırma dilidir. O, həmçinin dinamik, 
zəif bir şəkildə yazılmış, prototip əsaslı və çox paradiqma olunan bir dil kimi xarakterizə olunur.
 HTML və CSS ilə yanaşı JavaScript də World Wide Web-in üç əsas texnologiyasından biridir. 
JavaScript interaktiv veb səhifələrə imkan yaradır və bu, veb tətbiqlərin ən vacib hissəsidir. Veb 
saytların böyük əksəriyyəti onu istifadə edir.
 Başlanğıcda yalnız müştərilər tərəfindən veb brauzerlərdə həyata keçirilən JavaScript mühərrikləri 
indi artıq bir çox başqa proqram təminatında, veb serverlərdə və verilənlər bazasında yerləşdirilir. 
JavaScript və Java arasında dil adı, sintaksis və s. daxil olmaqla kənardan nə qədər oxşarlıq olsa 
da, iki dil müxtəlifdir və dizayn baxımından çox fərqlənir. JavaScript Self və Scheme kimi pro-
qramlaşdırma dillərindən təsirlənmişdir.  
 Yekun olaraq mən çoxsaylı mənbələrə, xüsusilə YouTube, Yahoo, Wikipedia, “https://www.
w3schools.com”, “https://www.yourhtmlsource.com”, “https://www.lifewire.com” və “http://
www.simplehtmlguide.com” və Google saytlarına təşəkkür edirəm. Onlar mənə texniki təcrübə 
modulu dərsliyinin hazırlanmasında köməklik etdilər. 

                YUN, Hyung Soon, IKT üzrə Texniki Ekspert
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1. Müxtəli̇f qutular hazırlamaq

İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Veb dizaynı ilə bağlı veb proqramları dəqiq şəkildə izah edəcək;
2.   HTML redaktoru ilə düzgün şəkildə müxtəlif qutu və çərçivələrin düzəldilməsini biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/Məlumat kitabı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   HTML/JavaScript redaktoru
3.   Proyektor

Mövzu ilə əlaqəli biliklər

1. HTML tərcüməçisi
1.1 Veb brauzer 
1. Veb brauzer World Wide Web-də (dünya hörümçək toru) məlumat mənbələrinin alınması, 

təqdimatı və transferi üçün proqram təminatı tətbiqidir. Məlumat mənbəyi resursun universal iden-
tifikatoru  (URİ) tərəfindən müəyyən edilir və veb səhifə, şəkil, video və digər məzmuna malik ola 
bilər. Resurslarda mövcud olan hiperlinklər istifadəçilərə brauzerləri asanlıqla əlaqəli qaynaqlara 
yönəltməyə imkan verir.

2. Baxmayaraq ki, brazuerlər World Wide Web-ə daxil olmaq üçün nəzərdə tutulub, onlar 
həmçinin veb serverlər tərəfindən təqdim olunan məlumatlara, xüsusi şəbəkələr və fayl sistem-
lərindəki fayllara daxil olmaq üçün də istifadə oluna bilər.

1.2 HTML
1. HTML ifadəsi HyperText Markup Language deməkdir.
2. HyperText veb üzərində hərəkət metodudur - hyperlinks adlanan xüsusi mətni klik edərək 

növbəti səhifəyə keçid edilir. Hyper olması yalnız xətti olması mənasını daşımır. Misal üçün, siz 
linklər üzərində klik edərək internetdə istədiyiniz yerə gedə bilərsiniz - bu işlərin edilməsi üçün 
heç bir əmr yoxdur.

3. Markup HTML işarələrinin mətnin içərisinə etdiyi qeyddir. Onlar bunu mətnin müəyyən bir 
növü olaraq qeyd edirlər.

4. HTML digər dillər kimi kod-sözləri və sintaksisə sahib dildir. 

2. HTML sənədi
2.1 HTML teqləri 
1. HTML tərtibata ehtiyac olmadan şəxs tərəfindən oxuna bilən, kodlarla yazılan işarə dilidir. 

Başqa sözlə, veb brauzer göstərişləri vermək üçün veb səhifədəki mətn bu kodlarla işarələnir. Bu 
işarələr isə HTML-in özüdür.

2. Bütün HTML teqləri aşağıdakılar da daxil olmaqla bir sıra xüsusi hissələrdən ibarətdir:
• Kiçikdir işarəsi
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• İşarənin yazıldığı müəyyən edən söz və ya simvol 
• Cüt şəklində HTML işarələrinin sayı

• Böyükdür işarəsi

3. Misal üçün, siz burada bir neçə HTML teqlərini görə bilərsiniz:

4. Bu etiketlər aşağıdakıları təmsil edir:

5. Aşağıdakılar da həmçinin HTML teqləridir:

2.2 HTML elementləri 
1. W3C HTML spesifikasiyasına əsasən element HTML-in əsas təməli hesab olunur və adətən 

iki teqdən ibarət olur: açılış və bağlanış. İndiyə qədər biz yalnız elementləri başladan açılış te-
qlərinə baxdıq. Bu elementi bitirmək üçün yekun bağlanış teqlərini yazmaq lazımdır. 

2. Misal üçün, paraqraf elementi üçün aşağıdakını yazırsınız:

• Bu, bir az əvvəl gördüyümüz açılış və bağlanış teqlərindən ibarətdir - </p>. Bağlanış teqi açılış 
teqinin təkrarıdır amma çəp xətt (forward slash) kiçikdir simvolundan sonra birbaşa əlavə olunur.

3. Demək olar ki, bütün HTML elementlərinin açılış və bağlanış teqləri mövcuddur. Bu teqlər 
veb səhifədə nümayiş olunacaq mətni əhatə edirlər. Misal üçün, mətnə paraqraf yazmaq üçün mət-
ni yazırsınız və onu aşağıdakı teqlərdə əhatələyirsiniz:

• Bəzi HTML elementlərinin bağlanış teqi olmur. Bunlar "boş elementlər" adlanır. Bəzən onlar 
“singleton” və ya “vəid” elementləri kimi də istinad olunur. Boş elementlərin istifadəsi asandır, 
çünki siz veb səhifənizə yalnız bir teq  əlavə edirsiniz. Misal üçün, səhifənizə tək xətt əlavə etmək 
üçün siz <br> teqini istifadə etməlisiniz.

4.  Açılış teqinə daxil olan digər ümumi element "image"(şəkil) elementdir. Misal üçün:

<

>

<p> </p>

<p> Bu, istifadəçinin veb-səhifədə nümayiş etdirmək istədiyi paraqraf mətnini yazdığı sahədir. 
</p>

<p>
<html>
<div>

<p> - paraqrafları müəyyən edir. 
<html> - səhifəni HTML kimi müəyyənləşdirir. 
<div> - bölgünü müəyyən edir.

<ul id=”menu-list”> 
<div class= featured-article”>
<a herf=”indes.html”>
<img src=”images/logo.png” >

Name=”value”
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<img src=”images/logo.png ">

• Biz bu nümunəni daha əvvəl gördük, amma bu şəkil elementi üçün bağlanış teqi yoxdur. 
Brauzer bu kodu asanlıqla "href" atributundakı referans şəkil ilə əvəzləyə bilər. Bu halda bu, "logo.
png." olacaq. 

5. Ümumi olaraq, biz HTML elementlərinə və ya teqlərinə istinad etdikdə elementin bütün 
hissələrinə istinad etdiyimizi göstərmək üçün “element” terminin istifadə edəcəyik (həm açılış, 
həm də bağlanış teqləri). Yalnız bir və ya digərinə istinad etdikdə "tag" istifadə edəcəyik. Bu, iki 
terminin düzgün istifadə yoludur və biz bunları doğru şəkildə istifadə etməyə təşviq edirik, amma 
siz onlarda kiçik yerdəyişmə etsəniz, yenə də yeni veb inkişafı düzgün şəkildə anlaşılacaq. 

3. CSS
3.1 CSS-nin müəyyən olunması
1. CSS - Cascading Style Sheets sözlərinin qısaldılmasıdır və veb səhifənin görünüşünü tən-

zimləmək üçün üstün tutulan metoddur.
2. CSS HTML fayllarının məzmunu və necə təşkil edildiyini müəyyən edərək HTML işarələri-

nin mətn yerləşməsini, ölçüsünü və rəngini müəyyən edir.  Onları ayırmaq istifadəçinin bütün veb 
səhifəni yenidən yazmasına ehtiyac olmadan rəng sxemini dəyişdirməyə icazə verir.

3. Cascading əsas elementə tətbiq olunan üslubun ana element içərisindəki bütün törəmə ele-
mentlərə də tətbiq olunacağı mənasına gəlir. Misal üçün, əsas mətnin rəngini müəyyənləşdirmək, 
mətn daxilindəki bütün başlıqların və paraqrafların da eyni rəngə dəyişəcəyi deməkdir.  

3.2 Stillərin (üslubların) müəyyən olunması və istifadəsi
1. Veb səhifəyə və ya veb sayta stil əlavə etməyin üç əsas yolu var:
• İnline styles adlanan bir teqinin style=”?” atributunu tənzimləmək
• HTML header teqi içində <style> etikenin istifadə olunması
• External CSS file-ı yaratmaq
2. Əsas stil səhifələri <body> və <p> kimi HTML teqlərinin görünüşünü dəyişir.
3. Başlıqda CSS faylını və ya stil səhifələrini istifadə etdikdə istifadəçi, həmçinin üslubların 

növlərini müəyyən edə bilər və onları class=”?” atributunu istifadə edərək hər hansı elementə tət-
biq edə bilər. Ancaq bu təlimatdan kənardır. 

1) Sətir içi üslublar (Inline Styles)
1. HTML-də sətir içində müəyyən olunmuş üslublar yalnız əlavə olunmuş teqlərə tətbiq olunur. 

Qeyd: rənglər CSS rəng adı və ya hex rəng kodu kimi göstərilə bilər. 
<p style=”color: green;”>some red text</p>

2) HTML başlığı daxilində 
1. müəyyən olunan stil bütün səhifəyə tətbiq olunur. Aşağıdakı nümunə səhifədəki bütün h1 

teqlərinin başlığı qırmızı rəngdə göstərilməsini təmin edir.   

3) Xarici CSS faylı
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1. HTML faylları kimi CSS faylları da normal mətnlərdir və adətən .css fayl adı uzadılmasına 
sahibdir. Misal üçün, CSS fayl adı style.css aşağıda görünə bilər.

2.  <link ... > teqi HTML head teqləri başlığı əlavə olunur

<head>
<style type=”text/css”>
h1 {
   Color: green;
}
</style>
</head>

<head>
<link rel=”stylesheet” type=”text/css” href=”style.css” title=”style”>
</head>

body {
  background-color: violet;
  color: #000080; (or #******;)
 }
h1 {
 color: violet;
}

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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<FRAMESET ROWS=”WIDTH DIVISION 
SIZE” COLS=”HIGHT DIVISION  SIZE”>
 <FRAME SRC=”DOC1.html” 
NAME=”left”
 <FRAME SRC=”DOC1.html” 
NAME=”right’
</FRAMESET>

Təcrübə mərhələləri

1. HTML sənədinin əsas formatı
1) HTML sənədi <HTML> teqi ilə başlayır, </
HTML> teqi ilə bitir. 
• <HTML> və </HTML> arasındakı sahənin 
<HEAD> and <BODY> hissəsi mövcuddur. 
2) <HEAD> hissəyə veb başlığı və ya veb 
məlumatı yazın.
3) <BODY> hissənin içərisinə faktiki məzmun 
yazın. 
4) <HEAD> teqləri arasındakı sahə veb brau-
zerdə başlıq hissədə olan məzmunu əhatə edir
• <TITLE> qısaltması mümkündür. 

2. HTML sənədinin tətbiq edilməsi
1)  Windows-dan Editplus Editor proqramını və 
ya Note proqramını açın.
2) Pəncərədəki məzmunu kodlaşdırın.    

 

3. Müxtəlif çərçivələrin düzəldilməsi
1) Çərçivə sənədləri üçün formatın yaradılması
1. Çərçivə formatını formalaşdırın. 

 

  
2. 3 çərçivəni şaquli olaraq bölün.
• Birinci və üçüncü çərçivə ölçüsü: 150 piksel
• Mərkəzi çərçivə ölçüse: qalan piksellər 

<HTML>
  <HEAD>
 <TITLE> TOPIC </TITLE>
  </HEAD>
  <BODY>
      CONTENTS 
  </BODY>
</HTML>

1

2

3

4
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3. 3 çərçivəni üfüqi olaraq bölün. 
• Birinci çərçivə ölçüsü: 50 piksel
• İkinci çərçivə ölçüsü: 100 piksel
• Üçüncü çərçivə ölçüsü: qalan piksellər

4. 2 çərçivəni üfüqi və şaquli bölün.
• İlk olaraq 2 çərçivəni şaquli bölün. 
• İkinci olaraq 2 çərçivəni üfüqi bölün.
   
 
 

 
 

5. 2 çərçivəni üfüqi və şaquli bölün.
• İlk olaraq, 2 çərçivəni şaquli bölün. 
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• İkincisi 2 çərçivəni üfüqi bölün. 

 
4. Müxtəlif qutuların düzəldilməsi
1) İşarələr ilə bağlı 
1. <div>
2. Border (Kənar çərçivə)
3. Margin (Boşluq)
4. Padding (Dolğu)
5. Background (Arxa fon)
6. Border-radius (Kənar radius)

 
2) Veb səhifənin blok etiketi ilə düzəldilməsi
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<!DOCTYPE HTML>
<html>
 <head>
   <title>HTML 01_Box </title>
  <meta name="Generator" content="EditPlus">
  <meta http-equiv="Content-Type" content="text/html; charset=UTF-8" />
  <style type="text/css">
 .boregiontop {width:710px; margin:0 0 100px 5px;}
 .blocktop h1, .boregiontop h1 {margin:0; font-size:1.2em; padding:0 10px 5px 10px; 
                                         border-bottom:1px solid #444;}
 .blocktop p, .boregiontop p { margin:0; padding:5px 5px 5px 10px; font-size:12px;}
 .blocktop {background: transparent; width:210px; float:left; margin:0 3px; display:inline;}
 .regiontop, .regionbottom {display:block; background:transparent; font-size:1px;}
 .xb1, .xb2, .xb3, .xb4 {display:block; overflow:hidden;}
 .xb1, .xb2, .xb3 {height:1px;}
 .xb2, .xb3, .xb4 {background:#fff; border-left:1px solid #444; border-right:1px solid #444;}
 .xb1 {margin:0 5px; background:#444;}
 .xb2 {margin:0 3px; border-width:0 2px;}
 .xb3 {margin:0 2px;}
 .xb4 {height:2px; margin:0 1px;}
 .boxcontent {display:block; border:0 solid #444; border-width:0 1px; height:auto;}
 * html .boxcontent {height:1px;}
 .color_a {background:#c965ba; color:#fff;}
 .color_b {background:#d4bdd8; color:#000;}
 .color_c {background:#757982; color:#fff;}
 .color_d {background:#b29bab; color:#000;}
   </style>
 </head>
 <body>
<div class="blocktop">
     <b class="regiontop"><b class="xb1"></b><b class="xb2 color_a"></b><b class="xb3 color_a"></b>
     <b class="xb4 color_a"></b></b>
 <div class="boxcontent">
  <h1 class="color_a">Box model</h1>
  <p>&lt;p&gt; mark the box through block</p>
  <p>&lt;div&gt;mark the box through block</p>
  <p>&lt;span&gt;mark the box through block</p>
  </div>
  <b class="regionbottom"><b class="xb4"></b><b class="xb3"></b><b class="xb2"></b>
                    <b class="xb1"></b></b>
 </div>
 <div class="blocktop">
  <b class="regiontop"><b class="xb1"></b><b class="xb2 color_b"></b>
                    <b class="xb3 color_b"></b><b class="xb4 color_b"></b></b>
  <div class="boxcontent">
    <h1 class="color_b">how to define the line</h1>
    <p>how to use border</p>
    <p>how to use outline</p>
    <p>how to use background</p>
  </div>
  <b class="regionbottom"><b class="xb4"></b><b class="xb3"></b><b class="xb2"></b>
                    <b class="xb1"></b></b>
 </div>
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<div class="blocktop">
  <b class="regiontop"><b class="xb1"></b><b class="xb2 color_b"></b>
                    <b class="xb3 color_b"></b><b class="xb4 color_b"></b></b>
  <div class="boxcontent">
    <h1 class="color_b">how to define the line</h1>
    <p>how to use border</p>
    <p>how to use outline</p>
    <p>how to use background</p>
  </div>
  <b class="regionbottom"><b class="xb4"></b><b class="xb3"></b><b 
                  class="xb2"></b>
                    <b class="xb1"></b></b>
 </div>
 <div class="blocktop">
  <b class="regiontop"><b class="xb1"></b><b class="xb2 color_c"></b>
                    <b class="xb3 color_c"></b><b class="xb4 color_c"></b></b>
  <div class="boxcontent">
  <h1 class="color_c">Title</h1>
  <p>Content 1</p>
  <p>Content 2</p>
  </div>
  <b class="regionbottom"><b class="xb4"></b><b class="xb3"></b><b 
                    class="xb2"></b>
                    <b class="xb1"></b></b>
 </div>
</div>
</body>
</html>
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Veb dizaynı ilə bağlı veb proqramları dəqiq şəkildə izah etdi? 
2. HTML redaktoru ilə müxtəlif qutular və çərçivələr düzəltdi?
3. HTML redaktorunu asanlıqla istifadə etdi?
4. Veb proqramlaşdırma formatını dəqiq olaraq yaratdı? 
5 . Proqramı əminliklə kodlaşdırdı?
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2. CSS i̇lə menyu yaratmaq 

İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Veb dizaynı ilə bağlı veb proqramları dəqiq şəkildə izah edəcək;
2.   HTML redaktoru ilə düzgün şəkildə müxtəlif qutu və çərçivələrin düzəldilməsini biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/Məlumat kitabı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   HTML/JavaScript redaktoru
3.   Proyektor

Mövzu ilə əlaqəli biliklər

1. HTML <DIV> teqi
1.1 Tanınması və istifadəsi 
1. <div> teqi HTML sənədində bir bölməni və ya bölümü müəyyən edir. 
2. <div> elementi adətən onları CSS ilə üslublaşdırmaq və ya JavaScript ilə müəyyən tapşırıqları 

yerinə yetirmək üçün digər HTML elementləri üçün əhatəedici kimi istifadə olunur. 
1.2 Atributlar

1.3 Nümunə

2. HTML <ul> teqi 
2.1 Tanınması və istifadəsi 
1. <ul> teqi  sırasız listi müəyyən edir. 
2. <ul> teqi  <li> teqini ilə birgə sırasız list yaratmaqda istifadəsi edin
※ Qeyd: 
• CSS üslub (stil) listini istifadə edin. 
• List yaratmaq üçün,  <ol> -i istifadə edin. 

Atributlar Dəyər              Təsvir 
Align 

(Düzmək)
Left

Right

Center

Justify

HTML5-də dəstəklənmir. 

<div> elementinin içindəki məzmunun yerləşməsini 
müəyyənləşdirir. 

<div style="background-color:lightblue">
  <h3>Bu bir başlıqdır</h3>
  <p>Bu bir paraqrafdır.</p>
</div>
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ul { 
    display: block;
    list-style-type: disc;
    margin-top: 1em;
    margin-bottom: 1 em;
    margin-left: 0;
    margin-right: 0;
    padding-left: 40px;
}

2.2 Atributlar

Atributlar Dəyər                Təsvir

Compact 
(Kompakt) Compact

HTML5-də dəstəklənmir. 

Siyahının normaldan daha kiçik göstərilməsini 
təmin edir. 

Type 
(Növ)

Disc

Square

Circle

HTML5-də dəstəklənmir. 

Siyahıda istifadə olunacaq işarələyicinin 
növünü bildirir. 

2.3 Standart CSS parametrləri 
1. Əksər brauzerlər aşağıdakı standart dəyərlər ilə <ul> elementini göstərir:

3. HTML <li> teqi 
3.1 Tanınması və istifadəsi 
1. <li> teqi siyahı elementini müəyyən edir. 
2. <li> teqi sıralı (<ol>)-də, sırasız (<ul>)-də və menyu listdə istifadə olunur. 
※ Qeyd: 
Siyahı növünü müəyyən etmək üçün CSS istifadə edin.  
3.2 Attributlar
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Atributlar Dəyər Təsvir 

Type (növ)

1

A

a

I

I

disk

kvadrat

dairə

HTML5-də dəstəklənmir. 

Hansı növ hədəf nöqtəsinin istifadəsini müəyyən-
ləşdirir. 

Value 
(dəyər)

Rəqəm Siyahı elementinin dəyərini müəyyənləşdirir. 

Aşağıdakı siyahı elementləri bu rəqəmdən artacaq 
(yalnız <ol> siyahısı üçün) 

3.3 Nümunə

3.4 Nümunə
1. Əksər brauzerlər aşağıdakı standart dəyərlər ilə <li> elementini nümayiş etdirir:

<ol>
  <li>Coffee</li>
  <li>Tea</li>
  <li>Milk</li>
</ol>

<ul>
  <li>Coffee</li>
  <li>Tea</li>
  <li>Milk</li>
</ul>

li {
    display: list-item;
}
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4. CSS-də fırlatma zolağı atributu

Atribut Təsvir 
scrollbar-face-color Fırlatma zolağının düymə rəngini müəyyən edir. 
scrollbar-shadow-color Sahə rəngini parlaq şəkildə aydınladacaq rəngi müəyyən edir.  
scrollbar-highlight-color Sahə qaranlıqda parlaq şəkildə aydınlandırır.
scrollbar-3dlight-color Sahə rəngini ən parlaq rəngdə müəyyən edir. 
scrollbar-darkshadow-color Sahə rəngini ən qaranlıqda aydınlandırır. 
scrollbar-track-color Sürüşdürmə izinin rəngini müəyyən edir. 
scrollbar-arrow-color Sürüşdürmə oxu düyməsinin rəngini müəyyən edir. 

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

1. Məlumatların kodlaşdırılması 
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2. Stil səhifələrinin yoxlanılması 
1) Məlumatın kodlaşdırılması
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3. CSS ilə sürüşdürmə zolağının (Scroll bar) 
yaradılması 
1) Sürüşdürmə zolağına müxtəlif effektlərin 
verilməsi

1) HTML sənədinin əsas formatı
1. HTML sənədi <HTML> ilə başlayır və </
HTML> teqi ilə bitir. 
• <HTML> və </HTML> arasındakı sahənin 
<HEAD> və <BODY> hissəsi var. 
2. <HEAD> sahədə veb məlumatı və ya veb 
başlığını əlavə edin. 
3. <BODY> hissənin içərisinə cari məzmunu 
yazın. 
4. <HEAD> teqləri arasındakı sahəyə veb brau-
zerdə başlıq hissədə göstərilən məzmunu daxil 
edin.
• <TITLE> qısaltması mümkündür. 

2. HTML sənədinin tətbiq edilməsi
1) Windows-dan Editplus Editor proqramını və 
ya Note proqramını açın.
2) Pəncərədəki məzmunu kodlaşdırın.     

 <HTML> 
  <HEAD> 
 <TITLE> TOPIC </TITLE> 
  </HEAD> 
  <BODY> 
      CONTENTS  
  </BODY> 
</HTML> 

1 

2 4 

3 

1

2

3

4
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3. Müxtəlif çərçivələrin düzəldilməsi 
1) Çərçivə sənədləri üçün formatın yaradılması 
1. ‘Çərçivə formatını’ formalaşdırın. 

  
2. 3 çərçivəni şaquli olaraq bölün. 
• Birinci və üçüncü çərçivə ölçüsü: 150 piksel
• Mərkəzi çərçivə ölçüsü: qalan piksellər 

3. 3 çərçivəni üfüqi olaraq bölün. 
• İlk çərçivə ölçüsü: 50 piksel
• İkinci çərçivə ölçüsü: 100 piksel
• Üçüncü çərçivə ölçüsü: qalan piksellər
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4. 2 çərçivəni üfüqi və şaquli olaraq bölün. 
• İlk olaraq 2 çərçivəni şaquli bölün. 
• İkinci olaraq 2 çərçivəni üfüqi bölün. 
   
 
 

 
 

5. 2 çərçivəni şaquli və üfüqi olaraq bölün. 
• İlk olaraq 2 çərçivəni şaquli bölün.  
• İkinci olaraq 2 çərçivəni üfüqi bölün. 

  
4. CSS ilə menyu düzəltmək
1) İşarələr (etiketlər) və ya məlumat ilə bağlı 
1. a:link
2. a:visited
3. a:hover
4. a:active

2) Menyu düzəldilməsi 
1. Məlumatın kodlaşdırılması 
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2. Veb səhifəni gözdən keçirin.
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Veb proqramlaşdırmada CSS-i aydın şəkildə izah etdi?
2. Menyunu stil işarəsi ilə düzgün şəkildə yaratdı? 
3. Müvafiq başlıq ilə əlaqəli işarələri düzgün şəkildə istifadə etdi?
4. Veb proqramlaşdırma üçün formatı dəqiq şəkildə tətbiq etdi?
5. Veb axtarışda nəticəni əminliklə yoxladı?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   HTML ilə düzgün şəkildə əsas menyu zolağının düzəldilməsi yollarını izah edəcək;
2.   Müxtəlif teqlər ilə aydın şəkildə əsas menyu zolağını düzəltməyi bacaracaq.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/Məlumat kitabı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   HTML/JavaScript redaktoru
3.   Proyektor

Mövzu ilə əlaqəli biliklər

1. <ul> teqi (tag) formatı

2.  <OL> teqi (tag) formatı

3. HTML i̇lə əsas Menyuları düzəltmək

 <UL>          /*Rəqəmsiz siyahını başlatmaq*/
   <LI>        /*Siyahıdan ibarət element*/
   <LI>        /* Siyahıdan ibarət element */
</UL>         /*Rəqəmsiz siyahını bağlamaq/

<OL>          /* Rəqəm ilə siyahını başlatmaq */
   <LI>        /* Siyahıdan ibarət element */
   <LI>        /* Siyahıdan ibarət element */
</OL>         /* Rəqəm ilə siyahını bağlamaq */
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Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Rəqəmsiz siyahı düzəltmək 
1) Rəqəmsiz siyahı düzəldilməsi 

2. Rəqəm ilə siyahı düzəltmək 
1) Rəqəm ilə siyahı düzəldilməsi 
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Məlumatın kodlaşdırılması 

3. İyerarxik strukturun düzəldilməsi 
1) <DL> teqi ilə iyerarxik strukturu düzəldin. 
1. <DL> teqini müəyyənləşdirin.

2. Məlumatın kodlaşdırılması

4. HTML ilə əsas səhifəni düzəltmək
1) Məlumat və teqlər ilə bağlı
1. <table>
2. <style>
3.<A>
4. Align 

<DL>       /*rəqəm ilə siyahını başladın */
   <LI>     /*siyahıdan ibarət element*/
   <LI>     /*siyahıdan ibarət element*/
</DL>      /*rəqəm ilə siyahını bağlayın*/
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 2) Menyunun düzəldilməsi 
1. Məlumatı kodlaşdırmaq
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2. Veb brauzerin işlədilməsi 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. HTML ilə düzgün şəkildə əsas menyu zolağını yaratmağın yol-
larını izah etdi?
2. Müxtəlif işarələr ilə aydın şəkildə əsas menyu zolağını yaratdı? 
3. Menyu zolağı üçün əlaqəli işarələri düzgün şəkildə istifadə etdi?
4. Proqramla bağlı məlumatları düzgün şəkildə kodlaşdırdı?
5. Veb görünüş nəticəsini əminliklə yoxladı?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Cədvəl teqinin atributunu dəqiq şəkildə izah edəcək;
2.   Hyper linkləri düzgün şəkildə müəyyən etməyi biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/Məlumat kitabı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   HTML/JavaScript redaktoru
3.   Proyektor

Mövzu ilə əlaqəli biliklər

1. HTML və CSS-də CGI
1.1 CGI-nin müəyyən olunması 
1. Common Gateway Interface (CGI) hesablama zamanı veb serverlər üçün əmr proqramları 

kimi proqramları icra etmək üçün standart protokol təklif edir. Bu proqramlar CGI scripts və ya 
qısaca CGIs adlanır. Server tərəfindən verilən skriptin xüsusiyyətləri server tərəfindən müəyyən 
edilir. Ümumi vəziyyətdə GI skripri istək olduqda icra olunur və HTML yaradır. 

2. Qısacası, CGI proqramı HTML form məlumatını standart giriş vasitəsilə göndərir. URL 
keçidlər, HTTP başlıq məlumatı da daxil olmaqla digər məlumatlar mühit dəyişikliyi prosesləri 
kimi təqdim olunur. 

3. <TABLE> teqi
3.1 CGI tanınması
1. <table> teqi HTML cədvəlini müəyyən edir. 
2. HTML cədvəli  <table>  elementindən və bir və ya daha çox <tr>, <th> və  <td> ele-

mentlərindən ibarətdir. 
3. <tr> elementi cədvəl sətrini, <th> elementi cədvəl başlığını və <td> elementi cədvəl sütununu 

müəyyən edir. 
4. Daha mürəkkəb HTML cədvəlinə <caption>, <col>, <colgroup>, <thead>, <tfoot> və 

<tbody> elementləri daxildir.

4. Faydalı məlumat lövhəsi̇ yaratmaq

<FORM NAME= “formanı müəyyən etmək üçün ad”
ACTION=”URL”
METHOD= CGI proqramını serverə ötürmək üçün metod kimi postu müəyyən edir.
TARGET= çıxışı göstərmək üçün pəncərəni müəyyən edir. 
ENCTYPE= proqramı ötürmək üçün məlumat növünü müəyyən edir.
Müxtəlif giriş formaları
</FORM>
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3.2 Sadə <Table> teqi
1. Sadə HTML cədvəli iki sütun və iki sətirdən ibarətdir:
2.Nümunə

3.3 Standart CSS parametrləri 
1. Əksər brazuerlər <table> elementini aşağıdakı dəyərlər ilə nümayiş etdirir:
2. Nümunə

<table>
  <tr>
    <th>Month</th>
    <th>Savings</th>
  </tr>
  <tr>
    <td>January</td>
    <td>$100</td>
  </tr>
</table>

table {
    display: table;
    border-collapse: separate;
    border-spacing: 2px;
    border-color: gray;
}

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

1. Cədvəl başlıqlarının düzəldilməsi 
1) Cədvəl başlıqlarının düzəldilməsi 

<!DOCTYPE html>
<html>
<head>
<style>
table, th, td {
    border: 1px solid black;
}
</style>
</head>
<body>
<h4>Table headers:</h4>
<table>
  <tr>
    <th>Name</th>
    <th>Telephone</th>
  </tr>
  <tr>
    <td>Saida Hohe </td>
    <td>+94451*******</td>
  </tr>
  <tr>
    <th>Name</th>
    <th>Telephone</th>
  </tr>
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2. Başlıq ilə cədvəlin düzəldilməsi
1) Başlıq ilə cədvəlin düzəldilməsi

3. Cədvəl içərisində teqlərin düzəldilməsi 
1) Digər elementlərin içərisindəki elementləri 
göstərin.

 <!DOCTYPE html> 
<html> 
<head> 
<style> 
table, th, td { 
    border: 1px solid black; 
} 
</style> 
</head> 
<body> 
 
<table> 
  <caption>Monthly savings</caption> 
  <tr> 
    <th>Month</th> 
    <th>Savings</th> 
  </tr> 
  <tr> 
    <td>January</td> 
    <td>$100.000</td> 
  </tr> 
  <tr> 
    <td>February</td> 
    <td>$150,000</td> 
  </tr> 
</table> 
 
</body> 
</html> 

 <!DOCTYPE html> 

<html> 

<head> 

<style> 

table, th, td { 

    border: 1px solid black; 

} 

</style> 

</head> 

<body> 

<table> 
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4. Xanaların yaradılması
1) Birdən çox sətir və sütundan ibarət olan cəd-
vəl xanalarını müəyyən edin.

<!DOCTYPE html>
<html>
<head>
<style>
table, th, td {
    border: 1px solid black;
}
</style>
</head>
<body>
<h4> iki sütunu əhatə edir: </h4>
<table>
<tr>
  <th>Ad</th>
  <th colspan="2">Telefon</th>
</tr>
<tr>
  <td>Henry</td>
  <td>+944 55 *** ****</td>
  <td>+944 51 *** ****</td>
</tr>

 
<td>This cell contains a table: 
   <table> 
   <tr> 
     <td>A</td> 
     <td>B</td> 
   </tr> 
   <tr> 
     <td>C</td> 
     <td>D</td> 
   </tr> 
   </table> 
  </td> 
</tr> 
<tr> 
  <td>This cell contains a list 
   <ul> 
    <li>apples</li> 
    <li>bananas</li> 
    <li>pineapples</li> 
   </ul> 
  </td> 
  <td>HELLO</td> 
</tr> 
</table> 
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</table>
<h4> iki sətiri əhatə edir:</h4>
<table>
<tr>
  <th>Ad:</th>
  <td>Kate</td>
</tr>
<tr>
  <th rowspan="2">Telefon:</th>

5. Üzvlük üçün qeydiyyatdan keçmək
1) Üzvlük üçün qeydiyyatdan keçmək
1. Məlumatın kodlaşdırılması

 <HTML> 
 </HEAD> 
  <TITLE>membership enrollment.html</TITLE> 
 </HEAD> 
<BODY LEFTMARGIN="0" TOPMARGIN="0" MARGINWIDTH="0" MARGINHEIGHT="0"> 
<CENTER> 
<IMG SRC="images/3-21_1.gif" WIDTH="580" HEIGHT="90" BORDER=0 ALT=""><BR> 
<TABLE WIDTH="600" CELLPADDING="5" CELLSPACING="1" BGCOLOR="#CCCCCC"> 
 <TR> 
  <TD COLSPAN="2"><FONT COLOR="#FFFFFF"><B>◈ basic Information 
 </B></FONT></TD>    
 </TR> 
 <!-- id --> 
 <TR> 
  <TD ALIGN ="right"  BGCOLOR="#F4F4F4"><FONT COLOR="#FF9900"> 
                *</FONT>ID&nbsp;</TD>  
  <TD BGCOLOR="#FFFFFF"> 
   <INPUT TYPE=""text"" MAXLENGTH="12" NAME="userid"> 
   <INPUT TYPE="image" SRC="images/3-21_2.gif">&nbsp; 
   <FONT COLOR="#FF9900" size="2">(4~12 digits including english character 
                        and figures)</FONT> 
  </TD> 
 </TR> 
 <!-- password --> 
 <TR> <TD ALIGN ="right"  BGCOLOR="#F4F4F4"><FONT COLOR="#FF9900"> 
                 *</FONT>password&nbsp;</TD>  
  <TD BGCOLOR="#FFFFFF"> 
   <INPUT TYPE="password" MAXLENGTH="8" NAME="password1">&nbsp; 
   <FONT COLOR="#FF9900" size="2">(make it within 4~8 letters)</FONT>  </TD> 
 </TR> 
   <INPUT TYPE="image" SRC="images/3-21_2.gif">&nbsp; 
   <FONT COLOR="#FF9900" size="2">(4~12 digits including english character 
                        and figures)</FONT> 
  </TD> 
 </TR> <!-- password --> 
 <TR> 
  <TD ALIGN ="right"  BGCOLOR="#F4F4F4"><FONT COLOR="#FF9900"> 
                 *</FONT>password&nbsp;</TD>  
  <TD BGCOLOR="#FFFFFF"> 
   <INPUT TYPE="password" MAXLENGTH="8" NAME="password1">&nbsp; 
   <FONT COLOR="#FF9900" size="2">(make it within 4~8 letters)</FONT>  </TD> 
 </TR> 
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<!-- confirm the password --> 
 <TR> 
  <TD ALIGN ="right"  BGCOLOR="#F4F4F4"><FONT COLOR="#FF9900">  
                *</FONT>confirm the password&nbsp;</TD>  
  <TD BGCOLOR="#FFFFFF"> 
   <INPUT TYPE="password" MAXLENGTH="8" NAME="password2">&nbsp; 
   <FONT COLOR="#FF9900" size="2">(enter the above password)</FONT> 
  </TD> 
 </TR> 
 <!-- name --> 
 <TR> 
  <TD ALIGN ="right"  BGCOLOR="#F4F4F4"><FONT COLOR="#FF9900"> 
                 *</FONT>Name(english)&nbsp;</TD> 
  <TD BGCOLOR="#FFFFFF"> 
   <INPUT TYPE=""text"" MAXLENGTH="30" NAME="NAMEkor">&nbsp; 
   <FONT COLOR="#FF9900" size="2">(sample;YUN HyungSoon)</FONT> 
  </TD> 
 </TR> 
 
 
 <!-- e-mail --> 
 <TR>  
   <TD ALIGN ="right"  BGCOLOR="#F4F4F4"><FONT COLOR="#FF9900">*</FONT> 
           e-mail&nbsp;</TD>  
   <TD BGCOLOR="#FFFFFF"><INPUT TYPE="text" MAXLENGTH="35"  NAME="email"  
          SIZE="35" ></TD> 
 </TR> 
 
 
 <!-- personal private infomation --> 
 <TR> 
  <TD COLSPAN="2"><FONT COLOR="#FFFFFF"><B>◈ personal private information 
               </B></FONT></TD>    
 </TR> 
 
 
 <!-- address --> 
 <TR> 
   <TD ALIGN ="right"  BGCOLOR="#F4F4F4">address&nbsp;</TD>  
   <TD BGCOLOR="#FFFFFF"> 
  <INPUT TYPE="text" MAXLENGTH="15" NAME="jobpostno" SIZE="15"  
                 READONLY>&nbsp; 
  <INPUT TYPE="button" VALUE="searching for zip code"><BR> 
  <INPUT TYPE=""text"" MAXLENGTH="55"  NAME="jobaddr" SIZE="55">&nbsp; 
   </TD> 
 </TR> 
 
 
 <!-- telephone/mobile phone --> 
 <TR> 
   <TD ALIGN ="right"  BGCOLOR="#F4F4F4">telephone/mobile phone&nbsp;</TD>  
   <TD BGCOLOR="#FFFFFF"> 
     <INPUT TYPE="text" MAXLENGTH="5"  NAME="hptel1" SIZE="5" >&nbsp;- 
     <INPUT TYPE="text" MAXLENGTH="5"  NAME="hptel2" SIZE="5" >&nbsp;- 
  <INPUT TYPE="text" MAXLENGTH="12" NAME="hptel3" SIZE="12">  
 </TR> 
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 <!-- occupation --> 
 <TR> 
  <TD ALIGN ="right"  BGCOLOR="#F4F4F4">occupation&nbsp;</TD> 
  <TD BGCOLOR="#FFFFFF"> 
   <SELECT NAME="job"> 
   <OPTION VALUE=""selected >select the job</OPTION> 
   <OPTION VALUE="0">unemploed</OPTION> 
   <OPTION VALUE="1">student</OPTION> 
   <OPTION VALUE="2">computer/internet</OPTION> 
   <OPTION VALUE="3">press</OPTION> 
   <OPTION VALUE="4">public officier</OPTION> 
   <OPTION VALUE="5">soldier</OPTION> 
   <OPTION VALUE="6">service</OPTION> 
   <OPTION VALUE="7">education</OPTION> 
   <OPTION VALUE="19">other</OPTION> 
  </SELECT>    
   </TD> 
 </TR> 
 <!-- hobby --> 
 <TR>  
   <TD ALIGN ="right"  BGCOLOR="#F4F4F4">hobby&nbsp;</TD>  
   <TD BGCOLOR="#FFFFFF"> 
     <INPUT TYPE="checkbox" value="1" NAME="hobby1">reading 
     <INPUT TYPE="checkbox" value="2" NAME="hobby2">climbing 
     <INPUT TYPE="checkbox" value="3" NAME="hobby3">fishing 
  <INPUT TYPE="checkbox" value="4" NAME="hobby4">movie  
   </TD> 
 </TR> 
 <!-- the path to know--> 
 <TR>  
   <TD ALIGN ="right"  BGCOLOR="#F4F4F4">the path to know&nbsp;</TD>  
   <TD BGCOLOR="#FFFFFF"> 
     <INPUT TYPE="radio" value="1" NAME="inputpath">TV/newspapwr/magazine 
     <INPUT TYPE="radio" value="2" NAME="inputpath">internet 
     <INPUT TYPE="radio" value="3" NAME="inputpath">collegue 
  <INPUT TYPE="radio" value="4" NAME="inputpath">other 
   </TD> 
 </TR> 
<!-- entry greeting --> 
 <TR>  
   <TD ALIGN ="right"  BGCOLOR="#F4F4F4" VALIGN="top">Entry greeting&nbsp;</TD>  
   <TD BGCOLOR="#FFFFFF"><TEXTAREA NAME="" ROWS="2" 
COLS="60"></TEXTAREA></TD> 
 </TR> 
 <!-- 사진 첨부 --> 
 <TR>  
   <TD ALIGN ="right"  BGCOLOR="#F4F4F4" VALIGN="top">Photo attachment&nbsp;</TD>  
   <TD BGCOLOR="#FFFFFF"><INPUT TYPE="file" NAME="photo"></TD> 
 </TR> 
 <TR BGCOLOR="#FFFFFF"> 
   <TD HEiGHT="30" COLSPAN=2 ALIGN="center"> 
  <INPUT TYPE="submit" NAME="regist" VALUE="Membership"> 
  <INPUT TYPE="reset" NAME="cancle" VALUE="Cancel"></TD> 
 </TR> 
</TABLE> 
</CENTER> 
</BODY> 
</HTML> 
 



HTML - JAVASCRIPT

331

 
Reconfirm 

2. Veb brauzerini yoxlayın. 

5. Üzvlük üçün qeydiyyatdan keçmək
1) Bununla bağlı teqlər
1. <table>
2. <a>
3. Yerləşdirilməsi

2)  
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3. Veb səhifəsini gözdən keçirin.
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Cədvəl işarəsi atributunu dəqiqliklə izah etdi?
2. Hyper link işarəsini (tag) düzgün istifadə etdi?  
3. Məlumat lövhəsi üçün müvafiq işarələri düzgün şəkildə istifadə 
etdi?
4. Proqram haqda məlumatları düzgün şəkildə kodlaşdırdı?
5. Veb brauzinq nəticəsini yoxladı?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Özünü təqdimat üçün veb səhifə yerləşdirilməsini aydın şəkildə izah edəcək;
2.   Özünü təqdimat üçün veb səhifəni detallı şəkildə tərtib etməyi biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/Məlumat kitabı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   HTML/JavaScript redaktoru
3.   Proyektor

Mövzu ilə əlaqəli biliklər
1. <table> tag                                  
2. <style> tag

- Margin
- Position
- Float
- Background
- Line spacing

5. Özünü təqdi̇mat üçün veb səhi̇fə tərti̇b et-
mək

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

Ⅰ. <table> teqinin istifadə olunması 

1) Cədvəl tərtibatının qurulması 
1. En: 500px
2. Hündürlük: 350px
3. Növ: 2x2

2) Hər bir xananın ölçüsünün tənzimlənməsi 
1. Cədvəl 1.1: 370x150px
2. Cədvəl 1.2: 130x150px
3. Cədvəl 2.1: 370x200px
4. Cədvəl 2.2: 130x2000px

3) Məlumatın kodlaşdırılması 

 

1.1 

2.1 

1.2 

2.2 

 
Sentence sector 1 Photo 

Sentence sector 2 
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4. Veb brauzerin yoxlanılması 

2. Şəkil qalereyasının yaradılması
1) Qalereya tərtibatının dizayn olunması 
1. Şəkilləri eyni boşluqda düzün. 
2. Şəkil adını müəyyən edin. 
3. Şəkil görüşünü klik edərək böyüdün.

2) Sadə qalereya düzəltmək 
1. Ekranda şəkillərin yerləşdirilməsi
2. Siçana böyütmək funksiyasını verin. 

3) Əlaqəli atributlar və teqlər
1. <table> tag
2. border
3. caption-side
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4. anchor

4) Şəkil qalereyası yaratmaq
4.1 Cədvəl tərtibatını tənzimləmək
1. En: 4 sütun
2. Hündürlük: 4 sətir 
3. Sağ yuxarı hissə: [2x3] sahəsini birləşdirin. 

4.2 Şəkil üzərində siçanı yerləşdirərək obyektin 
böyüdülməsi
1. <a> teqinin ‘hover’ atributunu istifadə edin. 
2. ‘onmouseover’ və ‘onmouseout’-i istifadə 
edin.  
3. Məlumatı kodlaşdırın. 

 
Thumbnail 

Image 1 
Thumbnail 

Image 2 

Image display Thumbnail 
Image 3 

Thumbnail 
Image 4 

Thumbnail 
Image 5 

Thumbnail 
Image 6 

Thumbnail 
Image 7 

Thumbnail 
Image 8 

Thumbnail 
Image 9 

Thumbnail 
Image 10 
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4. Veb brauzerini yoxlayın.
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Özünü təqdimat üçün veb səhifə tərtibatını izah etdi?
2. Özünü təqdimat üçün veb səhifəni detallı şəkildə yaratdı?
3. Cədvəl ilə bağlı işarələri (tags) düzgün istifadə etdi?
4. Veb brauzinq nəticəsini əminliklə təsdiq etdi?
5. Baş verən xətaları dəqiqliklə yoxladı?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Veb proqramlaşdırma üçün JavaScript-in rolunu izah edəcək;
2.   Veb brauzerində istifadə olunan pop-up pəncərəsini göstərməyi biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/Məlumat kitabı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   HTML/JavaScript redaktoru
3.   Proyektor

Mövzu ilə əlaqəli biliklər
1. Metodun tətbiq olunması [“widow.open(ur1), name, option);”]                               

1.1 Tanınma və istifadə
1. Open (Açmaq) metodu yeni brauzer pəncərəsini açır.
※ Pəncərəni bağlamaq üçün Close (bağlamaq) metodunu istifadə edin.
1.2 Sintaksis

6 . Pop-up pəncərəsi̇ni̇ göstərmək

<  window.open (URL, name, specs, replace)

1.3 Parametr dəyərləri

para-
metr

Təsvir

URL Fakultativ:  Açılan pəncərənin URL-sini müəyyənləşdirir. Əgər heç bir URL 
müəyyən olunmayıbsa about:blank ilə yeni bir pəncərə açılır. 

Name Fakultativ: Pəncərənin adını və ya hədəf atributu müəyyənləşdirir. Aşağıdakı dəyərlər 
dəstəklənir:

•	 _blank – URL yeni pəncərəyə yüklənir. Bu, standartdır.

•	 _parent - URL əsas çərçivəyə yüklənir. 

•	 _self - URL cari səhifəni əvəz edir. 

•	 _top – URL yüklənə biləcək hər hansı çərçivələri əvəz edir. 

name – Pəncərə adı (Qeyd: ad yeni pəncərənin başlığını müəyyən etmir)
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specs Fakultativ: Vergüllə ayrılmış element siyahısı, boşluq yoxdur. Aşağıdakı dəyərlər 
dəstəklənir:

channelmode=yes|no|1|0 Teatr rejimində pəncərənin göstərilib göstərilməməsi Default 
-no. Yalnız İE

directories=yes|no|1|0 İstifadədən çıxmış. Kataloq düymələrini əlavə etmək və ya 
etməmək 
Default - yes. Yalnız IE 
fullscreen=yes|no|1|0 Bütöv ekran rejimində brauzeri nümayiş etmək və ya etməmək 
Default - no.  
Bütöv ekran rejimində pəncərə həmçinin teatr rejimində də olmalıdır. Yalnız IE.

height=pixels Pəncərənin hündürlüyü 
Minimum dəyər 100-dür. 
left=pixels Pəncərənin sol yerləşməsi 
Neqativ dəyərlərə icazə verilmir. 
location=yes|no|1|0 Adres sahəsinin göstərilib-göstərilməməsi 
Yalnız opera
menubar=yes|no|1|0 Menyu zolağının göstərilib-göstərilməməsi

resizable=yes|no|1|0 Pəncərənin ölçüsünün yenidən dəyişdirilib-dəyişdirilməməsi 
Yalnız IE.
scrollbars=yes|no|1|0 Sürüşdürmə zolağının göstərilib-göstərilməməsi 
Yalnız IE, Firefox & Opera.

status=yes|no|1|0 Status panelinin əlavə edilib-edilməməsi

titlebar=yes|no|1|0  Başlıq zolağının göstərilib-göstərilməməsi 
Çağırış tətbiqi HTML və ya digər etibarlı dialoq qutusu olmadıqda sayılmır. 

toolbar=yes|no|1|0  Brazuer alətlər panelinin göstərilməsi və ya göstərilməməsi 
Yalnız IE və Firefox.

top=pixels Pəncərənin üst yerləşməsi 
Neqativ dəyərlərə icazə verilmir.  
width=pixels Pəncərənin eni 
Minimum dəyər 100-dür. 

Replace (yer-
ləşdirmək)

Fakultativ: URL-in yeni giriş yaratmağı və yaxud tarixçə siyahısından cari girişin əvəz 
olunmasını müəyyən edir. Aşağıdakı dəyərlər dəstəklənir:

•	 true – URL tarixçə siyahısından cari sənədi əvəz edir. 

•	 false - URL tarixçə siyahısında yeni giriş yaradır. 

1.4 Nümunə
1. "MsgWindow"adlanan yeni pəncərəni açın və içərisinə bir neçə mətn yazın.

2. Yeni pəncərə açın. Yeni pəncərəni bağlamaq üçün close() istifadə edin.

var myWindow = window.open("", "MsgWindow", "width=200,height=100");
myWindow.document.write("<p>This is 'MsgWindow'. I am 200px wide and 100px tall!</p>");
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function openWin() {
    myWindow = window.open("", "myWindow", "width=200,height=100");   // Yeni pəncərə 
açır
}

function closeWin() {
    myWindow.close();   // Yeni pəncərəni bağlayır
}

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

Ⅰ. Pop-up pəncərəsi ilə bağlı məlumatları kodlaşdırın.
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2. Veb brauzerin yoxlanılması 

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Veb proqramlaşdırma üçün JavaScript rolunu izah etdi?
2. Veb brazueri istifadə etməklə pop-up pəncərəsini göstərdi?
3. ‘window.open’ ilə bağlı metodları istifadə etdi?
4. Veb brauzinq ilə bağlı nəticələri əminliklə təsdiq etdi?
5. Veb brauzinqdə baş verən xətaları dəqiq şəkildə yoxladı?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   JavaScript proqramlaşdırmada dəyişənlər ifadəsini izah edəcək; 
2.   Rəqəmin daxil edilib-edilməməsini dəqiqliklə yoxlamağı biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/Məlumat kitabı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   HTML/JavaScript redaktoru
3.   Proyektor

Mövzu ilə əlaqəli biliklər
                       
1. Xüsusi cərgəni daxil edin. 

1) Giriş məzmununu yoxlayın. 
2) Rəqəmin çıxışının olub-olmadığını yoxlayın. 
3) Əgər istifadəçi ‘var anum=/  /-u dəyişirsə simvol və xüsusiyyət yoxlanıla bilər. 

2. JavaScript dəyişənləri
2.1 var
1. JavaScript dəyişənləri verilənlərin dəyərlərini saxlamaq üçündür. 
2. Misal üçün, x, y və z dəyişənlərdir. 
• var x = 5;
var y = 6;
var z = x + y;

2.2 JavaScript identifikatoru
1. Bütün JavaScript dəyişənləri unikal adlar (unique names) ilə müəyyən olunur.
2. Bu unikal adlara identifikatorlar (identifiers) deyilir.
3. İdentifikatorların qısa adları (x və y kimi) və ya daha çox təsviri adları olur (cəm, ümumi 

həcm və s.) 
4. Dəyişənlərə ad formalaşdırmaq üçün ümumi qaydalar aşağıdakılardır (vahid identifikatorlar):
• Adlar hərflərdən, alt xətlərdən, pillələrdən və dollar işarələrindən ibarət olur.
• Adlar hərf ilə başlamalıdır. 
• Adlar həmçinin  $ işarəsilə də başlaya bilər. (Amma biz bunu nəzəriyyədə istifadə etməyəcə-

yik.)
• Adlar böyük və kiçik hərf fərqləri ilə olur. (y və Y müxtəlif dəyişənlərdir)
• Bronlanmış adlar (JavaScript açar sözləri kimi) ad kimi istifadə oluna bilməz. 

7 . Rəqəmi̇ yoxlamaq

JavaScript identifikatorları hərflərə qarşı (böyük və kiçik hərf fərqləri) həssas olur.
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2.3 Təyinat operatoru 
1. JavaScript-də bərabərdir (=) işarəsi bərabərdir operatoru yox, təyinat operatorudur. 
2. Bu cəbrdən fərqlənir. Aşağıdakı cəbrdə heç bir məna kəsb etmir. 
• x = x + 5
3. JavaScript-də isə məna daşıyır: O, “x + 5 to x” dəyərini təyin edir. 
• x + 5-in dəyərini hesablayır və nəticəni x-ə qoyur. X-in dəyəri 5 ilə artırılır.

2.4 JavaScript məlumat növləri
1. JavaScript dəyişənləri 100 kimi rəqəmləri və “YHS” kimi mətn dəyərlərini saxlaya bilər. 
2. Proqramlaşdırmada mətn dəyərləri mətn sətirləri (text strings) adlanır.
3. JavaScript məlumatın çoxlu növlərini saxlaya bilir, amma hələlik biz yalnız rəqəmləri və 

sətirləri nəzərdə saxlayırıq. 
4. Sətirlər bir və ya iki dırnaq içərisində yazılır. Rəqəmlər dırnaq işarəsi olmadan yazılır. 
5. Əgər siz dırnaq işarəsinə rəqəm qoysanız o, mətn sətri kimi görünəcək.
6. Misal üçün,
var pi = 3.14;
var person = "YHS";
var answer = 'Yes I am!';

2.5 Dəyər = təyin olunmayıb (Value = undefined)
1. Kompüter proqramlarında dəyişənlər dəyər olmadan göstərilir. Dəyər hesablana bilinməlidir 

və ya istifadəçi tərəfindən sonradan təmin oluna bilər. 
2. Dəyəri olmayan dəyişənin müəyyən olunmamış (undefined) dəyəri olur. 
3. carName dəyişəni  bu açıqlamanın yerinə yetirilməsindən sonra müəyyən olunmamış dəyərə 

sahib olacaq.
4. Misal üçün,
var carName;

2.6 JavaScript dəyişənlərinin yenidən elan olunması
1. Əgər siz JavaScript dəyişənini yenidən elan edirsinizsə o, öz dəyərini itirməyəcək. 
2. carName dəyişəninin bu açıqlamanın yerinə yetirilməsindən sonra "Vəlvə" dəyəri olacaq:
3. Misal üçün,
var carName = "Vəlvə";
var carName;

Bərabərdir işarəsi JavaScript-də = = kimi yazılır.  

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

Ⅰ. Rəqəm girişi (Figure input) haqda məlumatın kodlaşdırılması 

2. Veb brauzerinin yoxlanılması 

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. JavaScript proqramlaşdırmasında dəyişənlər ifadəsini izah etdi? 
2. Rəqəmlərin daxil edilib-edilmədiyini dəqiq şəkildə izah etdi? 
3. Cədvəllə bağlı funksiyaları müvafiq şəkildə müəyyən etdi?
4. Veb brauzinq nəticəsini əminliklə təsdiq etdi?
5. Vebdə baş verən xətaları dəqiq şəkildə yoxladı?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   E-poçt yoxlaması ifadəsini izah edəcək;
2.    Brauzerdə e-poçt növünü yoxlamağı biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/Məlumat kitabı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   HTML/JavaScript redaktoru
3.   Proyektor

Mövzu ilə əlaqəli biliklər
                       
1. Forma xüsusiyyətləri və elementləri 

1.1 Naviqasiya: forma və elementlər 
1. Sənəd formaları xüsusi sənəd formaları toplusunun bir hissəsidir. 
2. Bu, adlı kolleksiyadır: Formanı əldə etmək üçün biz həm ad, həm də rəqəm istifadə edə 

bilərik. 

3. Bizim formamız olduqda adlı kolleksiya forması elementlərində hər hansı bir element 
mövcud olur. 

4. Misal üçün,

8. E-mail (e-poçt) Formasını yoxlamaq

1 document.forms.my - the form with name=»my»
2 document.forms [0] – sənəddə ilk formadır.

 <form name="my"> 
  <input name="one" value="1"> 
  <input name="two" value="2"> 
</form> 
 
<script> 
  // get the form 
  let form = document.forms.my; // <form name="my"> element 
 
  // get the element 
  let elem = form.elements.one; // <input name="one"> element 
 
  alert(elem.value); // 1 
</script> 
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5. Eyni ad ilə çoxlu elementlər ola bilər. Bu radio düymələrində tez-tez rast gəlinən haldır. 
6. Bu halda forma elementləri [name] topludur. Məsələn,

 <form> 
  <input type="radio" name="age" value="10"> 
  <input type="radio" name="age" value="20"> 
</form> 
 
<script> 
let form = document.forms[0]; 
 
let ageElems = form.elements.age; 
 

1.2  Input və Textarea
1. Yoxlama qutuları üçün dəyəri adətən “input.value” və ya “input.checked” kimi əlavə edirik.
2. Nümunə

 input.value = "New value"; 
textarea.value = "New text"; 
input.checked = true; // Yoxlama qutusu və ya radio düyməsi üçün 

 

※ Qeyd : textarea.innerHTML  deyil,  textarea.value istifadə edin. 
O, cari dəyəri deyil, yalnız başlanğıc səhifədə olan HTMLi saxlayır.  

1.3 Select və Option (seçim və alternativ) 
1) <select> elementinin 3 vacib xüsusiyyəti var:
1. select.options – <option> elementlərinin toplusu
2. select.value – seçilən alternativin dəyəri 
3. select.selectedIndex – seçilən alternativin sayı
2) <select> dəyərini yaratmaq üçün 3 əsas yolumuz var:
1. Ehtiyac olan <option> seçilməsi və option.selected to true-nun qurulması 
2. select.value  dəyərini qurun.
3. Seçim sayına select.selectedIndex-i tənzimləyin. 
3) İlk yol ən çox bilinən yoldur, amma  2 və 3 adətən daha rahat sayılır.
4) Misal üçün,

 <select id="select"> 
  <option value="apple">Apple</option> 
  <option value="pear">Pear</option> 
  <option value="banana">Banana</option> 
</select> 
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 <script> 
  // all three lines do the same thing 
  select.options[2].selected = true; 
  select.selectedIndex = 2; 
  select.value = 'banana'; 
</script> 

5) Digər kontrollardan fərqli olaraq <select multiple> çox seçim imkanı verir. Bu halda bütün 
dəyərləri əlavə etmək üçün “select.options” üzərindən getməliyik. 

Misal üçün,

  let option = new Option("Text", "value"); 
// creates <option value="value">Text</option> 

 

• Eyni element seçilir.

 let option = new Option("Text", "value", true, true) 

※ Qeyd:
<option> -ın əlavə xüsusiyyətləri
    Seçim elementlərinin əlavə xüsusiyyətləri var:
    Selected - alternativ seçiləndir. 
    Index - <select> -də seçim rəqəmi 
    Text - seçimin məzmun mətni (ziyarətçi tərəfindən görünür)

2.  Xülasə (Summary)
1) Forma naviqasiyası
1. document.forms
Sənəd forması kimi mövcuddur. [name/index]
2. form.elements
Forma elementləri form.elements [name/index] kimi mövcuddur. Və yaxud [name/index] For-

masını istifadə edə bilərsiniz. Element xüsusiyyətləri, həmçinin <fieldset> üçün işləyir.
3. element.form
Elementlər forma xüsusiyyətindəki formalara istinad edirlər. 
2) Dəyər (Value) input.value, textarea.value, select.value və ya input.checked for checkboxes 

və  radio buttons kimi mövcuddur.
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Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

Ⅰ. Məlumatın kodlaşdırılması
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2. Veb brazuerin yoxlanılması

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Email check funksiyası ifadəsini əminliklə izah etdi?
2. Brauzer üçün e-poçt növünü düzgün şəkildə yoxladı?
3. Veb brauazinq nəticəsini əminliklə təsdiq etdi?
4. Veb brauzinqdə baş verən xətaları dəqiqliklə yoxladı?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Javascript proqramlaşdırmasında istifadə olunan işlərin növlərini əminliklə izah edəcək;
2.   Giriş məlumatının ingilis simvol və rəqəmi olmasını dəqiq şəkildə izah etməyi biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/Məlumat kitabı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   HTML/JavaScript redaktoru
3.   Proyektor

Mövzu ilə əlaqəli biliklər
                       
1. Onkeyup Event   

İstifadəçi düyməni buraxdıqda Javascript icra edin:

9. İngi̇li̇s si̇mvolu və rəqəmi̇ni̇ 
müəyyənləşdi̇rmək

Nümunə 0 <input type=»text» onkeyup=»myFunction()»>

1.1 Tanınması və istifadəsi
1. Onkeyup event istifadəçi düyməni buraxdıqda baş verir. (klaviaturada)
• Onkeypress: Düyməni basdıqda JavaScript-i icra edin:

• Onkeydown: Düyməni basdıqda JavaScript-i icra edin:
  

• Onkeyup: (refer example 0)

1.2 Sintaksis
1) HTML-də:

2) JavaScript-də:

3) JavaScript-də “addEventListener()” metodunu istifadə edin.

 <input type="text" onkeydown="myFunction()"> 

 <input type="text" onkeypress="myFunction()"> 

<element onkeyup="myScript">

object.onkeyup = function(){myScript};

object.addEventListener("keyup", myScript);



İKT

360

※ Qeyd: addEventListener() metodu Internet Explorer 8 və daha əvvəlki versiyalarda dəstəklən-
mir. 

2. Texniki funksiyalar 
2.1 Event detalları

Bubbles (Şarlar): Yes
Cancelable (Ləğv 

edilə bilən):
Yes

Event type (növü): KeyboardEvent
Supported HTML tags 
(Dəstəklənən HTML 

teqləri):

<base>, <bdo>, <br>, <head>, <html>, <iframe>, <meta>, 
<param>, <script>, <style>, and <title>-dan başqa bütün 
HTML element növləri 

DOM Version (versi-
yası):

Level 2 Events

1.2 Nümunələr 
1.  "onkeyup" ilə birlikdə "onkeydown" istifadəsi 
2. 

<input type="text" onkeydown="keydownFunction()" onkeyup="keyupFunction()">

<script>
function myFunction() {
 var x = document.getElementById("fname").value;
    document.getElementById("demo").innerHTML = x;
}
</script>

3. "onkeyup"ilə "onkeydown"-nun birgə istifadəsi

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

1. Məlumatın kodlaşdırılması
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2. Veb brazuerin yoxlanılması

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. JavaScript proqramlaşdırmasında event-lərin növlərini əminliklə 
izah etdi? 
2. Giriş məlumatının ingilis simvol və ya rəqəmi olduğunu dəqiq-
liklə yoxladı? 
3. ‘Onkey’ event ilə bağlı teqləri tətbiq etdi?
4. Veb brauzinq nəticəsini əminliklə təsdiq etdi?
5. Veb brauzinqdə baş verən xətaları dəqiqliklə yoxladı?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Qadağan olunmuş dil ifadəsini asanlıqla izah edəcək:
2.   Qadağan olunmuş söz üçün proqramı əminliklə kodlamağı biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/Məlumat kitabı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   HTML/JavaScript redaktoru
3.   Proyektor

Mövzu ilə əlaqəli biliklər
                       

• Məlumat lövhəsində yazının yüklənməsinə baxın.  
• Məlumat lövhəsində qadağan olunmuş sözü axtardıqda müştəri xəbərdarlıq mesajı alacaq və 

sayta qoşulmaqdan imtina edəcək. 

1. Mətn sırasında vulqar sözlər
1.1 Vulqar sözlər 

10. Qadağan olunmuş sözü axtarmaq 

 

var PROFANITY = ['ass','bottom','damn','shit'] 
  , CENZOR = ("#####################").split("").join("########") ; 
PROFANITY  = new RegExp( "(\\W)(" + PROFANITY.join("|") + ")(\\W)","gi"); 
function clearProfanity(s){ 
    return s.replace( PROFANITY 
                    , function(_,b,m,a) {  
                         return b + CENZOR.substr(0, m.length - 1) + "!" + a 
                      }  
                    ); 
} 
alert( clearProfanity("'ass','bottom','damn','shit'") ); 
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1.2 Vulqar sözlərin istifadəsi

 var Swear_wordsArr=new Array(" ",  " ",  " "…); 
var SwearAlertArr=new Array; 
var SwearAlertCount=0; 

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

Ⅰ. Məlumatın kodlaşdırılması
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2. Brauzerin yoxlanılması

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Qadağan edilmiş dil ifadəsini asanlıqla izah etdi?
2. Qadağan olunmuş söz üçün proqramı əminliklə kodlaşdırdı? 
3. Qadağan olunmuş söz obyektini düzgün şəkildə istifadə etdi?
4. Veb brauzinqdə baş verən xətaları dəqiq şəkildə yoxladı?
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UX/UI

Sənaye və İnnovasiyalar üzrə 
Bakı Dövlət Peşə Təhsil Mərkəzi

Səriştə əsaslı 
modul İKT
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İKT

Ön söz 

 İstifadəçi interfeysi dizaynı (User Interface design (UI)) və ya istifadəçi interfeysi mühəndisliyi 
-  maşınlar, kompüterlər, telefon cihazları və digər elektron vasitələri istifadəyə verən və istifadə 
edənin təcrübəsinə maksimum diqqət yetirən istifadəçi interfeysi dizaynıdır. Bu proqramın məqsə-
di istifadəçinin məqsədlərini həyata keçirmək üçün istifadəçi təsirini sadə və effektiv etməkdir. 
 İstifadəçi interfeys dizayn avadanlıqları özünə lazımsız diqqət cəlb etmədən tapşırıqların icrasını 
tamamlayır. Qrafik dizayn və tərtibat bu istifadəni birləşdirir, istifadəçinin konkret qarşılıqlı fəali-
yyətini həyata keçirməyə və tərtibatın effektiv müraciətini təkmilləşdirməyə təsir edir. Dizayn 
estetikası interfeysin funksiyalarını istifadə etmək üçün istifadəçinin qabiliyyətindən asılı olaraq 
arta və azala bilər.[1] Dizayn prosesi istifadəçinin dəyişən ehtiyacına uyğun olaraq qəbul edilən 
və istifadəyə uyğun olan sistem yaratmaq üçün texniki funksionallığa və vizual elementlərə uyğun 
olmalıdır. 
 İnterfeys dizaynı kompüter sistemlərinin çoxsaylı layihələrində öz əksini taparaq maşınlara, ti-
carət təyyarələrinə ötürülür. Bu layihələrin hamısı insanların qarşılıqlı fəaliyyət imkanlarını 
birləşdirsə də bəzi vahid bilik və bacarıqlar da tələb edir. Nəticədə dizaynerlər layihələrin dəqiq 
növ sahələrində xüsusiləşməyə meyl edir və proqram təminatı dizaynı, istifadəçi araşdırması, veb 
dizayn və ya sənaye dizaynı kimi ekspertizaya yönəlmiş qabiliyyətlər qazanırlar.
 İstifadəçi təcrübə dizaynı (UX, UXD, UED və ya XD) proqramı istifadəçinin məmnunluğunun 
artmasına yardımçı bir proses olub məhsulla əlaqədar məmnunluq, qəbul etmə və istifadəni tək-
milləşdirməyə kömək edir.[1] Bu təcrübə ənənəvi insan-kompüter tərtibatını (HCI) əhatə edir və 
onun istifadəçi tərəfindən istifadə olunan məhsulun və xidmətin bütün aspektlərinə müraciət etmək 
imkanını genişləndirir.[2] 
 Yekun olaraq mən çoxsaylı mənbələrə, xüsusilə YouTube, Yahoo, Wikipedia, “www.hrdbank.net” 
və Google saytlarına təşəkkür edirəm. Onlar mənə texniki təcrübə modulu dərsliyinin hazırlan-
masında köməklik etdilər. 

                YUN, Hyung Soon, IKT üzrə Texniki Ekspert
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   UI və UX arasında fərqi əminliklə izah edəcək;
2.   Kamera tətbiqi ikonlarında hər hansı bir hissəni tərtib etməyi biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   Photoshop proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

- Dairəvi düzbucaqlı aləti (Rounded Rectangle Tool)       -  Böyütmə aləti (Zoom Tool)
- Ellips aləti (Ellipse Tool)           -  Qat stili  (Layer Style)
- Qradient aləti (Gradient Tool)                                 

1. Kamera tətbi̇qləri̇ üçün i̇kon di̇zayn etmək

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

1. Obyektiv gövdənin dizayn olun-ması
1) File>New-n klik edərək yeni sənədin tərtib 
olunması.
1. İş lövhəsi parametrləri:
• En 1024 px
• Hündürlük: 1024px 
• Dəqiqlik (Resolution): 72  
• Rəng rejimi (Color mode): RGB  

2) Obyektiv gövdəsi üçün düzbucaqlının 
çəkilməsi
1. [Rounded Rectangle Tool] alətini seçin.
2. İş sahəsi üzərində iki dəfə klik edin. 
3. Düzbucaqlı parametrlərini aşağıdakı kimi tə-
yin edin:
• En x hündürlük: 1024 x 1024 piksel
• Radius: 160px
• [Move Tool] ilə  obyekti iş sahəsinin mərkəzinə 
sürüyün. 
4. Rəngi [white; #ffffff] təyin edin. 
5. Qatı [Rounded Rectangle]-a dəyişin.

3) Düzbucaqlı obyektini iş lövhəsinin mərkəzinə 
qoyun. 
1. Xətkeşi göstərin.
2. Kənar xətləri çəkin. 
3. Düzbucaqlının sağ mərkəzində əsas nöqtəni 
təyin edin. (512x512px)
4. Ekranı [Zoom Tool] aləti ilə böyüdün.
5. Əgər mərkəz [512x512px] olarsa [Info] pane-
li ilə x və y oxunun yerləşmə mövqeyini təsdiq 
edin. 
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4) Düzbucaqlının mərkəzindən dairənin çəkilmə-
si
1. Ellips alətini seçin.
2. Əsas xəttin mərkəzindən dairə çəkin.
• Ölçü: 500x500 px
• Rəng: #ffffff

 
3. Qat adını [Ellipse 1]-ə dəyişin. 

5) “Layer Style” parametrlərinin tənzimlənməsi 
1. “Layer Panel”də [Ellipse 1] qatına iki dəfə 
klik edin. 
2. [Layer Style] pəncərəsini göstərin.
3. [Stroke] stilini seçin. 
Struktur     
• Ölçü: 9px
• Yerləşmə mövqeyi: daxili
• Qeyri şəffaflıq: 16%
Dolum növü: 
• Qradient
• Stil: Xətti
• Şkala: 99%

6) “Drop Shadow” (kölgə salma) effektinin ver-
ilməsi
1. [Drop Shadow] elementlərini aşağıdakı kimi 
təyin edin:
Struktur
• Qeyri-şəffflıq: 16%
• Bucaq: 90°
• Məsafə: 11px
• Ölçü: 11px
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7) Obyektiv (Lens) hissənin təsvir edilməsi  
1. Dairəni əvvəlki qaydada bir dəfə də çəkin. 
2. Ölçü (EnxHündürlük): 446x446px
3. Rəng: [black #000000]
4. Yeni qat adını [Ellipse 2] təyin edin. 

8) Obyektivin (Lens) kənar hissəsinin təsvir ol-
unması
1. Tənzimlənmiş obyektlərin 3 növü var.
[Layer Style] pəncərəsində
• Stroke effekti
• Gradient Overlay effekti
• Pattern Overlay effekti
2. [Ellipse 2] qatını iki dəfə klik edin. 

9.) [Stroke] stilinin istifadə olunması
1. Kameranın ağ konturu və obyektivin təsvir 
hissəsi arasındakı sərhədi qeyd edin. 
2. [Stroke] parametrlərini aşağıdakı kimi təyin 
edin:
Struktur
• Ölçü: 2px
• Yerləşmə mövqeyi: Daxili
Dolum növü
• Rəng: [black, #000000]
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10) “Gradient Overlay” stili ilə əks olunan par-
laqlığın ifadə olunması
1. [Gradient Overlay] stilini yoxlayın.
2. Parametrləri aşağıdakı kimi təyin edin:
Qradasiya
• Qarışdırma rejimi: Normal
• Qeyri-şəffaflıq: 42%
• Stil: Bucaq 
• Rəng: [black, #000000]

11) “Gradient Editor” ilə üç qara və üç ağ sahənin 
tənzimlənməsi
1. [Gradient Color] sahəsini klik edin. 
2. 3 ağ və 3 qara sahə qurun. 
• Başlama nöqtəsi və son nöqtəsi: eyni rəng 

12) Obyektivin hissəsinə “Pattern Overlay” ef-
fektinin tənzimlənməsi
1. 3 ağ və 3 qara sahə qurun.
Pattern
• Qarışdırma rejimi (Blend Mode): Normal
• Qeyri-şəffaflıq (Opacity): 9%
2. Parametləri tənzimlədikdən sonra  [down] 
düyməsini klik edin. 

13) Obyektdə hamar teksturanın tənzimlənməsi 
1. [Library] pəncərəsinin sağ yuxarı hissəsində 
“Settings” ikonunu klik edin.  
2. [Add Set List] görünür.
3. [Artist Surfaces]-i seçin.
4. [Append]-i klik edin. 
5. [ Smooth Texture] tətbiq edin. 

14) Tekstura səviyyəsinin tənzimlənməsi
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15) Qara dairənin bir dəfə də çəkilməsi 
1. Dairəni çəkin: [380 x 380 px; widthxheight]
2. Bir neçə dairə çəkərək dəliyi təsvir edin.
3. Yeni qatı [Ellipse 3]-ə dəyişin. 

16) Sahəyə qara xətt ilə parlaq effekt əlavə 
edilməsi 
1. Daha əvvəl çəkilmiş dairəni kopyalayın.
2. [Ellipse 3 copy] adlı “Ellipse 3”-ün kopyasını 
yaradın. 
 

17) [Ellipse 3 copy]-ə sərbəst transformasiyanın 
tətbiq edilməsi
1. [Ellipse 3 copy] qatını klik edin.
2. [Ctrl + T] qısayol düyməsini klik edin. 
3. Photoshop menyusunun [Edit] seçimindən 
[Free Transform]-u seçin. 

18) Dairə fiqurunun transformasiya olunması 
1. Dairə ətrafında düzbucaqlı kənarlarını trans-
formasiya edin. 
2. [Shift+Alt] düyməsini basılı saxlayaraq 
kənarlar ilə şəkil ölçüsünü [350 350 px]-ə 
azaldın.

19) “Ellipse 2” qatının kopyalanması
1. [Layer Style]-ı kopya etmək üçün [Layers] 



UX/Uİ 

377

panelində [Ellipse 2] qatını klik edin. 
2. “Ellipse 2” qatı üzərində siçanın sağ düyməsi-
ni klik edin. 
3. Əgər [Copy Layer Style]-ı seçsəniz qat stili 
sizin kompüterinizin yaddaşına kopyalanacaq. 

20) Kopyalanan qatın əlaqəli qata tətbiq olun-
ması
1. [Layers] panelində [Ellipse 3 copy] qatını klik 
edin. 
2. “Ellipse 3 copy” qatı üzərində siçanın sağ 
düyməsini klik edin. 
3. [Paste Layer Style]-ı klikləyin. 

21) “Stroke” ikonunu klik edərək müvafiq qat 
stil effektini qeyri-aktiv edin.
1. [Ellipse 3 copy] qatında [Eye] ikonunu klik 
edin. 

22) “Layers” panelində “Ellipse 3” qatının 
kopyalanması 
1. [Ellipse 3 copy 2]-nu yaradın. 
2. [Ellipse 3 copy 2]-nu [Ellipse 3 copy] qatında 
yerləşdirin. 
3. [Ellipse 3 copy 2]-nun ölçüsünü kiçildin: [En 
340 x Hündürlük 340 px]

23) “Layer style” ilə kopyalanmış “Ellipse 3 
copy”-ni kopyalayın. 
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1. [Ellipse 3 copy 3]-ni yaradın. 
2. [Ellipse 3 copy 3]-ni [Ellipse 3 copy 2] qatında 
yerləşdirin. 
3. [Ellipse 3 copy 3]-nin ölçüsünü kiçildin:  [En 
325x Hündürkük 325 px]

24) “Ellipse 3 copy 3”-ə müxtəlif effektlərin tət-
biq edilməsi
1. [Ellipse 3 copy 3]-ni yaradın. 
2. [Ellipse 3 copy 3]-ni [Ellipse 3 copy 2] qatında 
yerləşdirin. 
3. [Ellipse 3 copy 3]-nin ölçüsünü kiçildin: [En 
325x Hündürlük 325 px]

25) Obyektiv gövdəsinin tamamlanması

2. Obektivin hissəsinin dizayn olunması 
1) “Ellipse 3 copy 4”-un yaradılması
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1. Dairə ətrafında düzbucaqlı sərhədini transfor-
masiya edin.
2. [Ellipse 3 copy 3] qatında [Ellipse 3 copy 4] 
qatını yerləşdirin.
3. Dairənin şəkil ölçüsünü [268 - 268 px]-ə dəy-
işin. 

2) Üzük növü ilə dəliyin detallı ifadə olunması
1. Kiçildilmiş [Ellipse 3 copy 4]-u bir daha 
kopyalayın. 
2. [Ellipse 3 copy 5]-ı yaradın. 
• Şəkil ölçüsünü 202 - 202 px (W-H)-ə kiçildin. 
3. [Layer Style] pəncərəsində hər bir elementi 
aşağıdakı kimi təyin edin:
[Stroke] bölməsində
Struktur
• Ölçü: 3px
Dolum növü
• Qradient

3) Əlavə üç dairənin yaradılması
1. Əvvəlki qaydanı (addım 2) üç dəfə təkrar edin. 
2. [Ellipse 3 copy 5]-ı kopya edərək ümumilikdə 
3 dairə yaradın. 
3. Müvafiq dairəni azaltdıqda qatları aşağıdakı 
kimi yığın:
• Dairə 1: 135 x 135 px
• Dairə 2: 82 x 82 px
• Dairə 3: 54 x 54 px
 
 
4) “Ellipse 3 copy 4” qatı üzərində yeni 
yaradılmış qatların (Ellipse 3 copy 8, 7, 6, and 5 
(azalan qaydada)) yaradılması.
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1. Yeni yaradılmış qatları aşağıdakı kimi yer-
ləşdirin:
• [Ellipse 3 copy 8]  
• [Ellipse 3 copy 7]  
• [Ellipse 3 copy 6]  
• [Ellipse 3 copy 5]  
2. [Shift] düyməsini birgə basaraq yuxarıdakı 
qatları seçin.
3. [Ellipse 3 copy 4] qatı üzərində hələ tətbiq ol-
unmamış 4 qatı qoyun. 

5) “Ellipse 3 copy 4” adını  “LENS”-ə dəyişin. 
1. Seçilən dörd qata [Clipping Mask] tətbiq et-
mək üçün  [Alt+Ctrl+G] düyməsini basın. 
2. [Layers] panelində siçanın sağ düyməsi ilə 
[Create Clipping Mask]-ı klik edin.  
3. “Ellipse 3 copy 4” adını “LENS” adına dəy-
işin. 

6) Yeni qata “Clipping Mask” tətbiq olunması 
1. “Clipping Mask” tətbiq olunan yeni bir qat 
yaradın. 
• Şəkildə “Qat 3”
2. Yeni yaradılmış qata [Clipping Mask] effekti-
ni tətbiq edin.

7) Dairənin doğru istiqamətə əyilərək çəkilməsi
1. Müvafiq qat rəngi: [#55dd58]

8) Smart obyektə müvafiq qatın konvertasiya ol-
unması 
1. Saxlanılan vektor növünə filtr effekti tətbiq et-
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mək üçün [Ellipse 7] qatını klik edin. 
• Əvvəlcə obyekt “Layer 3” qatı idi. 
• Ellipsi çəkərkən “Layer 3” adı [Ellipse 7] qatı-
na dəyişdi.
2. Siçanın sağ düyməsini klik etdikdən sonra 
[Convert to Object]-i seçin.  

9) Photoshopda “Gaussian Blur” effektinin tən-
zimlənməsi
1. Photoshop menyusundan 
[Filters]-[Blur]-[Gaussian Blur]-u seçin.
2. Radiusu 45.8 px təyin edin. 
3. Effekt tətbiq olunan əlavə qat daxil edin. 

10) Digər sahəyə filtr effektinin tətbiq olunması
1. Şəkildəki kimi obyektin yuxarı sağ hissəsində 
dairə yaradın.
2. Şəkilə (Gaussian Blur) filtr effektini müəyyən 
edin.

11) Ağ əksetdirmə işığı ilə obyektivin təsvirini 
vermək 
1. Eyni qaydada ağ rəngdə əksetdirmə işıq 
fiqurunu yaradın.
2. Əksetdirən bir işıq əlavə etmək üçün spotun 
fiqurunu tapın.  

12) Qeyri-şəffaflığın tənzimlənməsi
1. Obyektivin daha parlaq parıldaması üçün 
dairə yaradın.
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• Dairə rəngi: [#98869e]
2. [Layers] panelində [Blend Mode] və [Color 
Dodge] ikonunu seçin.
3. Ehtiyaca uyğun olaraq [Opacity]-ni tənzimlə-
yin. 

13)  Balans səviyyəsini obyektiv səviyyəsinə 
uyğunlaşdırılması
1. [Layer Style] pəncərəsində balans səviyyəsini 
tənzimləyin. 

14) Obyektivin içərisində xəttin təbii şəkildə if-
adə olunması
1. [Stroke]-[Opacity]-ni müəyyən edin. 
2. Obyektiv qatında daxili kölgəni (Inner Shad-
ow) dəyişdirin.
3. Qovluğu “Obyektiv və obyektiv gövdəsi”nə 
bölün.

 
3. Kamera gövdəsinin dizayn olunması
1) Kölgə hissəsi və kölgə sıxlığının əlavə olun-
ması
1. [Drop Shadow] ilə kölgə fiqurunu forma-
laşdırın.  
2. Onu [Lens Body] qovluğu altında yerləşdirin.

2) “Rounded Rectangle” qatında “Layer style” 
pəncərəsinin açılması
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3) “Layer style” pəncərəsində parametrlərin tən-
zimlənməsi
1. [Bevel and Emboss] sahəsini aşağıdakı kimi 
təyin edin:
Struktur
• Stil: Inner Bevel
• Üslub: Hamar (Smooth)
• İstiqamət: Yuxarı (Up)
• Size: 79 px
• Soften: 16 px

Kölgələndirmə
• Bucaq: 90°
• Yüksəklik: 30°
• Kölgə rejimi: Artan (Multiply)
• Qeyri-şəffaflıq: 75% 

4) Gövdə və obyektivin balansının müəyyən ol-
unması
1. Daha çox kub effekti üçün obyektivə bir neçə 
effekt  daha  tətbiq edin.
Daxili kölgə (Inner Shadow)
• İstifadəçinin istəyinə uyğun olaraq 

 Daxili parıltı (Inner Grow)
• İstifadəçinin istəyinə uyğun olaraq 

 

5) Ağ obyektiv gövdəsində kamera haqqında 
məlumatların daxil edilməsi
1. [Ellipse Tool]-u seçin.
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2. Yuxarı menyudan [Path] ikonuna klikləyin.
3. Dairəni çəkin.
4. [Text Tool]-u seçin. 
• Siçanı müvafiq xətt üzərində qoyun. 
• Dairə boyunca mətni daxil edin.

Mətn
• CAMERA LENS
• AF-S DX
• 123456 20-50MM 
5. [Layer Style] panelində [Inner Shadow] effek-
ti ilə mətni dekorasiya edin. 
Struktur
• Qeyri şəffaflıq: 52%
• Bucaq: 90°
• Məsafə: 1 px
• Ölçü: 1 px

6) Əlavə bir neçə elementin şəklə daxil edilməsi



UX/Uİ 

385

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. UI və UX arasında fərqi əminliklə izah etdi?
2. Ağıllı telefon sxemini qısaca izah etdi?
3. Alət panelini sərbəst şəkildə tətbiq etdi?
4. İstifadə etdiyiniz qat panelini doğru şəkildə düzəltdi?
5. Görünüşü tərtib etmək üçün təlimatları tətbiq etdi?
6. Əmri lazım olan vaxtda tətbiq etmək üçün qısa yol düyməsini 
(shortcut) istifadə etdi?
7. Dairə boyunca mətni düzgün şəkildə yazdı? 
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Kamera tətbiqinin komponentlərini əminliklə izah edəcək;
2.   Ağıllı telefon tətbiqi ilə bağlı bölməni qısa şəkildə çəkməyi biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   Photoshop proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

- Dairəvi düzbucaqlı aləti (Rounded Rectangle Tool)  -  Böyütmə aləti (Zoom Tool)
- Ellips aləti (Ellipse Tool)                 -  Qat stili  (Layer Style)
- Qradadient aləti (Gradient Tool)                                                     -  Görünüş  (View)     

2. Kamera çəki̇li̇şi̇ üçün səhi̇fəni̇ di̇zayn etmək

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

1. “App.” tərtibatının çəkilməsi
1) App.tərtibatının hazırlanması
1. App. tərtibatının dizayn olunması
• Nəzarət sətiri (Control bar)
• Qeyd işığı (Record light)
• Kamera obyektiv qapağı 
• (Camera shutter)utton

2. Nəzarət sətrinin dizayn olunması
1) File>New-ya klik edərək yeni sənədin yaradıl-
ması
1. İş lövhəsi parametrləri
• En (Width) 640 px 
• Hündürlük (Height): 960px
• Dəqiqlik (Resolution): 72
• Rəng rejimi: RGB

2) Şəbəkə və təlimat xətlərinin tənzimlənməsi
1. Təlimat xətlərini təyin edin. 
• Horizontal  (en):
282, 564, 852 px
• Şaquli (hündürlük):
213, 426 px
2. Nəzarət sətrinin ölçüsü 108 px-dir.
3. 3 hissə arasında nəzarət sətri üçün qalan sahəni 
bölün.
4. Hər bir sahəyə şəbəkə çəkin. 

3) İş lövhəsinin aşağı sağ hissəsində qutu 
fiqurunun çəkilməsi
1. [Rectangle Tool] ilə qutu fiqurunu çəkin. 
• Ölçü: 108 x 640 px (W x H)
2. İlk olaraq [Color] ilə daxili hissəni doldurun. 
Yeni qatı [Rectangle 1] qatına dəyişin. 
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4) Bütün faylların yeni bir sənədə köçürülməsi
1. Tərtib olunmuş  faylın açılması (*.psd)
2. App. ikon faylı ilə bağlı qovluğu köçürün. 

5) Qatlar arasında fərqlilik olması üçün arxa fon 
qatını qeyri-aktiv edin. 
1. [Rectangle 1] qat adını [Control bar 108 px] 
qatına dəyişin.
• Arxa fon rəngini ağ rəng edin.
2. App.-nin [Layer style] ikon qatını kopyalayıb 
aşağı sətrə yapışdırın. 
3. [Rounded Rectangle] qatının [Layer style] 
seçimini kopyalayıb [Control bar] qatına 
yapışdırın. 
4. Yapışdırılmış qatları  [Bevel and Emboss] ef-
fekti üçün vacib olmayacaq şəkildə qeyri-aktiv 
edin.
• [Eye] ikonunu klik edin. 

6) “Layer style” pəncərəsinin parametrlərinin 
tənzimlənməsi
1.  [Layer style] pəncərəsində parametrləri təyin 
edin. 
 [Gradient Overlay] bölməsində
Qradient
• Qeyri-səffaflıq (Opacity): 10%
• Bucaq (Angle): 90°
• Rəng (Color): #a5a5a5
• Stil (Style): linear



İKT

390

7) ()vx H: 640 x 1 px) qutusunun yaradılması
1. [Rectangle Tool] alətini seçin.
2. Qutunu çəkin. 
• Ölçü: [W x H: 640 x 1 px]
3. Yeni qatın adını [Rectangle 2] kimi müəyyən 
edin. 
4. Bu qatı [Control bar 108 px] qatı üzərində yer-
ləşdirin. 

8) Düzbucaqlının “Control bar 108 px”-in yuxarı 
hissəsində yerləşdirilməsi
1. [Rectangle 2] qatının rəngini  [#58514c] təyin 
edin. 
2. Qat adının [Line over Control bar]-na dəyişdi-
rilməsi
3. [Move Tool]-u seçin.
4. Düzbucaqlını [Control bar 108 px] qatının 
yuxarısında yerləşdirin.

9) “Line over Control bar” qatının iki dəfə klik 
olunması
1. Əlavə xətt çəkmədən [Line over Control bar] 
qatını iki dəfə klik edin. 
2. [Layer Style] pəncərəsində dəyərləri aşağıdakı 
kimi təyin edin:
 [Drop Shadow]-da:
Struktur
• Qarışdırma rejimi (Blend Mode): Multiply (Ar-
tan)
• Qeyri-şəffaflıq (Opacity): 20%
• Bucaq (Angle): 90°
• Məsafə (Distance): 1 px
• Ölçü (Size): 0 px
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3. 1 pikseldən aşağı piksel xətti yaradın. 
4. Düzbucaqlını [Control bar 108 px] qatının 
yuxarısında üst-üstə düşən şəkildə yerləşdirin. 

10) Çəkiləcək bütün elementləri “Control bar” 
üzərində yerləşdirin. 
1. [Create a new group] ikonunu klik edin. 
2. Yeni yaradılmış qrupu [REC] qovluğuna dəy-
işin. 

11) İşləmək üçün qat ikonunun (Layer con) ak-
tivləşdirilməsi
1. [MKIII] mətn qatı arasında göz ikonunu klik 
edin. 
2. İş sənədi sahəsində görünmək üçün yerləşmə 
mövqeyini dəyişin.

12) Ekranda nəzarət sətri üçün müxtəlif təlimat 
xəttinin (Guide lines) əlavə olunması
1. Təlimat xətlərini əlavə edərək tənzimləmələri 
daha çox tərtib edin.
• En: 946, 866 px
(Şaquli)
• Hündürlük: 16, 624 px
(Üfüqi)
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13) “Free Transform” funksiyasının istifadə ol-
unması
1. İş sahəsi görünməz olur. 
• App. ikonu [1024 x 1024 px] sənədi ilə tama-
mlanır. 
• (Göz) ikonu aktivləşsə də görünməz qalır.  
2. İş sahəsini yoxlamaq üçün  [Free Trans-
form]-dan istifadə edin. 
• İş sahəsindən kənarda olsa da obyekti başqa 
yerləşmə 

• mövqeyinə köçürün. 

3. REC Light dizayn olunması 
1) Nəzarət  panelinin yuxarı sol tərəfində işıq 
tərtib etmək
1. 3 Qat tələb olunur. 
• İşıq modeli (Light model) qatı
• Parıltı (Sheen) qatı
• Kub parıltı (Cubic sheen) qatı
2. Qatları bir-bir ifadə edəcək şəkildə işıqları 
dizayn edin. 

2) Hər bir qatın düzəldilməsi
1. [Ellipse Tool] ilə yuxarı sol nöqtədə dariə 
çəkin.
• Ölçü: [W x H: 18 x18 px]
2. Rəngi ləğv etmək 
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3) “Layer Style” pəncərəsində parametrlərin tən-
zimlənməsi 
1. Yeni qat adını “İşıq modeli”-nə (Light Model) 
dəyişin. 
2. [Layer Style]-ın hər bir elementini aşağıdakı 
kimi təyin edin:
 [Gradient Overlay] filtr effektində
Gradient
• Stil (Style): Radial
• Bucaq (Angle): 90°
• Ölçü (Scale): 150%

          Gradient Editor
• Sol rəng: #14b9b9
• Sağ rəng: #c92943

4) Şəkilin mərkəzində işıqlandırma ilə dairənin 
yaradılması 
1. [Layer Style]  [Gradient Overlay] seçimində
• Siçanın işarəsini real şəklin iş sahəsində forma-
laşdırıldığı nöqtəyə qoyun. 
2. İşıqlama nöqtəsini aşağıya doğru köçürün.  

5) “Light Model” qatını “Light Model”-a 
kopyaladıqdan sonra qatı yerləşdirin. 
1. [Layer Style]-ı birgə kopyalayın. 
2. [Layer Style] [Gradient Overlay] seçimində
3. [Gradient Overlay] effektinin göz ikonunu 
qeyri-aktiv edin. 

6) Müvafiq qatla bağlı dəyərin tənzimlənməsi
1. Hər bir qata [Stroke], [Inner Shadow], [Inner 
Glow] və [Drop Shadow] effektinin tətbiq olun-
ması
2. Hər bir qata müvafiq dəyəri təyin edin.
6.a Üslub
Struktur
• Ölçü (Size): 1 px
• Yerləşmə mövqeyi (Position): Inside (Daxili)
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• Qeyri-şəffaflıq (Opacity): 100%

 Dolum növü
• Qradient (Gradient)
• Stil (Style): linear (Xətti)
• Bucaq (Angle): 90°

 Qradient redaktoru
• Rəng a: #a46565
• Rəng b: #6a2343
• Rəng c: #693333

6.b Daxili kölgə (Inner Shadow)
            Struktur
• Qarışdırma rejimi (Blend Mode): Normal
• Rəng (Color): #610136
• Qeyri-şəffaflıq (Opacity): 73%
• Bucaq (Angle): 90°
• Məsafə (Distance): 1 px
• Sıxışdırılmış (Choke): 48%
• Ölçü (Size): 5 px

6.c1 Daxili Parıltı (Inner Glow)
            Struktur
• Qarışdırma rejimi (Blend Mode): Normal
• Qeyri-şəffaflıq (Opacity): 18%
6.c2 Daxili Parıltı (Inner Glow)
            Elementlər
• Üslüb (Technique): Softer
• Mənbə (Source): Edge (Künc)
• Sıxışdırmaq (Choke): 24%
• Ölçü (Size): 3%

6.d Kölgə salmaq (Drop Shadow)
            Stroke
• Qarışdırma rejimi (Blend Mode): Normal
• Rəng (Color): #ffffff
• Qeyri-şəffaflıq (Opacity): 100%
• Bucaq (Angle): 90°
• Məsafə (Distance): 2 px
• Ölçü (Size): 1 px
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7) Dairənin kənar çərçivəsinə görə  kub effekti-
nin tənzimlənməsi
1. “Light Model” qat adını 2Cubic effect” qatına 
dəyişin.

8) Parlaqlığın ifadə olunması
1. Şəkili genişləndirin. 
2. [Rectangle Tool] ilə düzbucaqlı fiqurunu 
düzəldin. 
• Ölçü: 4 x 2 px (W x H)
• Rəng: ağ
3. Yeni yaradılmış qat adını “Sheen”-ə dəyişin. 

9) Şəkilə filtr effektinin tətbiq olunması
1. [Sheen] qatını klik edin.
2. [Sheen] qatı üzərində siçanın sağ düyməsini 
klik edərək [Convert to Smart Object] seçiminə 
gedin.
3. [Gaussian Blur] effekti üçün dəyəri müəyyən 
edin. 
• [Menu]-[Filter]-[Gaussian Blur]-u seçin. 

10) Şəkilin yerini müəyyən etmək üçün köçürün. 
1. [MkIII] mətni olan qatı aktivləşdirin. 
• İlkin olaraq mətn başqa fayldan köçürülür. 
2. (MkIII) mətnini [REC]-ə dəyişin. 

4. Kamera çəkiliş düyməsinin dizayn olun-
ması
1) Dairəvi düzbucaqlı fiqurunun çəkilməsi
1. [Rounded Rectangle Tool] sətirini seçin. 
2. Siçanı kənar xəttin hündürlüyünə gətirin. 
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3. Fiquru çəkin:
• En: 230 px
• Hündürlük: 80 px
• Radius: 40
4. Yeni qat adını [Button_Back]-ə dəyişin. 

2) Düymənin eyni sahə içərisində olmasını təmin 
edin. 
1. Fiquru çəkin:
• En: 170 px
• Hündürlük: 70 px
• Radius: 40
2. Yeni qat adını [Button]-a dəyişin. 

3) “Button_back” fiqurunun dizayn olunması
1. [Button] qatını iki dəfə klik edin. 
3.1 [Stroke] effektinin parametrlərinin tənzim-
lənməsi
         Struktur
• Ölçü (Size): 1 px
• Position (Yerləşmə mövqeyi): Inside (Daxili)
• Qeyri-şəffaflıq (Opacity): 100%

          Dolum növü
• Növ (Type): color (rəng)
• Rəng (Color): #636633

3.2 [Inner Shadow] effektinin parametrlərinin 
tənzimlənməsi
         Struktur
• Qarışdırma rejimi (Blend Mode): Normal
• Rəng (Color): #000000
• Qeyri-şəffaflıq (Opacity): 73%
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• Bucaq (Angle): 90°
• Məsafə (Distance): 2 px
• Sıxışdırmaq (Choke): 49%
• Ölçü (Size): 5 px

3.3 [Inner Glow] effektinin parametrlərinin tən-
zimlənməsi
        Struktur
• Qarışdırma rejimi (Blend Mode): Normal
• Qyeri-şəffaflıq (Opacity): 63%

         Elementlər 
• Üslub (Technique): Softer (daha yumşaq)
• Mənbə (Source): Edge (Künc)
• Sıxışdırmaq (Choke): 57%
• Ölçü (Size): 6 px

3.4 [Gradient Overlay] effektinin parametrləri-
nin tənzimlənməsi
         Qradient
• Qarışdırma rejimi (Blend Mode): Normal
• Qeyri-şəffaflıq (Opacity): 13%
• Stil (Style): Reflected (Əks olunan)
• Bucaq (Angle): 90°
• Ölçü (Scale): 124%

3.5 [Drop Shadow] effektinin parametrlərinin 
tənzimlənməsi
         Struktur 
• Qarışdırma rejimi (Blend Mode): Normal
• Rəng (Color): #ffffff
• Qeyri-şəffaflıq (Opacity): 100%
• Bucaq (Angle): 90°
• Məsafə (Distance): 2 px
• Ölçü (Scale): 4 px
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4) Qradient yerləşmə mövqeyinin yuxarıdan 
aşağıya dəyişdirilməsi
1. İş sahəsini şəklə köçürün. 
2. Yuxarıdan aşağıya qradient effekti verin. 

5) Arxa hissənin tamamlanması

6) Düymənin hazırlanması
1. [Button] qatını klik edin. 
2. [Ctrl+T] qısayol düyməsi ilə [Free Trans-
form]-u istifadə edin. 
3. Ölçünü [200 x 80 px]-ə dəyişin. 
4. Düyməni arxa plana uyğun şəkildə yerləşdi-
rin. 

7) Obyektiv gövdəsinin ağ hissəsinin qat stilinin 
kopyalanması
1. Obyektiv gövdəsində ağ hissəyə gedin. 
2. [Ellipse 1] qat stilini kopyalayın.
3. Onu [Button] qatına yapışdırın. 

8) “Button” qatında  “Layer Style” parametrləri-
nin tənzimlənməsi
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1. [Button] qatını iki dəfə klik edin. 
8.1 “Stroke” effektinin verilməsi
2. [Stroke] effektinin parametrlərinin tənzimlən-
məsi
         Struktur 
• Qarışdırma rejimi (Blend Mode): Normal
• Ölçü (Size): 4 px
• Yerləşmə mövqeyi (Position): Inside

         Dolum növü
• Növ (Typ): Gradient (Qradient)
• Rəng 1(Color 1): #9c9c9c
• Rəng 1 (Color 1): #ffffff

8.2 “Gradient Overlay” effektinin verilməsi 
1. [Gradient Overlay] effekti parametrlərinin 
tənzimlənməsi
         Struktur 
• Qarışdırma rejimi (Blend Mode): Normal
• Ölçü (Size): 4 px
• Yerləşmə mövqeyi (Position): Inside (Daxili)

         Dolum növü 
• Növ (Type): Gradient (Qradient)
• Rəng 1 (Color 1): #e8e8e8
• Rəng 2 (Color 2): #c8c8c8
• Rəng 3 (Color 3): #dbdbdb
• Rəng 4 (Color 4): #ffffff

8.3 “Drop Shadow” effektinin verilməsi
1. [Drop Shadow] effektinin parametrinin tən-
zimlənməsi
          Struktur 
• Qarışdırma rejimi (Blend Mode): Normal
• Qeyri-şəffaflıq (Opacity): 100%
• Bucaq (Angle): 90°
• Məsafə (Distance): 3 px
• Yayılma (Spread): 0%
• Ölçü (Size): 3%

9) Düymənin və onun arxa tərəfinin tamamlan-
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ması

5. View düyməsinin dizayn olunması
1) “View” düyməsi ilə əlaqəli fiqurun çəkilməsi 
1. [Rounded Rectangle Tool] sətrini seçin. 
2. Fiquru çəkin.
• Ölçü: 88 x 88 px (W xH)
3. Yeni fiquru düyməyə yaxın qoyun.

2) Şəkili göstərmək üçün yerin müəyyənləşdir-
ilməsi
1. [Rectangle Tool] sətrini seçin. 
2. Fiquru çəkin. 
• Ölçü: 64 x 64 px (W x H)

3) Maye kristala əksetdirmə vermək üçün effek-
tin seçilməsi
1. [Rectangle Tool] sətrini seçin. 
2. Uzun düzbucaqlı fiquru çəkin. 
3. [Ctrl+T]  qısa yol düyməsi ilə [Free Trans-
form] funksiyasını istifadə edin.  
• Obyekti bir az yanlara çəkin. 
• Onu “View” düyməsi və şəkilin görünə biləcəyi  
yerdə qoyun.
• Qeyri-şəffaflıq: 54%

4) Şəkili daxil etmək üçün “Clipping Mask”-ın 
yaradılması 
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1. “Grow” effekti vermək üçün  “Rectangle 1” 
və “Rectangle 2” qatlarını seçin. 
2. Seçilmiş qatlar üzərində siçanın sağ düyməsi-
ni klik edin. 
3. Hər iki qata  [Clipping Mask] effektini verin. 

5) “Layer style” pəncərəsinin tənzimlənməsi
1. [Rounded Rectangle] qatını seçin. 
2. Hər bir elementə [Stroke] effekti tətbiq edin. 
          Struktur
• Ölçü (Size): 2 px
• Yerləşmə mövqeyi (Position): Outside (xarici)

6) Dizayn işinin yekunlaşdırılması

 
6. Rotasiya/Flash düyməsinin dizayn olun-
ması 
1) Dairələrin çəkilməsi
1. [Ellipse Tool] sətrini seçin.
2. Dairəni çəkin.
• Dairə 1: 86 x 86 px
• Dairə 2: 68 x 68 px
3. Birincisi digər düymə, ikincisi düymənin arxa 
hissəsidir. 

2) “Layer style” pəncərəsinin parametrlərinin 
tənzimlənməsi 
1. Müəyyən olunmuş qat rəngini ağ rəng edin.
2. Seçilmiş qatı iki dəfə klik edin. 
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2.1 “Layer style” pəncərəsində müəyyən olun-
muş qata  [Stroke] stilinin tətbiq edilməsi
    Struktur 
• Qarışdırma rejimi (Blend Mode): Normal
• Yerləşmə mövqeyi (Position): Inside (daxili)
• Ölçü (Size): 3 px

Dolum növü
• Növ (Type): Gradient 
• Rəng 1: #9c9c9c
Rəng 2: #ffffff

2.2 “Layer style” pəncərəsində [Gradient Over-
lay] stilinin tənzimlənməsi
          Gradient
• Qarışdırma rejimi (Blend Mode): Normal
• Qeyri-şəffaflıq (Opacity): 82%
• Rəng 1: #e8e8e8
Rəng 2: #dbdbdb
Rəng 3: #ffffff
• Stil (Style): Linear (Xətti) 
• Bucaq (Angle): 90°
• Ölçü (Scale): 100%

2.3 “Layer style” pəncərəsində [Drop Shadow] 
stilinin tənzimlənməsi
Struktur 
• Qarışdırma rejimi (Blend Mode): Normal
• Qeyri-şəffaflıq (Opacity): 100%
• Bucaq (Angle): 90°
• Məsafə (Distance): 2 px
• Yayılma (Spread): 0%
• Ölçü (Size): 4 px

3.  “Layer style” pəncərəsində  digər effektlər 
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parametrinin tənzimlənməsi
3.1 “Layer style” pəncərəsində [Other Button_
Back] qatına daxili parıltı stilinin tətbiq edilməsi 
            Struktur 
• Qarışdırma rejimi (Blend Mode): Screen 
(Ekran)
• Qeyri şəffaflıq (Opacity): 755
• Rəng (Color): #ffffff

Elementlər
• Mənbə (Source): Edge (Künc)
• Sıxışdırma (Choke): 0%
• Ölçü (Size): 5 px

Quality
• Aralıq (Range): 50%

3.2  “Layer style” pəncərəsində daxili kölgə (In-
ner style) stilinin tənzimlənməsi
Struktur 
• Qarışdırma rejimi (Blend Mode): Normal
• Qeyri-şəffaflıq (Opacity): 44%
• Bucaq (Angle): 90°
• Məsafə (Distance): 5px
• Sıxışdırma (Choke): 0%
• Ölçü (Size): 5 px

3.3 “Layer style” pəncərəsində digər düymə qa-
tına (Other Button) [Stroke] stilinin tətbiq olun-
ması
Struktur 
• Ölçü (Size): 1 px
• Yerləşmə mövqeyi (Position): Inside (daxili)
• Qeyri-şəffaflıq (Opacity): 15%

Dolum növü
• Növ (Type): Color (rəng)
• Rəng (Color): #000000

3.4 “Layer style” pəncərəsində [Gradient Over-
lay] stilinin tənzimlənməsi
Gradient
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• Qarışdırma rejimi (Blend Mode): Normal
• Qeyri-şəffaflıq (Opacity): 100%
• Rəng 1: #a5a5a5
Rəng 2: #c9c9c9
Rəng 3: #151515

3.5 “Layer style” pəncərəsində [Pattern Overlay] 
stilinin tənzimlənməsi
Struktur 
• Qarışdırma rejimi (Blend Mode): Darken 
(Tündləşdirmək)
• Qeyri-şəffaflıq (Opacity): 58%
• Naxış (Pattern): Stone
• Ölçü (Scale): 100%

3.6 [Layer Style] pəncərəsində [Xarici parıltı] 
stilinin tənzimlənməsi
Struktur 
• Qeyri-şəffaflıq (Opacity): 72%
• Rəng (Color): #ffffff

Elements
• Ölçü (Size): 5 px

Quality
• Aralıq (Range): 50%

4) Digər düymə ilə bağlı işlərin tamamlanması
1. Bu, fırlatma ikonu üçün yerdir. 
2. Bu işləri “Camera Rotation” qovluğu kimi 
yerləşdirin. 
3. “Layers” panelində işləyən bütün faylları əldə 
edin. 
4. Bütün faylları [Folder] kimi bir yerə toplayın.
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5) Düyməni bir dəfə də kopya edin. 
1. “Camera Rotation” qovluğunu kopyalayın. 
2. Bütün şəkillərin uyğunluğunu yoxlayın. 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Şəklə qradienti düzgün şəkildə tətbiq etdi?
2. Ağıllı telefon tətbiqi ilə bağlı hissəni qısa şəkildə çəkdi?
3. Qat stili  parametrlərini düzgün şəkildə təyin etdi?
4. Qat stili pəncərəsində parametr dəyərlərinin dəyişilməsini aydın 
şəkildə yoxladı?
5. Qat panelinin ən yaxşı istifadəsini tətbiq etdi?
6. Tələb olunan vaxtda şəbəkələrin istifadəsini təmin etdi?
7. Qısa yol düyməsindən (shortcut key) sərbəst şəkildə istifadə etdi? 
8. Dairə boyunca dəqiq şəkildə mətn yazdı?
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SQL
(Oracle üçün)

Sənaye və İnnovasiyalar üzrə 
Bakı Dövlət Peşə Təhsil Mərkəzi

Səriştə əsaslı 
modul İKT
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Ön söz 

 “Oracle SQL Developer” Oracle məlumatlar bazasında SQL ilə iş üçün inteqrasiya inkişaf mühit-
idir (İDE). Oracle korporasiyası bu məhsulu pulsuz təmin edir. O, Java Development Kit istifadə 
edir.
 “Oracle SQL Developer” Oracle məhsullarını dəstəkləyir. “Oracle SQL Developer” IBM DB2, 
Microsoft Access, Microsoft SQL Server, MySQL, Sybase Adaptive Server, Amazon Redshift və 
Teradata məlumatlar bazası ilə işləyir.
“Oracle SQL Developer” PL/SQL üçün avtomatik etiket, kod anlayışı, mötərizə uyğunluğu və 
sintaksis rəngləməni dəstəkləyir. 
 “Oracle SQL Developer” məhsul komponentlərinə Apache veb serveri üçün uzatma modulu olan 
OWA (Oracle Web Agent və ya MOD_PLSQL) daxildir və “Oracle SQL Developer” daxilində PL/ 
SQL-dən dinamik veb səhifələri qurmağa kömək edir. 
 Yekun olaraq mən çoxsaylı mənbələrə, xüsusilə YouTube, Yahoo, Wikipedia, “www.hrdbank.net” 
və Google saytlarına təşəkkür edirəm. Onlar mənə texniki təcrübə modulu dərsliyinin hazırlan-
masında köməklik etdilər.

                YUN, Hyung Soon, IKT üzrə Texniki Ekspert
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   SQL(Oracle) ifadəsini aydın şəkildə izah edəcək;
2.   SQL sintaksisini düzgün şəkildə yaratmağı biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   Photoshop proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər
1. Oracle SQL Developer

1.1 Windows OS üçün Oracle SQL
1. Oracle SQL developer
2. Database (DB)
3. Proqramı yükləmək üçün kvalifikasiya: OTN (Oracle Technology Network) üzvlüyü
※ http://www.oracle.com

1. Kamera çəki̇li̇şi̇ üçün səhi̇fəni̇ di̇zayn etmək

 

2. Oracle məlumatlar bazasının yüklənməsi
2.1 Faylın yüklənməsi
1. [Oracle Database Express Edition (XE) Release 11.2.0.2.0 (11gR2)] və ya “www.oracle.com”-

dan son versiyanı yükləyin.
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2. Lisenziya razılaşmasını qəbul edin. 

4. Final keçiddə 3 qovluğu kopyalayın. 
•  [win64_11gR2_database_2 of 2]-da 3 qovluğu kopyalayın. 
•  Onu [win64_11gR2_database_1 of 2]-ya yapışdırın.
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5. [SetUp.exe] faylını çalışdırın.

6. İlkin ekranı açın.
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2.2 Proqramın quraşdırılması
1. Quraşdırma sseçımlərində [Create and configure a database] seçin.
2. Öyrənmək üçün “System Class”-ı [Desktop class] olaraq tənzimləyin 

 
1 2 

3. “Typical Installation” tənzimlənir.
4. “Prerequisite Checks”-ə gedin. 
5. Bundan sonra Oracle tənzimləmə məlumatlarını və seçilən məlumatları görüntüləyin 

 

3 
5 

4 

6. “Database Configuration Assistant”-ı çalışdırın.
7. Şifrəni idarə edin.

 

6 

7 

1 2

5
3

4

6

7
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8. Proqram quraşdırmasını yekunlaşdırın.

Təcrübə mərhələləri

1. [Start] menyusunda [Oracle Developer] 
tətbiqini klik edin. 
1) [Start] ikonunu klik edin.
2) [Oracle-OraDB12Home3] qovluğuna gedin. 
3) [SQL Developer] proqramını klik edin.
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2. Sistem hesabı bağlantısını yaradın. 
2.1 Yeni məlumat bazası bağlantısını seçin.
1. Bağlantı adı: İstifadəçi tərəfindən müəyyənləşdirilən bağlantı (ConName)
2. İstifadəçi adı: System
3. Şifrə: Administrator Password 
- Oracle proqramının qurulmasında qeydiyyat olunan şifrə (məsələn: 123Admin) 
4. [Save Password Checkbox]-a işarə qoyun. 
5. SID: [xe]-ni [orcl]-ə dəyişin. 

2.2 Yeni məlumat bazası bağlantısını seçin.
1. “Scott” istifadəçi hesabı üçün oturum parametrlərini dəyişin. 
Oturum setini dəyişdirin “_ORACLE_SCRIPT”=true

2. İstifadəçi hesabı yaradın.
• Hesab adı: scott
• Şifrə: tiger
“tiger”ilə müəyyən edilən istifadəçi “Scott”-u yaradın.

3. “Scott” hesabına qoşulmaq üçün icazə verin.
“Grant” bağlantı, “Scott” üçün mənbə

4. INSERT ifadəsi “Scott” hesabına keçdikdə xəta baş verərsə o zaman cədvəl sahəsini ayıraraq onu 
dəyişdirin. 
ALTER USER Scott quota unlimited on USERS;
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5. TEST

• Bağlantı: İstifadəçi tərəfindən təyin edilmiş bağlantı (test)
• İstifadəçi adı: scott // İstifadəçi hesabı ilə yaradılıb.
• Şifrə: tiger // İstifadəçi hesabı ilə yaradılıb.
• [Save Password] yoxlama qutusuna işarə qoyun.  
• SID: [xe]-ni [orcl]-ə dəyişin.

3. Ən vacib SQL əmrlərindən bəziləri
1) CREATE TABLE – yeni cədvəl yaradır
2) ALTER TABLE – cədvəli dəyişdirir
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3) DROP TABLE – cədvəli silir.
4) CREATE INDEX – indeksi yaradır (axtarış düyməsi).
5) DROP INDEX – indeksi silir.
6) INSERT INTO – məlumat bazasına yeni məlumat daxil edir.
7) SELECT – məlumat bazasından məlumat çıxarır.
8) UPDATE – məlumat bazasında məlumatı yeniləyir. 
9) DELETE – məlumat bazasından məlumatı silir. 

4. SQL funksiyaları
4.1 CREATE TABLE (Cədvəl yaratmaq ifadəsi)
1. The CREATE TABLE (Cədvəl yaratmaq) əmri məlumatlar bazasında yeni cədvəl yaradır.
2. CREATE TABLE sintaksisi

 

CREATE TABLE [schema] table_name  
(column datatype 
 [. Column datatype …] 
 ) 
 [TABLESPACE tablespace] 
 [PCTFREE integer] 
 [PCTUSED integer] 
 [INITRANS integer] 
 [MAZTRANS integer] 
 [STORAGE storage-clause] 
 [LOGGING/NOLOGGING] 
 [CACHE/NOCAHE];  
      

• Sxem: cədvəl sahibi
• Cədvəl adı : cədvəl adı
• Sütun: sütun adı
• Məlumat növü : sütunun məlumat növü
• Cədvəl Sahəsi : məlumatı saxlamaq üçün cədvəl sahəsi
 
CREATE TABLE EMP
       (EMPNO NUMBER(4) NOT NULL,
        ENAME VARCHAR2(10),
        JOB VARCHAR2(9),
        MGR NUMBER(4),
        HIREDATE DATE,
        SAL NUMBER(7, 2),
        COMM NUMBER(7, 2),
        DEPTNO NUMBER(2));
 
3. Column1, Column2, ...sizin seçmək istədiyiniz cədvəlin sahə adlarıdır. 

4.1  ALTER TABLE (Cədvəli dəyişdirmək) əmri
1. ALTER TABLE əmri mövcud cədvəldə sütunları əlavə etmək, silmək və dəyişdirmək üçün isti-
fadə olunur.
2. ALTER TABLE əmri mövcud cədvələ müxtəlif məhdudiyyətləri əlavə etmək üçün istifadə olunur. 
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3. ALTER TABLE sütun sintaksisini əlavə edir. 

4. ALTER TABLE - DROP Sütun sintaksisi

5. ALTER TABLE - ALTER/ MODIFY Column sintaksisi

4.2 DROP TABLE (Cədvəli açıb-bağlamaq) əmri
1. The DROP TABLE ifadəsi məlumat bazasında mövcud cədvəli silmək üçün istifadə olunur. 
2. DROP TABLE sintaksisi

3. TRUNCATE TABLE sintaksisi
• TRUNCATE TABLE cədvəli yox, onun içindəki məlumatları silmək üçün istifadə olunur. 

4.3 CREATE INDEX (İndeks yaratmaq) əmri
1. CREATE INDEX əmri cədvəllərdə indeksləri yaratmaq üçün istifadə olunur.
2. İndekslər məlumat bazasından məlumatı cəld şəkildə geri qaytarmaq üçün istifadə olunur. 
İstifadəçilər indeksləri görə bilmir, yalnız axtarışları/sorğuları sürətləndirmək üçün istifadə edirlər.  
3. CREATE INDEX (İndeks yaratmaq) sintaksisi                                                                                         
• Cədvəldə indeks yaradın. Çoxaldılan dəyərlərə icazə verilir.

 
4. CREATE UNIQUE INDEX (Xüsusi İndeks yaratmaq) sintaksisi
• Cədvəldə xüsusi indeks yaradın. Çoxaldılan dəyərlərə icazə verilmir.

4.4 DROP INDEX (Cədvəli açıb-bağlamaq ifadəsi)
1. The DROP INDEX cədvəldə indeksi silmək üçün istifadə olunur. 
2. DROP INDEX sintaksisi(oracle)

 ALTER TABLE cədvəl adı 
ADD sütun_adı məlumat növü;      

 

ALTER TABLE cədvəl adı 
DROP COLUMN sütun adı;      

 ALTER TABLE cədvəl adı. 
MODIFY column_name datatype;     

 

DROP TABLE cədvəl_adı;     

 TRUNCATE TABLE cədvəl_adı;     

 

CREATE INDEX indeks_adı 
ON cədvəl_adı (sütun1, sütun2, ...);    

 CREATE UNIQUE INDEX indeks_adı 
ON cədvəl_adı (sütun1, sütun2, ...);    
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4.5 INSERT INTO (Əlavə etmək) əmri 
1. The INSERT INTO əmri cədvələ yeni qeydlər əlavə etmək üçün istifadə olunur. 
2. INSERT INTO sintaksisi

 
• INSERT INTO əmrini iki yolla yazmaq mümkündür.
• İlk yol həm sütun adlarını, həm də əlavə olunacaq dəyərləri ifadə edir.
3. Dəyərlərin ardıcıllığının cədvəldəki sütun ardıcıllığı kimi eyni olduğundan əmin olun. 
The INSERT INTO sintaksisi asağıdakı kimi olacaq:

4.6 SELECT (Seçim) əmri
1) Seçim əmri 
1. Məlumatlar bazasından seçmək üçün istifadə olunur.
2. Nəticə cədvəlinə geri qayıdan məlumatlar nəticə seti adlanır.

2) SELECT sintaksisi
SELECT dəyər1, dəyər2 FROM cədvəl_adı; 
1. Dəyər1, Dəyər2 məlumatları seçmək istədiyiniz cədvəlin sahə adlarıdır  

3) Bütün sahələri seçən sintaksis cədvəldə mövcuddur. 
SELECT * FROM cədvəl_adı

4) SELECT DISTINCT əmri
1. The SELECT DISTINCT əmri yalnız fərqli dəyərləri qaytarmaq üçün istifadə olunur.
2. Sütun cədvəlin içində birdən çox təkrarlanan dəyərlər olur. Fərqli (təkrarlanmayan) dəyərləri 
göstərmək üçün DISTINCT ifadəsi istifadə olunur
3. SELECT DISTINCT sintaksisi
SELECT DISTINCT sütun1, sütun2, ...
FROM cədvəl_adı

5) SELECT WHERE şərti
1. WHERE əmri qeydləri filtrləmək üçün istifadə olunur. 
2. WHERE əmri yalnız müəyyən bir vəziyyəti yerinə yetirən qeydləri çıxarmaq üçün istifadə olunur. 
3. SELECT WHERE sintaksisi 
SELECT sütun1, sütun2, ...
FROM cədvəl_adı

 

DROP INDEX indeks adı ;  

 

INSERT INTO cədvəl adı (sütun1, sütun2, sütun3, ...) 
VALUES (dəyər1, dəyər2, dəyər3, ...);   

 INSERT INTO cədvəl adı 
VALUES (dəyər1, dəyər2, dəyər3, ...);    
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WHERE şərt və ya şərtlər;
※ Qeyd: 
WHERE əmri yalnız SELECT ifadəsində deyil, eyni zamanda UPDATE, DELETE və s.-də  istifadə 
olunur.

6) AND, OR və NOT operatorları
1. WHERE şərti AND, OR, NOT operatorları ilə birləşdirilə bilər. 
2. AND, OR operatorları birdən çox şərt əsasında yazılanları filtrləyirlər.
• AND operatoru (And) ilə ayrılmış bütün hallar doğrudursa (True) qeydləri nümayiş etdirir.  
• OR operatoru (Or) ilə ayrılmış bütün hallar doğrudursa (True) qeydləri nümayiş etdirir.  
3. NOT operatoru şərtlər doğru olmadıqda (NOT TRUE) qeydləri nümayiş etdirir.
4. AND sintaksisi
SELECT sütun1, sütun2, ...
FROM cədvəl_adı
WHERE şərt1 AND şərt2 AND şərt3...;
5. OR sintaksisi 
SELECT sütun1, sütun2, ...
FROM cədvəl_adı
WHERE şərt1 OR şərt2 OR şərt3...;
6. NOT sintaksisi
SELECT sütun1, sütun2, ...
FROM cədvəl_adı
WHERE NOT şərt1;

7) ORDER BY açar sözü
1. ORDER BY açar sözü nəticə sırasını artan və azalan formada sıralayır. 
2. ORDER BY açar sözü qeydləri artan sıra ilə sıralayır (default olaraq). Azalan sıra ilə sıralamaq 
üçün DESC açar sözündən istifadə edin. 
3. ORDER BY açar sözü
SELECT sütun1, sütun2, ...
FROM cədvəl_adı
ORDER BY sütun1, sütun2, ... ASC | DESC;

4.7 UPDATE (Yeniləmək) əmri 
1) UPDATE əmri
1. UPDATE əmri cədvəldə mövcud qeydləri dəyişdirmək üçün istifadə olunur. 
2. UPDATE sintaksisi
UPDATE cədvəl_adı
SET sütun1 = dəyər1, sütun2= dəyər2, ...
WHERE şərt;
※ Qeyd:
Cədvəldə qeydləri dəyişən zaman ehtiyatlı olun. UPDATE əmrində WHERE şərtinə diqqət edin. 
WHERE şərti hansı qeydlərin yenilənməli olduğunu müəyyən edir. Əgər siz WHERE şərtini yox 
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etsəniz cədvəldə olan bütün qeydlər yenilənəcək.

2) UPDATE Multiple Records (Yeniləmək əmri)
1. Bu, nə qədər qeydin yenilənəcəyini müəyyən edilən WHERE şərtidir. 
2. Aşağıdakı SQL ifadəsi ölkə adı “Azerbaijan” olan bütün qeydlərdə kontakt adını “Baku” adına 
yeniləyir.
3. UPDATE Multiple Records sintaksisi
UPDATE Customers
SET ContactName='Baku'
WHERE Country='Azerbaijan';

4.8 DELETE (Silmək) əmri
1. DELETE əmri cədvəldə verilənləri silmək üçün istifadə olunur. 
2. DELETE sintaksisi
DELETE FROM cədvəl_adı WHERE condition;

※ Qeyd: 
Cədvəldə verilənləri silən zaman ehtiyatlı olun! 

• DELETE əmrində WHERE şərtinə diqqət edin. 
• WHERE şərti hansı qeydin silinəcəyini müəyyən edir. 
• Əgər siz WHERE şərtini ləğv etsəniz cədvəldə olan bütün qeydlər silinəcək. 

5. SQL JOINS (SQL Birləşmələri) prinsipləri
1) JOIN (Birləşmə şərti) 
JOIN iki və daha çox cədvəldən aralarındakı sıraları müvafiq sütuna əsasən birləşdirmək üçün isti-
fadə olunur. 
2) Sifarişlər cədvəli

3) Müştərilər cədvəli

Sifariş nömrəsi Müştəri nömrəsi Sifariş tarixi
10308 2 2018-09-18
10309 37 2018-09-19
10310 77 2018-09-20

Müştəri nöm-
rəsi

Müştəri adı Kontakt şəxs Ölkə

1 Alfreds Futterkiste Maria Anders Almaniya
2 Ana Trujillo Emparedados y 

helados
Ana Trujillo Meksika

3 Antonio Moreno Taquería Antonio Moreno Meksika
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※ Qeyd: 
Sifariş cədvəlində (Order table) müştəri nömrəsinin (CustomerID) müştəri cədvəlinə (Customers 
table) aid olduğuna diqqət yetirin. 

• Yuxarıdakı iki cədvəl arasındakı əlaqə müştəri nömrəsi (CustomerID) sütunudur. 

4) SQL əmri INNER JOIN şərtini özündə birləşdirir. 
SELECT Orders.OrderID, Customers.CustomerName, Orders.OrderDate
FROM Orders
INNER JOIN Customers ON Orders.CustomerID=Customers.CustomerID;

• Nəticəni aşağıdakı kimi tərtib edin:

2) SQL JOIN (SQL birləşmə) müxtəlif növləri
1. (INNER) JOIN hər iki cədvəldə uyğun dəyərlərə sahib verilənləri geri qaytarır. 
2. LEFT (OUTER) JOIN sol cədvəldən bütün verilənləri və sağ cədvəldən uyğun verilənləri geri 
qaytarır. 
3. RIGHT (OUTER) JOIN sağ cədvəldən bütün verilənləri və sol cədvəldən uyğun verilənləri geri 
qaytarır. 
4. FULL (OUTER) JOIN sağ və ya sol yarlıkda bütün uyğun verilənləri geri qaytarır.

   

 

a. INNER JOIN (Daxili birləşmə) açar sözü
• The INNER JOIN açar sözü hər iki cədvəldə uyğun dəyərləri olan verilənləri seçir. 

Sifariş nömrəsi Müştəri adı Sifariş tarixi
10308 Ana 9/18/2018
10365 Antonio 11/27/2018
10383 Around the Horn 12/16/2018
10355 Around the Horn 11/15/2018
10278 Berglunds 8/12/2018
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• INNER JOIN sintaksisi.
SELECT column_name(s)
FROM table1
INNER JOIN table2 ON table1.column_name = table2.column_name;
b. LEFT JOIN (Sol birləşmə) açar sözü
• LEFT JOIN açar sözü sol cədvəldən (Cədvəl 1) bütün verilənləri və sağ cədvəldən (Cədvəl 2) 
uyğun verilənləri geri qaytarır.  
• Uyğunluq olmadıqda sağ tərəfdən nəticə sıfır olur.
• LEFT JOIN sintaksisi. 
SELECT column_name(s)
FROM table1
LEFT JOIN table2 ON table1.column_name = table2.column_name;
 
c.  RIGHT JOIN (Sağ birləşmə) açar sözü
• RIGHT JOIN açar sözü sağ cədvəldən (Cədvəl 2) bütün verilənləri və sol cədvəldən (Cədvəl 1) 
uyğun verilənləri geri qaytarır.
• Uyğunluq olmadıqda sol tərəfdən nəticə sıfır olur.
• RIGHT JOIN sintaksisi
SELECT column_name(s)
FROM table1
RIGHT JOIN table2 ON table1.column_name = table2.column_name;
  
d. FULL OUTER JOIN açar özü
• The FULL OUTER JOIN açar sözü sol (Cədvəl 1) və ya sağ cədvəl (Cədvəl 2) verilənlərində 
uyğunluq olduqda bütün verilənləri geri qaytarır.
※ Qeyd: 
FULL OUTER JOIN potensial olaraq çox geniş nəticə setini geri qaytarır.

• RIGHT JOIN sintaksisi
SELECT column_name(s)
FROM table1
FULL OUTER JOIN table2 ON table1.column_name = table2.column_name;
  
5. SELF JOIN açar sözü
• SELF JOIN müntəzəm birləşmədir, amma cədvəl öz-özünə birləşir. 
• SELF JOIN sintaksisi.
SELECT column_name(s)
FROM table1 T1, table1 T2
WHERE condition;

• SQL əmri eyni şəhərdən olan müştəriləri çeşidləyir. 
SELECT A.CustomerName AS CustomerName1, B.CustomerName AS CustomerName2, A.City
FROM Customers A, Customers B
WHERE A.CustomerID <> B.CustomerID
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AND A.City = B.City 
ORDER BY A.City;

 
6. UNION (Birləşmə) operatoru
1) UNION iki və daha çox SELECT əmrinin nəticə setini birləşdirmək üçün istifadə olunan opera-
tordur.
• UNION ilə hər bir SELECT əmri eyni sayda sütun sayına sahib olmalıdır. 
• Sütunların məlumat növləri də oxşar olmalıdır.
• Hər bir SELECT əmrində sütunlar eyni sifarişdə olmalıdır. 
2) UNION sintaksisi.
SELECT column_name(s) FROM table1
UNION
SELECT column_name(s) FROM table2;
  
3) UNION ALL sintaksisi
• UNION operatoru yalnız fərqli dəyərləri seçir. Dəyərlərin surətini çıxarıb artırmaq üçün UNION 
ALL-u istifadə edin. 
SELECT column_name(s) FROM table1
UNION ALL
SELECT column_name(s) FROM table2;
※ Qeyd: 
Nəticə setində olan sütun adları adətən UNION-da ilk SELECT əmrində sütun adlarına uyğun olur. 

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. SQL (Oracle) ifadəsini aydın şəkildə izah etdi?
2. Proqramı birbaşa yükləyib/quraşdırdı?
3. Cədvəl yarat (CREATE TABLE) ifadəsini düzgün şəkildə 
yaratdı?
4. ALTER TABLE ifadəsini düzgün şəkildə yaratdı?
5. JOIN-u düzgün şəkildə yaratdı?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   ERD-nin əsas konseptini aydın şəkildə izah etməyi bacaracaq;
2.   Qısa müddətə element əlaqə diaqramını (ERD) qurmağı biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   Photoshop proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. ERD (Element əlaqə diaqramı)
1.1 ERD 
1. ERD verilənlər bazasında toplanan element toplusunun əlaqələrini göstərir. 
2. Bu, konteksdə mövcud olan bir obyekt, məlumat komponentidir. 
3. Element toplusu oxşar elementlərin toplusudur. Bu elementlərin xüsusiyyətlərini müəyyən 

edən atributlar mövcuddur. 
4. Elementlərin müəyyən olunması, onların atributları və aralarındakı əlaqələrin göstərilməsi ilə 

ER diaqramı verilənlər bazasının məntiqi quruluşunu göstərir. 
5. ER diaqramları verilənlər bazasının dizaynını tərtib etmək üçün istifadə olunur. 

1.2 Data ilə mövcud verilənlər bazasının sənədləşdirilməsi 
1. Verilənlər bazasını yaratmaq üçün iki səbəb var:
• Yeni sxem tərtib etmək
• Mövcud strukturu sənədləşdirmək
2. Əgər sizin mövcud verilənlər bazanız varsa sənədləşdirməyə ehtiyacınız var. 
• Öz verilənlər bazanızdan məlumatları istifadə edərək verilənlər bazası diaqramını yaradın. 
• Verilənlər bazası strukturunu CSV faylı kimi  eksport edin (bunu etmək qaydası ilə bağlı bəzi 

əmrlər mövcuddur) və daha sonra proqramın avtomatik ERD yaratmasını təmin edin. 
3. Bu, verilənlər bazasının ən doğru portreti hesab olunur və sizdən heç bir çəkim tələb etməyəcək. 
4. Verilənlər bazasından formalaşdırılan əsas verilənlər bazası strukturu nümunəsi:

2. Oracle məlumatlar bazasının yüklənməsi
2.1 Faylın yüklənməsi
1. [Oracle Database Express Edition (XE) Release 11.2.0.2.0 (11gR2)] və ya “www.oracle.com”-

2. Erd əsaslari
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dan son versiyanı yükləyin.

1.3 Tarix
1. Peter Chen 1976-cı ildə ERD-ni yaratdı. 
2. Bu vaxtdan sonra Charles Bachman və James Martin əsas ERD prinsiplərinə kiçik dəyişikliklər 

əlavə etdilər.

※ http://www.oracle.com,  https://www.smartdraw.com/ https://www.w3schools.com/ 
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Təcrübə mərhələləri

1. Simvolların çəkilməsi
1) ERD ifadəsi
• ER diaqramı sistemin yaratdığı məlumatların necə əlaqəli olduğunu vizuallaşdıran vasitədir.  

ERD-nin 5 əsas komponenti var:
1. Entities (Elementlər) düzbucaqlılar ilə təmsil olunur. 
• Entity-haqqında məlumat toplamaq istədiyiniz obyekt və ya konsepsiyadır.  

• Zəif element digəri ilə xarici açar əlaqəsi şəklində müəyyən olunur, çünki o, tək başına öz xüsu-
siyyətləri ilə müəyyənləşdirə bilməz. 

2. Romb şəkili ilə nümayiş olunan fəaliyyətlər verilənlər bazasında məlumatların bölünməsini 
göstərir. 

• Bəzi hallarda elementlər öz-özünə bağlı ola bilər. Misal üçün, işçilər digər işçilərə nəzarət edə 
bilər. 

3. Atributlar (Fərqləndirici xüsusiyyətlər) ellips ilə nümayiş olunur.  
• Buradakı əsas xüsusiyyət obyektin unikal, fərqli xüsusiyyətidir. 
• Misal üçün, işçinin sosial təhlükəsizlik kodu onun əsas atributudur.
Çox dəyərli atribut  birdən çox dəyərə sahib ola bilər.
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• Misal üçün, bir işçinin birdən çox bacarıq dəyəri ola bilər. 
Əldə edilən atribut digər bir xüsusiyyətə əsaslanır. 

• Misal üçün, işçinin aylıq maaşı işçinin illik maaşına əsaslanır. 

4. Bağlantı xətləri diaqramda mövcud olanların əlaqəsini göstərmək üçün atributları birləşdirən 
düz xətlərdir.  

5. Kardinallıq element nümunəsinin neçəsinin digər elementin bir nümunəsi ilə bağlı olduğunu 
müəyyən edir. 

• Sıralanma eyni zamanda kardinallıq ilə sıx bağlıdır. 
• Kardinallıq bir əlaqənin meydana gəlməsini müəyyən edərkən sıralama əlaqəni məcbur və ya 

istəyə bağlı olaraq təsvir edir.
• Digər sözlə kardinallıq əlaqələrin maksimal sayını müəyyən edir, digəri isə mütləq minimum 

sayı ifadə edir. 

2) Kardinallığı ifadə edən notasiya üslublarının növləri
A. Məlumat texniki üslublar (Information Engineering Style)
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B. Chen növü

A. Bachman növü
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D. Martin stili

2. Data diaqram istifadəsi
1) Məlumat axını diaqramı (Data Flow Diagram)



İKT

432

• Data Flow Diagram (DFD) giriş və çıxışlar baxımından verilən sistem tərəfindən datanın necə 
işləndiyini təsvir edir.  

• Adından da göründüyü kimi o, məlumat axını, məlumatın hara gəldiyi, hara getdiyi və harada 
toplandığına fokuslanır. 
3) ERD-nin qurulması

1) Elementləri  (Entities) müəyyən edin.
• ERD yaratmağın ilk addımı istifadə 
edəcəyiniz bütün elementlərin müəyyən 
olunmasıdır.
• Element sisteminiz haqqında məlumat 
toplayan bir 
şeyin açıqlamasından ibarət dördbucaqdan başqa bir şey deyil. 
• Bu, müştəri, menecer, qaimə, cədvəl və s. ola bilər. 
• Səhifənizdə düşündüyünüz hər şey üçün bir düzbucaqlı 
çəkin. Onları bir az aralı saxlayın. 

2) Əlaqələri müəyyənləşdirin. İki şəklə də baxın. Onlar bir-biri ilə əlaqəlidirmi?
• Əgər belədirsə hər ikisini birləşdirən düz xətt çəkin.
3) Əlaqəni təsvir edin. Hər iki şəkil bir-biri ilə əlaqəlidirmi? 
• Yeni əlavə etdiyiniz xətt üzərində hər iki element arasında romb çəkin. 
• Rombda onların bir-biri ilə necə əlaqəli olmasının qısa təsvirini yazın. 
4) Atributları əlavə edin. 
• Hər bir əsas atribut ellips formalı simvolları istifadə edərək əlavə olunmalıdır. 
5) Diaqramı tamamlayın. 
• Elementləri (entities) xətlərlə birləşdirməyə davam edin və bütün əlaqələr təsvir edilincəyə qədər 

hər bir əlaqəni təsvir etmək üçün romblar əlavə edin. 
• Hər elementin (entities) bir və ya birdən çox əlaqəsi ola bilər. Bu, normaldır. 

4) Effektiv ER diaqramları
1) Hər bir elementin diaqramda bir dəfə göründüyünə əmin olun. 
2) Diaqramınızda hər bir əlaqəyə, atributa ad verin. 
3) Elementlər (entities) arasında əlaqələri analiz edin. Onlar zəruridirlərmi? Əskik bir əlaqə var-

mı? Lazımsız əlaqələri ləğv edin.  Əlaqələri bir-birinə bağlamayın.
4) Diaqramın vacib hissələrini vurğulamaq üçün rənglərdən istifadə edin. 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. ERD-nin əsas konsepsiyasını izah etdi?
2. Elementlər arasında əlaqə diaqramını (ERD) qısa şəkildə düzəlt-
di?
3. ERD ilə bağlı simvolları çəkdi?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Verilənlər bazası strukturunu düzgün şəkildə izah etməyi bacaracaq;
2.   Cədvələ/sütuna məhdudiyyət tətbiq etməyi biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   Photoshop proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Cədvəl yaratmaq
1.1 Cədvəl yaradın. 
1. REATE TABLE sintaksisi

3. Cədvəl, və (dəyər obyekti̇) və məlumat 
toplusu yaratmaq

 

CREATE TABLE table_ name( 
Column name Datatype    Column Constraint, 
….. 
Table Constraint 
); 
 

CREATE TABLE table_name ( 
    column1 datatype, 
    column2 datatype, 
    column3 datatype, 
   .... 
); 

※ Qeyd:
• Cədvəl adı (TABLE NAME) digər cədvəl adı ilə üst-üstə düşməməlidir.  
• Eyni cədvəldə sütun adı (COLUMN NAME) üst-üstə düşməməlidir. 
• Məlumat növü sütunun (COLUMN) məlumat növü mənasında işlənir. 
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• Sütun məhdudiyyəti (COLUMN CONSTRAINT) sütuna bütünlük məhdudiyyətini (INTEGRI-
TY CONSTRAINT) xarakterizə edir. 

• Cədvəl məhdudiyyəti (TABLE CONSTRAINT)  cədvələ bütünlük məhdudiyyətini (INTEGRA-
ITY CONSTRAINT) xarakterizə edir. 

2, Nümunə:

 CREATE TABLE CHATER_1( 
  SABUN  VARCHAR2(10)  NOT NULL, 
  NAME   VARCHAR2(50)  NOT NULL,  
  AGE  VARCHAR2(3), 
  PHONE  VARCHAR2(11), 
CONSTRAINT CHAPTER_1_PK PRIMARY KEY(SABUN) 
) 
TABLESPACE SYSTEM 
PCTFREE 10 
PCTUSED 40 
INITRANS 1 
MAXTRANS 255 
STORAGE ( 
 INITIAL 64K 
 NEXT 1024K 
 MINEXTENTS 1 
 MAXEXTENTS UNLIMITED 
 FREELISTS 1 
) 
  

▒ Saxlama parametrləri

2) SQL-də əmrlərin növləri 
1) DML (Verilənlərin emalı dili)
2) DDL (Verilənlərin təyini dili)
3) DCL (Verilənlərə nəzarət dili)
4) TCL (Əməliyyatlara nəzarət dili)
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1) DML (Verilənlərin emalı dili)
1. DML əmri cədvəldəki qeydlərə təsir edə bilir. 
2. Biz verilənlərdə cədvəldən yeni qeydləri seçmək, yeni qeydləri əlavə etmək, lazımsız qeydləri 

silmək və mövcud qeydləri yeniləmək/dəyişiklik etmək kimi bəzi əsas əməliyyatları tətbiq edirik.  
3.DML əmrinə aşağıdakılar daxildir:
• SELECT – cədvəldən qeydləri seçir.
• INSERT – yeni qeydlər əlavə edir.
• UPDATE – mövcud qeydləri yeniləyir və ya dəyişiklik edir. 
• DELETE – mövcud qeydləri silir. 

2) DDL (Verilənlərin təyini dili)
1. DDL əmri verilənlər bazasına, cədvəl strukturuna və sxemə dəyişiklik etmək üçün istifadə 

olunur. 
2. Bu əmrlər verilənlər bazasının obyektlərinin dizaynını və saxlanmasını idarə edir.
• CREATE –yeni cədvəl, məlumatlar bazası və sxem yaradır.  
• ALTER – mövcud cədvəldə, sütun təsvirində dəyişiklik edir. 
• DROP – Məlumatlar bazasından mövcud obyektləri silir. 

3) DCL (Verilənlərə nəzarət dili)
1. DCL əmri istifadəçinin verilənlər bazası obyektlərinə giriş səviyyəsinə nəzarət edir.  
• GRANT – istifadəçilərə mövcud verilənlər bazası obyektlərində oxuma/yazma icazəsi verir. 
• REVəKE – istifadəçilərin verilənlər bazası obyektlərində oxuma/yazmasına maneə törədir.  

4) TCL (Əməliyyatlara nəzarət dili)
1. TCL əmri sizə SQL əmrləri içərisində verilənlərin bütövlüyünü qorumaq üçün əməliyyatları 

idarə etmək və onlara nəzarət etməyə icazə verir.
• BEGIN Transaction – əməliyyatı açır.
• COMMIT Transaction – əməliyyat icra edir. 
• ROLLBACK Transaction – hər hansı bir xəta vəziyyətində əməliyyatı geri çağırır.
※ https://www.tech-recipes.com/
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Təcrübə mərhələləri

1. Cədvəl yaratmaq
1) ALTER, DELETE (Dəyişdirmək və Silmək) sütunu
1. Əsas sintaksis

2. Example

2) RENAME Table Name (Cədvəl adını yenidən adlandırmaq) 
1. Əsas sintaksis

2. TABLE CONSTRAINT (Cədvəl məhdudiyyəti)
1) PRIMARY KEY (İlkin açar) 
2) PRIMARY KEY CONSTRAİNT (Açar məhdudiyyəti)

1. Təsvirlər
• Digər cədvəlin xarici açarından SABUN açarına istinad edin. 
• PK dəyəri vahiddir. 
• NULL dəyərini əlavə etməyə icazə verməyin. 
• PK (İlkin açar) ilə avtomatik INDEX yaradın. 
2. İlkin açar (PRIMARY KEY) və xarici açar (FOREIGN KEY) arasındakı fərq:

 ALTER TABLE table_name ADD (Colunm_name DATATYPE) 
ALTER TABLE table_name RENAME Colunm_name1 TO Column_name2 
ALTER TABLE table_name MODIFY (Colunm_name2 DATATYPE) 
ALTER TABLE table_name DROP COLUMN Colunm_name  
 

 ALTER TABLE CHAPTER_1 ADD (JOIN_DAY VARCHAR2(8) 
                                  // ADDING COLUMN 
ALTER TABLE CHAPTER_1 COLUMN RENAME PHONE TO HP 
                                  // CHAGE COLUMN NAME 
ALTER TABLE CHAPTER_1 MODIFY (AGE NUMBER(3))  
                                  // CHANGE COLUMN DATATYPE 

 RENAME Before TABLE NAME TO After TABLE NAME 

 CREATE TABLE CHAPTER_1( 
 SABUN(//ID) VARCHAR2(10) CONSTRAINT CHAPTER_1_PK_SABUN PRIMARY KEY 
) 
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             Xarici açar                              İlkin açar
Xarici açar iki cədvəldə verilənlər 
arasında əlaqə yaradan sütun və ya 
sütunlar qrupudur.  

İlkin açar bütün cədvəl qeydlərini unikal 
şəkildə müəyyən etməyə imkan verən xüsusi 
verilənlər bazası, cədvəl sütunu və ya çoxlu 
sütunların birləşməsidır. 

NULL
Xarici açar NULL dəyərini qəbul 
edir. 

İlkin açar NULL dəyərini qəbul edə bilmir.

Açarların sayı
Cədvəldə çoxlu xarici açar ola 
bilər.

Cədvəldə yalnız bir açar ola bilər. 

Surətini çıxarmaq
Verilənlər bazasında qeydləri for-
malaşdıran verilənlər qrupu xarici 
açar atributu üçün ikili dəyərə 
sahibdir.

Verilənlər bazasında qeydləri forma-
laşdıran verilənlər qrupu ilkin açar atribu-
tu üçün ikili dəyərə sahib deyil. 

3) NOT NULL
1. NOT NULL Constraint (Məhdudiyyət)

2. Təsvir
• Əgər boş deyilsə AD (NAME) dəyər əldə etməlidir. 
4) XARİCİ AÇAR
1. XARİCİ AÇAR məhdudiyyəti

 
CREATE TABLE CHAPTER_1( 
 SABUN VARCHAR2(20) CONSTRAINT CHAPER_1_PK_SABUN PRIMARY KEY 
 NAME VARCHAR2(20) CONSTRAINT CHAPTER_1_nn_NAME NOT NULL 

 CREATE TABLE CHAPTER_1( 
 SABUN(//ID) VARCHAR2(10) CONSTRAINT CHAPTER_1_PK_SABUN PRIMARY KEY 
 NAME VARCHAR2(20) CONSTRAINT CHAPTER_1_nn_NAME NOT NULL 
 PHONE VATCHAR2(11) CONSTRAINT CHAPTER_1_FK_PHONE 
      FOREIGN KEY (PHONE) REFERENCES CHAPTER_2(PHONE) 
) 
 

2. Təsvirlər 
• XARİCİ AÇAR: Sütun ilkin açara istinad edir.
• XARİCİ AÇAR: İlkin açar sütunu və məlumat növü ilə eyni olmalıdır. 

5) DEFAULT
1. DEFAULT məhdudiyyəti
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 CREATE TABLE CHAPTER_1( 
 SABUN(//ID) VARCHAR2(10) CONSTRAINT CHAPTER_1_PK_SABUN PRIMARY KEY 
 NAME VARCHAR2(20) CONSTRAINT CHAPTER_1_nn_NAME NOT NULL 
 PHONE VATCHAR2(11) CONSTRAINT CHAPTER_1_FK_PHONE 
      FOREIGN KEY (PHONE) REFERENCES CHAPTER_2(PHONE) 
 PUT_START_DAY DATE DEFAULT SYSDATE 
) 
 

2. Təsvirlər 
• Default INSERT və UPDATE əmrində istifadə olunur. 

6) TABLE (Cədvəl) məhdudiyyətini yoxlamaq 
1. DEFAULT məhdudiyyəti
2. INSERT, SELECT, UPDATE və DELETE SQL əmrlərini istifadə etmədikdə məcburi şərti 

yoxlamadan SQL əmrlərini yaradın. 

 SELECT TABLE_NAME, B.COLUMN, A.CONSTRAINT_NAME, A.CONSTRAINT_TYPE, 
   A.SERARCH_CONDITION 
 FROM USER_CONSTRAINTS A. USER_CONS_COLUMNS B 
WHERE A.CONSTRAINT_NAME = B.CONSTRAINT_NAME 
 AND A.TABLE_NAME = INSA’ 
 AND A.CONSTRAINT_TYPE = ‘P’ 
 

3. Təsvirlər 
A. USER CONSTRAINTS: İstifadəçinin öz cədvəli ilə bağlı məhdudlaşdırma məlumatı 
• DBA_CONSTRAINT: Bütün cədvəl ilə bağlı məhdudlaşdırma məlumatı 
• ALL_CONSTRAINT: Giriş imkanı üçün bütün cədvəl ilə bağlı məhdudlaşdırma məlumatı 
B. USER CONS_COLUMNS: İstifadəçinin öz sütunu ilə bağlı məhdudlaşdırma məlumatı
• DBA_CONS_COLUMNS: Bütün cədvəl sütunu ilə bağlı məhdudlaşdırma məlumatı 
• ALL_CONS_COLUMNS: Giriş imkanı üçün bütün cədvəl sütunu ilə bağlı məhdudlaşdırma 

məlumatı
C. CONSTRAINT_TYPE: Unikal məhdudiyyət şərti işarəsi
• P – PRIMARY KEY, U – UNIQUE KEY, F- FOREIGN KEY, C – CHECK, V –VIEW haqqında 

unikal məhdudiyyət şərtini ifadə edir 
7) ADD TABLE (Cədvəl əlavə et) məhdudiyyəti
1. ADD məhdudiyyəti

 ALTER TABLE INSA 
ADD CONSTRAINT INSA_MOBILE_UK UNIQUE(MOBILE) 
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2. Cədvəl yaradarkən məhdudiyyətləri diqqətə almadığınız cədvəl məhdudiyyətlərini əlavə edin. 

8) DROP TABLE (Açılıb-bağlanan cədvəl) məhdudiyyəti 
1. DROP məhdudiyyəti 

2. Məhdudiyyətləri silmək üçün ALTER DROP əmrini istifadə edin. 
3. Referans bütövlüyü məhdudiyyətini aradan qaldırmaq üçün CASCADE istifadə edin. 

3. CARİ CƏDVƏL YARADIN
1) INSA cədvəli
1. INSA MASTER cədvəli
• İşçilərin şəxsi məlumatlarını əlavə edin. 
• ACAD (Akademik bacarıq) çoxlu hadisələr ilə uyğunlaşır. 
2. Proqram

 ALTER TABLE INSA 
DROP CONSTRAINT INSA_MOBILE_UK  

 CREATE TABLE INSA 
( 
  SABUN           VARCHAR2(10 BYTE)             NOT NULL, 
  JOIN_DAY        VARCHAR2(8 BYTE), 
  RETIRE_DAY      VARCHAR2(8 BYTE), 
  PUT_YN          VARCHAR2(1 BYTE), 
  CLASS_GBN_CODE  VARCHAR2(3 BYTE), 
  NAME            VARCHAR2(100 BYTE), 
  REG_NO          VARCHAR2(13 BYTE), 
  ENG_NAME        VARCHAR2(100 BYTE), 
  PHONE           VARCHAR2(25 BYTE), 
  HP              VARCHAR2(25 BYTE), 
  CARRIER         VARCHAR2(500 BYTE), 
  POS_GBN_CODE    VARCHAR2(5 BYTE), 
  CMP_REG_NO      VARCHAR2(10 BYTE), 
 SEX             VARCHAR2(1 BYTE), 
  YEARS           NUMBER, 
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   EMAIL           VARCHAR2(50 BYTE), 
  ZIP             VARCHAR2(6 BYTE), 
  ADDR1           VARCHAR2(250 BYTE), 
  ADDR2           VARCHAR2(250 BYTE), 
  MIL_YN          VARCHAR2(10 BYTE), 
  HOME_PHONE      VARCHAR2(25 BYTE), 
  JOIN_GBN_CODE   VARCHAR2(3 BYTE), 
  SALARY          NUMBER                        DEFAULT 0, 
  KOSA_REG_YN     VARCHAR2(1 BYTE), 
  KOSA_CLASS      VARCHAR2(3 BYTE), 
  PW              VARCHAR2(15 BYTE), 
  CONSTRAINT INSA_PK 
  PRIMARY KEY 
  (SABUN) 
  ENABLE VALIDATE 
) 
TABLESPACE USERS 
RESULT_CACHE (MODE DEFAULT) 
PCTUSED    0 
PCTFREE    10 
INITRANS   1 
MAXTRANS   255 
STORAGE    ( 
            INITIAL          64K 
            NEXT             1M 
            MINEXTENTS       1 
            MAXEXTENTS       UNLIMITED 
            PCTINCREASE      0 
            BUFFER_POOL      DEFAULT 
            FLASH_CACHE      DEFAULT 
            CELL_FLASH_CACHE DEFAULT 
           ) 
LOGGING  
NOCOMPRESS  
NOCACHE 
NOPARALLEL 
MONITORING; 
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3. Məhdudlaşdırma təyinat növü

                        Inline      &     Outline
CREATE TABLE INSA(

 SABUNVARCHAR2(10) PRIMARY KEY

CREATE TABLE INSA(

 SABUN VARCHAR2(10)

CONSTRAINT “INSA_PK_SABUN” 
PRIMARY KEY(SABUN))

2) ACADEMIC ABILITY TABLE (Akademik bacarıq cədvəli)
1. INSA_ ACAD_ABILITY TABLE

   CREATE TABLE INSA_ACAD_ABILITY 
( 
  SABUN            VARCHAR2(10 BYTE)            NOT NULL, 
  SEQ              NUMBER                       NOT NULL, 
  MAJOR_STUDY_GBN  VARCHAR2(100 BYTE), 
  GRAT_YN          VARCHAR2(1 BYTE), 
  GRAT_YEAR        VARCHAR2(4 BYTE), 
  GRAT_MONTH       VARCHAR2(2 BYTE), 
  SCHOOL_NAME      VARCHAR2(50 BYTE), 
  CONSTRAINT PK_INSA_ACAD_ABILITY 
  PRIMARY KEY 
  (SABUN, SEQ) 
  ENABLE VALIDATE 
) 
TABLESPACE USERS 
RESULT_CACHE (MODE DEFAULT) 
PCTUSED    0 
PCTFREE    10 
INITRANS   1 
MAXTRANS   255 
STORAGE    ( 
            INITIAL          64K 
            NEXT             1M 
            MINEXTENTS       1 
            MAXEXTENTS       UNLIMITED 
            PCTINCREASE      0 
            BUFFER_POOL      DEFAULT 
            FLASH_CACHE      DEFAULT 
            CELL_FLASH_CACHE DEFAULT 
           ) 
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 LOGGING  
NOCOMPRESS  
NOCACHE 
NOPARALLEL 
MONITORING; 

2. Təsvir
• SEQ –nü PK (İlkin açar) sütunu kimi müəyyən edin.
• SABUN ilə NOT NULL və UNIQUE məhdudiyyətlərini verin. 
3. Məhdudiyyət

 
SELECT COLUMN_NAME, DECODE(B.CONSTAINT_TYPE, ‘P’,’PRIMARY KEY’ 
 ,‘U’,’UNIQUE KEY’ 
 ,‘C’,’CHECK OR NOT NULL’ 
 ,‘R’,’FOREIGN KEY’) 
AS CONSTRAINT_TYPE, A.CONSTRAINT_NAME, B.CONSTRAINT_NAME 
FROM USER_CONS_COLUMNS A. USER_CONSTRAINTS B 
WHERE A.TABLE_NAME = UPPER(:NAME) 
AND A.TABLE_NAME = B.TABLE_NAME 
AND A.CONATRAINT_NAME = B.CONSTRAINT_NAME 

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Verilənlər bazası strukturunu düzgün şəkildə izah etdi
2. Cədvəl/sütuna məhdudiyyəti düzgün şəkildə təyin etdi?
3. Apply DML əmr sintaksisini proqrama aydın şəkildə tətbiq etdi?
4. DDL əmr sintaksisini proqrama aydın şəkildə tətbiq etdi? 
5. DCL əmr sintaksisini proqrama aydın şəkildə tətbiq etdi?
6. TCL əmr sintaksisini proqrama aydın şəkildə tətbiq etdi?  
7. Cədvəl məhdudiyyətini düzgün formada müəyyən etdi?
8. Sütun məhdudiyyətini düzgün formada müəyyən etdi?
9. İlkin açar məhdudiyyətini düzgün şəkildə qurdu?
10. NOT NULL məhdudiyyətini düzgün formada qurdu?
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PHP

Sənaye və İnnovasiyalar üzrə 
Bakı Dövlət Peşə Təhsil Mərkəzi

Səriştə əsaslı 
modul İKT
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Ön söz 

 PHP: Hypertext Preprocessor (və ya qısa olaraq PHP) vebin inkişafı üçün tərtib olunmuş xidməti 
yazı və məqsədli proqramlaşdırma dilidir. Rasmus Lerdorf tərəfindən 1994-cü ildə yaradılıb. İndi 
isə PHP qrup tərəfindən inkişaf etdirilir. Əvvəllər PHP Personal Home Page (şəxsi ana səhifə) 
demək idisə, indi təkrarlanan qısaltmalar PHP Hypertext Preprocessor əvəzinə işlənir.  
PHP kodu HTML kodu daxilinə salına bilər və ya o, müxtəlif veb şablon sistemləri, veb məz-
mun idarəetmə sistemləri, veb çərçivələrlə birlikdə işlənə bilər. PHP kodu adətən PHP şərhedici 
proqramı tərəfindən veb serverdə və ya Common Gateway Interface (CGI)-də modul kimi tətbiq 
olunur. Veb server şərh və icra olunmuş PHP kodunun nəticələrini (şəkillər də daxil olmaqla hər 
hansı bir məlumat növünü) yaradılan veb səhifə ilə birləşdirir. PHP kodu həmçinin CLI ( Com-
mand Line Interface) ilə icra oluna və müstəqil qrafik tətbiqlərini həyata keçirmək üçün istifadə 
edilə bilər. 
 2014-cü ilə qədər PHP dili rəsmi yazılı standartlar olmadan orijinal tətbiqetmə əsasında ( de-fak-
to standartı kimi) inkişaf edib və digər tətbiqlər də məhz bunun ardınca gedib. 2014-ci ildən bu 
günədək isə rəsmi PHP xüsusiyyətlərini yaratmaq sahəsində işlər aparılır. 
 ASP.NET açıq mənbəli server veb tətbiqetmə çərçivəsi olub dinamik veb səhifələrin yaradıl-
ması və inkişafı üçün nəzərdə tutulub. Həmçinin Microsoft tərəfindən proqramçılara dinamik veb 
səhifələrin yaradılması və inkişafı üçün nəzərdə tutulub. İlk dəfə 2002-ci ilin yanvarında NET 
Framework-ün 1.0 versiyası ilə buraxılıb və ASP-nin (Microsoft's Active Server Pages ) texno-
loji varisidir.  ASP.NET CLR-də (Common Language Runtime) yaradılıb və proqramçılara NET 
dilini istifadə edərək ASP.NET kodunu yazmağa icazə verir. The ASP.NET SOAP genişləndirmə 
çərçivəsi SOAP mesajlarını işləmək üçün ASP.NET komponentlərinə şərait yaradır. Bu, ASP.NET-
in modulyar layihə kimi yenidən həyata keçirilməsidir. Yeni çərçivə layihəsi və açıq mənbə olan 
.NET Compiler Platform-u (Codename “Roslyn”) istifadə edir. ASP.NET MVC, ASP.NET Web 
API və ASP.NET Veb səhifələri (yalnız Razor səhifələrini istifadə edən platforma) vahid MVC 6-a 
daxil edilib.
 Yekun olaraq mən çoxsaylı mənbələrə, xüsusilə YouTube, Yahoo, Wikipedia, “www.w3schools.
com” və Google saytlarına təşəkkür edirəm. Onlar mənə texniki təcrübə modulu dərsliyinin hazır-
lanmasında köməklik etdilər. 

                YUN, Hyung Soon, IKT üzrə Texniki Ekspert
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   PHP proqramlaşdırma anlayışını əminliklə izah edəcək;
2.   PhpMyAdmin funksiyasını əminliklə başa düşəcək;
3.   Proqramı birbaşa yükləməyi/quraşdırmağı bacaracaq.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.   PHP tətbiq proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. PHP Shopping Mall üçün inkişaf mühiti  
1.1 Windows OS üçün APM-in komponentləri
1. Apache Web Server & MySQL
2. Database (DB)
3. PHP dili
※ http://www.apachelounge.com

2) Apache Web serverinin quraşdırılması
3) 

2.2  “httpd” faylının yaradılması
1. “httpd.conf”-nin dəyişdirilməsi
• Edit “httpd.conf” in “c:\APM\Apache24\conf”
• “httpd.conf” vebserver konfiqurasiya parametrləri üçün fayldır. 
2. SeverRoot-u dəyişdirin. 
• Açmaq üçün ServerRoot-u qovluğa dəyişin.

1. PHP-ni̇n i̇sti̇fadəsi̇nə başlamaq

 
1 

 

2 

1 ServerRoot c:/APM/Apache24

1
2
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“c:/APM/Apache24” 

3. Document Root-u dəyişin. 
• “htdocs” qovluğu veb-serverin ana səhifəsində olan qovluqdur. 
• “Document Root” və “Directory” qovluqlarının lokatorunu dəyişin. 

1
DocumentRoot

Directory locator

c:/APM/Apache24/htdocs

c:/APM/Apache24/htdocs

 

2.3 “httpd”-ni quraşdırın və onu işlədin. 
1. Prompt əmrini icra edin. 
• “Administrator authority” ilə “httpd”-ni icra edin.

 1 

2 

3 

4 

2. Serveri quraşdırın və başlayın. 
• Keçidi “bin” qovluğuda daxil olmaqla “execute file”-a dəyişin. 
[Keçidi dəyişdir: cd c:\apm\apache24\bin]

1

2

3

4
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1 

2 

• dir/w-nu təsdiq edin.

• “Web Server”-i quraşdırın. 
[c:\apm\apache24\bin>httpd -k install]

• “Web Server”- i başladın.
[c:\apm\apache24\bin>httpd -k start]

 

 
1 

2 

1

2

1

2



PHP

451

3. “Server”-i sınaqdan keçirin. 
• Veb brazerin URL-də “localhost” və ya “127.0.0.1” daxil edin. 
• “Server operation”-u təsdiq edin. 

 

 Apache Web Server-in ana səhifə adresi və qovluğu
1 Ana səhifə qovluğu c:/APM/Apache24/htdocs
2 Ana səhifə adresi http://127.0.0.1 or http://localhost 

3. PHP-nin quraşdırılması
1. Windows üçün PHP: “http://windows php.net”

 
1 

2 

3 

1

2

3
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3.1 PHP-nin quraşdırılması 
1. Php proqramını açın. 
• “php-7.1.6-Win32-VC14-x64.zip”-i və ya ən son versiyanı kopyalayın və onu “c:\APM”-ə 

yapışdırın. 
• “c:\APM”-də onu açın. 

2. Qovluq adını “PHP”-ə dəyişin. 
• Qovluğu açdıqdan sonra adını “PHP7” və ya “PHP *”-ə dəyişin.

 

1 

2 

3.2 PHP-nin tənzimlənməsi
1. “php.ini” yaradın. 
• php.ini-production faylını kopyalayın. 
• “php.ini” faylını düzəldin. 

2. “short_open_tag” atributunu dəyişin. 
• “php.ini” faylının parametr məzmunları arasında “short_open_tag” dəyərini dəyişin. 
• “<?” instead “<?php”-ni etməyə icazə verin. 

 

1 

2 

 

1 

2 

1 Short_open_tag = On

1

2

1

1

2

2
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3. “extension_dir” atriutunu dəyişin. 
• “extension_dir” atributunu dəyişin. 

1 Extension_dir c:/APM/PHP7(or PHP*)/ext

 

1 

2 

4. “post_max_size” və “upload_mx_filesize”-ni dəyişin. 
• Maksimum transfer dəyərini 200Mb-ə dəyişin.
• Əgər istifadəçi daha böyük həcmli fayllar köçürərsə transfer dəyərini düzəltməlidir. 

1 Post_max-size 200Mb
2 Upload_max-filesize 200Mb 

 

1 

2 

3.3 PHP-nin tənzimlənməsi və dəyişdirilməsi
1. İlk olaraq”httpd.conf”-u dəyişin.
• “index.php”-ni c:APM\Apache24 qovluğunda “httpd.conf”-dan Directory Index-ə əlavə edin. 
• “Directory Index” faylı yalnız qovluq adını daxil edərək əmrlər verən qeydiyyat üçün yerdir. 
2. İkinci olaraq “httpd.conf”-da dəyişiklik edin.  

1 Directory Index DirectoryIndex index.html index.php

• “httpd.conf” faylının sonuna aşağıdakı məzmunu əlavə edin. 
3.  “Apache” – ni yeniləyin 

1

2

1

2
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… … … 
PHPiniDir “c:/APM/php7” 
LoadModule php7_module “c:/APM/PHP7/php7apache2_4.dll” 
AddType application/x-httpd-php .html .php 
AddHandler application/x-httpd-php .php 

 

• “Administrator authority” ilə “command prompt”-u seçin.
• Keçidi “c:\apm\apache24\bin”-ə dəyişin. 
• Apache – ni yeniləyin
3.4 PHP-nın sınaqdan keçirilməsi 

1 Path change cd c:\APM\Apache24\bin
2 Redo Apache httpd-k restart

 
Siçanın sağ düyməsini klik 

edin 

1 

2 

3 

4 

5 
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1. “test.php” yaradın. 
• “New” menyusu ilə “c:\apm\apache24\htdocs”-da “test.php” yaradın.
2. “test.php” faylını yaradın. 

 

1 

2 

3 

• Aşağıdakı proqramı daxil edin. 

3. Nəticəni təsdiq edin. 
• Veb brauzerdə proqramı başladın və nəticəni təsdiq edin. 

 

<? 
 phpinfo(); 
?>  

1 URL localhost/test.php

1

2

3
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4) MariaDB-nin qurulması 
1. MySQL ən çox Linux istifadə edən verilənlər bazası proqramlarından biridir. 
2. MairaDB Windows istifadəçiləri üçün verilənlər bazası proqramıdır. 
3. Birbaşa istifadə üçün proqramı kompüterdə quraşdırın. 
4. Yükləmə edin: https://mariadb.org  

 

1 

2 

3 

4 

1

2
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4.1 MariaDB-nin quraşdırılması 
1. “MariaDB program”
• Əlavədə “mariadb-10.2.6-winx64.msi” faylını iki dəfə klik edin.

2. [Browser] düyməsini klik edin və “c:\APM\MariaDB10.2”-ə yaddaşa vermək üçün qovluq 
axtarışını müəyyənləşdirin.  

 

1 

2 

3 
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3. “root” şifrəsini və simvol setini (Character set) müəyyən edin. 
• “New root password”-u “1234” müəyyən edin. 
• UTF8 as default of “Character set”-də klik işarəsini qoyun. 

1 New root password 1234
2 Confirm 1234
3 use UTF8 as default server’s character set √

 

1 

2 

3 4 

5 6 7 

4.2 MariaDB-nin tənzimlənməsi
1. “php.ini”-ni dəyişin. 
• “c:\APM\PHP7”-də “php.ini”dəyişin.
• İlk hərfi silin: “;” 3-cü sətirdə 

 

… … … 
;extension=php_ldap.dll 
extension= php_mbstring.dll 
;extension=php_exit.dll 
extension=php_mysqli.dll 
… … …  
;extension=php_pdo_firebird.dll 
extension=php_pdo_mysql.dll 

1

2

3

6 7

4

5
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2. “httpd”-ə yenidən başlayın. 
• Command Prompt-u istifadə edin və Apache proqramını yenidən başladın. 

4.3 MariaDB-ni işlədin. 
1. “HeidiSQL”-i işlədin. 
• Arxa fonda “HeidiSQL”-i iki dəfə klik edib işlədin.

 

1 Yolu dəyişin cd c:\APM\Apache24\bin
2 Apache-ni yeniləyin httpd-k restart
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2. “HeidiSQL”-in işlədilməsi
• [New] süyməsini klik edin və adı (session name) “MariaDB”-ə dəyişin. 
• “1234” şifrəsini daxil edin. 
• [Open]-i klik edin və verilənlər bazasına qoşulun.

5. PhpMyAdmin-in quraşdırılması 
1) PhpMyAdmin serverdə quraşdırılır.
2) Proqram istənilən şəxs tərəfindən, istənilən zaman, istənilən yerdə istifadə oluna bilər. 
3) “www.phpmyadmin.net” saytından yükləmə edin. 

1 Session name (Ad) MariaDB
2 Password (Şifrə) 1234
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2 
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5.1 PhpMyAdmin-in quraşdırılması
1.  “phpMyAdmin”-i açın.
• “APM” qovluğunda, arxa fonda “phpMyAdmin-4.7.5-all-languages.zip”-i və ya ən son versi-

yanı açın. 
• Qovluq adını “phpMyAdmin”-ə dəyişin.

2. “phpMyAdmin” qovluğunu kopyalayın. 
• “phpMyAdmin” qovluğunu “c:\APM\Apache24\htdocs” qovluğuna kopyalayın.

3. “config.inc.php” yaradın. 
• “phpMyAdmin” qovluğunda “config.sample.inc.php” faylını kopyalayın. 
• “config.sample.inc.php” fayl adını “config.inc.php”-ə dəyişin. 

4. “config.inc.php” faylını dəyişdirin. 
• Məzmundan $cfg[“blowfish_secret”] dəyərini dəyişin. 
• Bu dəyərə istənilən dəyər əlavə edin: “abcdefg12345”
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… … … 
$cfg[“blowfish_secret”] = “abcdefg12345” 
… … …  

 

5. “httpd”-ni yeniləyin. 
• Command Prompt ilə Apache proqramını yeniləyin. 

6.  “phpMyAdmin” proqramını işlədin. 
• Veb brauzerdə URL daxil edin. 
• “phpMyAdmin”-nin qeydiyyat ekranında istifadəçi adı və şifrəsini daxil edin. 
• “phpMyAdmin” və MairaDB-nin yaxşı işləyib işləmədiyini təsdiq edin. 

6. Editplus redaktoru
6.1 “Editplus”-un quraşdırılması və tənzimlənməsi 
1. https://www.editplus.com/download.html-dən Editplus proqramının yüklənməsi 
2. “İnstalling Editplus” proqramını başladın. 
• Əlavədə proqram quraşdırmasında “epp430_64bit.exe”-ni iki dəfə klik edin.
• Başqa yolla, 30 günlük müvəqqəti (demo) versiyanı yükləyin. (epp510_1828 64bit)

1 Path change (Keçid 
dəyişəni)

cd c:/APM/Apache24/bin

2 User name (İstifadəçi 
adı)

httpd -k restart

1 URL http://localhost/phpmyadmin

2 User name 
(İstifadəçi adı)

root 3 Password 
(şifrə)

1234

 

2
1 

3
1 

1 4
1 

1 2

3
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2. Editplus proqramını konfiqurasiya edin. 
• [Tools]-[References…] -ə gedin.

3. “Categories” bölməsinin “General” hissəsində “Fonts”-u (Şrifti) müəyyən edin. 
• Şrifti seçin və bəyəndiyiniz rəng seçimini edin. 
4. “Active line” rəngini müəyyən edin. 
• Area bölməsindən “Active line-ı seçin.
• “Default” qutusundan klik işarəsini götürün. 
• Foreground/Background qutusunu seçin və sonra [more…] düyməsini klik edin.

5.  “File” seçimini qurun.
• “Categories” bölməsindən “File” seçimini edin.  
•  “Encoding” elementindən UTF-8-i seçin. 

 1 

2 
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4
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5
2 
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6. “Remote Toolbars” seçimini tənzimləyin. 
• “Open Remote və “Save As Remote” əmrlərinin hər birini seçin. 
• Onu “Commands” bölməsindən “Toolbars” bölməsinə çəkin  

7. “Document Selector Locations”-ı tənzimləyin. 
“‘Tools” sseçımlərindən “Layout” elementini seçin. 
• “Document Selector Locations” “Top” seçiminə qurulur.  

7. “Homepage Modification” nümunəsinin yaradılması 
7.1 Təcrübə məqsədi 
1. PHP məlumat ekranı əvəzinə adınızı göstərən PHP proqramını hazırlayın.

7.2 Təcrübə bilikləri
1) PHP proqram formatı: “<? Php program ?>”
1. PHP faylının fayl genişlənməsi: [*.php]
2. Proqram nümayişi:

 

1 

2 

3 

Sürüyün 
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• Başlama işarəsi: [<?]
• Bitmə işarəsi: [?>]

2) Echo funksiyası (Echo function)
1. Echo veb brauzeri tərəfindən “html tag”-i çıxaran funksiyadır. 
2. Echo əmri əvəzinə “print” (çap) əmrini istifadə edin.

3) Daxili IP adresi 127.0.0.1 və ya Localhost
1. Sizin şəxsi IP-niz olmamasına baxmayaraq hər bir kompüterin “127.0.0.1” kimi daxili IP adresi 

mövcuddur.
2. Siz “127.0.0.1” IP adresi əvəzinə “localhost” adını istifadə edə bilərsiniz. 
3. İstifadəçi “APM for Windows” istifadə etdikdə  

[PHP] <? ‧‧‧ ?>
PHP proqramı üçün başlama və bitmə işarələri

Nümunə:

         <html>

         <?

            $a= ‘My Name’;

         ?>

[PHP] echo(“string” or echo “string”
Echo əmri veb brauezerdə müəyyən olunmuş sətri yazdırır. 

Əgər sətrin PHP dəyişəni və ya funksiyası mövcud olursa müvafiq 
dəyəri çıxarır.

“Echo”əvəzinə “Print” əmrini istifadə edin. Bu halda parantezlər qısaldılmış 
ola bilər. Məsələn,

         echo(“My name”) :              My name

         echo “<b>My name</b>” :        My Name

         $a= “My name”; echo(“$a”):       My name

1 Ana səhifə qovluğu c:\APM\Apache24\htdocs
2 Şifrə http://127.0.0.1 , or http://localhost

7.3 Addımlar
1. “index.php”-ni oxuyun. 
• c:\APM\Apache24\htdocs” qovluğunda “index.php” proqramı üzərində siçanın sağ düyməsini 

klik edin. 
2. Proqramı dəyişdirin.
• [htdocs] qovluğuna gedin. 
• Proqramı dəyişdirin.
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      <?

         echo(“Hello! YUN HyungSoon!”);

      ?>

3. Proqrama gedin. 
• Veb brauzer adresində “127.0.0.1” daxil etmək üçün nəticəni təsdiq edin.

1. “MySQL” və “phpMyAdmin”
1) Verilənlər bazasının yaradılması (database shop())
1. Təcrübə məqsədi
• MySQL və “phpMyAdmin”-i istifadə edin. 
• Shop (), verilənlər bazasını yaradın.
• Verilənlər bazasında “shop()” məlumatını qeydiyyatdan keçirin. 

2) Əlavə təcrübə bilikləri
1. VB (Verilənlər bazası) yaratmaq və qeydiyyatdan keçirmək (4 mərhələ)

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1 URL http://localhost/phpmyadmin
2 İstifadəçi adı Root 3 Şifrə 1234
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2. “Database shop ()” yaratmaq
1. phpMyAdmin proqramını istifadə edin. 
2. Veb brauzerdə “URL” daxil edin.

2) “shop() database” yaradılması 
1. Sol menyu panelində [New]-nu klik edin.
2. [Database Name] hissəyə “shop()” yazın. 
3. [Create] düyməsini klik edin.
4. “Character Set”-i [utf8-general_ci] kimi müəyyənləşdirin. (Böyük və kiçik hərfləri ayırmır)

 

1 URL http://localhost/phpmyadmin
2 İstifadəçi adı Root 3 Şifrə 1234

1 Verilənlər 
bazasının adı

Shop()
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3) [Home] ikonundan “User accounts” yaradılması
1. [Home] ikonuna klik edin. 
2. [User accounts] yarlıkına 
klik edin. 
3. [Add user account]-a klik
edin. 

 
4) “User account” (İstifadəçi hesabının) əlavə olunması 
1. İstifadəçinin məlumatlarını aşağıdakı kimi daxil edin:

1 İstifadəçi adı shop()                 3 Şifrə 1234
2 Qonaq adı % 4 Təkrar şifrə 1234
5 Eyni adla 

məlumat 
bazası yaradın 
və bütün 
səlahiyyətləri 
verin. 

Check 
in v
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2. “Sale” istifadəçi hesabı əlavə olunduqda “shop()” istifadəçinin məlumatı ilə bağlı nəticə ekran-
la bağlı olur.

 
3. İstifadəçi (user) cədvəlinə shop() hesabın əlavə olunmasını göstərən ekran nəticəsi

3. “sj” cədvəli yaradın.
1) Təcrübənin məqsədi 
1. Verilənlər bazası istifadəsi üçün qeyd cədvəlini (Record table) yaradın. 

2) Əlavə təcrübə bilikləri 
1. “sj” cədvəlinin strukturunu qurun. 
Cədvəl strukturu
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“sj” cədvəl strukturunun qeydləri
• no: “auto_increment”-i ilkin açar kimi müəyyən edir.  
• auto_increment: ilkin açar kimi rəqəmləri avtomatik əlavə edir. 
• aze, eng, mat, tot: 3 fənni daxil edir və 4 bayt ilə tam ədədi müəyyən edir. 
• tot: 4 bayt ilə tam ədədi müəyyən edir.
• avg: float məlumat tipi
• İlkin açar: yoxdur
• Digər sahələr: boşluq (NULL)
 
2. Cədvəldə məlumatı birbaşa yazın. 
• Sadə məlumat: “Insert”-i istifadə edərək məlumatı dərhal daxil edin.   
3. “external file”-ı daxil edin. 
• Böyük həcmli məlumat: “phpMyAdmin” proqramından “import” menyusunu istifadə edin.  
• “sj_list.text”-i istifadə edin. 

Bölmə Sahə Növ Boşluq Seçim İlkin 
açar

No. no Int ▒ auto_
increment

Ad name varchar(20) v
Azərbaycan 

dili
aze Int v

İngilis dili eng Int v
Riyaziyyat mat Int v

Cəm tot Int v
Ortalama 

rəqəm
avg Float v
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4. “sj” cədvəli üçün proses
1) “sj” cədvəlinin yaradılması
1. “shop() database”-ə gedin.  
• İstifadəçi adı: shop()
• Şifrə: **** (1234)
• [Go] düyməsini klik edin.

 
2. “sj” cədvəlinin düzəldilməsi 
• Ad: sj
• Sütunların sayı: 7
• [Go] düyməsini klik edin. 

 

3. Cədvəl strukturu
• [PRIMARY KEY] kimi “no” sahəsini müəyyənləşdirin. 
• İndex pəncərəsində [Go] düyməsini klik edin.
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4. “sj-table” strukturunu daxil edin. 

2) “seongjeok(sj)” verilənin import olunması
1. Xarici verilənlərə “import”-u gətirin. 
• “sj” verilənini seçin.  
• “Import” menyusunu klik edin. 
• “Browse your computer” hissəsindən [Choose File] düyməsini klik edin. 

Bölmə Sahə Növ Boşluq INDEX A_I
Yoxdur No UNT ▒ PRIMARY

Ad name VARCHAR(20) v
Azərbaycan 

dili
aze INT v

İngilis dili eng INT v
Riyaziyyat mat INT v

Cəm tot INT v
Ortalama 

rəqəm
avg FLOAT v
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2.  “sj_talbe.txt” faylını import edin. 
• “c:\APM\Apache24\htdocs\sj folder”-ə gedin. 
• “sj_table.txt” faylını seçin.
• [Open] düyməsini klik edin. 

3. CSV formatının seçilməsi
• CSV formatını seçin.
• <field separator> kimi [\t]-ni daxil edin.  
• [Go] düyməsini klik edin.
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4. sj_data.txt

• “Import” nəticə ekranı

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E

Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. PHP proqramlaşdırmasının məzmununu izah etdi? 
2. “PhpMyAdmin” rolunu başa düşdü?
3. Proqramı birbaşa yükləyib/quraşdırdı? 
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   “Form tag” və “A tag” sintaksisini aydın şəkildə izah etməyi bacaracaq; 
2.    $_POST, $_GET, and $_REQUEST format dəyərlərini doğru şəkildə əldə etməyi biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylı
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar 
2.    PHP tətbiq proqramı
3.   Dərslik & Dizayn məlumat kitabı
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Veb sənədindəki dəyəri göndərmək 
1.1 Təcrübə məqsədi 
- “Form tag” və “A tag” ilə aşağıdakı sənəddə dəyəri yazdırmaq üçün proqram hazırlayın.
- irum1( veb sənədə daxil edilən dəyər)
- irum2 (sənəddə yaddaşa verilən dəyər)

1.2 Təcrübə bilikləri
1) Faylın strukturu
1. “test.html”-də irum1və irum2-də dəyişənin dəyərini əlavə edin. 
2. “testout.php”-də çıxarın. 

3. “Test.html” proqramı

2. Php qeydlər proqramıni hazirlamaq

 
Cari Sənəd Növbəti sənəd 

Irum1 

Irum2 

 

Tetest.html Tetestout.php 
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<html> 
<head> 
<title>test</title> 
</head> 
<form name=”form1” method=”post” action=”testout.html”> 
 irum1 : <input type=”text” name=”irum1” size=”20” value=””> 
 <input type=”submit” value=”send”> 
 <input type=”reset” value=”delete”> 
 <br><br> 
 irum2 : <a href=”testout.html?irum2=YUN”>Send YUN</a> 
</form> 
</body> 
</html> 

2)  “Form tag”-ın istifadə olunması
• Proses
a. “Form tag” müəyyən olunan veb sənəddən [submit]-i seçin. 
b. “Form tag”-in [action] bölməsində göstərilən veb sənədi işlədin. 
c. “Form tag” və “Input tag”-də qeyd edilən obyektlər (mətn, radio, seçim, yoxlama …) növbəti 

mətn sənədində obyektin adı ilə əldə edilə bilər.

1. [HTML Form tag]-i istifadə edərək dəyərlərin köçürülməsi

2. [PHP]-də dəyişən işarəsi  
• “Form tag” və “A tag”-də müəyyən olunan “variable 1” (dəyişən 1) və “variable 2” 
(dəyişən 2).
1-ci veb sənəddə “$variable1” və “$variable2” adlanan dəyişən adı (Variable name) istifadə oluna 

bilər. 
Nümunə

 
<form name=” form name” method=”post or get” action=”web document”> 
 <input type=”type” name=”varialbe1” value=”value1” …..> 
 <input type=”type” name=”varialbe2” value=”value2” …..> 
 …. 
 <input type=”submit” value=”send”> 
 <input type=”reset” value=”delete”> 
 
</form> 
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 <form name=” form1” method=”post” action=”testout.php”> 
 irum1 ; <input type=”text” name=”irum1” size=”20” value=””.> 
  <input type=”submit” value=”send”> 
  <input type=”reset” value=”delete”> 
 
</form> 

 
[PHP] $ variable name or $ object name 
   - $ symbol: dəyişəni təmsil edir 
   - [$] [dəyişən] dəyişənin qabağına dollar simvolu yazılır 
   - the object name ‘Form tag’ and ‘A tag’  bir sonrakı dokumentdə dəyəri əldə etdiyimizdə 
bəya edilir       

3) “A tag”-i necə istifadə etmək
1. Göndərmə yöntəmi
Veb sənədin arxa hissəsində dəyişən adını və dəyəri müəyyən edərək dəyəri köçürmək müm-

kündür.

• Adres məlumatında [?] işarəsi ilə sənəd adını (document name) və dəyişənləri (variables) 
müəyyən edin. 

• [$] işarəsi ilə dəyişənləri (variables) müəyyən edin.
• Dəyişən təyinatında “variable name=value” kimi formatı  istifadə edin.
2. Nümunə

4) Dəyişən dəyərini ekranda çıxarmaq 
- “<?” və “?>” işarələri bu sahənin PHP proqramında olduğunu bildirir. 
- PHP-də normal ekran çıxışı : echo funksiyasını istifadə edin.  
1.  Dəyişən dəyərinin çıxışını göstərin. 

 
 Dəyəri HTML A teqi ilə transter  etmək üçün qayda 
 <a href=”webdocument name?variable1=value1$varaiable2=value2 …”>      

irum2 : <a href=”testout.php?irum2=YUN”>Send YUN</a>    

 
<?=$variable; ?> or <? echo(”$variable”); ?>    
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2. Dəyəri çıxaran zaman
• “=$variable name”
• Diqqət edin: “<?” və “=” arasında boşluq olmamalıdır. 
5) Veb brauzerində sətri müəyyən etmək üçün çıxış funksiyası (Output function) 

$_POST, $_GET, $_REQUEST

1. Köhnə versiya 
• Veb brauzerdə “Form teqi”-də eyni dəyişən adı istifadə olunur. 
• Misal üçün,
; Variables “irum1” və “irum2”; “Form tag”
; Variable name “$irum1” və “$irum2”; veb sənəd

2. Ən son versiya
• Təhlükəsizlik səbəblərinə görə sonrakı sənəd eyni adla istifadə oluna bilmir.
• Əvvəlki dəyişən dəyərini almaq üçün köçürmə növünə əsasən növbəti format dəyərini əldə et-

məlisiniz. 
           
        Köçürmə metodu (Transfer method) 
• “Form tag” formatı
POST: $_POST[“variable name”]
GET: $_GET[“variable name”]

• Siz köçürmə metodunu bilmədiyiniz halda
$_REQUEST[“variable name”] istifadə edin. 
“post” və ya “get” ilə dəyə əldə edə bilərsiniz. 
• Misal üçün,

 
echo”string” və ya print”string”    

 Cari sənəd Növbəti sənəd 

irum1 
irum2 

$irum1 
$irum2 

 test.html testout.php 

 Cari sənəd Növbəti sənəd 

POST format: irum1 
GET format: irum2 

$irum1 = $_POST[“irum1”] 
$irum2 = $_GET[“irum2”] 
Or 
$irum1 = $_REQUEST[“irum1”] 

test.html testout.php 
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2. Windows üçün APM
2.1  “test.html”-i dəyişdirin. 
1. Dəyişiklik etmək üçün qovluğu köçürün.
• C:\APM_Setup\htdocs
• “test.html”-i açın. 
2. Proqramda “testout.html”-i  “testout.php”-ə dəyişin.
3. “testout.php” faylı

4. “testout.php”-ni qeydiyyatdan keçirin. 

2.2 “testout.html”-i dəyişdirin. 
1. “testout.html”-ə iki dəfə klik edin. 
2. Aşağıdakıları dəyişdirin:

3. Əvvəlki sənədin dəyəri olan “irum1” və “irum2”-ni almaq üçün
• $_POST, $_GET
Və ya
• $_REQUEST for “post” və “get” istifadə edin.

 

<html> 
<head> 
<title>test</title> 
</head> 
<form name=’form1’ method=”post” action=”testout.php”> 
 irum1 : <input type=”text” name=”irum1” size=”20” value=””> 
 <input type=”submit” value=”send”> 
 <input type=”reset” value=”delete”> 
 <br><br> 
 irum2 : <a href=”testout.php?irum2=YUN”>Send YUN</a> 
</form> 
</body> 
</html> 

 

<? 
$irum1=$_REQUEST[irum1]; // $irum1=$_POST[irum1]; 
$irum2=$_REQUEST[irum2]; // $irum2=$_GET[irum2];  

<? 
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• Faylı yaddaşa verin
File>Save As
Faylı adı: “testout.php”

5. “test.html”-i işlədin.
• [Web Browser         ]-ə gedin. 

4. “testout.html” faylı

 
<? 
$irum1 = $_POST[“irum1”] 
$irum2 = $_GET[“irum2”] 
?> 

or 
<? 
$irum1 = $_REQUEST[“irum1”] 
$irum2 = $_REQUEST[“irum2”] 
?> 

 
<? 

$irum1=$_REQUEST[“irum1”]; // $irum1=$_POST[“irum1”]; 
$irum2=$_REQUEST[“irum2]”; // $irum2=$_GET[“irum2”]; 

<? 
<html> 
<head> 
<title>testout</title> 
</head> 
<body> 
The receiving irum1 is <font color=”blue”<?=$irum1; ?></font> 
 <br><br> 
The receiving irum2 is <font color=”blue”<? echo(“irum2”); ?></font> 
 <br><br> 
<a href=”javascript:history.back();”>Return</a> 
</body> 
</html> 
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Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbə masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

Ⅰ. Sadə qeydlər proqramını yaradın.
- Verilənlər bazası: shop()
- Cədvəl: sj

1.1 Proqramın məzmunu əldə etmək
1) Qeydlər proqramı və funksiyası
1. Proqramda daxil et və redaktə funksiyaları
2. Ad ilə məlumat üçün axtarış funksiyası 
3. Hər 20 sətirdə bir səhifə ilə işarələyən funksiya
4. Zəruri proqramlar: “sj_list.html”, “si_new.html”, “sj_edit.html”, mesaj qutusunun silinməsi

2) Fayl komponenti 
1. Emal axını
2. Yenicə yaradan fayllar: “sj_insert.php”, “sj_update.php”, “sj_delete.php”
3. Funksiyalar: insert SQL statement (daxil edilməsi), update SQL statement (yenilənməsi), delete 

SQL statement (silinməsi)
4. Bütün fayl strukturu və emal axını

 

sj_list.php 

Qeydlər siyahısı 
ekranı 

Əlavə etmək 

sj_new.php sj_insert.php 

Daxil etmək 

sj_update.php 

Yeniləmək 

sj_delete.php 

Silmək 

sj_edit.php 

Redaktə 
etmək 

 “sj_list”-ə gedin 
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1.2 “sj_list.html”-in yaradılması
1) Təcrübə məqsədi
1. [sj_list.html]forma sj cədvəlini yaradın.
2. [sj_list.html]-in nəticəsi

<html> 
<head> 
<title>sj(records) process program</title> 
</head> 
<body> 
<table width="400" border="1" cellpadding="2" style="border-collapse:collapse"> 
 <tr border="lightblue"> 
  <td width="100" align="center">name</td> 
 <td width="50" align="center">azer</td> 
 <td width="50" align="center">eng</td> 
 <td width="50" align="center">mat</td> 
 <td width="50" align="center">tot</td> 
 <td width="50" align="center">avg</td> 
  </tr> 
 <tr border="lightyellow"> 
  <td>&nbsp seoul</td> 
 <td align="right">90 &nbsp</td> 
    <td align="right">90 &nbsp</td> 
 <td align="right">90 &nbsp</td> 
 <td align="right">270 &nbsp</td> 
 <td align="right">90.0 &nbsp</td> 
  </tr> 
</body> 
</html> 

1.3 Təcrübə bilikləri
1) Server və MySQL əlaqəsi
• shop() verilənlər bazasını istifadə edərək məlumatı emal etmək və serverin shop() verilənlər 

bazasına qoşulmaq üçün proqram yaradın. Mysql_connect MySQL hesab loqini, şifrəsi və məlumat 
bazası adını müəyyən edərək əlaqə üçün icazə tələb edən funksiyadır. 

 
<? 

$db = mysql_connect(“localhost”, “accountID”, “accountPW”, DBName”); 
If(!$db exit(“connection error”); 

<? 



İKT

484

• Əvvəlki addımlarda yaradılan və eyni zamanda “shop()” istifadəçi adı və “1234” pasportu ilə 
qeydiyyatdan keçirilən “shop()” verilənlər bazasını istifadə etməlidir. 

• Əgər başqa istifadəçi adı və şifrəsi ilə qeydiyyatdan keçmisinzsə onları müəyyən etməlisiniz. 
1. [PHP] mysql_connect(“servername,”MySQLaccountID”,MySQL_password”,DBname”)
a. Verilənlər bazası: shop()
b. Server adı: localhost
c. İstifadəçi adı: shop()
d. Şifrə: 1234

2. [PHP] “string”-i çıxarır.
• Müəyyən olunmuş string-in çıxarılmasından sonra fəaliyyətdə olan proqramı bağlayın.

2) INCLUDE (Daxil etmək) əmri
- Təkrarlanan hissəni ayrı proqram ilə idarə edin.
- Proqramı “common.php” kimi müəyyən edin.
- Ehtiyac olduqda onu funksiya kimi istifadə edin.
1. Əmr: INCLUDE (Daxil etmək)
Misal üçün,

2. [PHP] fayl adının əlavə olunması
• Mövcud faylda müəyyənləşdirilmiş faylı oxuyan və onu əlavə edən əmr
3) Siyahı məlumatlarının çıxarılması üçün metod
1. [PHP] mysqli_query(mysqli $link, string $query)

 

a.php 

<? 
 Təkrarlanan proqram və ya 
dəyişən 
?> 
 
<? 
… 
?>   

common.php 

<? 
Təkrarlanan proqram və ya 
dəyişən 
?> 

a.php 

<? 
 “common.php”-ni daxil edin 
… 
?> 

 

Bütün məlumatları göstərmək üçün [PHP] output proqramı 

$query=”select SQL statement”; // elementi seçir 
$result=”mysql_query($db, $query); //sorğunu müəyyən edir 
If (!$result) exit(“error: $query”); //icra nəticələrini yoxlayır 
$count=mysqli_num_rows($result); //qeydlərin rəqəmləri 
For($i=0:$i<$count;$i++)        //elementi təkrar edir 

{ 
 $row=mysqli_fetch_array($result);  // 
value output) 
} 
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• SQL cümləsini göndərin. 
• Əgər uğurlu olursa qaynağı geri qaytarın.
• Olmursa səhvi (False) qaytarın. 

2. [PHP]mysqli_num_rows(resource $result)
• Yalnız SELECT (Seçim) skripti 
• $result-dan qeydlərin sayını qaytaran funksiya

3. [PHP] mysqli_fetch_array(resource $result)
• Nəticədən bir qeydi oxuyun və onu string-də dəyər sahəsinə qaytarır.
• Qeyd işarəedicisi avtomatik olaraq növbəti qeydə keçir. 

4. Bir xəttin ad verilənlərini çıxaran proqram 
 

`
5. “sj” cədvəlindən veriləni oxuyun. 
 

<tr border="lightyellow"> 
  <td>&nbsp seoul</td> 
 <td align="right">90 &nbsp</td> 
    <td align="right">90 &nbsp</td> 
 <td align="right">90 &nbsp</td> 
 <td align="right">270 &nbsp</td> 
 <td align="right">90.0 &nbsp</td> 
  </tr> 

 

$query=”select * from sj order by name”; 
$result=mysqli_query($db,$query); 
if (!$result) exit(“error: $qurery”); 
$count=mysql_num_rows($result); 
for($i=0;$i<$count;$i++) 
{ 
 $row=mysqli_fetch_array($result); 
  echo(“<tr bgcolor=”lightyellow”> 
     <td>&nbsp $row[name]</td> 
  <td align=”right”>$row[azer] &nbsp</td> 
  <td align=”right”>$row[eng] &nbsp</td> 
  <td align=”right”>$row[mat] &nbsp</td> 
  <td align=”right”>$row[tot] &nbsp</td> 
  <td align=”right”>$row[avgr] &nbsp</td> 
</tr>”); 
} 
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• “Select * from sj order by name;”
SQL əmri ad ilə sj cədvəlinin bütün məlumatlarını oxumaq üçündür. 

4) $row[field name or array subscript]
1. Əgər belədirsə
0 1
sj-dən adı, cəmi seçin. 

2. $row=mysqli_fetch_array($result);
• Sahə adını necə istifadə etmək olar: $row[field name]
Ex) $row[name], $row[tot]
• String subskript-ni necə istifadə etmək olar: $row[subscript]

5) AVERAGE (Ortalama rəqəm)
1. $avg = sprint(“%6,if”, $row[avg]);

2. [PHP] sprint (“string format” dəyəri)
• Dəyəri müəyyən olunmuş string formatına çevirən funksiya 
• Simvol növləri:  
a. s(string)
b. f(float)
c. d(integer)
• ex) sprintf(“%6,2f”,2.3)    2.30
 sprintf(“%5d”,2)       2
 sprintf(“%05d”,2)      00002

6) SELECT (Seçim) əmri
1. [SQL] –in əsas qramatika ifadəsi 

Seçim: fieldname1, fieldname2…
Haradan: cədvəl adları
Haraya: məntiq və operator istifadə edən şərti formula
Sifariş: asc və ya desc ilə sıralamaq üçün sahə adları
Qruplaşma : sahə adları ilə 
Sahib olmaq: qrup haqqında şərti formula

2. SQL üçün beş əmr 
- Roma əlifbasında cümləni qayda olaraq təsvir edin.  
- Qeydlər (Remarks) yazıla biləndir və digər dil də həmçinin [‘’] (tək dırnaq işarəsi) içərisində 

yazıla bilir. 
- Nədir-i işarələdikdə [‘’] istifadə edin.  
Sətir içərisində Nədir-i işarələdikdə [‘’] (tək dırnaq işarəsini) iki dəfə ardıcıl istifadə edin. Qey-

 $row[0]        name,   $row[1]       tot 
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dləri [/* and */] ilə işarə edin. 
Proqrama əks etdirməmək üçün izahatı istifadə edə bilərsiniz. /* */
- Rezerv olunmuş söz ilə ehtiyatlı olun. 
Bu, xüsusi mənası olan açar kəlmədir.
Rezerv olunmuş söz “cədvəl adı” və “sıra adı” ilə istifadə olunursa onu [ ] ilə əhatə edin. 
• İfadənin sonunda nöqtəli vergüldən istifadə edin (;)

3. Situasiyaya əsasən SELECT əmrinin qeydlərini ləğv etmək (daxil etməmək) mümkündür.    
• Qeyd növləri: haradan, haraya, ilə sifariş, ilə qruplaşma, sahib olmaq (from, where, order by, 

group by, having)
• Digərləri: daxil olmaq, məhdudlaşdırmaq və s. (into, join on, limit)  

4. Misal üçün,
a. “My name is 000” formatında veriləni ifadə edin. 
Sj-dən ‘My name’ + ‘is’ + name-i seçin;

b. “sj”cədvəlinin adını, cəm və aralığını müəyyən edin. 
sj-dən ad, cəm və aralığı seçin;
    

   

c. Adı, cəmi, aralığı yalnız artan sıra adı ilə ifadə edin. 
“sj order by name” hissədən ad, cəm və aralığı seçin;

“sj order by name asc” hissədən ad, cəm və aralığı seçin;
 

 SELECT əmrinin seçimləri 
 Bütün verilənlərdə : where (haraya) şərtini istifadə etməyin.   

Vergül ilə sahə adını bölün (,) və sahələri yerləşdirin.  
 Düzgün sahə adı format: cədvəl adı, sahə adı. 
 Ad (name) faylı: sj.name  
 Vahid sahə adı və ya təkcə cədvəl: cədvəl adını (table name) ləğv edin.  

Təkcə adı (name) istifadə etmək mümkündür.   
 Bütün sahələrin mənaları: ulduz işarəsi (asterisk) simvolunu istifadə edin (*). 

 SORT təyin olunduqda: “order by” şərtini istifadə edin. 
 Artan sıra: asc 
 Azalan sıra: desc 
 Sıralamanı ləğv etdikdə: asc avtomatik olaraq təyin olunur.  
 Kompleks sıralama halında (1-ci, 2-ci, 3-cü sıra və s.) sahə adını vergül işarəsi ilə b

ölün və “order by” şərti ilə yerləşdirin. 
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d. Azaltma əmri ilə adı, cəmi və aralığı sıralayın. Əgər ortalama rəqəm eyni olarsa cəm ilə artan 
sırada yerləşməni ifadə edin. 

“sj order by avg desc, tot” hissədən adı, cəmi və aralığı seçin.

▒ Verilənlərin bir hissəsinin çıxarılması halında 

 
▒ SQL də string-in (mətn tipli dəyişənləri yaddaşda saxlamaq üçün istifadə olunan obyekt tipi) 

işarələnməsi

5. 90-dan yuxarı veriləni ifadə edin. 
* from sj where avg >= 90;

6. 70-dən yuxarı və 90-dan aşağı aralıqda veriləni ifadə edin. 
   select * from sj where avg between ‘70’ and ‘90’;

7. Verilənin “SEOUL” (simvol halında) olaraq adlandırıldığı bütün sahələri ifadə edin. 
select * from sj where name=’SEOUL’;

 a. “where” şərtinin formulu istifadə edin.  
b. Şərti formulun növləri: 
 Əlaqəli operatorlar: =, >, >=, <, <=, <>, != 
 Məntiqi operatorlar: və, və ya , xeyr (and, or, not) 
 Digər operatorlar: oxşar, arasında və s. (like, between, in null)  
 Format ifadəsi: Fieldname Operator Value-nu müəyyən edir.  

c. Mürəkkəb vəziyyət 
 [and, or, not] və ya qövsvari mötərizə [( )] ilə ifadə edin.  

 a. String-i istifadə edən zaman qoşa dırnaq işarəsi (“ ”) deyil tək dırnaq işarəsini (‘’) istif
adə edin.  

b. Məlumat növü: string kimi fəaliyyəti müəyyən edin. 
c. Verilənlərdə xüsusi simvol üçün axtarış 
 Bir neçə simvolu əvəz edən simvolun istifadəsi, [%]  
 İfadə formulu: fieldname like ‘%value%’  
 Misal üçün, 

“S” hərfi ilə başlayan adı axtarmaq üçün: 
‘S%’ kimi ad 
 
“S” hərfi ilə bitən adı axtarmaq üçün: 
‘%S’ kimi ad  
 
Ad arasına “S” hərfini daxil etdikdə: 
‘%S% kimi ad’ 
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8. “S” ilə başlayan adlar olan sahəni ifadə edin. (Simvolun bir hissəsinin daxil olduğu verilənin 

çıxarılması halında)
select * from sj where name like ‘S%’;

9. Adının “S” hərfi olan və azalan sırada ümumi 90-dan yuxarı olan bütün verilənlər sırasını ifadə 
edin.

select * from sj where name like ‘S%’ and avg>=90
order by tot desc;

 
 

2. Proqram pillələri
1) VB əlaqə proqramını yaradın. 
1. Yeni sənədi açın. 
2. Proqramı aşağıdakı kimi düzəldin:

▒ Qeyd: əgər siz digər verilənlər bazası, istifadəçi hesabı və istifadəçi şifrəsini daha əvvəl istifadə 
etmisinizsə onları istifadə etməlisiniz. 

3. “sj” qovluğunda “common.php”-ni yaddaşa verin. 
 
 

<? 
 $dbb = mysqli_connect(“localhost”, “shop()”, “1234”, “shop()”); 
 if (!$dbb) exit(“Server Connection Error”); 
?> 
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4. “sj_list.html” faylını iki dəfə klik edin. 
• “sj_list.html” faylını “sj_list.php” kimi yaddaşa verin.

 

5. Proqramı aşağıdakı kimi dəyişdirin:

  
 <? 
  $query="select * from sj order by name;"; 
 $result=mysqli_query($db, $query); 
 if (!$result) exit("Error: $query"); 
 $count=mysqli_num_rows($result);   //numbers of sj(records) 
 for ($i=0; $i<$count; $i++) 
{ 
 $row=mysqli_fetch_array($result);  // read one sj(record) 
 $avg=sprintf("%6.1f",$row[avg]);   // decimal positon 1 
 echo("<tr bgcolor='lightyello'> 
   <td width='100'>&nbsp $row[name]</td> 
  <td width='50' align='right'>$row[azer] &nbsp</td> 
  <td width='50' align='right'>$row[eng] &nbsp</td> 
  <td width='50' align='right'>$row[mat] &nbsp</td> 
  <td width='50' align='right'>$row[tot] &nbsp</td> 
  <td width='50' align='right'>$avg &nbsp</td> 
  </tr>"); 
} 
?> 
 
 </table> 
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2) Proqramı işlədin.  

1. Veb brauzer adresində “http://localhost/sj/sj_list.php”-ni daxil edin. 
2. Nəticə
 
 
 

 

3. Sj-nin əlavə olunması
1) Təcrübə məqsədləri
- [input] düyməsini klik edin. 
- Yeni məlumatı qeydiyyatdan keçirmək üçün yeni proqram yaradın. 

2) Təcrübə bilikləri 
1.Məlumatı əlavə etmək üçün fayl strukturu
 
 

a. “sj_list.php” siyahısından [input] düyməsini klik etdikdə məlumatı daxil edən ekran görünür. 
b. “sj_list.html” proqramında məlumatı qeydiyyat etmək üçün daxil etdikdə onu “sj_insert.php” 

adlandırın.
c.  Giriş veriləni sj cədvəlində yaddaşa verilir və sonra “sj_list.php” sənədini qaytarır.  

2. INSERT 
1. SQL əmri verilən cədvələ əlavə olunan vaxtı istifadə olunur. 
2. Sintaksis

 

sj_list.php 

[input]-u klik 
edin. 

[input screen]-i göstərin. 
[Registration]-i klik edin. 

sj_new.html sj_insert.php 

Əlavə edin və 
yaddaşa verin. 

Save data 

Birinci addıma gedin. 
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3. Misal üçün,
Cədvələ aşağıdakı məlumatı [Name: Seoul, Male 0, Birthday 2000-01-01] kimi əlavə edin. 

Ad, soyad və ad gününü əlavə edin. 
Dəyərlər (‘Seoul’, ‘0’, ‘2000-01-01’);

4. INSERT-in istifadəsində ehtiyat tədbirləri 
• Sahənin bütün hissəsini deyil bir hissəsini istifadə edərək veriləni əlavə etdikdə NULL sahəsi 

No kimi müəyyən olunur. 
• INSERT-də istifadə olunan sahə adı və dəyər 1-ə uyğun gəlir. Onların məlumat növü və sayı 

həmişə eyni olur.  
• Sahədən bütün adların çıxarılması halında dəyərlər cədvəldə olan sahə sayı qədər olur. 
• Sahənin verilənlər növü simvol və ya tarix olduqda siz dəyərin hər iki tərəfində həmişə tək dır-

naq işarəsi (‘’) qoymalısınız  

3. Proqram mərhələləri
1) “sj_list.php”-ə “input html” əlavə edin. 
1. “sj_list.html” veb sənədinə qoşulmaq üçün “html” mənbəyini “sj_list.php”-ə (A tag) əlavə edin. 
2. “html tag”-ı
• Siz “INPUT” düyməsi üzərinə klik etdikdə, “A tag html” proqramı “sj_new.html” sənədinə 

köçürür. 

• Proqram

2) “Form tag”-in fəaliyyət (Action) məzmununu dəyişin. 
1. “sj_new.html” –in “Form tag”-ni dəyişin. 
INPUT (qeydiyyat üçün) düyməsini klik etdikdə “sj_insert.asp”-ni axtarın.
2. Dəyişdirilmiş proqram (sj_new.html)

Cədvəl adına (fieldname1, fieldname2, ‧‧‧)  dəyərləri əlavə edin. (value1, value2, ‧‧‧); 

 
<table width=”400” border=”0”> 
 <tr> 
  <td align=”right”> 
  <a href=”sj_new.html”>INPUT</a> 
  </td> 
 </tr> 
</table> 
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<html> 
<head> 
 <title>sj(Records) Process Program</title> 
 <meta http-equiv="content-type" content="text/html; charset=utf-8"> 
 <link rel="stylesheet" href="font.css"> 
</head> 
 
<script language="javascript"> 
function cal_jumsu() 
{ 
 form1.hap.value=Number(form1.azer.value) + Number(form1.eng.value) + 
Number(form1.mat.value); 
 form1.avg.value=(form1.tot.value/3.).toFixed(1); 
} 
</script> 
 
<body> 
 
<form name="form1" method="post" action="sj_insert.php"> 
<table width="300" border="1" cellpadding="2" bgcolor="lightyellow" 
style="border-collapse:collapse"> 
  <tr> 
    <td width="100" align="center" bgcolor="lightblue">name</td> 
    <td width="200"> 
      <input type="text" name="name" size="20" value=""> 
    </td> 
  </tr> 

 
<tr> 
    <td width="100" align="center" bgcolor="lightblue">azer</td> 
    <td width="200"> 
      <input type="text" name="kor" size="6" value="" 
onChange="javascript:cal_jumsu();"> 
    </td> 
  </tr> 
  <tr> 
    <td width="100" align="center" bgcolor="lightblue">eng</td> 
    <td width="200"> 
      <input type="text" name="eng" size="6" value="" 
onChange="javascript:cal_jumsu();"> 
    </td> 
  </tr> 
  <tr> 
    <td width="100" align="center" bgcolor="lightblue">mat</td> 
    <td width="200"> 
      <input type="text" name="mat" size="6" value="" 
onChange="javascript:cal_jumsu();"> 
    </td> 
  </tr> 
  <tr> 
    <td width="100" align="center" bgcolor="lightblue">tot</td> 
    <td width="200"> 
      <input type="text" name="hap" size="6" value="" readonly 
style="border:0;background-color:#ffffe0"> 
    </td> 
  </tr> 
  <tr> 
    <td width="100" align="center" bgcolor="lightblue">avg</td> 
    <td width="200"> 
      <input type="text" name="avg" size="6" value="" readonly 
style="border:0;background-color:#ffffe0"> 
    </td> 
  </tr> 
</table> 
<br> 
<table width="300" border="0"> 
  <tr> 
    <td align="center">  
   <input type="submit" value="INPUT"> &nbsp 
   <input type="button" value="PREVIOUS" onclick="javascript:history.back();"> 
 </td> 
  </tr> 
</table> 
 
</form> 
 
</body> 
</html> 
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• “sj_insert.php” veb sənədini işlətmək üçün INPUT düyməsini klik etdikdə ACTION of Formda 
sənəd adını müəyyən edin.  

• Giriş veriləni name, aze, eng, mat, tot və avg dəyişənlərində yaddaşa verilib. (Input tag-in adı)

3) “sj_insert.php”-ni yenidən yaradın.
1. Siçanın sağ düyməsini klik edin. 
2. [Create] alt menyusunu seçin.
3. “sj_insert.php”-ni daxil edin.
4. [OK] düyməsini klik edin. 

4) “sj_insert.php” proqramını hazırlayın. 

 
<tr> 
    <td width="100" align="center" bgcolor="lightblue">azer</td> 
    <td width="200"> 
      <input type="text" name="kor" size="6" value="" 
onChange="javascript:cal_jumsu();"> 
    </td> 
  </tr> 
  <tr> 
    <td width="100" align="center" bgcolor="lightblue">eng</td> 
    <td width="200"> 
      <input type="text" name="eng" size="6" value="" 
onChange="javascript:cal_jumsu();"> 
    </td> 
  </tr> 
  <tr> 
    <td width="100" align="center" bgcolor="lightblue">mat</td> 
    <td width="200"> 
      <input type="text" name="mat" size="6" value="" 
onChange="javascript:cal_jumsu();"> 
    </td> 
  </tr> 
  <tr> 
    <td width="100" align="center" bgcolor="lightblue">tot</td> 
    <td width="200"> 
      <input type="text" name="hap" size="6" value="" readonly 
style="border:0;background-color:#ffffe0"> 
    </td> 
  </tr> 
  <tr> 
    <td width="100" align="center" bgcolor="lightblue">avg</td> 
    <td width="200"> 
      <input type="text" name="avg" size="6" value="" readonly 
style="border:0;background-color:#ffffe0"> 
    </td> 
  </tr> 
</table> 
<br> 
<table width="300" border="0"> 
  <tr> 
    <td align="center">  
   <input type="submit" value="INPUT"> &nbsp 
   <input type="button" value="PREVIOUS" onclick="javascript:history.back();"> 
 </td> 
  </tr> 
</table> 
 
</form> 
 
</body> 
</html> 
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• Əlavə etmək, silmək və yeniləmək kimi “Exec SQL statement” funksiyası “mysqli_query” və ya 
“select” funksiyası tərəfindən idarə olunur.

• [name, azer, eng, mat, and avg]-da yaddaşa verilən dəyər “sj_new.html”-də INPUT tag-in dəy-
işəni $_REQEST funksiyası ilə nəticəni əldə edir.

• Əldə edilmiş dəyəri yaddaşa vermək üçün SQL-i daxil edin. 
• “$name” simvol növüdür və onu “$name”-in hər iki tərəfində bir dırnaq işarəsi ilə (‘’) ifadə edin. 

5)  Proqramı idarə edin və nəticəni yoxlayın. 
1. Veriləni və ya məlumatı əlavə edin.  
• Veb brazuerdə   “http://localhost/sj/sj_new.html” daxil edin. 
Verilən-[data]
• Ad: YHS
• Azərbaycan dili: 77
• İngilis dili: 95
• Riyaziyyat: 97
• Cəmi: 269
• Orta rəqəm: 89.7

2. Nəticəni yoxlayın.
• “http://localhost/sj/sj_list.php”-ni daxil edin. 

 

<? 
 include "common.php"; 
  
 $name=$_REQUEST[name]; 
 $azer=$_REQUEST[azer]; 
 $eng=$REQUEST[eng]; 
 $tot=$REQUEST[tot]; 
 $avg=$REQUEST[avg]; 
 
 $query="insert into sj(name, azer, eng, hat, tot, avg) 
   values ('$name', $azer, $eng, $mat, $tot, $avg);"; 
 $result=mysqli_query($db,$query); 
 if (!$result) exit("Error: $query"); 
 
 echo("<script>location.href='sj_list.php'</script>"); 
?> 
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• Nəticə

4. Sj-nin silinməsi
1)  Təcrübə məqsədi 
- “sj_list.php”-ə “delete” adlı sütunu əlavə edin. 
- Mesajı göstərin.
- Silmək
- Müvafiq proqramı hazırlayın.

2) Təcrübə bilikləri 
1. Faylı silmə məlumatı və prosesi
 
 

2.“sj_list.php”-də silmək üçün şəxsi klik etdikdə seçilən şəxsin sahə rəqəm dəyərini “A tag” növü 
ilə köçürün. 

<a href=”sj_delete.php?no=value”>DELETE</a>

2. “sj_list.php” proqramında n_th-ni sildikdən sonra yenidən “sj_list.php” sənədinə qayıdın.
2) DELETE
1. Delete SQL əmri olub xüsusi qeydləri və mövcud olan bütün qeydləri silmək üçün istifadə 

 

sj_list.php 

[Delete] düyməsini klik edin. 
Silmək üçün rəqəm (number ) dəyərini 
köçürün.  

Sj_delete.php 

n_th verilənini silin. 

İlk mərhələyə gedin. 
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olunur.
2. Sintaksis

• DELETE əmrində “where” conditional formula daxil edilməyibsə bütün qeydlər silinir.
3. Misal üçün,
a. “S” ilə başlayan ad verilənlərini silin.
   delete from sj where name=’S’;
b. sj cədvəlində bütün verilənləri silin.
delete from sj;

3) Proqram mərhələləri
1. Delete html-i “sj_list.php”-ə əlavə edin. 
2. DELETE funksiyasını işlətmək üçün “A tag” və “javascript” ilə “html” mənbəyini “sj_list.

php”-ə əlavə edin. 
3. Proqram
• “sj_list.php” sənədində
• Confirm (Təsdiq) “Javascript” funksiyası olub YES və NO düyməsi ilə mesaj qutusunu göstərir. 
• Əgər YES seçilirsə veriləni silin. 

Delete from tablename where conditional formula; 

<table width="400" border="1" cellpadding="2" style="border-collapse:collapse"> 
 <tr border="lightblue"> 
  <td width="100" align="center">name</td> 
 <td width="50" align="center">azer</td> 
 <td width="50" align="center">eng</td> 
 <td width="50" align="center">mat</td> 
 <td width="50" align="center">tot</td> 
 <td width="50" align="center">avg</td> 
   <td width="50" align="center">DELETE</td> 
  </tr> 
 
 <? 
  … 
 
 <td width='100'>&nbsp $row[name]</td> 
 
 /*<td width='50' align='right'>$row[azer] &nbsp</td> 
 <td width='50' align='right'>$row[eng] &nbsp</td> 
 <td width='50' align='right'>$row[mat] &nbsp</td> 
 <td width='50' align='right'>$row[tot] &nbsp</td> 
 <td width='50' align='right'>$avg &nbsp</td>*/ 
  <td align=’right’>$avg &nbsp</td>  
  <td align=’center'> 
   <a href=’sj_delete.php?no=$row[no]’ 
   onClick=’javascript:return confirm(\”Delete?\”);’> 
   DELETE 
   </a> 
  </td> 
   </tr>”); 
} 
?> 
… 
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<table width="400" border="1" cellpadding="2" style="border-collapse:collapse"> 
 <tr border="lightblue"> 
  <td width="100" align="center">name</td> 
 <td width="50" align="center">azer</td> 
 <td width="50" align="center">eng</td> 
 <td width="50" align="center">mat</td> 
 <td width="50" align="center">tot</td> 
 <td width="50" align="center">avg</td> 
   <td width="50" align="center">DELETE</td> 
  </tr> 
 
 <? 
  … 
 
 <td width='100'>&nbsp $row[name]</td> 
 
 /*<td width='50' align='right'>$row[azer] &nbsp</td> 
 <td width='50' align='right'>$row[eng] &nbsp</td> 
 <td width='50' align='right'>$row[mat] &nbsp</td> 
 <td width='50' align='right'>$row[tot] &nbsp</td> 
 <td width='50' align='right'>$avg &nbsp</td>*/ 
  <td align=’right’>$avg &nbsp</td>  
  <td align=’center'> 
   <a href=’sj_delete.php?no=$row[no]’ 
   onClick=’javascript:return confirm(\”Delete?\”);’> 
   DELETE 
   </a> 
  </td> 
   </tr>”); 
} 
?> 
… 

4. [JavaScript] təsdiq funksiyası

• Funksiya YES və NO düyməsi ilə mesaj qutusunu göstərir. 
• [YES] seçildikdə doğru (True) dəyəri əldə olunur.
• Əgər [NO] olursa yanlış (False) dəyəri qaytarılır.  

2) “sj_delete.php” faylını yaradın.  
1. [New] menyusu ilə “sj_delete.php” adlı yeni faylı yaradın.  

2. Proqramı hazırlayın.
• “sj_insert.php” proqramını kopyalayın. 
• Proqramı aşağıdakı kimi hazırlayın:
3. Nəticəni yoxlayın. 
• “http://localhost/sj/sj_list.php”-ni daxil edin.
• Nəticə
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<? 
 include "common.php"; 
 $no=$_REQUEST[no]; 
 
 $query="delete from sj where no=$no;"; 
 $result=mysqli_query($db,$query); 
 
 echo("<script>location.href='sj_list.php'</script>"); 
 ?> 

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. “Form tag” və “A tag”-in sintaksisini aydın şəkildə izah etdi?
2. $_POST, $_GET, və $_REQUEST format dəyərlərini düzgün 
şəkildə əldə etdi?
3. Sahə/Qeyd məzmununu düzəltdi?
4. Fayl strukturunu yaratdı?
5. SQL-in yaratmaq əmrini formalaşdırdı?
6. SQL-in Insert (daxil etmək) əmrini düzgün şəkildə yaratdı? 
7. `Fayl strukturunu əminliklə düzəltdi?
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Proqramlaşdırma dili
(Java)

Sənaye və İnnovasiyalar üzrə 
Bakı Dövlət Peşə Təhsil Mərkəzi

Səriştə əsaslı 
modul İKT
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İKT

Ön söz 

 Java ümumi məqsədli kompüter proqramlaşdırma dilidir və paralel, sinfi əsaslı, əşya təyinatlı, 
eyni zamanda mümkün qədər az təbliğ asılılığına malikdir. Bu, tətbiqi inkişaf etdirənlərə bir dəfə 
yaz istənilən yerə ötür prinsipi ilə fəaliyyət göstərməyə imkan yaradır. Bu o deməkdir ki, tərtib 
olunmuş Java kodu bu proqramı təsdiqləyən bütün platformalarda tətbiq edilə bilər. Java pro-
qramları baytkodla tərtib olunub və bu o deməkdir ki, kompüter quruluşundan asılı olmayaraq 
bütün Java virtual avadanlıqlarına tətbiq oluna bilər. 2016-cı ildən etibarən Java istifadə olunan ən 
məşhur proqram dillərindəndir, xüsusilə də müştəri-server veb proqramlamasında daha önəmlidir. 
Java tarixən Ceymz Qoslinq tərəfindən Sun mikrosistemlərində (o zamandan Oracle korporasiyası 
tərəfindən qəbul edilib) inkişaf etdirilib və 1995-ci ildən Sun mikrosistemlərinin Java platFor-
masının əsas komponenti kimi ayrılıb. Bu proqramlama dili daha çox C++ sintaksindən törəyib, 
amma onun digərlərindən daha az keyfiyyətli xidmət vasitələri var. Java tərtibatlarının, virtual 
maşınların, sinif kitabxanalarının orijinal və istinadlı tətbiqi tarixən Sun tərəfindən xüsusi icazə 
vəsiqələri ilə buraxılıb. 2007-ci ilin mayında Sun özünün Java texnologiyalarının əksəriyyətini 
Ümumi İctimai Lisenziyaya (GNU) əsasən rəsmiləşdirərək yenidən buraxdı. Digərləri də həmçi-
nin Java (baytkod tərtibatçısı), GNU Classpath (standart kitabxanalar) və Icedtea-Web kimi Sun 
texnologiyalarının Java üçün alternativ tətbiqini inkişaf etdiriblər.  
 Java-nın 2015-ci ilin 25 sentyabrında buraxılan son versiyası cəmi altı ay sonra son qrafiklə Java 
10-u izləyir. Java 8 hələ də kommersiya əsaslı şirkətlərdə dəstəklənsə də Java 9 üçün hələ heç bir 
təhlükəsizlik yenilənməsi gözlənilmir. Məsələn, şirkətlər 2017-ci ilin oktyabrında Oracle şirkəti 
tərəfindən Java 6-ya qayıtsalar belə hələ də Windows kompüterlərində Java 8-dən əvvəlki tətbiqi 
məsləhət görmür.  
 Bu modulun ən fərqləndirici xüsusiyyəti Piktorial sistemi qəbul etməsidir. Modul dərsliyin bu 
konsepti içində rəqəmlər əsas məzmunu yazılı cümlələrdən daha çox ifadə edir. Texniki tədris/
təlim kimi şagirdlər sözlərdən çox rəqəmlərlə texniki məzmunu aydın şəkildə başa düşə bilərlər. 
Faktiki olaraq söz rəqəmdəki məzmunu ifadə etməyə yalnız yardımçı ola bilir.
 Yekun olaraq mən çoxsaylı mənbələrə, xüsusilə YouTube, Yahoo, Wikipedia, “www.booksholic.
co.kr” və Google saytlarına təşəkkür edirəm. Onlar mənə texniki təcrübə modulu dərsliyinin hazır-
lanmasında köməklik etdilər. 

                YUN, Hyung Soon, IKT üzrə Texniki Ekspert
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 package GameJava; 
import java.text.SimpleDateFormat; 
import java.util.Date; 
import java.util.Random; 
 
// Today's Fortune Game 
public class GameJava01 { 
 
 public static void main(String[] args) { 
  Date today= new Date(); 

 
  
  SimpleDateFormat dateForm= new SimpleDateFormat("yyyy/MM/dd"); 
   
  System.out.println(dateForm.format(today)); 
 
   Random r= new Random(); 
 
  int randomNum= Math.abs(r.nextInt() % 100)+1; 
 
  System.out.println("Today's Fortune(100): "+ randomNum + "%"); 
 } 
} 

2018/12/18 
Today's Fortune(100): 24% 
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Java proqramlaşdırma dilini aydın şəkildə izah etməyi bacaracaq;
2.   Bugünün şans oyununu yaratmağı biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/İstinad kitabları
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar
2.   JDK
3.   JRE
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. JDK və JRE   https://www.javaworld.com/
1.1 JDK 
1. JDK Java tətbiqetməsini qurmaq üçün əsas platforma komponentdir. Onun mərkəzində isə Java 

kompilyatorudur.
2. Java Development Kit (JDK) JVM (Java Virtual Machine) və JRE (Java Runtime Environ-

ment) ilə yanaşı Java proqramlaşdırmasında istifadə olunan 3 əsas texnoloji paketdən biridir. Bu üç 
texnologiyanı fərqləndirmək və onların bir-biri ilə əlaqəli olduqlarını başa düşmək vacibdir:

• JVM proqramları idarə edən Java platforma komponentidir. 
• JRE JVM-i yaradan Java-nın diskdəki bir hissəsidir. 
• JDK proqramçıların JVM və JRE tərəfindən icra və idarə olunan Java proqramlarını yaratmağa 

imkan verir. 
3. Java-da yeni olan proqramçılar tez-tez Java Development Kit və Java Runtime Environment-i 

qarışdırırlar. 
• Fərq odur ki,  JDK Java-ya əsaslanan proqram yaratmaq üçün alətlər paketi, JRE isə Java ko-

dunu işlətmək üçün alətlər paketidir. 
1.2 JRE
1. JRE Java proqramlarını sadə şəkildə işlətmək üçün JDK-in bir hissəsi olaraq sərbəst kompo-

nent kimi istifadə oluna bilər.  
2.JDK JRE-ni tələb edir, çünki Java proqramlarını işlətmək onları yaratmağın bir hissədir. 

2. Redaktə alətləri 
2.1 Java üçün Eclipse Editor-u

1. Bu günün şans oyununu yaratmaq
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1. Eclipse kompüter proqramlaşdırılmasında istifadə olunan inteqrasiya olunmuş inkişaf mühiti-
dir (IDE) və geniş şəkildə istifadə olunur. 

2. O, mühiti özəlləşdirmək üçün əsaslı bir iş mühiti və genişlənəbilən plug-in sistemindən ibarət-
dir. 

• Eclipse ən çox Java-da istifadə olunur və əsas istifadə məqsədi Java proqramlarını inkişaf et-
dirməkdir.  

• Həmçinin ABAP, C, C++, C#, Clojure, COBOL, D, Erlang, Fortran, Groovy, Haskell, JavaS-
cript, Julia, Lasso, Lua,NATURAL, Perl, PHP, Prolog, Python, R, Ruby ( Ruby on Rails framework 
də daxil olmaqla), Rust, Scala, və Scheme də daxil olmaqla digər proqramlaşdırma dillərində də 
proqramları inkişaf etdirmək üçün istifadə oluna bilər. 

• LaTeX (TeXlipse plug-in) ilə sənədləri və riyaziyyat proqramı üçün paketləri yaratmaq üçün də 
istifadə edilə bilər.

• Eclipse Java development və Development environments-a Java və Scala üçün Eclipse, Java 
development tools (JDT), C/C++ üçün Eclipse, CDT və PHP üçün Eclipse, PD və digərləri daxildir. 

2.2 Ödənişsiz və açıq mənbələr
1. Software Development Kit (SDK) ümumi ictimai lisenziyaya (GNU) uyğun olmamağına bax-

mayaraq, Eclipse ictimai lisenziyanın şərtləri ilə buraxılan ödənişsiz və açıq mənbəli proqramdır.
2. Bu, GNU Classpath ilə işləyən ilk IDE-lərdən biridir və IcedTea-də problemsiz işləyir. 

3. Sinif və metod
3.1 Sinif 
1. Sinif Java məzmununda obyektlər yaratmaq, obyektin məlumat növləri və metodlarını müəyyən-

ləşdirmək üçün istifadə olunur. 
2. Əsas xüsusiyyətlərinə obyektlər tərəfindən istifadə oluna bilən məlumat növləri və metodlar 

daxildir. 
3. Bütün sinif obyektləri əsas sinif xüsusiyyətlərinə malik olmalıdır.
3.2 Metod 
1. Metod Object Oriented Programming-də (OOP) mesaj və obyekt ilə əlaqəli prosedurdur.
• Bir obyekt əsasən xarici ətrafa təqdim etdiyi interfeysdən ibarət olan məlumat və davranışlardan 

ibarətdir. Məlumatlar obyekt və davranışların xüsusiyyətləri kimi təqdim edilir. 
• Misal üçün, bir Window (Pəncərə) obyektinin open (açmaq) və close (bağlamaq) kimi metodları 

var. 
2. Metodlar, həmçinin digər siniflərin obyektin məlumat xüsusiyyətlərinə daxil olmağa və onu 

dəyişməyə imkan verən interfeysi təmin edir.
3. Bu, “Enkapsulasiya” kimi tanınır. Enkaspsulasiya ləğv etmə metodları və prosedur çağırışları 

arasında əsas sadə fərqləndirici xüsusiyyətdir: 
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Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. JDK qurulması və konfiqurasiyası
1) JDK-nin yüklənməsi  
1. [www.oracle.com/technetwork/java/javaee/
downloads/index.html]-ə gedin. 
2. Menyu panelindən [Downloads]-u seçin. 
3. [Java™ EE 8 SDK Downloads]-u yükləyin. 

  

2) Java platFormasını seçin.  
1.  [Accept License Agreement] düyməsini seçin. 
2. [ java_ee_sdk-8.zip]-i seçin. 

  

3) Yükləmə təchizatına keçidin konfiqurasiya ol-
unması
1. Yaddaşa vermək üçün keçidi qurun.

 

4) Proqramı quraşdırın. 
1. Quraşdırma keçidi
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2. Oyuna öncədən baxış
1.) Baxış
1. əsadüfi nümunələr sayının dəyərini əldə edin. 
2. Məlumat növü prinsipi haqqında əsasları 
öyrənin. 

1.1 Məlumatları tərtib etmək
1. Məlumatın icrası 
• İcra zamanı maşın kodunu bayt koduna çevirin.
2. Şərh bəyanatı
• İcra zamanı bu şərhi nəzərə almayın. 

2) “Əsas məlumatlar”ın başa düşülməsi 
1. İkili rəqəm
2. Onluq rəqəmlər 
3. Məlumat tipinin növləri: 8 növ
• 1 bayt = 1 otaq
• Int = 4 otaq 
• Bildiriş [int]

3. Sabit və dəyişənlər 
3.1 Sabit 
1. Kinds of type/ Növ
2. Variable name/ Dəyişən ad
3. Declare the variable/ Dəyişənin bildirilməsi
4. Dəyəri yadda saxlamaq   

3.2 Dəyişən 
1. Boolean 
• Yalnız [true or false]-u ayırın.  
• “True” and “False” (doğru və yalnış) xaricində-
ki dəyərlər ayrıla bilməz. 
2. Character
• Mark/ Qeyd etmək (‘)
• Char type/ Çar növü: variable/dəyişə bilən
[myChar] variable/ [myChar] dəyişənində [A] 
xarakterini yaddaşda saxlayın. 
3. Integer/Tam say
• 10
• 0x15

Binary 
number

Decimal number

00000000 0
00000001 1
00000010 2
00000011 3
11111110 254
11111111 255

System.out.printIn (“Name:” + employee.
name); 
//employee’s name

// execution 
/*execution*/

int MyInt

Int myInt = 200

Boolean myBoolean= false;

Char myChar= ’A’;

Char myChar= ’\u0041’;

Data type/ Məlumatın növü  Variable name/ 
Dəyişən ad

Data type/ 
Məlumatın 
növü 

Variable 
name/  
Dəyişən ad 

Value/Dəyər

Data type/ 
Məlumatın növü 

Variable name/  
Dəyişən ad 
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4. Sürüşdürmə (Float) 
• İfadənin 4 növü

3.3 Nümunə
Mənbə:Text.java
1. Brauzinq

4. Sinifləri bildirmək 

15  decimal number/ Onluq say  15
0x15 hexadecimal number/ On altılıq say 0x 
= ‘16’

-1.23 common expression/ Ümümi ifadə 
double treatment/ İkiqat yanaşma -.23e+3 
expression by exponentiation/genişləndirmə 
ilə ifadə
1.23F və ya 1.23E  float type/Sürüşdürmə 
növü 

 

 
public class G1_VariableTest { 
 
 public static void main(String[] args) { 
  // TODO Auto-gen erated method stub 
 
  char myChar = '\u0041'; //Unicode character 
  System.out.println("myChar - "+ myChar); 
   
  int myInt = 0x15; 
  System.out.println("myInt = "+ myInt); 
   
  float myFloat = 15.1F; 
  System.out.println("myFloat = "+ myFloat); 
   
  System.out.println("Single Qute(\')\tBackslah(\\)"); 
 } 
 
} 
 

 myChar - A 
myInt = 21 
myFloat = 15.1 
Single Qute(') Backslah(\) 
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4.1 Məlumat sinfi 

1. [Date and Time]-ı tapmaq üçün “Date” sinfini tapın. 

2. Bəyan etmək (Declare)

3. İmportun bəyan olunması ( Declare Import ) 

4.2 Məlumatların kodlaşdırılması 
1. Nümunə proqramı 

2. Nəticə 

5. Forma və sinfin əldə olunması
5.1 Nümunə məlumat forması

1. Nümunə proqramı 

ClassX MyClass =  new ClassX

Date today= new Date(); Bü günün tarixi= yeni tarix 

Import java.util.Date;

Mon Dec 17 21:21:39 KST 2018

Class name/ 
Sinif adı 

Variable 
name/ Dəyişə 
bilən ad     

Class name/ 
Sinif adı

 import java.util.Date; 

public class G1_DateTest { 

 public static void main(String[] args) { 

  Date today= new Date();  //Create "today" as 
Date class object 

  System.out.println(today); // Print out created date 
class object  

 

import java.util.Date; 

import java.text.SimpleDateFormat; 

public class G1_SimpleDateFormatTest { 

 public static void main(String[] args) { 

  Date today= new Date(); 

} 
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2. Brauzinq 

5.2 Kalendar sinfi                        
1. Format

2. İfadə 
    dot       factor 
myClass.myMethod(x);
Class name /Method name (Sinif adı/ Metod adı)

3. Nümunə proqramı 

4. Brauzinq 

6. Təsadüfi seçilmiş nümunə rəqəmin əldə olunması
6.1 Təsadüfi sinif (Random class)
1. Sinfi olan bağlama: java.util
2. “jav.util” bağlamasında təsadüfi sinfin idxalı

3. “Random class”-da nextInt() metodu
• “Random class”-ın yaradılması

2018/12/17 11:04:55

 

  Date today= new Date(); 

  SimpleDateFormat dateForm= new SimpleDateFormat("yyyy/MM/dd 
hh:mm:ss"); 

  // yyyy: year, MM: month, dd: day, hh: hour, mm: minute, ss: second 

    System.out.println(dateForm.format(today)); 

   } 

} 

 Calendar name= Calendar.getinstance(); 

 import java.util.Calendar; 
public class G1_CalendarTest { 
 public static void main(String[] args) { 
  Calendar now= Calendar.getInstance(); 
   int hour = now.get(Calendar.HOUR); 
  int min = now.get(Calendar.MINUTE); 
   System.out.println("the current time is "+ hour 
+" o'clock "+ min +" minute."); 
 } 
} 

 

the current time is 11 o'clock 40 minute. 
 

 import java.util.Random 
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• “nextInt()” metodunun çağırılması
• “-2147483648~2147483647” arasındakı dəyərləri qaytarmaq
4. “%(the rest “mod” operator”-unu istifadə et. 

5. Müsbət təyinatı “0 ~99” arasında məhdudlaşdırsanız 
• Math sinfində “abc” metodunu istifadə edin. 
• “abc” dəyəri “pozitiv rəqəmə” çevirən mütləq funksiyadır. 
6. Nümunə proqram mənbəyi

 
7. Brauzinq 

7. Bu günün şans oyunu
1. Proqramın mənbəyi 

2. Brauzinq 

 Random r= new Random(); 
Int random r.nextInt() % 10; 

 import java.util.Random; 
public class G1_RandomTest { 
 public static void main(String[] args) { 
  Random r= new Random();  // Create Random 
class object 
  System.out.println("0 ~ 99 randomize: "+ 
Math.abs(r.nextInt() % 100)); 
 } 
} 

 0 ~ 99 randomize: 95 

 package GameJava; 
import java.text.SimpleDateFormat; 
import java.util.Date; 
import java.util.Random; 
 
// Today's Fortune Game 
public class GameJava01 { 
 
 public static void main(String[] args) { 
  Date today= new Date(); 
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  SimpleDateFormat dateForm= new SimpleDateFormat("yyyy/MM/dd"); 
   
  System.out.println(dateForm.format(today)); 
 
   Random r= new Random(); 
 
  int randomNum= Math.abs(r.nextInt() % 100)+1; 
 
  System.out.println("Today's Fortune(100): "+ randomNum + "%"); 
 } 
} 

 2018/12/18 
Today's Fortune(100): 24% 

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Java proqramlaşdırma dilini izah etdi? 
2. Bugünün şans oyununu yaratdı?
3. İcra və şərhi qısa şəkildə fərqləndirdi?
4. Sinif formatını düzgün şəkildə istifadə etdi?
5. Metod və sinif əlaqəsini tam şəkildə əlaqələndirdi?  
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switch(expression formula){ 
 case result1: 
  command; 
   break; 
 case result2: 
  command; 
default: 
 command; 
 break; 
} 

switch 

Case1 

Case2 

command 

command 

command 

break 

break 

default: 

1000 “Hello” 

s 

Address 100 

String Storage 

Ad: Address 

1000 “Hello” 

s 

Ad.100 

String Storage 

“World
” 

Ad.1000 

2000 

“Hello” s 

Ad. 100 

String Storage 

“Hello World” 

Ads. 1000 

Ad. 2000 

Garbage Collection 
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Daş, kağız və qayçı oyununun prinsiplərini əminliklə izah etməyi bacaracaq;
2.   Daş, kağız və qayçı oyununu maraqlı şəkildə düzəltməyi biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/İstinad kitabları
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar
2.   JDK
3.   JRE
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. String verilənlər növü
1) String (sətir) simvol ardıcıllığıdır. Məsələn, “Hello” sözü 5 simvoldan ibarət sətirdir. 
2) Javada sətir (string) - yaradıldıqdan sonra dəyişdirilə bilməyən və daimi olan dəyişməz bir 

obyektdir.  
3) Java platforması String class to create funksiyasını təmin edir.

2. Nəzarət idarəetmə şərtləri (Control Statement) 
1) Növləri
• Növ bəyanat şərtləri           Proqramda istifadə olunan dəyişənin növünü göstərir. 
• Arimetik şərtlər              Sabitlər və dəyişənlər arasında arimetik fəaliyyəti tamamlayır.
• Nəzarət idarəetmə şərtləri      Proqramın müxtəlif şərtlərini idarə etmək sırasına nəzarət edir. 
2) Nəzarət idarəetmə şərtləri
• Biz proqramda məlumatları bir neçə dəfə dəyib təkrarlayırıq. Bu dəyişikliklər üçün proqramın 

axışına nəzarət edən bir neçə alətə ehtiyacımız var və Java bu kimi tapşırıqları həyata keçirmək üçün 
nəzarət idarəetmə şərtlərini təmin edir. 

3) Nəzarətin dörd növü
• Ardıcıl nəzarət şərtləri (Sequence Control Statement)
• Seçim və ya qərar nəzarət şərtləri (Selection or Decision Control Statement)
• Təkrarlama və ya dövrü nəzarət şərtləri (Repetition or Loop Control Statement)

2. Daş, kağız və qayçı oyununu düzəltmək



İKT

514

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Sətir sinfinin xüsusiyyətləri 
1) Simvol-xarakter növləri: 
• “Simvol sətrini” əlavə edin. 
• C++ və C-nin simvol xarakter növü var.
• Javanın simvol sinfi yoxdur, amma Java üçün əvvəlcədən simvollar təmin edən sətir sinfi var.

2) Əsas məlumat növünü istifadə edin. 
3) Təyin etmə operatorunu istifadə edin. (‘=’)
• c “=” ilə “str2” kimi sinif yaradın.
• “+” ilə iki sinfi bir sinifdə birləşdirin. 

4) Qabaqcadan edilən müxtəlif metodlar 
• Misal üçün, simvolların sayını bilmək

  

2. Sətir sinfi (String Class)
1) Mənbə proqramı  

 Sting str1 = new String(Hello”); 
String str2 = “Hello”; 

 Sting str3 = str1 + str2 

 StringNum =      str.length(); 
‘Int type Var.’ ‘String type Var.’  
 

  
public class G2_StringTest { 
 
 public static void main(String[] args) { 
 
  String str1= "Hello "; 
  String str2= "World!"; 
  String str3= str1 + str2; 
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2) Brauzinq

2. İstinad məlumat növü
1) İstinad məlumat növünün başa düşülməsi
1. String s=“Hello”;

  

2. String s=s + “ World”;       String=S + “World”;    

2) Sətir növünün hesab əməliyyatı
1. Proqram mənbəyi

 

    System.out.println("str1: "+ str1); 
  System.out.println("str2: "+ str2); 
  System.out.println("str3: "+ str3); 
   
  System.out.println("str1's size: "+ str1.length()); 
  System.out.println("str2's lower case: "+ str2.toLowerCase()); 
  System.out.println("str3 change l to L: "+ str3.replace('l', 'L')); 
  System.out.println("str2's 3rd letter: "+ str2.charAt(2)); // begin from 0 
 } 
 
} 
 

 

str1: Hello  
str2: World! 
str3: Hello World! 
str1's size: 6 
str2's lower case: world! 
str3 change l to L: HeLLo WorLd! 
str2's 3rd letter: r 
 

 

1000 “Hello” 

s 

Address 100 

String Storage 

Ad: Address 

1000 “Hello” 

s 

Ad.100 

String Storage 

“World
” 

Ad.1000 

2000 

“Hello” s 

Ad. 100 

String Storage 

“Hello World” 

Ads. 1000 

Ad. 2000 

Garbage Collection 
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2. Brauzinq 

3) Klaviaturadan məlumatların alınması
1. Java-da bütün giriş/çıxışlar Stream konsepsiyasını istifadə edir. 
2. Monitorda sətri çıxarmaq üçün

 public class G2_EqualTest { 
 
 public static void main(String[] args) { 
 
  String str1= "Hello"; 
  String str2= new String("Hello"); 
  String str3 = str1; 
  String str4 = str2; 
   
  System.out.println("== relation"); 
  System.out.println("str1 == str1 : "+(str1==str1)); 
  System.out.println("str1 == str2 : "+(str1==str2)); // differnt memory address 
  System.out.println("str1 == str3 : "+(str1==str3)); // str3 copied str1 
  System.out.println("str1 == str4 : "+(str1==str4)); // str4 copied str2 
  System.out.println(); 
   
  System.out.println("Equal relation"); 
  System.out.println("str1 equals str1 : "+(str1.equals(str1))); 
  System.out.println("str1 equals str2 : "+(str1.equals(str2))); 
  System.out.println("str1 equals str3 : "+(str1.equals(str3))); 
  System.out.println("str1 equals str4 : "+(str1.equals(str4))); 
 } 
 
} 
 

 

== relation 
str1 == str1 : true 
str1 == str2 : false 
str1 == str3 : true 
str1 == str4 : false 
 
Equal relation 
str1 equals str1 : true 
str1 equals str2 : true 
str1 equals str3 : true 
str1 equals str4 : true 
 

 

System.out.print(“Hello”)’ 
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Oxşar olaraq “System.in” ilə sətri oxuyun və onu “ah” adlı simvol dəyişənində yaddaşa verin. 

3. “System.in”-in strukturu
• Yalnız bir simvolu qaytarın. 
• Simvol sətrini əldə etmək üçün Buffer istifadə edin (su anbarına bənzər)
• Buffer və Stream arasına Read daxil edin.

4. Read rolu Stream-in qaytardığı mətnə dil düzəlişi etməkdir.  
5.  Stream ilə bölünmə halı Filter adlanır.

6.  Stream və Filter
• Sinifləri istifadə edən zaman yalnız “Buffer in”-i istifadə edin. 

 char ch; 
ch= System. In.read(); 
 
char type variable 

 InputSteamReader isr= new InputStreamReader (System.in); 
 
 
 
Reader 
declaration 

Reader 
variable 

Transfer ‘System.in’ by 
parameter 

 BufferReader in= new BufferedReader (isr); 
 
 
 
Reader 
declaration 

Buffer 
variable 

Transfer ‘Reader’ by 
parameter 
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7. Klaviatura test mənbələri 

      

8. Brauzinq

3. İstinad məlumat növü
1) Bölmə şərti
 Nümunə A
 
 
 

 

InputStream(System.in) InputStream Reader BufferedReader 

 import java.io.*; 
 
public class G2_KeyboardTest { 
 
 public static void main(String[] args) throws IOException { 
 
  InputStreamReader isr= new InputStreamReader(System.in); 
  BufferedReader in= new BufferedReader(isr); 
   
  String str; 
  System.out.println("Input text, then follow it"); 
  str= in.readLine(); 
  System.out.println(str); 
 } 
 
} 

 str1: Hello  
str2: World! 
str3: Hello World! 
str1's size: 6 
str2's lower case: world! 
str3 change l to L: HeLLo WorLd! 
str2's 3rd letter: r 

 

Conditions 
True 

False 
Command 
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2) IF şərti
 
 

 
3) IF şərtinin “TRUE” və “FALSE”-u daxil edə biləcəyindən əmin olun. 
• “Boolean” dəyişəni və ya “Boolean” dəyərini qaytarmaq üçün hesab əməliyyatını daxil edin. 
• If int və ya simvol növündə xəta baş verir. 

4) “IfTest” proqram mənbəyi
 
 

 

True False 

Command Command 

IF cons. 

  
public class G2_IfTest { 
 
 public static void main(String[] args) { 
 
  boolean condition= true; 
     
  if(condition) { 
   System.out.println("Condition is True"); 
  } else { 
   System.out.println("Condition is False"); 
  } 
   
  // ! means not 
  if(!condition) { 
   System.out.println("Condition is not True"); 
  } else { 
   System.out.println("Condition is not False"); 
  } 
   
 } 
 
} 
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5) TBrauzinq

4. Switch (Birindən digərinə keçmə) şərti
1) If şərti
• Rahat və ya əlverişli hesab olunur.
• Yalnız iki şərti var: “true” və “false” (doğru və yalnış)
• Əgər istifadəçi çox iş görmək istəyirsə bu şərt əlverişli hesab olunmur.
2) Switch (Birindən digərinə keçmə şərti)
• İstifadəçi işi ifadə formasından qaynaqlanan dəyərə görə gördükdə bu, asan olur.
• Əmr ifadə Formasının nəticəsi ilə bağlı vəziyyətdən sonra işləyir. Əgər nəticə ilə bağlılıq yoxdursa 
əmr standartdan sonra işləyir. 

3) Switch şərti xəritəsi

4) “SwitchText” proqram mənbəyi

 Condition is True 
Condition is not False 

 

switch(expression formula){ 
 case result1: 
  command; 
   break; 
 case result2: 
  command; 
default: 
 command; 
 break; 
} 

switch 

Case1 

Case2 

command 

command 

command 

break 

break 

default: 
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  public static void main(String[] args) { 
 
  int num= 2; 
   
  switch(num) { 
   case 1: 
    System.out.println("Result is 1."); 
    break; 
   case 2:  // no break 
   case 3: 
    System.out.println("Result is 2 or 3."); 
    break; 
   default: // except cases 
    System.out.println("Result is not 1,2,3."); 
    break; 
  } 
 } 
 
} 

5) Brauzinq

6) Oyun qaydaları:
• Təsadüfi qrup 
0: Qayçı 
1: Daş 
2: Kağız   
Oyunçunun a: Qayçı b: Daş və c: Kağız görməsini müəyyən edin. 
• If şərti
7) Proqram mənbəyi
A: G2_ GameJava 

 
Nəticə 2 və ya 3-dür. 
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 package GameJava; 
 
import java.util.*; 
import java.io.*; 
 
// Rock, paper, and scissors game 
public class GameJava02 { 
 
 public static void main(String[] args) throws IOException { 
 
  Random r= new Random(); 
  int computer= Math.abs(r.nextInt() % 3); 
  // 0: scissors, 1: rock, 2: paper 
   
  BufferedReader in= new BufferedReader(new 
InputStreamReader(System.in)); 
  String user; 
  System.out.println("Select rock, paper, and scissors"); 
  System.out.println("(rock=r, paper=p, scissors=s)"); 
  user= in.readLine(); 
   
  if(user.equals("r")) { 
   if(computer==0) System.out.println("WIN (com: 
scissors, user: rock)"); 
   if(computer==1) System.out.println("DRAW (com: 
rock, user: rock)"); 
   if(computer==2) System.out.println("LOSE (com: 
paper, user: rock)"); 
  } else if(user.equals("p")) { 
   if(computer==0) System.out.println("LOSE (com: 
scissors, user: paper)"); 
   if(computer==1) System.out.println("WIN (com: 
rock, user: paper)"); 
   if(computer==2) System.out.println("DRAW (com: 
paper, user: paper)"); 
  }  
    
 

   
  else if(user.equals("s")) { 
   if(computer==0) System.out.println("DRAW (com: 
scissors, user: scissors)"); 
   if(computer==1) System.out.println("LOSE (com: 
rock, user: scissors)"); 
   if(computer==2) System.out.println("WIN (com: 
paper, user: scissors)"); 
  } else 
   System.out.println("Wrong character"); 
   
 } 
 
}  
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Daş, kağız və qayçı oyununun prinsiplərini əminliklə izah etdi? 
2. Daş, kağız və qayçı oyununu maraqlı şəkildə düzəltdi?
3. Proqram üçün sətir sinfini (String class) əminliklə izah etdi?
4. Bu oyun üçün if şərtini dəqiq şəkildə istifadə etdi? 
5. Bu oyunda təsadüfi sinfi tətbiq etdi?
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Operator Təsvir Nümunə 

|| Şərti-OR; Bul ifadələrindən hər hansı 
biri doğrudursa true olur.

false || true  true (doğru) olaraq 
dəyərləndirilir.

&& Şərti-AND; Bul ifadələrindən hər hansı 
biri doğrudursa true olur. 

false && true false (yanlış) 
olaraq dəyərləndirilir. 

Operator Təsvir Nümunə 

== Bərabərdir 5 == 3  false (yanlış) olaraq 
dəyərləndirilir 

!= Bərabər deyil 5 != 3 true (doğru) olaraq 
dəyərləndilir

> Böyükdür 5 > 3 true (doğru) olaraq dəyərlən-
dilir

< Kiçikdir 5 < 3 false (yanlış) olaraq 
dəyərləndirilir

>= Böyük və ya bərabərdir 5 >= 5 true (doğru) olaraq 
dəyərləndilir

<= Kiçikdir və ya bərabərdir 5 <= 5 true (doğru) olaraq 
dəyərləndilir

  * 7-ci mərhələ probleminə vurma. 
 
7 * 5 = 45 
Səhv. Cavab 35-dir. 
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Vurma oyununun qaydalarını qısa şəkildə izah etməyi bacaracaq;
2.   Aydın şəkildə vurma cədvəli yaratmağı biləcək.

Təcrübə materialları:
1.   Dərs mənbələri
2.   Dərslik/İstinad kitabları
3.   Media tədrisə dəstək vasitələri 

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar
2.   JDK
3.   JRE
4.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Əməliyyatlar (operatorlar) <Mənbə: https://www.programiz.com/java-programming/oper-
ators>

1) Operatorlar “operand”larda (dəyişən və ya dəyərlər) əməliyyat aparan xüsusi simvollardır. 
Misal üçün, + is əlavə edən bir operatordur. 

1.1 Hesab əməliyyatları
1. Hesab əməliyyatları toplama, çıxma, vurma və s. kimi riyazi əməliyyatların aparılması üçün 

istifadə olunur. 
2. Java hesab operatorları 

3. Vurma cədvəli̇ yaratmaq

Əməliyyat Mənası

+ Toplama əməliyyatı (həmçinin sətir birləşdirmək üçün də 
istifadə olunur)

- Çıxma əməliyyatı

* Vurma əməliyyatı 

/ Bölmə əməliyyatı

% Kəsir əməliyyatı
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1.2 Artma və azalma əməliyyatı 
1. Bu, təkli (Unary) əməliyyat adlanır.
• Bu əməliyyat yalnız bir operand üzərində fəaliyyət göstərə bilir.
2. Təkli (Unary) əməliyyatlar

Əməliyyat Mənası

+ Təkli toplama (istifadə edilməzdən qabaq rəqəmlər müsbət olarsa bunu isti-
fadə etməyə ehtiyac yoxdur)

- Təkli çıxma - ifadə işarəsini tərsinə çevirir.  

++ Toplama əməliyyatı - dəyəri 1 ilə toplayır. 

-- Çıxma əməliyyatı - dəyəri 1 ilə çıxır.

! Məntiqi tamamlama əməliyyatı - bul dəyərini tərsinə çevirir. 

1.3 Bit (Bitwise və bit shift) əməliyyatları 
1. Bitwise və bit shift əməliyyatlarını etmək üçün aşağıdakı əməliyyatlardan istifadə olunmalıdır:
2. Java Bitwise və Bit Shifts əməliyyatları  

1.4 Təyinat əməliyyatı
1. Təyinat əməliyyatı Javada dəyişənlərə dəyər təyin etmək üçün istifadə olunur.

1.5 Məntiqi əməliyyatlar
1. Məntiqi əməliyyatlar “||” (conditional-OR) və “&&” (conditional-AND) bul ifadələri üzərində 

əməliyyat edir. Onların necə fəaliyyət göstərdiyi aşağıda göstərilir: 
2. Java məntiqi operatorları  

Əməliyyat Təsvir

~ Bitwise Tamamlayıcısı

<< Sol Shift

>> Sağ Shift

>>> İşarəsiz Sağ Shift

& Bitwise AND (VƏ)

^ Bitwise exclusive OR (Ekskluziv VƏ YA)

| Bitwise inclusive OR (Daxil edilən VƏ YA)

 
int age; 
age = 5; 
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1.6 Bərabərlik və əlaqəli əməliyyatlar
1. Bərabərlik və əlaqəli əməliyyatlar iki operand arasında əlaqəni müəyyən edir. 
2. O, operandın böyük, kiçik, bərabər, qeyri-bərabər və s. olmasını yoxlayır. 
3. Əlaqədən asılı olaraq o, doğru (true) və ya yanlış (false) ilə nəticələnir.  
4. Bərabərlik və əlaqəli əməliyyatlar  

1.7 Üçlü əməliyyatlar
1. Proqramın nəzarət axınını dəyişdirmək üçün üçlü əməliyyat istifadə edin.
2. Üçlü əməliyyat “if...else” şərtini dəyişdirmək üçün istifadə oluna bilər. 
3. Üçlü əməliyyatlar
• Aşağıdakı kodu dəyişdirin:

Əməliyyat Təsvir Nümunə 

|| Şərti-OR; Bul ifadəsindən hər hansı biri 
doğru olarsa true olur. 

false || true doğru (true) kimi 
dəyərləndirlir

&& Şərti-AND; Bütün Bul ifadələri doğru 
olarsa true olur.

false && true yanlış (false) 
kimi dəyərləndirilir 

Əməliyyat Təsvir Nümunə 

== Bərabərdir 5 == 3 false (yanlış) kimi 
dəyərləndirilir.

!= Bərabər deyil 5 != 3 true (doğru) kimi 
dəyərləndirilir.

> Böyükdür 5 > 3 true (doğru) kimi 
dəyərləndirilir.

< Kiçikdir 5 < 3 false (yanlış) kimi 
dəyərləndirilir.

>= Böyükdür və ya bərabərdir 5 >= 5 true (doğru) kimi 
dəyərləndirilir.

<= Kiçikdir və ya bərabərdir 5 <= 5 true (doğru) kimi 
dəyərləndirilir.

 if (expression) { 
   number = 10; 
} 

 else { 
   number = -10; 
} 
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İlə

2. Növ dəyişdirmə 
2.1 Növ dəyişdirmə <mənbə: https://www.studytonight.com/java/type-casting-in-java>
1. Bir növün dəyərini başqa bir növ dəyərinə dəyişdirmək
2. Təsnifat: iki növ
• Genişlənmə kastinqi (Expanding casting (Implicit))

 Number = (expression) ? expressionTrue : expressionFalse 

 short int byte long float double 

Genişlənmə 
 

 float long double int short byte 

Daralma 

• Daralma kastinqi (Narrowing Casting)

2.2 Wrapper Class <mənbə: https://beginnersbook.com/2017/09/wrapper-class-in-java/>
1. Səkkiz bəsit verilən növü - byte, short, int, long, float, double, char və boolean obyekt hesab 

olunmur.  
2. Wrapper Class bəsit verilən növlərini obyektlərə çevirir. 
3. Sadə növ (Primitive Type) və Wrapper Class 

Bəsit növ Banderol sinfi

Boolean Boolean

Char Character

Byte Byte

Short Short

Bəsit növ Banderol sinfi

Int Integer

Char Character

Byte Byte

Short Short
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Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Tələbənin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Əməliyyatlar 
1.1 Hesab əməliyyatları  

 

class ArithmeticOperator { 

    public static void main(String[] args) { 

      

     double number1 = 12.5, number2 = 3.5, result; 

      

     // Using addition operator 

     result = number1 + number2; 

     System.out.println("number1 + number2 = " + result); 

      

     // Using subtraction operator 

     result = number1 - number2; 

     System.out.println("number1 - number2 = " + result); 

      

     // Using multiplication operator 

     result = number1 * number2; 

     System.out.println("number1 * number2 = " + result); 

 

     // Using division operator 

     result = number1 / number2; 

     System.out.println("number1 / number2 = " + result); 
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2. Brauzinq

2. Proqram nümunəsi

2. Brauzinq

 

     // Using remainder operator 

     result = number1 % number2; 

     System.out.println("number1 % number2 = " + result); 

    } 

} 

  

 
number1 + number2 = 16.0 
number1 - number2 = 9.0 
number1 * number2 = 43.75 
number1 / number2 = 3.5714285714285716 
number1 % number2 = 2.0 

 class ArithmeticOperator { 

    public static void main(String[] args) { 

      

     String start, middle, end, result; 

      

     start = "Talk is cheap. "; 

     middle = "Show me the code. "; 

     end = "- Linus Torvalds"; 

      

     result = start + middle + end; 

     System.out.println(result); 

    } 

} 

 Talk is cheap. Show me the code. - Linus Torvalds 
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1.2 Təkli əməliyyatlar
1. Nümunə 1

2. Brauzinq

 
class UnaryOperator { 

    public static void main(String[] args) { 

     double number = 5.2, resultNumber; 

     boolean flag = false; 

      

     System.out.println("+number = " + +number); 

     // number is equal to 5.2 here. 

     System.out.println("-number = " + -number); 

     // number is equal to 5.2 here. 

     // ++number is equivalent to number = number + 1 

     System.out.println("number = " + ++number); 

        // number is equal to 6.2 here. 

        // -- number is equivalent to number = number - 1 

     System.out.println("number = " + --number); 

        // number is equal to 5.2 here. 

     System.out.println("!flag = " + !flag); 

     // flag is still false. 

    } 

} 

 

 +number = 5.2 
-number = -5.2 
number = 6.2 
number = 5.2 
!flag = true 
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1.3 Bitwise və Bit Shifts əməliyyatları
1. Nümunə 1

 public class BitwiseTest 

{ 

 Public static void main(String[] args) 

 { 

  Int x, y; 

 

  X= 8;    // 0000 0000 0000 0000 0000 0000 0000 1000 

  Y= -x;   // 1111 1111 1111 1111 1111 1111 1111 0111 

              (‘y’ is x’s compliment) 

   System.out.printIn(“x = “+ x +”, y = “+ y +” (-x) ”);  

  System.out.printIn(x = “ AND ” + y +” = ”+ (x & y)); // 0000 

  0000 0000 0000 0000 0000 0000  

  System.out.printIn(x = “ OR ” + y +” = ”+ (x | y)); // 1111 

  1111 1111 1111 1111 1111 1111 1111 

  System.out.printIn(x = “ XOR ” + y +” = ”+ (x ^ y)); // 1111 

  1111 1111 1111 1111 1111 1111 1111 

   

  X= x << 2; // 0000 0000 0000 0000 0000 0000 0010 0000 

  Y= y << 2; // 1111 1111 1111 1111 1111 1111 1101 1100 

  System.out.printIn((“x = “+ x +” (x<<2), y = “+ y +” (y<<2)”);  

 

  X= x >> 2; // 0000 0000 0000 0000 0000 0000 0000 1000 

  Y= y >> 2; // 1111 1111 1111 1111 1111 1111 1111 0111   

  System.out.printIn((“x = “+ x +” (x>>2), y = “+ y +” (y>>2)”);  

 

  X= x >> 2; // 1111 1111 1111 1111 1111 1111 1111 1101   

  Y= y 2; // 0011 1111 1111 1111 1111 1111 1101 1101   

  System.out.printIn((“x = “+ x +” (y>>2), y = “+ y +” (y>>2)”);  

   } 

} 
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2. Brauzinq

2. Brauzinq

1.4 Məntiqi əməliyyatlar
1. Nümunə

1.5 Bərabərlik və əlaqə əməliyyatları
1. Nümunə

 // Sual həll edildi? 

 class LogicalOperator { 

    public static void main(String[] args) { 

      

     int number1 = 1, number2 = 2, number3 = 9; 

     boolean result; 

      

     // At least one expression needs to be true for result to be 
true 

     result = (number1 > number2) || (number3 > number1); 

     // result will be true because (number1 > number2) is true 

     System.out.println(result); 

        

     // All expression must be true from result to be true  

     result = (number1 > number2) && (number3 > number1); 

     // result will be false because (number3 > number1) is 
false 

     System.out.println(result); 

    } 

} 

 True (Doğru) 
False (Yalnış) 
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2. Brauzinq

2. Brauzinq

1.6 Üçlü (Şərti) əməliyyatlar 
1. Nümunə

 
class RelationalOperator { 
    public static void main(String[] args) { 
      
     int number1 = 5, number2 = 6; 
     if (number1 > number2) 

 { 
      System.out.println("number1 is greater than number2."); 
     } 
     else 
     { 
      System.out.println("number2 is greater than number1."); 
     } 
    } 
} 

 
number2 is greater than number1. 

 class Operator { 
   public static void main(String[] args) {    
 
      Double number = -5.5; 
      String result; 
       
      result = (number > 0.0) ? "positive" : "not positive"; 
      System.out.println(number + " is " + result); 
   } 
} 
 

 -5.5 is not positive 
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2. Növ dəyişmə
1.1 Genişlənmə və ya avtomatik növ dəyişmə 
1. Genişlənmə avtomatik növ  
• İki növ uyğundur.
• Hədəf növ mənbə növündən daha genişdir.
 
2. Nümunə

• Brauzinq

1.2 Daralma və ya genişlənmə növ dəyişimi
1. Daha kiçik növ dəyişəninə daha böyük növ əlavə olunursa genişlənmə kastinqi icra edilir. 
2. Nümunə

 public class Test 
{ 
    public static void main(String[] args) 
    { 
      int i = 100; 
      long l = i; //no explicit type casting required 
      float f = l; //no explicit type casting required 
      System.out.println("Int value "+i); 
      System.out.println("Long value "+l); 
      System.out.println("Float value "+f); 
    } 
 
} 

 Int value 100 
Long value 100 
Float value 100.0 

 public class Test 
{ 
    public static void main(String[] args) 
    { 
      double d = 100.04; 
      long l = (long)d;  //explicit type casting required 
      int i = (int)l; //explicit type casting required 
 
      System.out.println("Double value "+d); 
      System.out.println("Long value "+l); 
      System.out.println("Int value "+i); 
    } 
} 
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• Brauzinq

• Brauzinq

• Brauzinq

6. Misal 2: Əhatə sinfini primitiv obyektə dəyişdirmək

1.3 Əhatə sinfi (Wrapper Class)
1. API toplanması üçün əhatə sinfini istifadə edin.
2. Primitiv növlərlə müqayisədə daha çox yaddaşa sahibdir. 
3. Primitiv verilən növü digər sinfə adi olmayan obyektlərdir. 
4. Yalnız obyektləri dəstəkləyən məlumat strukturunda toplanan zaman primitiv növü obyektə dəy-
işmək tələb olunur. 
5. Misal 1: Primitiv növü əhatə obyektinə çevirin

 Double value 100.04 
Long value 100 
Int value 100 

 public class JavaExample{   
   public static void main(String args[]){   
 //Converting int primitive into Integer object   
 int num=100;   
 Integer obj=Integer.valueOf(num);   
 
 System.out.println(num+ " "+ obj);   
   } 
} 

 100 100 

 100 100 

 public class JavaExample{   
   public static void main(String args[]){   
 //Creating Wrapper class object  
 Integer obj = new Integer(100);   
   
 //Converting the wrapper object to primitive 
 int num = obj.intValue(); 
 
 System.out.println(num+ " "+ obj);   
   } 
} 
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3. Vurma oyunu
1) Oyunun qaydası
1. Faktor ilə dəyər verin. 
2. Yuxarıda verilmiş dəyəri təsadüfi rəqəmə vuraraq misal yaradın.
3. Oyunçunun daxil etdiyi dəyəri yuxarıda vurma ilə əldə etdiyiniz dəyər ilə müqayisə edin.

2) Oyun proqramı mənbəyi

 package GameJava; 
 
import java.util.*; 
import java.io.*; 
 
// A multiplication game 
public class GameJava03 { 
 
 public static void main(String[] args) throws IOException 
{ 
 
  int x, y; 
  Random r= new Random(); 
   
  if(args.length==1) { 
   x= Integer.valueOf(args[0]).intValue(); 
  } else { 
   x= Math.abs(r.nextInt() % 9) + 1; 
  } 
   
  y= Math.abs(r.nextInt() % 9) + 1; 
   
  int num= x*y; 
   
  System.out.println(); 
  System.out.println(" * multiplication "+ x + "rd(nd) 
stage's problem"); 
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   System.out.println(); 
   
  System.out.print(x +" * "+ y + " = "); 
   
  BufferedReader in= new BufferedReader(new 
InputStreamReader(System.in)); 
  String user; 
  user = in.readLine(); 
   
  int inputNum= new Integer(user).intValue(); 
   
  if(num==inputNum) { 
   System.out.println("Correct!"); 
  } else { 
   System.out.println("Wrong. Answer is "+ num + 
"."); 
  } 
 } 
 

3. Brauzinq

  * multiplication 7th(nd) stage's problem 
 
7 * 5 = 45 
Wrong. Answer is 35. 

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Vurma oyununun qaydalarını qısa şəkildə izah etdi? 
2. Vurma cədvəli yaratdı?
3. Əməliyyat növlərini bu oyuna tətbiq etdi?
4. Bu oyunu yaratmaq üçün dəyişəni düzgün şəkildə istifadə etdi?
5. Təsadüfi say və əhatə etmə sinfini dəqiq şəkildə istifadə etdi?  
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Sosial şəbəkə xidməti
(Bloq)

Sənaye və İnnovasiyalar üzrə 
Bakı Dövlət Peşə Təhsil Mərkəzi

Səriştə əsaslı 
modul İKT
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Ön söz 

 “Bloq” web-bloq sözünün qısaldılmış forması olub çox vaxt qeyri-rəsmi, gündəlik üslubda yazılar-
dan ibarət www-da nəşr olunmuş diskussiya və informasiya səhifəsidir. Paylaşmalar adətən tərs 
xronoloji ardıcıllıqla verilir. Belə ki, ən sonda baş verən hadisə haqda paylaşma birinci səhifənin 
lap əvvəlində verilir. 2009-cu ilə qədər bloqlar adətən bir nəfərin və ya təsadüfi hallarda kiçik bir 
qrupun hansısa mövzu haqqında yazısı idi. 2010-cu illərdə paylaşmaların böyük müəllif qrupları 
tərəfindən hazırlanaraq peşəkarcasına dərc olunduğu çoxmillətli bloqlar inkişaf etdi. Qəzetlərdən, 
digər KİV-dən, universitetlərdən, ekspert qruplarından, vəkillər və bu qəbildən olan qurumlardan 
ibarət çoxmillətli bloqlar “bloq trafikinin” artan keyfiyyətini təmin edir. Twitter və digər mikrobloq 
sistemlərinin inkişafı çoxmüəllifli sistemə inteqrasiyaya kömək edir və vahid müəllifi bloqlarının 
xəbər mediasına daxil olmasına yardımçı olur. 
 “Bloq” sözü feil kimi də işlənə bilir. Bu halda o, bloqu gücləndirmək və ona məzmun əlavə 
etmək mənasını verir. Bloqların yaranma zərurəti və inkişafı HTML və ya kompüter proqram-
larında texniki istifadəçilər tərəfindən  1990-cu illərin sonunda yaradılan məzmun dərc edilməsini 
asanlaşdıran vasitələrin gəlişi ilə üst-üstə düşdü. Əvvəlcə web-də məzmunlu yazını nəşr etmək 
üçün HTML və File Transfer protokol kimi texniki bilik tələb olunurdu. Ona görə də əvvəlki 
web istifadəçilər xaker kompüter həvəskarları idi. 2010-cı illərdən bu yana yaranan web saytların 
əksəriyyəti əsasən interaktiv web saytlardır ki, bu da online şərh verməyə imkan verir. Məhz bu 
interaktivlik onları digər statik web saytlardan fərqləndirir. Bu mənada bloqqerlik sosial şəbəkə 
xidmətinin forması kimi xarakterizə oluna bilər. Əlbəttə bloqqerlər təkcə öz bloqlarında yazmaq 
üçün məzmun yaratmır. Həmçinin çox vaxt öz oxucuları və digər bloqqerlər arasında sosial mü-
nasibətlər də yaradır. 
 Yekun olaraq mən çoxsaylı mənbələrə, xüsusilə YouTube, Yahoo, Wikipedia, “www.sonsultube.
co.kr”, “www.sejinbooks.com” və Google saytlarına təşəkkür edirəm. Onlar mənə texniki təcrübə 
modulu dərsliyinin hazırlanmasında köməklik etdilər. 

                YUN, Hyung Soon, IKT üzrə Texniki Ekspert
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Bloqun məqsədini qısaca izah etməyi bacaracaq;
2.   ‘www.wordpress.com’-u istifadə edərək sadə yolla ingilis dilində bloq yaratmağı biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar
2.   Dərslik & Dizayn məlumat kitabı
3.   Proyektor

Mövzu ilə əlaqəli biliklər
1. 8 Əsas bloqinq xüsusiyyətləri 

1) Paylaşmaların yaradılması
Bloqun məqsədi sayta tez-tez yeni mətn və informasiya paylaşmaq olduğuna görə paylaşımların 

yaradılması, adətən tez və asan olur. 
2) Şəkil və multimedia vasitələrinin sayta yüklənməsi və yerləşdirilməsi 
Bütün bloqlar paylaşımlara şəkil yükləməyə imkan verir. Hətta bəzilərində video və audio/mp3 

yükləməyə də imkan olur. Buradakı vacib qeyd odur ki, əksər bloqqerlər “Web ready” formatında ol-
mayan videolar istifadə etdiyinə görə bu kimi videoların həcmi çox böyük olur və yükləndiyi zaman 
çox pul itirmək riski meydana gəlir. Məsləhətdir ki, videoları YouTube və Vimeo kimi saytlarda 
paylaşın və sonra videonu sayta yükləmək üçün yükləmə funksiyasını seçin. Bu daha tez, asan və 
ödənişsiz olacaq.

3) Görünüş və yerləşməni konfiqurasiya etmək
Bloqların çoxu temalar - quraşdırıla və dəyişdirilə bilən dizayn şablonu üzərində qurulur. 
4) Ziyarətçilərə bildirişləri və şərhləri göstər.
Bloqqinq platforması oxucular üçün sizin postları görməyi və öz şərhlərini yazmağı asanlaşdırır. 
5) Ölçü götürmək 
Siz oxucular tərəfindən yazılmış və ya spam olan rəyləri silmək istəyəcəksiniz. Fərqli platforma-

lar istənməyən məlumatlardan azad olmaq üçün spam qoruyucularla təmin edir. 
6) RSS
RSS texnologiya ilə maraqlanan şəxslərə sizin bloqunuza abunə olmaq və myAOL, myYahoo, 

iGoogle və ya digərləri vasitəsilə başlıqlar almağa icazə verəcək. 
 
7) Dəstək almaq
Heç də bütün bloqqinq vasitələri eyni dərəcədə dəstək vasitəsi təklif etmir.  Bəziləri fərdi köməklik 

təklif edir, bəzilərinin də forumları mövcuddur və bu forumlarda suallarınıza cavab tapa bilərsiniz.  
8) Bloqu yeləşdirmək

1. İngi̇li̇s di̇li̇ndə bloq yaratmaq
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Bəzi bloq proqramları sizin şəxsi serverinizdə mövcud olur, digərləri isə proqram təminatçısı və 
ya satıcı tərəfindən hostinq olunur. Buna ən bariz nümunə kimi WordPress-i göstərmək olar. Word-
Press.org-u öz serverinizdə/hostinq hesabınızda yükləyə və quraşdıra bilərsiniz. 

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. WordPress-ə üzvlük üçün qeydiyyatdan 
keçmək
1) Bloq ilə bağlı veb-saytın açılması
1. [www.wordpress.com] saytına gedin.
• https://wordpress.com/start/user/en?ref=home-
page
2. [Sign Up now] bölməsini seçin.  

2) Üzvlük üçün başlanğıc
1. Aşağıdakı məlumatlarla formu doldurun: 
• Your email address (E-poçt adresi)-‘hsoon123@
naver’
• Choose a username (İstifadəçi adı seçin)- 
‘yhs11’
• Choose a password (şifrə seçin) -‘*happy***’

3) Saytı yaratmaq

Şəkil 1-1: www.wordpress.com  

Şəkil 1-2: Üzvlük üçün başlanğıc

www.wordpress.com1 2
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1. Aşağıdakı məlumatları dolduraraq sayt yarat-
maq
• Your site name (Saytınızın adı)- ‘EHnad’s Blog
• Interest item (Maraqlı element) ‘Friendship’
• Primary goal (İlkin hədəf) ‘Education Training 
or Mentoring’

 
2. ‘Wordpress’ bloqu yaratmaq
1) ‘Creating Blog’ səhifəsinə gedin. 
1. Bloqa daxil olun. 

2) Saytınıza ünvan vermək 
1. Sayt üçün axtarış etmək: [**yhs.com] 

3) Özünüz üçün doğru olan planı qurmaq
1. [Personal] planı seçin.  

 
 

4) Qeydiyyatın tərəqqisini göstərmək
1. Tərəqqi üçün mesajı nümayiş etdirin. 

5) Qeydiyyatı tamamlamaq üçün gizliliyin qo-
runması
1. Boşluqları şəxsi təhlükəsizlik məlumatları ilə 

Şəkil 1-3: Sayt yaratmaq
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doldurun. 

2. Variantı seçin.

3. [Continue to Checkout] ilə davam edin.

6) Öz bloqunuzu əldə edin. 
1. E-mail adresinizi yoxlayın.
2. [www.wordpress.com]-a gedin. 
3. Bloq saytına daxil olun.  
4. Öz bloqunuzu tamamlayın. 

 
3. Bloqda məlumat yazın
1) Mənim bloqumun yazılması
1. Siçanı [Blog Posts] üzərinə qoyun. 
• Əgər ilk dəfədirsə siçanı  [New Post] üzərinə 
qoyun
2. [Add] düyməsini basın. 
• Əgər ilk dəfədirsə [Add new Post]-u klik edin. 

  

2) Bloqu hazırlayın.
1. [Title]-ı müəyyən edin. 
• “Welcome to my Blog” 
2. [Body]-ni düzəldin.
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• Mənim adım “Azərbaycan”dır.
• “Mən web dizaynda dünya lideriyəm.”
• “Təşəkkür edirəm.”
• “Mr. YUN tərəfindən”
 

3) “Post Settings” haqqında sseçımləri müəyyən-
ləşdirmək
1. Slaq: başlıq 
2. Sitat: məzmunu qısaca izah edin.
3. Müzakirə

4) Yazını yekunlaşdırmaq 
1. [Publish] düyməsini klik edin. 

5 Yazını çap etmək
1. [Finish] mesajı görünür.

6) Tamamlanmış yazıya baxış
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Bloqun məqsədini qısaca izah etdi? 
2. ‘www.wordpress.com’-u istifadə edərək ingilis dilində bloq 
yaratdı?
3. Bloqu təhlükəsiz şəkildə yaratmaq üçün bütün prosedurları etdi?
4. Bloqda qısaca məzmunlar yazdı?
5. Tamamlanmış məzmunları sərbəst şəkildə dərc etdi?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Yahoo bloqu üçün prosedurları açıq şəkildə izah etməyi bacaracaq;
2.   “yahoo.com” saytında bloq yaratmağı biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylları
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar
2.   Dərslik & Dizayn məlumat kitabı
3.   Proyektor

Mövzu ilə əlaqəli biliklər
1. Yahoo bloq

Bloq “weblog”-un qısaldılmasıdır. Yahoo sizə pulsuz bloqları yaratmağa köməklik göstərir və 
bu zaman sizin veb dizayn haqda biliklərinizin olmasına ehtiyac duyulmur. Bu, müntəzəm olaraq 
yenilənən veb saytdır və tez-tez onlayn şəkildə gündəlik kimi istifadə olunur. Çoxlu bloq izləyən 
siyasətçilər, sənətkarlar, analar və s. kimi müəyyən kütlə mövcuddur. Bloqlar, həmçinin öz həyatınız 
haqqında yazmaqla dostlar və ailələr ilə əlaqə saxlamaq üçün mükəmməl vasitədir. Bloqun ən 
mükəmməl bir xüsusiyyəti də oxuyucuların bloqunuza şərh verərək bu prosesdə iştirak etməsidir. 

2. Yahoo saytında bloq yaratmaq

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.
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Təcrübə mərhələləri

1. ‘http://360.yahoo.com’-u açın.
1) [ https://www.facebook.com /Old.Yahoo.360 
]
1. https://www.facebook.com /Old.Yahoo.360-a 
gedin. 
2. Başlanğıc olaraq bloqunuz üçün [sign up]-ı 
seçin. 
• Əgər varsa [yahoo email ID and password] ilə 
[sign in]

2) [ https://www.facebook.com /Old.Yahoo.360]
2.1 Əgər artıq mövcuddursa 
1. [sign in]-ə gedin. 
• İstifadəçi adı: ‘hsoon123’
• Şifrə ‘!1******’
  

 2.2 Əgər indi qoşulursunuzsa
• [www.facebook.com]-a üzv olun. 

3) Səhifənin yuxarısından ‘My blog’-u seçin.
1. Bloq yaratmağa başlayın. 
2. Bura - istifadəçinin öz bloqunun necə görün-
məsini seçdiyi hissədir.
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V4) Səhifə yaratmaq
Əgər artıq üzvsünüzsə
1. [Community or Public Figure] seçimini seçin. 
• Səhifə yaradın. 

5) Növbəti üç suala cavab verin. 
1. Bloqun arxa fonunun necə olduğunu müəyyən 
edin. 
• Rəng 
• Ümumi və tutum
2. Bloqunuz üçün adı qərarlaşdırın. 
3. İstifadəçinin bloqu təsvir etmək üçün bəzi 
açarları seçməsi 
Bura - istifadəçinin öz bloqunun necə 
göründüyünü seçməyə başladığı hissədir. 
※ Artıq üzv olduğunuz halda
• Addım 1/2: Səhifə yaradın.

6) İlk bloq girişini yazmaq 
1. Arxa fonu müəyyən edin. 
2. Səhifənin yanından [New Blog Entry]-ni 
klikləyin.
3. Bloqunuz üçün məzmun yaradın.
• Bu girişlər “postlar” adlanır.
※ Artıq üzv olduğunuz halda
Addım 2/2: Səhifəni yaradın. 

7) Bloq postu və yazı üçün başlıq seçin. 
1. Əsas qutuda istifadəçi postunun məzmunu 
yazın. 
2. Dərc etmək üçün seçim edin. 
3. İstifadəçi bloqunun digər istifadəçilərə necə 
göründüyünə baxmaq üçün [View Blog]-a 
klikləyin. 
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8) URL-nizi dostlarınıza və ailənizə göndərin. 
Bloqunuzu müntəzəm olaraq yoxlayın.

1. Bloqu mütəmadi olaraq yoxlayın.
2. Şərhlər yazaraq qarşılıqlı reaksiya bildirin. 
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. “yahoo.com” saytında bloq yaratdı?
2. Yahoo bloqunuza düzgün formada üzvlük əlavə etdi?
3.  Bloqda qısa şəkildə məzmunlar yazdı?
4. Tamamlanmış məzmunları düzgün şəkildə dərc etdi?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Twitter üçün prosesləri aydın şəkildə izah edəcək ;
2.   Düzgün formada Twitter yaratmağı biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylları
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar
2.   Dərslik & Dizayn məlumat kitabı
3.   Proyektor

Mövzu ilə əlaqəli biliklər
1. Twitter

1) Twitter mikro-bloqqinq saytı kimi tanınır. 
1. Bloqqinq bir müddətdir ki, mövcuddur. 
2. Adətən bloqqinq siyasət, idman, yemək, moda və s. haqqında yazaraq sadə veb sayt quran şəx-

slərdən ibarət olur. 
3. Mesajın paylaşılması tweet adlanır. İnsanlar digərlərinin paylaşımlarını izləyərək əlaqələr 

yaradır.
4. İzləmək düyməsini klik etdikdə hər hansı bir şəxsin və ya təşkilatın paylaşdıqları sizin ana 

səhifənizdə çıxacaq. İstifadəçi adından qabaq @ simvolunu qoyaraq hər hansı bir şəxsi tweet edə 
bilərsiniz. 

2) “Retweet”ləmək Twitterin böyük bir hissəsidir. 
1. Burada veb-sayt istifadə edən şəxslər öz istifadəçiləri üçün digər istifadəçilərin tweet-lərini 

təkrarlayır.   
2. Twitter çoxlu fəaliyyət həştəqlərinin istifadəsini nəzərdə tutur. 
3. Həştəqlər eyni mövzu ilə əlaqəli tweet-ləri bir yerə yığmaq üçün istifadə olunan vasitələrdir. 
4. Misal üçün, əgər konfransda bir çox şəxs iştirak edirsə və spikerin danışdıqlarını digərlərinin 

də bilməyini istəyirlərsə o zaman onlar (#) simvolunu istifadə edərək razılaşdırılmış həştəq ilə tweet 
edə bilər.  

3) Tweet-lər ani olaraq meydana çıxır
1. Saniyələr içində bir tweet dünyanı fəlakətlərə qarşı xəbərdar edə bilər.
2. 2008-ci ildəki kimi: Mayk Vilson Denverdəki təyyarə qəzası haqda tweet paylaşdı. O nə edə 

bildi? Qəzadan qurtuldu. 
3. Hindistanın Numbai şəhərində də oteldən tweet yazan bir istifadəçi 2008-ci ildə terroristlərin 

qətlə yetirdiyi şəxslər haqda məlumat paylaşmışdı. Twitter mesajlaşmağın bir formasıdır. Mesajı 

3. Twitter yaratmaq
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bir şəxsə göndərməkdən fərqli olaraq Twitter istifadəçilərə mesajı bütün saytdakı şəxslərlə pulsuz 
şəkildə paylaşmağa icazə verir. 

Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Yeni hesab açmaq
1) https://www.twitter.com
1.  https://www.twitter.com-a gedin. 
• Internet Explorer, Firefox, Safari veb-saytlarını 
nəzərdən keçirin. 

2) Hesabı qeydiyyatdan keçirməyə başlayın.
1. [Sign Up] düyməsini klik edin. 

3) Hesab yaratmaq
1. Tələb olunan hissələri doldurun. 
• İstifadəçi adı: YUN Hyung Soon
• Telefon nömrəsi və ya əvəzinə e-mail adresi is-
tifadə edin. 
2.  [Next] düyməsini klik edin. 
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4) Hesabın qeydiyyatdan keçirilməsi 
1. [Sign up] düyməsini klik edin. 

5) Telefonu təsdiqləmək
1. [Ok] düyməsini klik edin. 

6) Qəbul edilmiş kodun daxil edilməsi
1. Telefon (və ya E-mail)-in yoxlanılması haqda 
kodu qəbul edin. 
2. [Next] düyməsini klik edin.  

7) Şifrənin tələb olunması
1. [Sign in] üçün şifrə tələb olunur. 
2. [Next] düyməsini klik edin.  

8) Şifrənin daxil olunması
1. Şifrənin daxil edilməsi
2. [Next] düyməsini klik edin.

9) Maraqlarınızı qeyd edin. 
1. Hər bir tələb olunan hissəni doldurun. 
• Və ya [Hələlik ötüb keçmək]-ə  klik edin.
2. [Next] düyməsini klikləyin. 
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10) İzləmək üçün təkliflər
1. İzləmək üçün siyahıdan şəxsi seçin. 
2. Adının qarşısında olan [Follow] düyməsini 
seçin. 
3. [Next] düyməsini klik edin. 

11) Yenidən izləmək üçün təkliflər
1. Siyahıdakıları [Follow] üçün axtarış edin.
2. Əvvəlki qayda ilə istədiyiniz qədər [Follow] 
seçin.
3. Sseçımləri bitirdikdən sonra növbəti addıma 
keçin. 

12) Bildirişin yandırılması
1. Bildirişə icazə verin və ya [Hələlik ötüb 
keçmək]-ə klik edin.
2. [Allow notification]-nı klikləyin.

13) Bildirişləri göstərmək
1. [Allow] düyməsinə klik edin. 
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14) Tweet pəncərəsinin əldə olunması
1. [Home] pəncərəsi

1. [Notification] pəncərəsi 

2. [Message] pəncərəsi 

15) Profili redaktə etmək 
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16.) Tweet-dən çıxmaq 

17) Tweet-ə yenidən daxil olmaq

2. Tweet-i paylaşmaq
1) Mənim twitter-imdə nə isə yazmaq
1. Pəncərənin yuxarı sağ hissəsində [tweet] 
yarlığını klik edin. 

2) Yeni tweet-in təşkil olunması
1. Mətn pəncərəsində istədiyinizi yazın. 
2. [Tweet] düyməsini klik edin. 

3) Mənim twitter-imin göndərilməsi
1. Mənim tweet-imin vəziyyətini yoxlayın. 
2. Hal-hazırda tweet-mi görmək üçün [see 1 new 
twitter] hissəni klik edin. 

4\) Twitter-mi təsdiq etmək 
1. İndicə yazılmış mesaj görünür. 
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3. Profil məlumatlarının qeyd olunması
1) Redaktə olunan profilə baxış
1.  Pəncərinin orta hissəsindən [Edit profile] 
yarlıkını klik edin. 

2. Profil şəklini seçin. 
• [Bio] qutusunda özünüzü təqdim edin.
• Emosiya işarəsi əlavə edin. 
• Hal-hazırki yerinizi daxil edin. 
• Veb məlumatlarına daxil olun. 
• Doğum tarixinizi qeyd edin. 

3. Tənzimləmələri yekunlaşdırın. 
4. Əgər hər dəfə dəyişiklik edirsinizsə [Save 
changes]-ə klik edin. 

4. Profil məlumatlarının qeyd olunması
1. Məlumat növlərinin daxil edilməsi
2. Pəncərənin orta sağ küncündən [Profile and 
Settings] yarlıkına klik edin. 
3. [Settings and Privacy] funksiyasını klik edin.
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2) Tweet-lə bağlı məlumat növlərinin daxil 
edilməsi
2.1 Aşağıdakı məlumatları daxil edin: 
※ Qeyd: Hər şey dəyişə biləndir.
1. İstifadəçi adı 
2. E-mail 
3. Dil
4. Vaxt Zonası  

2.2  [Security] bölməsinin qurulması
1. Girişi yoxlayın və təsdiq edin. 
2. Şifrəni yenidən yoxlayın.
 

2.3  [Contents] bölməsinin qurulması
1. Ölkə 
2. Video tweet
3. Time-line və ya zaman tuneli. 
4. Sizin tweet arxiviniz 
 
  

2.4  Dəyişilmiş məzmunun yaddaşa verilməsi
1. [Save change] düyməsini klik edin. 

3) Dəyişilmiş məzmunun yoxlanılması
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Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Twitter üçün prosesi açıq şəkildə izah etdi?
2. “twitter.com” saytında twitter yaratdı?
3  Twitter saytı üçün üzv oldu?
4. Profili müvafiq olaraq redaktə etdi?
5. Twitter-i qısa şəkildə paylaşdı?
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İşin məqsədi: Bu modulu bitirdikdən sonra tələbə:
1.   Facebook üçün prosesləri aydın şəkildə izah etməyi bacaracaq;
2.   Facebook yaratmağı biləcək.

Təcrübə materialları:
1.   Stolüstü kompüter/Noutbuk
2.   Mənbə faylları
3.   Media tədrisə dəstək vasitələri

Avadanlıqlar və alətlər: 
1.   Kompüter və periferiyalar
2.   Dərslik & Dizayn məlumat kitabı
3.   Proyektor

Mövzu ilə əlaqəli biliklər

1. Facebook 
1) Facebook, Inc.  Amerikanın Kaliforniya Menlo Parkda yerləşən sosial media və sosial şəbəkə 

xidməti şirkətidir. Veb-sayt 4 Fevral, 2004-cü ildə Mark Zuckerberg, Harvard tələbələri və Markın 
otaq yoldaşları Eduardo Saverin, Andrew McCollum, Dustin Moskovitz və Chris Hughes tərəfindən 
yaradılıb. Təsisçilər ilk başda veb-saytın üzvlüyünü Harvard tələbələri ilə məhdudlaşdırdılar. Daha 
sonra onlar fəaliyyətlərini Boston ərazisində ali təhsil institutlarına,  Ivy League məktəblərinə və 
Stanford Universitetinə qədər genişləndirdilər. 

2) Facebook yavaş-yavaş digər müxtəlif universitet tələbələrinə dəstək verməyə başladı. 2006-cı 
ildən etibarən 13 yaşı tamam olmuş bütün şəxslərə Facebook-da istifadəçi qeydiyyatdan keçməyə 
icazə verildi. Amma burada hər bir ölkənin yerli qanunlarına əsasən müxtəlif tələblər ola bilər. Saytın 
adı Amerikan universitet tələblərinə tez-tez verilən üz kitabı (Face Book) adından gəlir. Facebook 
ilk fərdi ictimai təklifini 2012-ci ilin fevral ayında etdi. O zaman şirkətin dəyəri yeni qeydiyyatdan 
keçmiş bir müəssisə üçün bu günə qədər ən böyük dəyərə malik olub 104 milyard dollara çatdı. Artıq 
üç ay sonra şirkət ictimaiyyətə səhm satmağa başladı. Hazırda Facebook gəlirinin ən çoxunu ekranda 
görünən reklamlardan edir.

3) 2018-ci ilin yanvarından etibarən Facebook-un aylıq 2,2 milyarddan çox aktiv istifadəçi var. 
Onun məşhurluğu şirkət üçün məxfiliyə və istifadəçilər üzərində olan psixoloji təsirlərə dair əhəmi-
yyətli araşdırma aparmağa səbəb oldu. Son zamanlar şirkət saxta xəbərlərin sayına, aqressiv nitqlərə, 
xidmətləri üzərində şiddət təsvirlərinə görə böyük təzyiqə məruz qalır.    

4. Facebook yaratmaq
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Təcrübə təhlükəsizliyi və ehtiyat tədbirləri
1. Şagirdin masasını təmiz saxlayın.
2. Kompüterin enerji təchizatına və periferiyalara toxunmayın.
3. Dərsdən sonra kompüterə bağlı olan bütün naqilləri cərəyandan ayırın.

Təcrübə mərhələləri

1. Facebook-a üzv olmaq
1) Facebook qoşulmaq
1. [https://www.facebook.com] saytına daxil 
olun.
2. [Sign Up]-ı seçin. 

2) Tələb olunan məlumatları əlavə edin.
1. Facebooka üzvlük
• Ad: Hy***S****YUN
• E-mail ünvanı: ‘hsoon123@naver’
• Şifrə: ‘**happy***’

3) Təhlükəsizliyin yoxlanılması
• Şəklin göstərilməsini seçin. 
• Mən robot deyiləm. 
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4) Təhlükəsizliyi yoxlamaq
• Şəklin göstərilməsini seçin. 
• Mən robot deyiləm. 
• [Sign Up] düyməsini klik edin. 
• Kod göndərin. (6 simvol uzunluğunda)
• Təhlükəsizlik kodunu daxil edin. 

5) ‘www.facebook.com’-a icazə vermək 
• [Allow] düyməsini klik edin.

6) Facebook açmaq
• [Start-up screen]-ə gedin.

7) Məlumatın daxil edilməsi
• Üzvlük üçün prosesi tamamlayın. 

2. Facebook-u bəzəmək
1) Ətraflı məlumatın daxil edilməsi [Profile]
1. [Profile] ilə dostlarınızı tapın və yeni dost-
luqlar qazanın. 
2. Şəxsi məlumatlarınızı məxfi saxlayın. 
• Yalnız əsas məlumatları açıq saxlayın. 

2) Məlumatın dəyişdirilməsi
1. Doğum günü tarixini silin və ya gizlədin.
• [profile: photo]-nu klik edin.
• [About] menyusuna gedin. 
• [Contact and basic info] 
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2. Faktiki dili başqa dilə çevirmək
• Yuxarı menyu hissədən [Profile] şəklinizi klik 
edin. 
• [Settings] alt-menyusuna gedin. 

• [Privacy] bölməsindən [Language] yarlıkını 
klik edin.  
•  İstifadə edəcəyiniz dili seçin. 

3) Dostların tapılması
1. [Find Friends] hissəsindən dostları əlavə edin.
2. Dostları onlayn axtarın.
• Məktəb
• İş
• E-mail
• Digər şəxsi məlumatlar

4) Hesabın qurulması
1. [Account Settings] haqqında məlu-matları 
əldə edin. 
• [ ] simvola gedin. 

2. [Settings] alt-menyusunu seçin.
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3. [General] menyudan
[Edition is possible] bölməsini nəzərdən keçirin. 

• Ad: HS YUN
Şifrə: *7*******
• İstifadəçi adı:
facebook.com/yunhyungsoon.90

4. [Security and Login] bölməsini seçin. 
• Şifrə dəyişildikdə
Şifrə: *1*******
• Köməkçi addımları izləyin.

5. [Trusted contacts] seçin. 
• Ümumi olaraq bu sseçımləri ləğv edin. 
 
 
 

6. [Privacy] bölməsini qurun.
• Hesabın təhlükəsizlik vəziyyətini dəyişdirin. 
• Digər qurğuların daxil olub-olmamasına qərar 
verin. 

※ Qeyd 1:
Əgər Facebook istifadə etmirsinizsə  hesabınızı 
deaktiv edin. 

a. Facebook səhifəsinin yuxarı sağ küncündən    
işarəsini klik edin.
b. Tənzimləmələri seçin.
c. Sol sütundan [General] düyməsini klik edin. 
d. Manage your account düyməsini klik edin.  
Daha sonra [Deactivate your account]-u seçin və 
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təsdiq etmək üçün göstərişləri izləyin. 

※ Qeyd 2:
Hesabınızı yenidən aktivləşdirin:
a. Əgər Facebook hesabınızı deaktiv etdikdən 
sonra yenidən aktiv etmək istəyirsinizsə istədiy-
iniz zaman qayıtmaq üçün Facebook loqin və şi-
frənizi daxil edərək hesabı aktivləşdirə bilərsiniz.  
b. Yenidən hesab aktiv edən zaman sizin email 
adresi və telefon nömrəsinə girişiniz olmalıdır. 

Qiymətləndirmə testi

*T/E (tətbiq edilmədi) – Tələbə təcrübi məşq şəraiti ilə əlaqədar olaraq məşqi yerinə yetirə bilmədi

Qiymәtlәndirmә standart meyarları Bәli Xeyr T/E
Tələbə bu modulun tapşırıqlarını yerinə yetirərkən:
1. Facebook-un məqsədini qısaca izah etdi?
2. Facebook yaratdı?
3. Facebook profili dekorasiya etdi?
4.  Facebook saytı vasitəsilə dostlar tapdı?
5. Facebook hesabını deaktiv etmək üçün prosesi izah etdi?


